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Preface
The Jazz Handbook describes how to use Jazz to perform particu­
lar tasks and provides reference information about the program. 
The Handbook is designed for readers who have read the Jazz 
Primer or who are familiar with Jazz or other software programs. 
If you haven’t used Jazz or similar software before, you should 
read the Primer first. The Primer provides basic tutorial instruction 
in all the Jazz applications.
The Handbook assumes that you are familiar with the standard 
Macintosh techniques and terminology presented in Macintosh, the 
owner’s guide. Before you use the Handbook, you should be famil­
iar with such basic Macintosh techniques as moving the pointer, 
clicking and dragging, and using menus and dialog boxes.
The Handbook contains seven chapters, four appendices, and a 
glossary of terms. Most chapters present two kinds of information. 
The first part contains step-by-step procedures for performing tasks 
with Jazz. The second part describes commands, organized by 
menu, and includes descriptions of advanced commands that the 
step-by-step procedures don’t describe.
Chapter 1, Standard Tasks, describes tasks and commands that you 
can use in every Jazz application. Chapters 2 through 6 describe the 
five Jazz applications: Worksheet (Chapter 2), Graphics (Chapter 3), 
Word Processing (Chapter 4), Database (Chapter 5), and Communica­
tions (Chapter 6). Chapter 7, Functions, contains reference informa­
tion about the Jazz functions you can use in the Worksheet and 
Database applications. The appendices provide information about 
integrating the Jazz applications, managing memory, using Jazz with 
an international system, and Macintosh character codes. The Glossary 
provides definitions of common Jazz terms.
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What is 
Jazz?

Worksheet

Graphics

"—Lx

Word Processing

Database

Communications

Introduction
Jazz™ is five programs in one — Worksheet, Graphics, Word 
Processing, Database, and Communications. Designed for the 
Macintosh™ 512K computer, Jazz takes advantage of all of the 
Macintosh’s special characteristics, such as icons, pull-down menus, 
and dialog boxes. Once you know how to use a Macintosh, it’s 
easy to learn how to use Jazz.

The Worksheet application is an electronic spreadsheet in which 
you enter and store data, including numbers and text. You can 
then perform many types of calculations using expressions you 
create or functions built in to the program. For example, you can 
calculate monthly expenses and estimate costs with a Jazz work­
sheet. When you change any of the numbers, Jazz automatically 
recalculates the worksheet for you.

The Graphics application lets you create many different kinds of 
graphs that visually represent numbers you enter in a worksheet or 
database. If you change the data a graph is based on, Jazz automati­
cally updates the graph. You can enhance a graph by using titles, 
labels, and legends that explain parts of the graph.

With Word Processing, you can write, edit, and format letters, 
memos, reports, and other documents. For example, you can 
delete unnecessary text, move words and sentences to a different 
part of a document, and change the margins and spacing of a 
document.

The Database application lets you organize and manage informa­
tion, such as employee files. Finding individual facts or groups of 
facts is easy in a database. It’s easy, too, to sort the data in 
numeric or alphabetical order and produce a report on selected 
data.
You can work with your database directly, or use a Jazz form. A 
form is an easy way to enter, edit, or view data in a database, one 
record at a time. You can customize a form to your needs by 
adding detailed instructions about what to enter in each database 
field or by rearranging elements of a form so that it presents the 
data clearly. A form can show only some of the information in a 
database if you don’t want users to see every field.

The Communications application lets you use your Macintosh as a 
terminal to communicate with other computers. You can call infor­
mation services, public databases, and electronic bulletin boards to 
get information such as stock quotations. You can also send and 
receive documents to and from other computers. Connecting to a 
larger computer system lets you use programs that the larger 
system supports.
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Data integration

What You
Need to Use
Jazz

How to Use 
this Book

Overview

Each of the five Jazz applications helps you work with information 
in a particular way. By integrating these five applications, however, 
Jazz lets you combine different types of data and use the same data 
in many different ways. For example, you can make financial 
projections about sales in a worksheet using information stored in 
a database. You can then create a graph that shows the projections 
and include the graph and database information in a word process­
ing document. Jazz automatically updates the graph and the word 
processing document to reflect any changes you make in the 
database.
You can also integrate data you receive using Jazz Communications 
into other Jazz documents. For example, you can receive stock 
quotations from a time-sharing service into a worksheet, and draw 
a graph based on the data. You can then include the worksheet 
and graph in a report you create with Word Processing, and use 
Communications to send the report to another computer.

To use Jazz, you need a Macintosh computer with 512K of RAM 
and an external disk drive. An Apple Imagewriter printer and a 
numeric keypad are recommended. To use Jazz Communications, 
you need a modem, such as an Apple™ Modem 1200 or a Hayes® 
Smartmodem™ 1200.

The Jazz Handbook is designed for readers who are familiar with 
Jazz or similar software programs, or who have read the Jazz 
Primer. Once you have a basic understanding of Jazz, use the 
Handbook when you need specific information about tasks and 
commands.
The Handbook is organized so that you can read only the sections 
that contain the information you need. Each chapter is independ­
ent of the others: for example, you don't need to read the chapter 
on word processing to work with a database. In fact, you don’t 
even need to read an entire chapter — just read the parts that 
describe the task you want to perform or the command you want 
to use.
Chapter 1 describes tasks and commands you use in every Jazz 
application. Chapters 2 through 6 describe the five Jazz applica­
tions. Each of these chapters contains an overview, how-to 
sections, and a reference section. Chapter 7 and the appendices 
also provide reference information. In addition, the Glossary 
defines most of the terms and concepts used in the Jazz books.

The overview describes the application and why you use it. It also 
discusses concepts and terms that apply to the whole application. 
Unless you are already familiar with the application or the tasks 
you want to perform, you should read the overview before you 
read other sections in the chapter.
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How-to sections If you need information about how to perform a specific task, use 
the how-to sections. The how-to sections contain step-by-step 
explanations of the most common tasks.
Each section begins with a brief description of the task and why 
you want to perform it. Numbered steps follow the introduction, 
with explanations where necessary. Each step is printed in bold. If 
you don’t need the explanatory material, you can perform the task 
by following the bold steps and ignoring any text that isn’t bold. If 
a step consists of choosing one of several options, the options are 
listed below the step.
Some sections contain additional information under the heading 
Keep in mind. This information may include alternate ways to 
perform the procedure or hints that help you perform the task 
more easily.

Reference section The final section in each chapter is the reference section. Use it if 
you need a definition of an icon or an area of the screen, a 
description of a specific command, or a brief summary of proce­
dures. The reference section also discusses some advanced 
commands that the how-to sections do not describe.
Each reference section begins with an illustration of the screen, 
with the parts of the screen and the icons labeled and defined. 
Some reference sections also contain tables that summarize 
common procedures or list reference material not included in the 
how-to sections.
Each reference section ends with a description of each command 
you can use in the application. The commands are organized in the 
order in which they appear on the menus in the application.

3 Introduction





Chapter 1
Standard Tasks

Some commands are common to all the Jazz appli­
cations. For example, you can open, save, print, 
and close documents in all applications. You can 
also move from document to document. This chap­
ter describes the commands that are standard for all 
Jazz applications.



How to Start and End a Jazz Session
No matter which application you’re using or what task you’re per­
forming with Jazz, you have to follow some basic procedures each 
time you use the program. You must start a Jazz session, open the 
document you want to work on, save the document after you fin­
ish working on it, close the document, and end the Jazz session. If 
you’re working in one document and want to work with another 
open document, you must make the other document active.

Starting a 
Session

ja?

Keep in mind

To begin a session, turn on your Macintosh and start Jazz.
1. Insert the Jazz Start-Up Disk in the internal drive and the 

Jazz Program Disk in the external drive.
2. Turn on your Macintosh.

The Macintosh takes a few seconds to start.
3. Click the Jazz icon on the Macintosh desktop.
4. Choose Open from the File menu.

You can also double-click the Jazz icon instead of choosing Open.
The Jazz copyright screen appears briefly and then the Jazz desktop 
and menu bar appear.

Copying the Jazz Start-Up Disk. Make copies of the Jazz
Start-Up Disk and use the copies as document storage disks. This 
lets you start Jazz with any disk on which you store documents. 
You can give these disks any name you want.
Using international versions of Jazz. If you are using an inter­
national version of Jazz, see Appendix C before getting started.

Opening a 
Document

After you start Jazz, you need to open a document to begin your 
work session. You can work on a new document or one that 
you’ve worked on and saved before. You can have several 
documents open at one time.

Creating a new 
document

1. Choose New... from the File menu.
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Opening an 
existing document

2. Click the icon for the type of document you want to open.
Each of the Jazz applications uses a different type of document.

3. Click New.
A blank document and console appear. The menu bar also changes, 
depending on the application you are using.
To create a new document, you can also double-click the icon for 
the type of document you want to open.

Opening an existing document lets you view or change a docu­
ment you saved earlier.

1. Choose Open... from the File menu.

Standard
Tasks

Disk name---------
List of documents

Open a Document

Worksheet

FormDatabase

CommWord 
Processing

Graphics

Dll Types

“X

Jazz Start-Dp

[ Cancel ]

[ Eject ]

[ Driue ]

2. Click the icon for the type of document you want to open. 
Jazz displays the names of all the documents for the application 
you clicked.

3. Scroll through the list of documents and click a name.
If the document you’re looking for is on a different disk, click 
Eject and insert the correct disk. To see the names of documents 
on a disk in the other drive, click Drive.

4. Click Open.
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Keep in mind Opening a dependent document. When you save a document 
that depends on data from another document, such as a graph that 
depends on a worksheet or database, it’s a good idea to save both 
documents on the same disk. If the documents are not on the 
same disk and you try to open the dependent document, Jazz asks 
if it should look for the data in another document. If you click 
OK, you must specify the name of the other document. If you 
click No, the dependent document opens but is incomplete. For 
example, Jazz cannot plot inaccessible data on a graph. In addition, 
remember not to delete or change the name of the document that 
contains the data on which the other document depends.
Locating the document name. To open an existing document, 
type the first letter of the document name after you choose 
Open... from the File menu. Jazz highlights the first document 
whose name begins with that letter.

Making a 
Document 
Active

When you have more than one document open, only one is active. 
To work with a different document, you must make it the active 
document. The active document has horizontal lines and a close 
box in the title bar.

• Choose the name of a document from the Window menu.
The Window menu contains the names of all open documents. The 
document you select becomes active.
You can also click anywhere in the document to make it active.

Saving a
Document

When you are working with a document, you are really working 
with a temporary copy of it. To make a permanent record of the 
document, you must save it on a disk.
If you’re working on a document for a long time, it’s a good idea 
to save it often during the work session. That way, you have an 
up-to-date copy on a disk in case of a power failure or other 
accident.
When you save a document, you have several options, depending 
on whether it is a new document or one you saved before. For 
example, you can save a document under the name that appears in 
the title bar of the window, or under a different name. You can 
also save a document on a different disk.

8 The Handbook



Saving a document 
for the first time

1. Choose Save As... from the File menu.
2. Type the document name in the space provided.

The name can include any character or symbol on the keyboard 
except a colon.

Saving a document 
again

Saving a document 
under a different 
name

If you are using the Word Processing application, you can save the 
entire document or just the text in the document. If you click 
Entire Document, Jazz saves the document as you created it with 
all its formatting, text, and pictures. If you click Text Only, Jazz 
saves the text of the document, but does not save formatting, 
fonts, point sizes, styles, pictures, page breaks, headers, or footers. 
Choose the Text Only option, for example, if you want to use the 
document with another program.

3. Click Save.
If the name you enter already belongs to another document, Jazz 
asks if you want to replace the other document with the new 
document. If you click Yes, the contents of the new document 
replace the contents of the other document. If you click No, you 
must type a new name. Jazz then saves the document under that 
name.
The name you give the document appears in the title bar.

If you have already saved a document, you can save it again using 
the same name.

• Choose Save from the File menu.
Jazz replaces the previously saved version with the new version.

If you make changes in a document and want to save the original 
version of the document and the new version, you must save the 
new version under a different name.

1. Choose Save As... from the File menu.
2. Type the new document name.
3. Click Save.

You can also use this procedure to make an exact copy of an exist­
ing document.

9 Standard Tasks



Saving a document 
on a different disk

You may want to save a document on a different disk. For exam­
ple, if the Jazz Start-Up Disk is full, you need to insert another disk 
before you save a document.

1. Choose Save As... from the File menu.
2. Click Eject to change disks.
3. Insert the new disk.
4. Type the document name.

To save the document under its current name, you don’t have to 
type a name.

5. Click Save.

Keep in mind Saving documents on copies of the Jazz Start-Up Disk. You 
should save documents on copies of the Jazz Start-Up Disk so that 
you can begin Jazz with any document storage disk.
Saving a document on a different disk in the other drive.
To save a document on a different disk in the other drive, click 
Drive in the Save As... dialog box and then follow steps 2 through 
5 above. If you do this, however, you may have to change disks 
several times to save the document.
Saving dependent documents. If you have a document that 
depends on data in another document, such as a graph (which 
depends on a worksheet or database) or a form (which depends on a 
database), it’s a good idea to save both documents on the same disk. 
Otherwise, when you try to open the dependent document, Jazz 
indicates that the data on which it relies is not available and asks 
where it should look for the data.

Discarding
Changes to a 
Document

The Revert to Saved command cancels any changes you made to a 
document since you last saved it. If you never saved the docu­
ment, choosing this command cancels the current document and 
displays a blank document.

1. Choose Revert to Saved from the File menu.
Jazz asks if you want to revert to the last saved version.

2. Click OK.
This procedure is the same as closing a document without saving it 
and then opening it again.

Closing a
Document

Closing a document removes it from the desktop. If you close a 
document that you have changed without saving it, Jazz asks if you 
want to save the document.

1. Make the document active, if it is not already active.
2. Choose Close from the File menu.

You can also click the close box in the title bar.
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Ending a
Session

Keep in mind

Ending a session lets you leave Jazz so that you can use other 
Macintosh programs or turn off your Macintosh. Before ending, be 
sure to save any documents you want to keep.

• Choose Quit from the File menu.
You return to the Macintosh desktop.

Quitting without saving. If you choose Quit while a document 
you have changed is open, Jazz asks if you want to save it. If you 
click No, you will lose the changes you made. You can save the 
document by clicking Yes.

Tasks

Standard Tasks



How to Use Windows
A window is your view of a Jazz document. Each window displays 
only one document, but several documents can be open at the 
same time. You can change a window’s size, move the window on 
the desktop, and scroll through a document in a window.
Macintosh, the owner’s guide, describes the basic Macintosh tech­
niques for using windows. The following sections describe ways of 
handling windows that apply only to Jazz documents.

Scrolling a 
Document

Scrolling displays different parts of a document. You scroll by 
clicking the scroll arrows or dragging the scroll boxes in the scroll 
bars, just as you do in any Macintosh document. In Jazz, you can 
also click the page boxes in the scroll bars to scroll the document 
one window at a time.

Scroll box —

Page box —
Scroll arrow

Scroll bar —

T A I B I C I D I E I F I G 15

_

• Click a page box.
Depending on which page box you click, the document scrolls to 
the right or left or up or down by one window.
If you press the mouse button instead of clicking it, the document 
scrolls continuously in the direction of the page box you are using 
until you release the mouse button.

Changing the
Size of a
Window

If you have only one document open, enlarging the window lets 
you see more of the document. If you have several documents 
open, making each window smaller helps you see other documents 
that may lie underneath. You change the size of a window by drag­
ging the size box. You can also use Zoom Up to make a window 
fill the entire screen.

1. Choose Zoom Up from the Window menu.
The window fills the entire screen. Zoom Up changes to Zoom 
Down on the menu.

2. Choose Zoom Down from the Window menu.
This returns the window to its original size.
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How to Choose Fonts, Point Sizes, 
and Styles
Choosing a font, point size, and style affects the way characters 
appear in a document.

Changing the
Font and 
Point Size

The font is the typeface in which characters are drawn, and the 
point size is the size of the characters. Each font looks best in cer­
tain point sizes. When you choose a font, the point sizes it looks 
best in are outlined in the menu. Although the outlined point sizes 
suit the current font best, each font can appear in any point size.

1. Pull down the Font menu.
The available fonts and point sizes vary according to what is pres­
ent on your Start-Up Disk. If you have the Macintosh Font Mover 
utility, you can change fonts to suit your needs. See Macintosh, the 
owner’s guide, for information on the Font Mover utility.

Font

Venice
Toronto

Chicago

Geneva

New York

Monaco

Uenice 
Toronto 
Chicago 
Geneua 
Neuj Vork 
Monaco

9 point

I 0 poi nt

12 point

1 4 point

1 8 point
24 point

36 point
2. Choose a font or point size.

In a worksheet or database, the entire document changes to the 
new font or point size. In a graph or form, all the characters in the 
selected box change to the new font or point size. In a graph, if 
no box is selected, the axis labels and titles change.
In a word processing document, any new text you type appears in 
the new font or point size. To change characters you typed previ­
ously, you must first select the text and then choose the new font 
or point size.
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Keep in mind Point sizes in Communications. Although you can't change the 
font or style in the Communications application, you can choose 
between two point sizes.

Changing the
Style

You can change the style of text, or how characters appear in a 
document. For example, you can change plain text to bold or 
italic.

1. Pull down the Style menu.

Style
✓Plain Tent 

Bold 
Italic 
Underline 
(DfflQDDma 
guiatiJaiiD

2. Choose a style.
In a worksheet or database, the entire document changes to the 
new style. In a graph or form, all the characters in the selected 
box change to the new style. In a graph, if no box is selected, the 
axis labels and titles change.
In a word processing document, any new text you type appears in 
the new style. To change characters you typed previously, you 
must first select the text and then choose the new style.
Jazz adds the new style to styles you chose previously. For exam­
ple, if you choose Bold and then choose Italic, the text appears in 
bold italic. Choosing Plain Text, however, removes all other style 
options from the text.
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How to Print a Document
You can produce a printed copy of any Jazz document or part of a 
document. Before you print a document, you must make it active.
You then specify page and print settings so that the printed copy 
appears in the format you want.

Setting Up the
Page Format

Before you print, you may want to specify the page format, or 
setup, of your printed copy. For example, you can specify the 
width of the page margins. Jazz saves these page settings when you 
save the document. You don’t need to set them again unless you 
want to print the document in a different format. If you want to 
use the Jazz default page settings, you don’t need to choose new 
settings.

These options appear in 
all applications.

These options appear in~ 
a worksheet or database.

1. Choose Page Setup... from the File menu.

The dialog box that appears depends on the printer type and the 
application you are using. Jazz is initially set up for the Apple 
Imagewriter printer. If you are using a different printer, see the 
manual that came with the printer for information on how to set up 
Jazz for use with another printer. The header, footer, and margin 
settings appear in the dialog box only when you print Jazz work­
sheet and database documents.

2. Click a Paper Size.
Click Business Envelope, Corporate Label, or Small Label only if 
you are using the Print Merge... command in the Word Processing 
application.
• Letter is 8 1/2 inches wide and 11 inches tall.
• Legal is 8 1/2 inches wide and 14 inches tall.
• Computer Paper is 14 inches wide and 11 inches tall.
• Business Envelope is 9 1/2 inches wide and 4 1/8 inches tall 

(standard size 10).
• Corporate Label is 5 inches wide and 3 inches tall.
• Small Label is 3 1/2 inches wide and 1 inch tall.
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3- Click the Paper Orientation you want.
• Tall prints text with the top line across the top of the page.
• Tall Adjusted prints text with graphs, charts, or other pictures. It 

correctly proportions the parts of the document that are not 
text.

• Wide prints text, graphs, charts, and other pictures sideways on 
the page.

4 Click the Pagination you want.
If you choose No Breaks Between Pages, Jazz ignores any page 
breaks you inserted in the document and does not print headers 
and footers (if any).

5. Click the Reduction option you want.
50 percent reduces the document you are printing to half its 
normal size.

6. Click the Header or Footer box and type a Header or Footer 
if you want one.
The Header and Footer boxes appear when you are working with a 
worksheet or database.
A header is information that Jazz prints on the top of each page. A 
footer is information that Jazz prints on the bottom of each page.
The vertical bar ( | ) that appears by default in the footer box 
causes Jazz to center the footer. Use the vertical bar to format the 
footer into one, two, or three parts. Text not preceded by a verti­
cal bar is left-aligned. Text to the right of the first vertical bar or 
between two vertical bars is centered. Text after a second vertical 
bar is right-aligned. The vertical bar works the same way in a 
header as in a footer.
The # character in the footer box causes Jazz to print page num­
bers in the footer of the document. If you don’t want Jazz to num­
ber the pages in the footer, delete the # character. If you want Jazz 
to number pages in the header, type the # character in the header 
box.
To insert the current date in a header or footer, type the @ charac­
ter where you want the date to appear.
See Creating Headers and Footers in Chapter 4 for more informa­
tion about using headers and footers in the Word Processing appli­
cation. The Page Setup... dialog box in that application does not 
display header and footer settings.
Click a Margin box and enter the margin widths in inches.
Use decimals for fractions of an inch. For example, type 1.25 for 1 
1/4 inches.
The margin boxes appear when you are working with a worksheet 
or database.

8. Click OK.
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Printing a 
Document

Keep in mind

Jazz prints documents using page settings you specify. These set­
tings determine the print quality, the part of the document you 
want to print, and the kind of paper you’re using.

1. Choose Print Document... from the File menu.
If you are printing a form, this command is Print Current, and it 
prints the current form.

2. Click a Quality setting.
• Click High for the highest quality printing. This setting takes the 

longest time to print.
• Click Standard for quality similar to the printing on your screen. 

This setting is faster than High quality.
• Click Draft to print text only, in the font and point size that are 

standard for your printer. You can print in Plain Text, Bold, and 
Underline styles. This setting is the fastest of the three.

3. Click a Page Range setting.
If you click From, specify the first and last page numbers you want 
to print. For example, if you type 4 in the From box and 8 in the 
To box, Jazz will print pages 4 through 8 of the document.

4. Click Copies and type the number of copies you want to 
print.

5. Click the Paper Feed setting that describes the kind of 
paper you’re using.
• Continuous is for perforated paper.
• Cut Sheet is for single sheets of paper.

6. Click OK.
Jazz begins printing the document and a dialog box appears. To 
stop printing before Jazz prints the entire document, click Cancel. 
To interrupt printing temporarily, click Pause. To resume printing, 
click Continue.

Printing part of a document. To print part of a document, such 
as a few rows of a worksheet, select the area you want to print. 
Then choose Print Selection... instead of Print Document... from 
the File menu. Otherwise, follow the steps listed above.
Using storage space when printing. To print a document, Jazz 
first stores a temporary copy of the document on the disk. Be sure 
that you have storage space available on the disk for the temporary 
copy. If the disk doesn’t have enough space, Jazz indicates that the 
disk is full.
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Inserting page breaks. In the Worksheet and Word Processing 
applications, you insert page breaks using the Set Page Break or 
Insert Page Break commands. A page break tells Jazz to stop print­
ing the current page and move to the beginning of a new page.
Printing with Communications. You cannot specify headers, 
footers, or margin sizes for information you print with the Com­
munications application. When you print with Communications, 
Jazz prints only the information that is on the screen.
Printing problems. If Jazz doesn’t begin printing after you click 
OK in the Print Document... or Print Selection... dialog box, check 
that your printer is correctly connected to your Macintosh, and 
that it is turned on. Refer to the manual that came with your 
printer for additional troubleshooting information.
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How to Use Information in Different 
Document Types
Jazz lets you use the same information in more than one docu­
ment. For example, you can move or copy information from one 
document and use it in another document. Jazz also lets you 
convert information from another program to a Jazz worksheet.
Some types of documents depend on information you enter in a 
document of a different type; for example, you create a graph from 
data you enter in a worksheet or database. When you create a 
graph, you can see where the data you are using comes from by 
looking at the Reference Board.

Moving or
Copying 
between 
Documents

Once you enter information in a Jazz document, you can cut it or 
copy it and then paste it in another document. When you move or 
copy information from one document to another, the two docu­
ments don’t have to be the same type. For example, you can move 
a range of sales figures from a worksheet to a word processing 
document, or copy salary information from a database to a 
worksheet.
If you move information, or cut it from the original document and 
paste it in the new one, it no longer appears in the original docu­
ment. If you copy information, it appears in both documents, but 
the two copies are independent: changing the information in the 
new document doesn’t change the information in the original 
document.
You may want information you use in more than one document to 
remain linked to the original document. In a Jazz word processing 
document, you can use a copy of another document, called a 
HotView™, that automatically reflects changes to the original docu­
ment. You cannot change the information in a HotView directly in 
the word processing document as you can change information you 
move or copy. For more information on HotViews, see Chapter 4, 
How to Include Other Jazz Documents in a Word Processing 
Document.

1. Open the document you want to move or copy the 
information to.
To open a document, choose Open... from the File menu.

2. Open the document that contains the information you want 
to move or copy.

3. Select the information.
How you select information depends on the application you are 
using; see the section on selecting areas in each application 
chapter.
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4. Choose Cut or Copy from the Edit menu.
Cut removes the information from the document and places a copy 
on the Clipboard. Copy leaves the information in the document 
and places a copy on the Clipboard. Choose Cut if you want to 
move the information so that it appears in the other document 
only; choose Copy if you want the information to appear in both 
documents.

5. Click the document you want to move or copy the 
information to.

6. Select the location where you want to place the 
information.
In each application, you select a location in the same way as when 
you move or copy information within the same document.

7. Choose Paste from the Edit menu.
If you are placing the information in a database, choose Paste 
Values, Paste Record, or Paste Field.
In each application, Jazz pastes the information in the same way as 
when you move or copy information within the same document.

The information you want 
to move or copy

You can edit the--------
information or change its 
format in the new 
document.

Before

After
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Keep in mind

Showing 
References

Moving or copying to a worksheet or database. When you 
paste information you cut or copied in a worksheet, it replaces any 
entries in the area it fills. Select an area that does not contain 
entries you want to keep. If you paste an entire row or column 
into a worksheet, Jazz inserts the new row or column in the work­
sheet without replacing existing entries.
If you paste information in a database by choosing Paste Values 
from the Edit menu, the new information replaces the existing 
values. If you paste an entire record or field (by choosing Paste 
Record or Paste Field), Jazz adds a new record or field to the data­
base automatically. The new record or field does not replace 
existing values.
Formatting characteristics. Jazz preserves format as much as 
possible when you move or copy information from one document 
to another. When you move or copy information to a document of 
a different type, however, Jazz cannot always preserve the format. 
For example, if you copy text entries from a worksheet to a word 
processing document, Jazz does not preserve the text alignment.
You can adjust the format of the moved or copied information in 
the new document, just as you would if you typed the information 
in the document directly.

Opening the Reference Board lets you see information about data 
you select in one document and use in another document. For 
example, if you are graphing data from a worksheet, use the Refer­
ence Board to see the worksheet name and the range that contains 
the data you are graphing.

1. Choose Reference Board from the Window menu.
The Reference Board window appears at the bottom of the screen.

This closes the Reference Board.

Document type l_ ----------------------------------------------------------------------------------------------------------------------------------------------------------------

Worksheet Worksheet 1 :A 1 —
Document name / [a
Data selection------------------

2. Click the close box.

Converting a 
File from 
Another 
Program

You can convert documents, or files, created in another program 
so that you can use them with Jazz. There are three types of files 
you can convert: Lotus Symphony™ files, Lotus 1-2-3™ files, and 
Microsoft® files in the SYLK format. The file you convert becomes 
a Jazz worksheet document. You cannot convert a 1-2-3 or 
Symphony graph or a Symphony form, but you can convert the 
worksheet file that contains the data the graph or database form is 
based on.

Tasks
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Before you can convert a file, you must store it on a Macintosh 
disk. If the file you want to convert is from another Macintosh 
program, such as Microsoft Multiplan®, save the file on a disk using 
the SYLK format. If the file is not on a Macintosh disk, you must 
receive it on a Macintosh disk using XModem protocol in Jazz 
Communications. See Chapter 6 for instructions on sending and 
receiving a document.

1. Choose Convert... from the Apple menu.
2. Click the file you want to convert.

Jazz lists the names of the documents you can convert. If you can’t 
see all of the document names, use the scroll bars to scroll through 
the list. Click Drive to see the document names on your other 
drive. Click Eject if you need to change disks.

3- Click the document type.
• Click Lotus Symphony if the document was originally a 

Symphony file.
• Click Lotus 1-2-3 if the document was originally a 1-2-3 file.
• Click Microsoft SYLK if the document is in SYLK format.

4. Click Convert.
When Jazz finishes converting the file, the Save As... dialog box 
appears.

5. Type the document name in the space provided and click 
Save.
Do not use the name the document had before you converted it. 
Jazz saves the converted document under the name you type. To 
work with the document, you must choose Open... from the File 
menu.
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FLO : (CO) 3SUH(F3 ■ .Ffl) SHEE

A B r n F
i Total Operati ng Expenses for the Fiscal Year
e 1st quarter 2n d quarter 3r d quarter 4th quarter Totals
3 Haintenance $35,870 538,750 5b5,7b0 $35,b30 517b,010
4 Suppl ies 12,100 14,5b8 21,341 13,110 $b2,727
5 Salaries 214,170 225,711 245,175 248,855 $135,511
b Advertising 11,370 13,245 17,b50 12,bl3. 554,878
7 Publications a,012 1,b50 12,310 1,033 $31,005
8 Insurance 1,500 1,500 15,000 15,000 $41,000

10 Totals $212,b22 5311,432 $378,044 5335,041 $1,317,131
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Keep in mind Converting 1-2-3 and Symphony files. If the document you 
convert was originally a 1-2-3 or Symphony file, Jazz preserves 
many of the original file’s settings. Settings that Jazz preserves 
include: column widths, cell formats, range names, protection 
settings, default format, recalculation preferences, calculation order, 
and iteration count. Settings Jazz does not preserve include: 
Symphony window settings, Symphony DOC window format lines, 
1-2-3 window splits, and Graph and Query settings in both 1-2-3 
and Symphony. If the 1-2-3 or Symphony worksheet contains 
macros, they appear as cell entries in the Jazz worksheet, but they 
do not function. Converting a file does not affect how formulas 
function.
Converting SYLK files. When you convert a Multiplan SYLK file, 
Jazz does not preserve Union ranges and the Show Formula or 
Link features.
Database and word processing documents. After you convert 
a file to a Jazz worksheet, you can cut or copy the data from the 
worksheet and paste it into a database or word processing 
document.



Standard 
Window 
Features

Close boxClose box Title barTitle bar

Scroll boxScroll box

Page boxPage box Scroll barScroll bar

Scroll arrow



The Standard Commands Reference
Title bar includes the name of the active Jazz document or 
window, and lets you move the window by dragging the title bar.
Close box lets you close a window. Clicking the close box is the 
same as choosing Close from the File menu.
Scroll arrow lets you scroll through a document. Clicking a scroll 
arrow scrolls by line or character. Pressing a scroll arrow scrolls 
continuously by lines or characters.
Page box lets you scroll through a document by windows. Click­
ing the page box scrolls one window at a time. Pressing the page 
box scrolls continuously by windows.
Scroll box lets you move to a specific location in a document, 
relative to the length or width of the entire document.
Scroll bar changes the view of a document when you click it.
Size box lets you resize a window.

Tasks
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The Standard 
Commands

Jazz contains certain menus of standard commands that appear in 
all Jazz applications, and other menus that vary depending on the 
application. The menus specific to each application are described 
in the Reference section for each application.
This chapter describes the five standard menus that appear in all 
applications. These are the Apple, File, Window, Font, and Style 
menus. (The only exception is Communications, which has no 
Font or Style menu.)
In all menus, commands that require you to provide additional 
information appear in the menu with an ellipsis (...) after the com­
mand. Also, the Command key can be used in combination with 
another key as a shortcut to choosing a command from a menu. 
Commands that have Command key equivalents list them in the 
menu next to the command.

Apple menu I* File Windom Font Style

About Jazz...

Conuert... 
Oisable Undo

Strapbook 
Alarm Clock 
Note Pad 
Calculator 
Key Caps 
Control Panel 
Puzzle

About Jazz... shows the release number of Jazz and displays infor­
mation about how much memory you're using. Memory available 
for data: Tells you how much memory is currently available for 
working in Jazz (not including the Jazz program). Memory currently 
in use: Tells you what percentage of available memory you are 
currently using. See Appendix B for hints on memory management.
Convert... translates Lotus Symphony, Lotus 1-2-3, or Microsoft 
SYLK format spreadsheets into Jazz worksheets. The document you 
want to convert must be on a currently inserted disk, so that its 
name appears in the dialog box. You can use Jazz Communications 
to receive the document, using the XModem protocol. See Chapter 
6 for information on receiving documents.
• Lotus Symphony: Converts the selected Symphony spreadsheet 

to a Jazz worksheet.
• Lotus 1-2-3: Converts the selected 1-2-3 spreadsheet to a Jazz 

worksheet.
• Microsoft SYLK: Converts the selected Symbolic Link (SYLK) 

format document to a Jazz worksheet.
When you click Convert, Jazz converts the selected document.
After conversion, Jazz displays a dialog box that lets you name and 
save the converted document.
Jazz preserves all cell contents, formulas, named ranges, sort, table, 
and distribution settings for converted Symphony, 1-2-3, and SYLK 
format spreadsheets. Jazz also preserves all recalculation and pro­
tection settings, default display formats, default formats for text 
and numbers, text prefixes, and column widths. Union ranges, 
Show Formulas, and Link features are not preserved in converted 
SYLK documents.
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File menu
J2H_____

Nem...
Open...

Saue
Saue Rs...
Close

Page Setup...
I Print Selection...

j Print Document...
Print Merge...

Reuert to Sailed 
Quit

Disable Undo changes the Undo command on the Edit menu to 
Undo Disabled, so that you cannot use the Undo command. Dis­
abling the Undo command means that Jazz works faster and uses 
less memory each time you perform an action. Keep in mind, how 
ever, that while Undo is disabled, you will not be able to use the 
Undo command to undo or redo any actions. This command alter­
nates with Enable Undo, which activates the Undo command.
Desk Accessories lists the accessories available when using Jazz. 
Refer to Macintosh, the owner’s guide.

* File LLiindom Font Style

New... creates a new Jazz document, with a default title consisting 
of the name of the application that created it, followed by a 
number. You click one of the application icons in the dialog box 
and click New. (You can also just double-click an application icon 
to create a new document.)
Open... opens an existing Jazz document that has been saved on 
the disk. Clicking one of the application icons in the dialog box 
displays only documents created by that application. Clicking All 
Types displays a list of all Jazz documents on the disk. After select­
ing a document, you click Open. (You can also open the document 
by double-clicking the name.)
Save updates the active document and replaces the old copy on 
the disk with the updated one. After saving the document, you 
may continue working on it.
Save As... names and saves a document on the disk. This com­
mand also lets you save the same document under a different name 
and/or on another disk.
(In Word Processing, the Save As... command lets you save the 
document as you created it — with the format, text, and pictures 
— if you click Entire Document. If you click Text Only, Jazz saves 
just the text of your document, without the format, fonts, sizes, 
styles, pictures, page breaks, headers, or footers.)
Close closes the active document. If you made changes but did 
not save them, a dialog box appears. Clicking Yes saves your 
changes; clicking No closes the window without saving your 
changes. Clicking Cancel cancels the command.
(In Communications, the Close command removes the Communica­
tions window, and may terminate a communications link.)
Choosing Close from the menu is identical to clicking the close 
box in the window’s title bar.

Tasks
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Page Setup... specifies print settings for the active document. Jazz 
saves these settings when you save this document. Actual printing 
is done with the Print Selection..., Print Document..., Print Cur­
rent..., or Print Merge... commands.
The options in the dialog box will vary slightly depending on the 
printer you have. The options described below are for an 
ImageWriter printer.
• Letter: 8 1/2 inches wide, 11 inches tall.
• Legal: 8 1/2 inches wide, 14 inches tall.
• Computer Paper: 14 inches wide, 11 inches tall.
• Business Envelope: 9 1/2 inches wide, 4 1/8 inches tall (standard 

size 10 envelope).
• Corporate Label: 5 inches wide, 3 inches tall.
• Small Label: 3 1/2 inches wide, 15/16 inches tall.
• Tall: Text is printed parallel to the top of the page. Use Tall to 

print documents that consist only of text.
• Tall Adjusted: Graphs, charts, and other pictures are printed in 

correct proportion to the page size, so they do not appear dis­
torted. Use Tall Adjusted to print documents that consist of text 
and pictures or just pictures.

• Wide: Text is printed parallel to the left edge of the page.
• Normal pages: Jazz prints according to the page length you 

chose for the paper option, above, and prints page breaks and 
headers and footers (if any).

• No breaks between pages: Jazz ignores the page length and 
prints a continuous page, without headers and footers.

• None: Jazz prints text and pictures normal size.
• 50 percent: Jazz prints text and pictures at half their normal size.
• Header: The text printed at the top of every page in a worksheet 

or database document. By default, no header is printed.
• Footer.- The text printed at the bottom of every page in a work­

sheet or database document. By default, Jazz prints a footer con­
sisting of the document’s name and the current page number, 
centered between the margins. If you don’t want to include a 
footer, you can select this entry and press Backspace to erase it.

• Left Margin: The number of inches for the left margin in a work­
sheet or database document.

• Right Margin: The number of inches for the right margin in a 
worksheet or database document.

• Top Margin: The number of inches for the top margin in a 
worksheet or database document.

• Bottom Margin: The number of inches for the bottom margin in 
a worksheet or database document. The default is one inch.
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For margins, you can enter fractions of an inch in decimal form.
For example, you can enter 1.25 for a 1 1/4 inch margin.
By default, Jazz prints a one inch bottom margin (for the footer) 
and 1/4 inch left, right, and top margins. If you enter a header, 
you must also specify a top margin of at least one inch so that Jazz 
has enough space to print it.
For the header and footer, you can include the current page num­
ber by typing the # character where you want the page number to 
appear. When Jazz prints a page, it substitutes the current page 
number for the # character. This number increases by one each 
time a page prints.
You can include the current date in the header and footer by 
typing the @ character where you want the date to appear.
When Jazz prints a page, it substitutes the current date for the
@ character.
You can use the vertical bar ( | ) to format a header and footer so 
that Jazz prints it in one, two, or three parts.

If you enter: Jazz prints:

Widget Corp.
Widget Corp.
| Widget Corp.

Page # Widget Corp.
Page # Widget Corp.|@

1 part, left-aligned
1 part, centered
1 part, right-aligned
2 parts
3 parts

Widget Corp.
= k
i 1

Widget Corp.

Widget Corp.

Page 1 Widget Corp.

Page 1 Widget Corp. . 20-Mar-85

(Headers, footers, and margins are not used in graphics, forms, or 
communications documents. In word processing documents, 
headers, footers, and margins are set using commands on the 
Format menu.)
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Print Selection... prints a selected part of the document, using 
the settings defined with the Page Setup... command. The Print 
Selection... dialog box lets you specify how you want your selec­
tion to be printed. This dialog box is identical to the one for the 
Print Document... and Print Merge... commands. These settings are 
saved when you save the document. (This command does not 
appear in Word Processing, Communications, or when you are 
modifying a form in Database.)
• High: Highest quality printing. (Slowest printing speed.)
• Standard: Screen-quality printing. (Faster than High quality.)
• Draft: Text only, one font, one size. Plain Text, Bold, and 

Underline styles only. (Fastest speed.)
• All: For printing the entire selection.
• From: Page number for the first page to print.
• To: Page number for the last page to print.
• Copies: Number of copies to print.
• Continuous: Perforated paper.
• Cut Sheet: Single sheets of paper.
Clicking OK confirms all the settings and starts printing. Clicking 
Cancel cancels the command and returns you to the document.
While printing is in progress, Jazz displays a dialog box so you can 
control printing. Clicking Pause temporarily suspends printing until 
you click Continue. Clicking Cancel stops printing.
Print Document... prints the entire document using the settings 
defined with the Page Setup... command. The Print Document... 
dialog box lets you specify how you want your document to be 
printed. This dialog box is identical to the one for the Print 
Selection... command. These settings are saved when you save the 
document. (In Communications, this command produces a printed 
copy of the entire window.)
When you are using the form to enter, edit, or view data in the 
database, this command is instead Print Current..., Print 
Current... prints a copy of the active record (the record you are 
looking at.) The Print Current... dialog box is identical to the one 
for the Print Selection... command.
Print Merge... prints a word processing document that includes 
merged database fields or worksheet ranges or both. (This 
command appears only in Word Processing.) The dialog box that 
appears is identical to the one for the Print Document... command.
Clicking OK confirms all the settings and starts printing. Clicking 
Cancel cancels the command and returns you to the document. 
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While printing is in progress, Jazz displays a dialog box so you can 
control printing. Clicking Pause temporarily suspends printing until 
you click Continue. Clicking Cancel stops printing.
For each merged database field, Jazz first copies the value of the 
field, for each selected record in the database, to the word 
processing document. Then Jazz prints one copy of the document 
for each selected record.
For each merged worksheet range, Jazz reads across rows and 
down columns, printing one copy of the document for each cell 
value in the range.
If you have several merged fields or ranges in one document, the 
number of copies Jazz prints is equal to the number of values in 
the largest selection. When printing, Jazz repeats the value of the 
last cell in the smallest selection until it reaches the end of the 
largest selection.
You should generally use selections that are the same size (contain 
the same number of values), but your selections do not always 
have to be the same size. For example, you could merge the value 
in one selected worksheet cell with the values from 10 selected 
records in a database to have Jazz print the same worksheet value 
for each of the 10 database records.
Revert to Saved discards all unsaved changes to this document 
and opens the last saved version. (In Communications, this 
command discards unsaved settings and reverts to the last saved 
settings.) Jazz asks you to confirm that this is what you want to do 
before performing the command.
Quit ends the Jazz session and returns you to the Macintosh 
desktop.

Window menu

Window
| Zoom Up 36 IF

Clipboard 
Reference Board

Worksheet 1

Zoom Up expands the active window so it fills the entire screen. 
The menu bar and console remain visible. When the window fills 
the screen, this command becomes Zoom Down, which returns 
the window to its original size.
Clipboard opens the Clipboard, which contains whatever you 
most recently cut or copied. If the Clipboard is open, this 
command makes the Clipboard the active window. To hide the 
Clipboard, click its close box.
Reference Board opens the Reference Board, which displays the 
name of the last active worksheet, database, graphics, or word 
processing document. If the Reference Board is open, this com­
mand makes the Reference Board the active window. To hide the 
Reference Board, click its close box.
For a worksheet selection, the Reference Board also displays the 
address of the selected cell or range. For a database selection, the 
Reference Board displays the first field name of the selection.
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Window List lists the names of all open Jazz documents. Choos­
ing a name from the list makes that window the active window. 
(Alternatively, you can click the window to make it active.)

Font menu « File Ulindoni Font Style

Font
tlenice 
Toronto
Chicago 

✓Geneua
Neil) York
Monaco

S paDEC 
✓DE

D S psDfflC
D «[psDEC
DE paBmD
SO [poDccQ
36 point

Lists the available fonts and point sizes. The font and point size 
you choose are checked in the menu. In Worksheet and Database, 
the chosen font affects the entire document and data yet to be 
typed. In Word Processing, the font affects currently selected text 
or text yet to be typed. In Graphics, the font affects text typed or 
text yet to be typed in notation boxes, axis labels, and titles. The 
chosen font affects text typed in notation boxes or fields when 
you are using the form to enter data in the database. The default 
font is 10 point, Geneva.
(This menu is not available in Communications. Instead, Jazz uses 
only one font, which you can choose to display in either 9 or 12 
point, using the Terminal... command on the Settings menu.)

« File Window Font StyleStyle menu

style '1
/Plain Tent aep
Bold
Italic aei
Underline aeu
UmQlinti]® aeo
gBafladD ses

Lists all styles available for Jazz documents. The style you choose is 
checked in the menu. The default style is Plain Text, which cannot 
be mixed with other styles. You can combine the other styles, 
however, for a variety of effects.
In Worksheet and Database, the chosen style affects the entire 
document and data yet to be typed. In Word Processing, the 
chosen style affects currently selected text or text yet to be typed. 
In Graphics, the chosen style affects text typed or text yet to be 
typed in notation boxes, axis labels, and titles. The chosen style 
affects text in notation boxes or fields when you are using the 
form to enter data in the database. (This menu is not available in 
Communications.)
Other commands on the Style menu vary depending on the appli­
cation you are using. These commands are described in the 
Reference section for each application.
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Chapter 2 
Worksheet

Jazz’s Worksheet is a powerful tool for storing, 
manipulating, and analyzing data. The Jazz work­
sheet is dynamic: you can use it to store data, to 
build relationships among data, and to calculate 
with data. If you change one entry in a worksheet, 
other entries that depend on it change also. This 
makes it easy to keep your worksheet up-to-date, 
and lets you play with variations of the same 
calculation. For example, Jazz makes it simple to 
calculate loan payments for various principal 
amounts.



L
A worksheet resembles a giant spreadsheet, and you use it in the 
same way — to enter data in tabular form and calculate with the 
data on it. The Jazz worksheet is large; it has 8192 rows and 256 
columns. Rows are labeled 1 through 8192 in the left border of the 
worksheet, and columns are labeled A through IV in the top 
border. The intersections of columns and rows define cells; the 
column letter and row number make up a cell's address. For exam­
ple, B67 is the cell address of the cell that is in column B, row 67.

L
L
L

Using ledger paper 
to tabulate data

Using a Jazz worksheet 
to tabulate the same data

Cell address-----------------
Cell

TotalsF* QuARTeR

'108Z10

£70
5 2

-

Tot als

7^50
1Z310
4wh

Ha /nte nance

F’AA.A'K IE » 

At>vE-ktisin& 

Fu-DE/CAT/OAJS

lir QuARtER 2H* QuA-KTER

IoTal. OpmA-rjN& Fx-tenses Fon Fhe Fiscal Year

2727
Z5IF

ZT

20,3\3
150 00

« File Edit Window Range Tools Font Style

2

L
L
L

Cells hold worksheet entries. You can enter numbers, text, or for­
mulas in a worksheet cell. Jazz also has built-in formulas, called 
functions, that you can enter in a cell.
Once you make an entry, Jazz lets you work with it in many ways. 
You can change cell entries or change how Jazz displays them. You 
can make several copies of an entry or move it to another part of 
the worksheet. You can use formulas or functions to calculate with 
other entries and to build relationships among them. Jazz also lets 
you protect entries from changes, and hide entries from view.
Even though the worksheet is large, Jazz works most efficiently if 
you use as little worksheet space as possible. It’s a good idea to try 
to keep entries in the upper left area of the worksheet.
You can use worksheet data with other Jazz applications. For 
example, you can present worksheet data visually using the 
Graphics application. When you change the data in the worksheet, 
Jazz automatically changes the graph, too. You can also include 
worksheet data in a word processing document. If you use work­
sheet data in another Jazz document, you should store the two 
documents on the same disk.

L
L
L
L
L
L
L
L
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How to Enter Data
Entering data in a worksheet ceil is similar to writing it on a piece 
of paper: you record the data in the cell just as you record it on 
the paper. You can edit and remove a worksheet entry, as you can 
a paper entry. With an electronic worksheet, however, you can 
build relationships among cells, so that a change to one entry 
changes other entries automatically, instead of requiring you to 
change other entries manually.
The data you enter in a cell can be a number, text, or a formula. 
See How to Do Basic Calculations for information on entering 
formulas.

"I
1

Entering 
Numbers

The entry appears in the 
entry box.

Active cell address--------

The entry appears in the 
contents box and in the 
cell after you press Enter.

Once you enter a number in a worksheet cell, you can use it in 
calculations. For example, you can enter the sales figure for the 
third quarter in a cell, and later use that entry to calculate a yearly 
sales total.

1. Click the cell in which you want to enter the number.
Jazz makes this cell the active cell by highlighting it.

2. Type the number.
The number appears in the entry box as you type it.
A number must begin with one of these characters:

0123456789+—.$%
Do not include letters or more than one decimal point in a num­
ber. Include spaces only when you enter a number that contains a 
fraction, such as 25 1/4. You can include commas, but Jazz does 
not display them. If you make a mistake, press Backspace to delete 
the last character.

3. Press Enter or Return, or click another cell.
The number appears in the cell. If you press Enter, this cell 
remains the active cell and the number appears in the contents 
box. If you press Return, the cell below this one becomes the 
active cell. If you click another cell, the cell you click becomes the 
active cell.

Before
Edit Window Range

------\

Jazz treats a number that doesn’t follow the rules listed above as a 
text entry. Correct the mistake in the entry and press Enter again.

Worksheet



Keep in mind The appearance of numbers. A number can appear in a cell in 
many different ways, depending on the display format you set for 
the cell. To change a cell's display format, select the cell and 
choose Format from the Range menu. See Changing the Format of 
Numbers later in this chapter.
Long numbers. A number may have too many characters to fit in 
the cell. If the display format of the cell is General, Jazz displays 
the number in scientific notation.
If the format of the cell that contains the number is not General, 
Jazz displays ellipses (...) in the cell instead of the entry. This does 
not affect the way Jazz stores the number. When you make the 
column wide enough, the entire number appears.
Entering a sequence of numbers. You may want to number 
rows or columns, or enter sequential numbers for a table or graph. 
To enter a sequence of numbers in a range, select the range and 
choose Fill from the Range menu.

Entering Text You can enter text in a worksheet cell to label numeric data. For 
example, you may want to use text entries as headings for the 
columns of a table.

1. Click the cell where you want to enter text.
2. Type the text entry.

The text appears in the entry box as you type it.
A text entry can begin with a letter or with any symbol on the 
keyboard except an equal sign (=). The rest of the entry can con­
tain any characters, with one exception. You can use numbers in a 
text entry only when it also includes one or more letters, or begins 
with a text-formatting character.
If you make a mistake, press Backspace to delete the previous 
character.

3. Press Enter or Return, or click another cell.
The text entry appears in the cell. If you press Enter, this cell 
remains the active cell, and the entry appears in the contents box. 
If you press Return, the cell below this one becomes the active 
cell. If you click another cell, the cell you clicked becomes the 
active cell.
A double quotation mark (”) appears in the contents box of a text 
entry, but not in the cell. This indicates that the entry is a text 
entry.
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Keep in mind Long text entries. If you enter text that is too long for Jazz to 
display in one cell, the entry extends into the empty cells to the 
right. If the cells to the right are not empty, Jazz cuts off the entry 
and displays ellipses (...) at the end of the entry.

The truncated entry 
appears in the cell, 
followed by ellipses.

The entire entry appears 
in the contents box. W

orksheet

Jazz stores the whole entry even if it cannot display it completely 
in the worksheet. To make the complete entry appear in the work­
sheet, clear the cells to the right, or widen the column that con­
tains the entry.
Text-formatting characters. Beginning an entry with a text­
formatting character identifies the entry as text, no matter what 
characters the entry contains. It also makes the entry appear in the 
cell in a specific way. When you type an accent mark (' ) as the 
first character, the entry is right-aligned in the cell. Typing an 
apostrophe (’) makes the entry left-aligned, typing a caret (A) 
centers it in the cell, and typing a backslash (\) repeats it across 
the cell. If you do not use a text-formatting character, Jazz aligns 
the text entry according to the format of the range, if any, or 
according to the default text format for the worksheet.
A double quotation mark (”) appears in the contents box of a text 
entry, no matter what text formatting character you use. It does not 
appear in the cell.
Text that begins with a number. A text entry can begin with a 
number, such as 15 Elm St. or 1985 Sales. Jazz assumes that an 
entry is text if it contains a letter, with the exception of numbers 
in scientific format.
To type a text entry that contains only numbers, use a text format­
ting character as the first character of the entry. This is helpful in 
creating a column heading such as 1985.

Editing an 
Entry

Editing a cell entry can involve erasing characters or inserting new 
characters. You can edit an entry while you’re typing it, or after 
you enter it.

Canceling an entry • Click the Cancel icon.
The Cancel icon appears as soon as you start typing an entry.
After you click the Cancel icon, Jazz erases the entry from the 
entry box. You can type a new entry or select another cell.
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Replacing an 
existing entry

1 Click the cell that contains the entry.
2 Type a new entry.

The original entry remains in the contents box, and the new 
characters appear in the entry box.

3 Press Enter.
The new entry appears in the contents box and in the worksheet 
cell. The original entry disappears.
If you cancel the new entry before you press Enter, the original 
entry remains in the cell.

Changing an entry 1 Double-click the cell that contains the entry.
The entry appears in the entry box, and the entry box is 
highlighted.
You do not have to double-click the cell to edit an entry you are 
currently typing.

2. Click a location between characters in the entry box.
To add a character, click where you want to insert it. To delete a 
character, click to the right of the character you want to delete.
The pointer becomes an I-beam when you move it into the entry 
box. When you click a location, the entry box is no longer high­
lighted. A vertical bar indicates the insertion point: the location 
where you add or delete characters.

3 Add or delete one or more characters.
To add a character, type the character. To delete the character to 
the left of the insertion point, press Backspace.
You can continue to edit the entry by clicking another location in 
the entry and adding or deleting characters.

The entry appears 
highlighted in the 
entry box.

You can insert or delete 
characters at the 
insertion point.

lb File Edit Window Range
Before After

* File Edit Window Range
"Janary

4. Press Enter.
The revised entry appears in the contents box and in the work­
sheet cell.

Keep in mind Deleting several characters. After you double-click an entry, 
drag the pointer across two or more characters to highlight them. 
Press Backspace once to delete the highlighted characters.
You can also highlight several characters and then type a character. 
Jazz deletes the highlighted characters and inserts the new charac­
ter at the insertion point.
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Inserting a cell or range address. After you double-click an 
entry and click an insertion point, click a cell or select a range in 
the worksheet. The cell or range address or name appears in the 
entry.
Changing an entry when a range is selected. You can change 
an entry in one cell without affecting the current selection. Make the 
cell you want to change the active cell and choose Open Cell from 
the Edit menu. The entry appears in the entry box, and the entry 
box is highlighted.

W
orksheet
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How to Select Worksheet Areas
Before you can work with an area of the worksheet, you must 
select it. The selected area can be a single cell, a range, or an entire 
row or column.
Selecting a cell makes it the active cell. You can enter data or a 
formula in the active cell, or perform commands on it, such as 
changing its format or copying its contents.
Selecting a range, or rectangular group of cells, lets you work on 
more than one cell at a time. You can perform many Jazz com­
mands on an entire range of cells. For example, you can change 
the appearance of cell contents in a range, or copy a range to 
another area of the worksheet.
Selecting a row or column lets you perform commands on the 
entire row or column, such as inserting or deleting.

Selecting a
Cell

E]

You must select a cell before you can enter data in it or perform a 
command on it. For example, you can cut the contents of a cell 
only after you select it.

1. Position the pointer in the cell you want to select.
You can use the standard Macintosh techniques to move around in 
a worksheet, such as clicking a scroll arrow or clicking and drag­
ging a scroll box. You can also click a page box to move the work­
sheet one window at a time.

2. Click the cell.
The cell is highlighted, and its address appears in the selection 
box. After you select a cell, the insertion point in the entry box 
means that you can enter data in the cell. If the cell already con­
tains an entry, the entry appears in the contents box.

< File Edit Window Range< File Edit Window Range

Keep in mind Typing a cell address. You can also select a cell by typing its 
address in the selection box. Double-click the selection box to 
highlight it. Type the cell address and press Enter.
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Alternate methods of moving. The End Navigator contains four 
arrows. When you click an End Navigator arrow, Jazz moves the 
active cell in the direction of the arrow you click. Jazz selects the 
next filled cell that borders a blank cell. The End Navigator is help­
ful for moving among adjacent blocks of data.

Selecting a 
Range

Selecting a range lets you perform commands on a group of cells, 
rather than on a single cell. A range is any rectangular block of 
cells, such as part of a row or column, a whole row or column, a 
rectangle that spans many rows and columns, or the whole 
worksheet.

These are ranges.

These are not ranges.

You select a range by dragging the pointer across the cells in the 
worksheet.

1. Drag the pointer from one corner of the range you want to 
select to the diagonally opposite corner.
To extend the range to include a cell that is outside the window, 
drag the pointer across the scroll bar onto the desktop. Jazz auto­
matically scrolls the worksheet and the range in the direction of 
the pointer. Move the pointer back into the worksheet to stop the 
scrolling.

2 Release the mouse button.
The range is highlighted, and its address appears in the selection 
box. The active cell, in the upper left corner of the range, is 
outlined.
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Keep in mind Typing a range address. A range address contains the addresses 
of the upper left and lower right corner cells of the range, sepa­
rated by two periods (for example, B7..D9). Do not use spaces in a 
range address.
To select a range by typing the range address, double-click the 
selection box to highlight it. Type a range address and press 
Return.

Window Range Tools Font Style

Changing the active cell in a range. Click the Corner Navigator 
to move the active cell counter-clockwise to the next corner cell.
Press Return or Shift Return to move the active cell one cell down 
or up, respectively. Press Tab or Shift Tab to move the active cell 
one cell to the right or left, respectively.
Expanding and shrinking the range. To expand a range you 
already selected, hold down the Shift key and click a cell outside 
the range. The range expands so that the cell you clicked becomes 
a corner cell. To shrink the range, hold down the Shift key and 
click a cell inside the range. The range shrinks so that the cell you 
clicked becomes a corner cell.
Using the End Navigator to select a range. Select a cell, then 
press Shift and click one of the arrows in the End Navigator. Jazz 
selects a range in the direction of the arrow you click. The range 
extends to the next filled cell that borders an empty cell.
You can also select a range and then press Shift and click the End 
Navigator. Jazz extends the range in the direction you click, so that 
it includes the next filled cell that borders a blank cell. This is 
helpful for selecting adjacent blocks of data.
Using range names. To make a range easier to work with, you 
can name it. After you name a range, you can use the range name 
instead of the range address in the selection box or in a formula. 
See Naming a Range later in this chapter.
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Selecting a
Row or 
Column

Selecting a row or column lets you perform a command on the 
entire row or column. For example, you select a column to delete 
it, or to move an entire column of a large table. To conserve mem­
ory, you should only select an entire row or column when you 
want to perform a command on every cell in the row or column.

Click here to select 
Row 1.

Click here to select 
Column A.

2 To select a range of rows or columns, drag the pointer 
across the labels of the rows or columns.
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How to Change Worksheet Entries
You can change worksheet entries in many ways. You can move 
them to another part of the worksheet, copy them, or erase them.
You can also transpose entries, or insert or remove entire rows and 
columns.
When you erase, move, or copy, you work on ranges that can con­
tain one cell or many cells. You can move or copy ranges from 
one worksheet area to another, or to another worksheet.
When you transpose entries, you move two or more cells from a 
row to a column, or from a column to a row. When you insert or 
delete rows or columns, you work on entire rows or columns of 
cells.
Jazz does not actually remove cells from the worksheet when you 
erase, move, or transpose entries. These procedures affect only the 
entries. When you delete entire rows or columns, however, Jazz 
removes the cells as well as the entries they contain. When you 
insert rows or columns, Jazz adds empty cells to the worksheet.

Erasing 
Entries

Erasing an entry removes the entry from the cell, but does not 
remove the cell itself.

1. Select the cell or range you want to erase.
2. Choose Clear from the Edit menu.

Jazz removes the entries from the cell or the range.

The range you want to 
erase

Keep in mind

i File Edit UJindoLL* Range
After

Cutting and pasting. You can also erase an entry by selecting it 
and then choosing Cut from the Edit menu. This removes the 
entry from the worksheet and places it on the Clipboard. You can 
then paste it in another part of the worksheet or in another 
document.
Erasing entries referred to by formulas. When you clear an 
entry from a cell that a formula refers to, the formula becomes 
invalid. All formulas that depend on the invalid formula also 
become invalid. Similarly, when you clear the contents of a corner 
cell of a range that a formula refers to, the formula becomes 
invalid.
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If you cut an entry and then paste it to the worksheet, a formula 
that refers to it is no longer invalid. Jazz recalculates the formula 
with the new cell address.
Protection status and display format. When you clear an entry, 
Jazz removes the protection status and display format from the cell. 
See How to Protect Data and How to Change the Worksheet’s 
Appearance later in this chapter.

Moving or
Copying 
Entries

Moving data, or cutting it from one part of the worksheet and 
pasting it in another area, is a useful way of reorganizing the 
worksheet. When you move an entry, it disappears from the 
original location and appears in a new location.
Copying data from one part of the worksheet and pasting it in 
another area lets you use the same data in different parts of the 
worksheet. When you copy an entry, it remains in the original 
location and appears in a new one.

1. Select the cell or range you want to move or copy.
2. Choose Cut or Copy from the Edit menu.

Choose Cut to prepare to move a range. Choose Copy to prepare 
to copy a range. In both cases, Jazz places a copy of the selected 
cell or range on the Clipboard.
If you choose Cut, the entries in the range disappear from the 
worksheet. If you choose Copy, the contents of the range do not 
change.

3. Click the upper left corner cell of the range to which you 
want to move or copy the entries.
If you want to move or copy the entries to another worksheet, 
open the worksheet. Then click the upper left corner cell of the 
range where you want to paste the entries.

4. Choose Paste from the Edit menu.
Jazz copies the range from the Clipboard to the new location.

W
orksheet

Before

The range you want to 
move

The cell you select 
becomes the upper 
left corner of the 
moved range.
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Keep in mind Multiple copies. To make multiple copies, select a range to paste 
the entries into that is large enough to contain one or more com­
plete copies of the range you cut or copied. After you choose 
Paste from the Edit menu, Jazz fills the range you selected with as 
many complete copies of the moved or copied range as possible. 
This is useful, for example, to copy a formula into every cell in a 
selected range.

The range you want to 
move

The range where you 
want to paste multiple 
copies

Before

Jazz fills the range withJazz fills the range with- 
as many copies as it canas many copies as it can

After

You can make multiple copies of part of a row or part of a column 
using a different method. If you cut or copied part of a row, select 
part of a column to paste into. When you choose Paste from the 
Edit menu, the column segment becomes the left side of the range 
that contains multiple copies.
Similarly, if you cut or copied part of a column, select part of a 
row to paste into. When you choose Paste from the Edit menu, the 
row segment becomes the top row of the range that contains mul­
tiple copies.
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The range where you 
want to paste multiple 
copies

The column segment you 
want to copy

1 Jazz fills the cells below 
each cell in the selected 
range with copies of the 
column segment.

Before

After

A
. Inuentory

C 4 D i e ' 1 F G O
24 Item fl
25 ---------------------- item no------------------- Item No. Item No Item No

26 Ordered Ordered ^Ordered Ordered

27 .Sold Sold Sold Sold

28 iOn Hand On Hand iOn Hand iOn Hand

Protection status and display format. When you cut an entry, 
Jazz removes the protection status and display format from the cell 
and moves it with the entry to the Clipboard. See How to Protect 
Data and How to Change the Worksheet’s Appearance later in this 
chapter.
Moving and copying formulas. Jazz automatically adjusts 
formulas that you move so that they still refer to the same cells. 
Similarly, Jazz adjusts formulas in other cells that refer to a moved 
cell. Formulas that you copy do not always refer to the same cells. 
See Copying Formulas later in this chapter.
Cutting entries referred to by formulas. When you cut an 
entry from a cell that a formula refers to, the formula becomes 
invalid. All formulas that depend on the invalid formula also 
become invalid. Similarly, when you cut the contents of a corner 
cell of a range that a formula refers to, the formula becomes 
invalid.
If you cut an entry and then paste it to the worksheet, a formula 
that refers to it is no longer invalid. Jazz recalculates the formula 
with the new cell address.
Canceling a moved or copied range. Choose Undo Paste from 
the Edit menu to erase a moved or copied range from the work­
sheet. The entries remain on the Clipboard until you place new 
data on the Clipboard.

W
orksheet
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Transposing
Entries

Transposing entries moves data from a row to a column, or from a 
column to a row. For example, you may want to transpose a 
column of entries in one table to a row in a new table.

1. Select the range that you want to transpose.
You can select cells in a single row or column, or a range with 
several rows or columns.

2. Choose Cut or Copy from the Edit menu.
Choosing Cut removes the entries from the original location and 
places them on the Clipboard. Choosing Copy leaves the entries in 
the original location, and places a copy of the entries on the 
Clipboard.

3. Select the cell or range at the location where you want to 
place the transposed range.
Select one cell to transpose one copy of the range.
To transpose multiple copies of a single column, select a range of 
cells in the same column. Similarly, to transpose multiple copies of 
a single row, select a range of cells in the same row.

I 4. Choose Paste Special. . . from the Edit Menu.
5. Click Transpose.
6. Click OK.

Jazz transposes the entries from a row to a column, or from a 
column to a row.

The row of entries you 
want to transpose.

Before

The cell you selected 
becomes the upper left 
corner of the transposed 
entries.

If you selected two cells, 
the transposed range 
contains two columns — 
of entries.

After After

Inserting and 
Deleting Rows 
and Columns

Inserting or deleting entire rows and columns lets you rearrange 
the worksheet easily. For example, you may want to enter new 
columns of information in a table, or delete rows of invalid data.
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Inserting Rows 
and Columns

1 Select one or more rows or columns.
To select a row or column, click the row or column label. When 
the command is completed, Jazz inserts the new row above the 
row you select. Similarly, Jazz inserts the new column to the left of 
the column you select.
To insert more than one row or column, select as many rows or 
columns as you want to insert.

Select the number of — 
rows you want to insert.

After

2. Choose Insert Rows or Insert Columns from the Edit menu.

W
orksheet

Jazz inserts blank rows­
and moves existing rows 
down.

1. Select one or more rows or columns to delete.Deleting Rows 
and Columns 2 Choose Cut from the Edit menu.

Jazz removes the selected rows or columns, along with any data 
they contain, from the worksheet, and closes up the space around 
them. The Clipboard now contains the deleted rows or columns, 
so you can choose Paste from the Edit menu to move them to 
another part of the worksheet, or to another worksheet.

Select the columns you 
want to delete.

Before
A Bill D E F G 1 o

1 ITEM |ITEI 1 Mil jjTpt'EPEt' SOLD ON HAND PRICE TOTAL fl

---------2- Bi nnc'Tji’3 n— •480 2 3 $45 00 $90 00

3 Booklets 1 10 250 87 163 $0 50 $43 50

4 Carryalls 376 1 00 7 93 $8 00 $56 00

5 688 1 oo| 47 53 $2 50 $1 1 7 50

Jazz removes the 
columns.

After
A B I C D —e r F G

1 ITEM SOLD ||jN HANI- PRICE TOTAL
2 3 $45 00 $90 00

87 163 $0 50 $43.50-

4 Carryalls 7 93 $8 00 $56 00

5 Film, Cart 47 53| $2 50 $1 17.50

Keep in mind Effect on formulas. Inserting or deleting entire rows or columns 
may move formulas or the cells they refer to. The formulas con­
tinue to refer to the same cells as before.
When you insert rows or columns into a range that a formula 
refers to, Jazz adjusts the formula to include the new cells in the 
range.
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When you delete a row or column that contains a cell that a for­
mula refers to, the formula becomes invalid. All formulas that 
depend on the invalid formula also become invalid. Similarly, 
when you delete a column or row that contains a corner of a 
range that a formula refers to, the formula becomes invalid.
If you paste a row or column in another part of the worksheet, a 
formula that refers to a cell in it is no longer invalid. Jazz recalcu­
lates the formula with the new cell address.
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How to Do Basic Calculations

Entering 
Formulas

Using formulas and Jazz functions, you can perform calculations 
automatically with the data you enter. A formula always begins 
with an equal sign (=). It can be a simple arithmetic operation 
with numbers, such as =3+5. It can also be more sophisticated, 
using the values in cells instead of actual numbers; for example, 
= A1+(A2-G4)/H3. Referring to cells in a formula instead of using 
actual numbers makes use of the power of the worksheet: if you 
change the value in the cell, Jazz recalculates the formula and dis­
plays the new result automatically. Jazz formulas let you calculate 
with numbers (arithmetic formulas), combine pieces of text (text 
formulas), and perform logical operations, such as comparing 
values in two cells (logical formulas).
Jazz functions are built-in formulas that save you time. Using a 
function saves you from entering a formula yourself; you just pro­
vide the values the function works with. Functions can be com­
bined with other functions or entries in a formula in order to 
perform more complex calculations. The Jazz functions include 
many formulas for common operations. For example, the AVG 
function finds the average of a series of numbers.
You can copy formulas and functions so that you need to build a 
set of relationships among cells only once. For example, if you 
have several columns of numbers that you want to total individu­
ally, you can enter a formula that totals the numbers in the first 
column, and then copy the formula to the other columns.

A formula calculates with numbers or text and results in a value. 
When you enter a formula, the value of the formula, rather than 
the formula itself, appears in the worksheet cell. When you change 
the value of a cell that a formula refers to, Jazz automatically recal­
culates the formula and displays the new result.

You enter: The cell displays:
= 3+5 8
= A1+A2 8, if the value in Al is 3

and the value in A2 is 5

A formula contains values. You can use actual values, such as 8, or 
cell or range addresses, such as G5..J2O. Most formulas also contain 
at least one operator. Operators, such as +, tell Jazz what kind of 
calculation to perform.

1. Select the cell in which you want to enter the formula.
2. Type =

This marks the beginning of a formula.

W
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3 Enter the first value.
You can type a cell address or an actual value. You can also click a 
cell to enter its cell address.
If you press Return after this step to complete the formula, the 
value of the formula is the same as the value of the cell whose 
address you entered.

4 Type an operator.
The basic arithmetic operators you can use in arithmetic formulas 
are addition ( + ), subtraction (-), multiplication (*), and division 
(/). Jazz also recognizes several other operators that perform more 
sophisticated calculations. See The Worksheet Reference.

5 Enter another value.
You can continue to enter operators and values, or you can com­
plete the formula after this step.

6 Press Enter.
The formula appears in the contents box, and the value of the for­
mula appears in the cell.

Before

* File Edit Windom Range Tools Font Style

After

If the formula contains a mistake, Jazz beeps, displays an alert mes­
sage, and highlights the problem area. For example, you may have 
typed two operators in a row. Correct the mistake and press Enter 
again.
When you change an entry in a cell that a formula refers to, Jazz 
automatically recalculates the formula and displays the new result.
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Keep in mind Precedence numbers. Jazz follows certain rules of order when it 
calculates formulas. For example, it reads the formula =4+5*2 as 
“multiply five by two and add four” (14), not “add four and five 
and multiply the total by two” (18). All operators have precedence 
numbers, which determine the order in which Jazz performs each 
operation in a formula.
Jazz performs an operation with a higher precedence number 
before an operation with a lower precedence number. It performs 
operations with the same precedence number in left to right order. 
Jazz interprets the formula =4+5*2 as “multiply five by two and 
add four,” therefore, because multiplication has a higher prece­
dence number than addition. The Worksheet Reference lists the 
precedence numbers of Jazz operations.
You can override precedence numbers by using parentheses in a 
formula. Jazz calculates expressions in parentheses first. Within 
each set of parentheses, precedence numbers apply. If you use 
parentheses within parentheses, Jazz calculates the innermost 
expression first.
Correcting errors. Some common errors that occur in a formula 
are:
• Starting with a letter. Do not begin a formula with a cell address 

such as M20. Jazz interprets this as a text entry. Always type = 
at the beginning of a formula.

• Unbalanced parentheses. Check each pair of parentheses. If you 
put parentheses in the wrong places or if you don’t have an 
equal number of left and right parentheses, the formula is 
invalid.

• Incorrect cell references. Check each cell the formula refers to, 
in case it contains the wrong kind of data (for example, text 
instead of a number).

• Circular references. A formula may refer to a cell that directly or 
indirectly refers back to the cell that contains the formula. This 
is called a circular reference. (For example, cell Al has a circular 
reference if it depends on cell Bl, which depends on cell Cl, 
which depends on the original cell, Al.) When this happens, the 
values in these cells can change every time Jazz recalculates the 
worksheet. Usually, you don’t want this to happen.
Click the Circular Reference icon, which appears when a formula 
creates a circular reference. Jazz moves the pointer to the first cell 
that caused the circular reference and makes that cell the active 
cell. Correct the circular reference, and press Enter.

Viewing a formula. To see a formula, select the cell that contains 
the formula. The formula’s value appears in the cell, and the for­
mula itself appears in the contents box.

W
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You can change the format of a range so that formulas, rather than 
their values, appear in the range. Select the range and choose For­
mat from the Range menu. Click Formula Text and then click OK. 
This does not change the way Jazz calculates the formulas. To see 
the values again, select the range, choose Format from the Range 
menu, and click a numeric format.
To change the whole worksheet so that formulas appear in the 
worksheet instead of values, choose Show Attributes from the Style 
menu. To see the values again, choose Show Values from the Style 
menu.
Changing the recalculation mode. The default recalculation 
mode is Automatic, which means that Jazz recalculates every for­
mula in the worksheet each time you change a value. You may 
want to change the recalculation mode if you have a large work­
sheet with many formulas. Choose Recalc Settings... from the 
Range menu. Click Manual for the Recalculation Mode. Jazz now 
recalculates formulas only when you choose Recalculate from the 
Range menu.
When the Recalculation mode is Manual and you change an entry 
that a formula depends on, Jazz may display the formula’s value 
incorrectly. Jazz displays the Recalculate icon when numbers have 
changed since the last recalculation. Click the Recalculate icon or 
choose Recalculate from the Range menu to recalculate all the work­
sheet formulas.
Converting a formula to a value. While a formula is in the 
entry box, click the Calculate icon to convert the formula to its 
value. The entry appears as a value in the worksheet, and Jazz 
stores it as a value rather than as a formula.

Calculating 
with Jazz 
Functions

Functions are built-in formulas that perform many standard types 
of calculations. Using a function can save you time, because Jazz 
performs many of the steps of a function automatically. You can 
refer to a range in a function, rather than listing individual cells. 
For example, to find the average of the values in five cells without 
a function, you type: = (Al+A2+A3+A4+A5)/5. Using a function, 
you type: = AVG(A1 ..A5).
Jazz has arithmetic functions that perform calculations such as 
adding, averaging, and rounding off. Text functions calculate with 
or result in text values. Logical functions result in TRUE or FALSE 
values. Other Jazz functions perform financial, scientific, calendar, 
or other specialized calculations.

1. Select the cell in which you want to enter the function.
2. Choose Enter into Formula... from the Edit menu.
3- Click Functions, if necessary.

All the Jazz functions are listed in alphabetical order. Jazz has a 
short name for every function. For example, AVG is the function 
name that stands for Average.
Chapter 7 describes all the Jazz functions.
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4. Click the function you want.
Use the scroll arrows to locate a function, if necessary.

5. Click Enter.
Jazz inserts an equal sign (=) and the function in the entry box, 
along with a description of the arguments.

6. Type the argument(s).
The format for most functions is:
= function name^argument 1, ar gument 2,...)
The arguments tell Jazz what values to use when it performs the 
function. Arguments can be specific values, as in the function 
= AVG(1,2,3); cell addresses, as in = AVG(B1,B2,B3); range 
addresses, as in = AVG(B1 ,.B3); or range names, as in 
= AVG(name). You can click a cell or drag across a range to enter 
its address, or you can type the cell or range address.

7. Press Enter.
The function appears in the contents box, and its value appears in 
the cell.

W
orksheet

Keep in mind

The SUM function in C18 
adds the contents of the 
cells in the range
C15. C17.

< File Edit Window Range Tools Font Style
---------------------------- =SUM(C 15..C17)
icTa

Other kinds of arguments. Functions can have arguments 
that are functions. For example, the formula
= SUM(MAX(A1..B7),MAX(C1..D7)) finds the highest numeric 
value in each of two ranges and adds them together.
Correcting errors. Some common errors that occur in a function 
are:
• Wrong number of arguments. If you have too few or too many 

arguments, the formula is invalid.
• Arguments in the wrong order. If you enter arguments in the 

wrong order, the formula is either incorrect or invalid.
• Text without quotation marks. When you enter text directly in a 

function, surround it with double quotation marks. If you do 
not, Jazz displays an alert message.

• Unbalanced parentheses. Check each pair of parentheses. If you 
put parentheses in the wrong places or if you don’t have an 
equal number of left and right parentheses, the function is 
invalid.
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Entering a function in a formula. If you have already typed an 
equal sign (=) in a formula, Jazz does not insert an equal sign in 
the entry box when you choose Enter into Formula... and choose 
a function.

Entering Text 
Formulas

Text formulas calculate with text just as arithmetic formulas calcu­
late with numbers. For example, text formulas can count the num­
ber of characters in a text entry, combine text from different cells 
into one cell, or change uppercase letters to lowercase. A text for­
mula is also useful, for example, when you want to include only 
the first four letters of a customer’s name as part of the customer 
code.
You can use an operator and/or functions in a text formula. The 
arguments in a text formula can be specific text, or they can refer 
to cells that contain text.

1. Select the cell in which you want to enter the text formula.
2. Type = .
3- Enter the first value.

You can type a cell address or an actual value. You can also click ; 
cell to enter its cell address. You can drag across a range or type 
its address to enter a range address. To enter text, enclose it in 
double quotation marks — for example, “Arwen Lloyd.”

4. Type an ampersand.
The only text operator is the ampersand (&). This operator com­
bines two text entries into a single entry.

You type:
= A1&A2

= “Name”&“Date”
= “Name”&“ and ”&“Date”
= “Name: ”&A1

The cell displays:
NameDate (when

Al = Name, 
A2 = Date)

NameDate
Name and Date
Name: Mary (when

Al = Mary)
5- Enter another value.

You can continue to enter the text operator and values.
6. Press Enter.

The text formula in A91 
calculates with text 
entries in F92 and C92.

Window Range Tools
=F92&" for the "&C92
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Keep in mind

Entering
Logical 
Formulas

Text functions. Jazz has text functions, which you enter the same 
way as other types of functions. Text functions either have text 
values as arguments or result in text values. For example, you can 
use a text function to change all the letters in a text entry from 
lowercase to uppercase. See Chapter 7.
Correcting errors. If an error value (ERR) appears in a cell, you 
may have:
• Used an arithmetic operator rather than ampersand (&) to 

combine text. For example, = “Day ” + “Year”, instead of 
= “Day ”&“Year”.

• Used the & operator to combine text with a number. For 
example, =“March”&Al, if Al contains a number. You can 
combine a number with text to produce a text value using the 
FIXED function. For example, enter = “March’’&FIXED(Al,O).

Logical formulas are useful when you want to perform calculations 
that depend on whether certain values are true or false. This is 
usually a two-step process. First, the logical formula produces a 
value of TRUE or FALSE, and then another formula calculates 
based on that value. For example, you can write a formula that 
gives a customer one interest rate if the balance is over $5000 
(TRUE), and a different interest rate if the balance is not over 
$5000 (FALSE).
A logical formula results in a value of either 1 or 0. If a logical for­
mula is TRUE, Jazz displays the number 1. If it is FALSE, Jazz 
displays 0.

You type: The cell displays:
= 3>2
= 3=2

1 (for TRUE) 
0 (for FALSE)

1. Select the cell in which you want to enter the formula.
2 Type =.
3 Enter the first value.

You can type a cell address or an actual value. You can also click a 
cell to enter its cell address. You can drag across a range or type 
its address to enter a range address.

4 Type an operator.
The common logical operators are equal ( = ), not equal (< >), less 
than (<), and greater than (>).

You type:
(where Al = 5)
= A1 =5
= Al < >6
= 6<A1
= 6>A1

The cell displays:
1
1
0
1
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Keep in mind

5. Enter another value.
You can continue to enter operators and values.

6 Press Enter.

Logical functions. Jazz has logical functions such as TRUE and 
FALSE that result in values of 1 or 0. You can also use the logical 
function IF, which results in values that you determine, such as 
YES or NO, depending on the result of a logical formula. Chapter 7 
describes Jazz’s logical functions.

The logical function in H2 
determines whether to 
reorder an item based on 
the data in D2 and C2.

- =IF((D2>(C2*0.5))/'YES","N0")

111H2

File Edit Windom Range Tools Font Style

=u= ^^3 Inuentory
E 1 F G 1 H 1 1 O

1 ORDERED ISOLD iON HAND iPRICE TOTAL 3100 17 831 $2.50
200I 187; 131 $5 50 $1,028,50:

4 50i 1 41 361 $9.00 $126,001 NOi

Copying 
Formulas

Relative and 
Absolute
Addresses

When you copy a formula that contains cell addresses, the 
addresses may be different in the new location, depending on 
whether you have made the addresses absolute, relative, or mixed. 
For example, copying a formula with relative addresses lets you 
use the same formula to add several different columns of numbers. 
Copying a formula with an absolute address lets you refer to a con­
stant, such as an interest rate, no matter where you copy the for­
mula to. Copying a formula with a mixed address lets you use a 
relative address and an absolute address in the same formula. Using 
a mixed address formula, for example, you can create a table of 
interest payments from a row of interest rates and a column of 
principals.

Use a relative address to refer to the position of a cell in relation 
to the cell that contains the formula. A relative address is not a per­
manent reference to a particular cell.

You type in cell DU
=Al+Bl

Jazz reads the formula as:
the value three columns to 
the left, same row, plus the 
value two columns to the 
left, same row
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Use an absolute address to refer to the same cell, no matter where 
you copy the formula to. An absolute address is a permanent refer­
ence to a particular cell.

You type in cell DI: Jazz reads the formula as:
= $A$1 + $B$1 the value in Al plus the

value in Bl

You can also combine relative and absolute addresses in a single 
formula. The difference between relative and absolute addresses 
becomes important when you copy a formula to another cell or 
cells.

W
orksheet

Copying a formula with a 
relative address.

■□1
A I B

1 ; 2; I
3= 4i
5;

Copying a formula with 
absolute and relative 
addresses.

=$A$1+B1 
-$ A$1+B2 
=$A$1+B3

B
1 ; 2: 1 ~
3; 4i

T

■

Use a mixed address to make a cell reference that is part relative 
and part absolute — either the column letter or the row number 
remains constant.

You type in cell DI: Jazz reads the formula as:
=AS1+&B1 the value three columns to 

the left, row 1, plus the 
value in column B, same 
row

Copying a
Formula

1. Make the formula’s cell addresses absolute or mixed, if 
necessary.
Cell addresses are relative by default. To make a cell address 
absolute, type a dollar sign ($) before each column letter and row 
number in the address, or use the Absolute icon.
The Absolute icon appears when you select a cell or range by 
clicking or dragging while entering or editing a formula. Click the 
Absolute icon once to make the address absolute. Click it two or 
three times to make the address mixed. Clicking a fourth time 
makes the address relative again. When you type another character, 
the Absolute icon disappears.

2. Select the cell or range that contains the formula or for­
mulas you want to copy.

3. Choose Copy from the Edit menu.

61 Worksheet



4 Select the cell in the upper left corner of the range where 
you want the copy to go.

Keep in mind

= C4*$D$1

Copying the formula in 
D4 to a range multiplies 
each principal amount 
(relative address) by the 
interest rate (absolute 
address).--------------------

Copying a formula into more than one cell. Copy the formula

5 Choose Paste from the Edit menu.

Copying range names. Range names are relative by default. Type 
a dollar sign ($) in front of the range name to make it an absolute 
reference. When you copy such a formula to a new location, the 
range name refers to the original range. You can edit the $ in the 
range name in the same way you edit other characters.
You cannot make a range name a mixed reference in a formula. L

l
L
■
■
L
L
L
L
■
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How to Change the Worksheet’s 
Appearance

Jazz can display data you enter in the worksheet in many different 
formats. Some formats only affect numbers; for example, Jazz can 
display a number you enter as currency or as a percent. Other for­
mats affect only the positioning of text entries in cells.
The width of the column can also affect how Jazz displays an 
entry. If the column is too narrow for Jazz to display the entire 
entry, the entry is either cut off and appears with ellipses, or it 
appears in scientific format. You can widen the column to see the 
whole entry.
Jazz also lets you create titles by “freezing” rows or columns so 
that they appear in the window, no matter what part of the work­
sheet you’re looking at.

Changing the 
Format of 
Numbers

W
orksheet

The way a number or formula appears in a cell depends on the dis­
play format of the cell. For example, the number 37 can appear in 
a cell as currency ($37.00), as a percent (3700%), in scientific nota­
tion (3.7E1), or in other formats. A cell’s display format does not 
affect the way Jazz stores the number in the cell.

1. Select the cell or range in which you want to set the display 
format.

2. Choose Format... from the Range menu.
3. Click Format for the Selected Range or Default Numeric 

Format.
Click Format for the Selected Range to set the format for the active 
area. Click Default Numeric Format to set the default numeric 
format for the entire worksheet. Until you change it, the default 
numeric format for the worksheet is General — numbers have no 
zeros after the decimal point, and very large and very small num­
bers appear in scientific format.

4. Click a format.

—O Fined
2.60E1 O Scientific

$26.00 Ciirrencii
2600.0093 —O Percent

26.00 _ —Comma1 6 26 —O General

If you choose any numeric format except General, you can enter a 
number of decimal places at the bottom of the dialog box. Click 
the up or down arrow to choose a number from 0 to 15. The 
default number of decimal places is 2.

5. Click OK
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Keep in mind Changing a cell’s format. You can change a cell’s format by 
choosing a new format, or by pasting an entry with a different for­
mat into the cell.
Date and time formats. You can format a cell by typing an entry 
in an explicit date or time format. Jazz automatically formats the 
cell according to the format you entered with the entry. For exam­
ple, if you type 22-Jul-85, the entry appears as 22-Jul-85 and Jazz 
gives the cell the Date format DD-MMM-YY.
There are four date formats and four time formats. The date for­
mats are DD-MMM-YY, DD-MMM, MMM-YY, and MM/DD/YY. The 
time formats are HH:MM:SS AM/PM; HH:MM:SS, 24 Hour; HH:MM 
AM/PM; and HH:MM, 24 Hour.
You can assign a range a Date or Time format by choosing Format 
from the Range menu. To choose a Date, click Date and click one 
of the four formats that appear at the bottom of the dialog box. To 
choose a Time, click Time and click one of the four formats at the 
bottom of the dialog box.
Seeing a cell’s format. To see the formats of all worksheet cells 
displayed in the worksheet, choose Show Attributes from the Style 
menu. Jazz displays the cell contents in the top half of each cell, 
and the cell attributes, including the format, in the bottom half of 
the cell. For example, the format Currency 2 appears as cur 2 in 
the cell. To display the values again, choose Show Values from the 
Style menu. See The Worksheet Reference for a list of abbrevia­
tions that appear in the cells.
Cutting and copying. When you cut a cell, Jazz removes the 
display format from the cell along with the cell contents. Similarly, 
when you copy a cell, Jazz copies the cell’s display format and the 
cell contents. When you paste an entry you cut or copied, Jazz 
pastes the format and the entry in the new location.

Changing the
Format of 
Text

The way text appears in a cell depends on the display format of 
the cell. Text can be left-aligned, right-aligned, centered, or repeat­
ing across the cell. The display format you select does not affect 
the way Jazz stores the cell entry.

1. Select the cell or range whose display format you want to 
set.

2. Choose Format... from the Range menu.
3. Click Format for the Selected Range or Default Text Format.

Click Format for the Selected Range to set the format for the 
selected range. Click Default Text Format to set the default text 
format for the entire worksheet. The default text format for the 
worksheet is left-aligned until you change it.

4. Click Text.
5. Click the text format you want.
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JuneJune

—O Left C> Center
—O Right /p Repeat

6. Click OK

Changing
Column
Widths

Changing the 
width of one 
column

The pointer becomes a 
double arrow when it is 
on a column border line.

Changing the width of a column does not affect the values in the 
cells in that column. You may need to widen the column to dis­
play a long number or a long text entry. You may want to shrink 
the width of all the columns to fit more columns on the screen.

W
orksheet

Changing the 
widths of all 
columns

Keep in mind

Freezing 
Rows and 
Columns

1. Position the pointer on the right border line of the column 
you want to change.

Inuentory -s.
C i D T E G

1 ITEM ■ITEM NO ORDERED SOLD ON HAND PRICE TOTAL ' 1
2 Binoculars 480 5 2 3 $45 00 $90 00

Booklets 1 10 250 87: 163 $0.50 $43 50

2. Drag the border line to the right to widen the column. Drag 
the border line to the left to make the column narrower.

1. Choose Column Widths... from the Style menu.
2 Type a new number.
3. Click OK.

Changing the widths of several columns. To change the
widths of a range of columns, select the columns, then change the 
width of one column in the range. Jazz changes all of the column 
widths in the range to match the one you changed.

Frozen rows always appear at the top of the worksheet, no matter 
where the active cell is. Frozen columns always appear on the left 
side of the worksheet. Frozen rows and columns are called titles.
When you freeze titles, you can move the pointer around in a large 
table, for example, and still be able to see the headings at the top 
or at the left of the table.

1. Select the rows or columns you want to freeze.
The rows you want to freeze must include row 1 and the columns 
must include column A.

2. Choose Set Left Titles or Set Top Titles from the Range 
menu.
If you selected rows, Set Left Titles appears on the Range menu. If 
you selected columns, Set Top Titles appears on the Range menu.
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Frozen row, or title

The titles remain visible— 
as you move down in the 
worksheet.

A i-Tj
i----- ITEM ITEM NO. ORDERED SOLD ON HAND PRICE TOTAL---------

i 6 Film., 36 .. 654: 1 7;
Film, 1 20 662; 100; 34; 66 $2.50 $85.00

I 8 Hats 341 i 200i 1561 44 $3.50 $546 00

1 9 Slides 680i 701 211 49 $3 00 $63.00

You cannot select or change cells in a title until you unfreeze the 
title.

Keep in mind Unfreezing a title. Choose Cancel Titles from the Range menu 
Once you unfreeze a title, you can edit the entries and perform 
other Jazz operations in that area again.
Freezing both rows and columns. To freeze both rows and 
columns in the same worksheet, freeze one and then freeze the 
other. You can perform the steps in either order, but you must 
freeze rows and columns separately.
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How to Protect Data
Jazz lets you protect entries, hide them, or both. Protecting data 
prevents changes to the entries. Hiding entries means that Jazz 
does not display them in the worksheet or console. You can still 
use the hidden entry in a formula that refers to the cell.
For the greatest security, you can both protect and hide your data. 
This is useful if you are creating a worksheet for others to use, and 
you want to ensure that essential formulas don’t get changed by 
accident, or that confidential information doesn’t appear on the 
worksheet.
The settings that let you protect cells and hide cells are the protec­
tion settings. You must enable the protection settings for the entire 
worksheet in order for specific range settings to work. If you 
disable the protection settings for the worksheet, specific settings 
do not work on ranges.

W
orksheet

Preventing
—« Data from

Being Changed

Keep in mind

Protecting a range lets you see, but not change, the contents of the 
cells. You may want to protect certain areas of a worksheet when 
you are preparing it for others to use.

1- Select a range.
To protect the whole worksheet, choose Select All from the Edit 
menu.

2. Choose Protection... from the Range menu.
3. Click Prevent Entry of New Values to check the box.
4. Click Enforce Protection Settings to check the box.

This activates all protection settings in the worksheet. If this box is 
checked, the selected range is protected in the worksheet. (This 
includes any cells you protected previously.) If it is not checked, 
the selected range is not protected in the worksheet.

5. Click OK.
The selected range is now protected. The appearance of the cells 
does not change. Jazz displays the Protect icon in the upper left 
corner of the console to show that protection is currently being 
enforced.

Temporarily turning off all protection settings. Choose Pro­
tection... from the Range menu and click Enforce Protection Set­
tings to remove the check.
Canceling protection. To cancel protection on a range or on an 
entire worksheet, use the steps above. In step 3, however, click 
Prevent Entry of New Values to remove the check.
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Checking values in cells. When you create a worksheet for 
others to use, you may want to ensure that the user enters the 
appropriate kind of data. To let Jazz check whether the values 
entered in a range are numbers, format the cells with a numeric 
format. Similarly, to check for text, dates, or times, choose a text, 
date, or time format. Then use the steps above. In step 3, how­
ever, click Check Entry Format to check the box. When you com­
plete the command, Jazz accepts only data entered in the correct 
format. For example, if you chose a numeric format, Jazz only 
accepts numbers in this range.
Click Check Entry Format again to turn off this setting.
Displaying protection settings. To see the protection settings of 
all cells in the worksheet, choose Show Attributes from the Style 
menu. Jazz displays the cell contents in the top half of the cell, and 
the cell attributes, including protection settings, in the bottom half 
of the cell. To see the values again, choose Show Values from the 
Style menu. See The Worksheet Reference for a list of abbrevia­
tions that appear in the cells.

Hiding
Worksheet
Data

Hidden entries do not appear in the worksheet or the console.
This does not change the way Jazz stores the hidden data.

1. Select a range.
2. Choose Protection... from the Range menu.
3. Click Hide Values to check the box.
4. Click Enforce Protection Settings to check the box.

This activates all protection settings in the worksheet. If you check 
this box, the entries in the hidden cells are not visible in the work­
sheet or in the contents box. If you remove the check, the entries 
in the cells are visible in the worksheet and in the contents box.

5. Click OK.

Keep in Mind Making hidden cells visible. Use the steps above. In step 3, 
however, click Hide Values (if necessary) to remove the check 
from the box.
Temporarily turning off all protection settings. Choose 
Protection... from the Range menu and click Enforce Protection 
Settings to remove the check.
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Naming a
Range

Naming a range

Choose a range name — 
that is easy to remember.

How to Do Advanced Tasks
Jazz has several advanced features that make using the worksheet 
easier. These include naming ranges, using date and time serial 
numbers in calculating, and performing “what-if” calculations.
If you often refer to the same range in formulas, you can name the 
range and then use the range name in formulas instead of selecting 
the range or typing the range address.
Date and time serial numbers let you calculate with dates and times 
as easily as with other values. Jazz displays the date or time in the 
format you choose.
What-if tables let you use the same formula or formulas with a 
series of values. For example, you might use a what-if table to 
calculate mortgage payments at various interest rates and payment 
periods.

Once you name a worksheet range, you can use the range name 
instead of typing the range address or selecting the range in a for­
mula or command. A range name is easier to remember than a 
range address, because the name can describe the contents of the 
range.

1. Select a range.
2. Choose Name... from the Range menu.
3. Type a range name.

Type a short name in the space provided. You can use only letters, 
numbers, and spaces in a range name; Jazz beeps if you try to 
enter any other character. Jazz beeps and displays an alert message 
if you type a range name that is already in use in this worksheet.

Name a Range t ok a
—Name; ] Principal [ Cancel ]

W
orksheet

4. Click OK.
There is no visible change to the range. The range name appears in 
the list of range names when you choose Review Names... from 
the Range menu. When you select the range, the range name 
appears in the selection box.
Jazz uses the range name instead of the range address whenever 
possible. For example, if you type the range address of a named 
range in a formula, Jazz displays the formula with the range name 
instead of the range address.
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Using a range 
name in a formula

Keep in mind

1 Begin typing the formula or function.
2. Type the range name.

You can also choose Enter into Formula... from the Edit menu.
Click Range Names, then click the range name you want to use and 
click Enter.

3- Complete the formula or function and press Enter.

Using a range name in the selection box. Once you name a 
range, you can select the range using its name. Double-click the 
selection box and type the range name. Press Enter. Jazz selects the 
range whose name you typed.
Giving a range more than one name. A range can have more 
than one name. When you give a range more than one name, how­
ever, Jazz displays only the name that comes first alphabetically.
For example, if you name the same range both Sales and June 
Sales, typing Sales in the selection box selects the range, but Jazz 
displays June Sales in the selection box.

Seeing or
Changing
Range Names

Jazz lets you look at all of the range names you have created. You 
can edit any range name or change the address associated with it. 
For example, you may want to do this to refresh your memory of 
the named ranges in this worksheet, or to change the size of a 
named range to accommodate new data.

1. Choose Review Names... from the Range menu.
2. Scroll through the range names, if necessary.
3 Click the range name you want to change.

4. Edit the range name, the range address, or both.
Use the same editing techniques that you use to edit a cell entry.
Click Undo if you want to return the selected range name and 
range address to their original values.

5. Click Done.
If you entered a new name, Jazz automatically changes the range 
name to the new name in all formulas that contain the range name. 
Changing a range address, however, causes Jazz to calculate all for­
mulas that contain the range name with the new range address.
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Keep in mindKeep in mind

Calculating 
With Dates 
and Times

Calculating 
With Dates 
and Times

Deleting a range name. To delete a range name, follow the steps 
above. After you click the range name you want to delete, click 
Discard. Jazz removes the name from the range and from the range 
name list. The contents of the range do not change.

Jazz can store dates and times as serial numbers so that you can 
use them in calculations. For example, using serial numbers lets 
you find the difference between the beginning and ending date of 
a particular project. You can enter a date in a cell in one of four 
date formats. You can enter a time in a cell in one of four time 
formats.
Jazz assigns a unique serial number to every date between 
January 1, 1904 and February 6, 2040.

You type: Jazz stores:
01-Jan-04 1460
01-Jan-05 1826

W
orksheet

7-Jul-84
12/31/99
1/1/100

30868
36523
36524

Jazz assigns a unique decimal fraction to each time of the day. The 
fractions range from .0000, representing midnight, to .9993, 
representing 11:59:59 pm.

You type: Jazz stores:
8:00 AM
12:00 PM
4:00 PM
8:19 PM

.3333

.5000

.6667

.8465

1 • Select a cell in which you want to enter a date or time.
2 Enter a date or time.

You can enter a date in four formats.

You type: The cell format becomes:
25-Nov-84
25-Nov
Nov-84
11/25/84

DD-MMM-YY
DD-MMM 
MMM-YY 
MM/DD/YY

You can enter a date over 2000 in two ways. To indicate the year, 
type a number over 2000, or type a number over 100. For exam­
ple, to enter the date May 4, 2030, type either 5/4/2030 or 5/4/130.



When you enter a date over the year 2000, it appears in the cell 
the same as a date under 2000. This does not affect the way Jazz 
stores the entry. For example, when you enter 5/4/130 in Al and 
5/4/30 in Bl, both entries appear in the worksheet as 5/4/30. Jazz 
stores the entry in Al as 47605, however, and stores the entry in 
Bl as 11080.
You can enter a time in four formats.

The cell format becomes:You type:
07:15:22 PM 
07:15 PM 
19:15:35 
19:15

HH:MM:SS AM/PM
HH:MM AM/PM
HH:MM:SS, 24 Hour
HH:MM, 24-hour

Once you enter a date or time, you can use it to perform 
calculations.

The formula in F3---------
determines the billing 
amount, based on the 
times in D3 and C3, and 
the rate in E3.

Keep in mind Formatting a cell with a Date or Time format. When you 
copy a formula that contains a date or time to another cell, format 
that cell with a Date or Time format. If you do not, a serial num­
ber (instead of a date or time) appears in the cell that contains the 
copied formula. To format the cell, select it, choose Format from 
the Range menu, and choose one of the Date or Time formats.
Using a time in a calculation. To convert a time you entered in 
one of the four time formats to a real number of hours you can 
use in calculations, multiply the time by 24. For example, the for­
mula ((D3-C3)*24) finds the number of hours a job takes, when 
D3 contains the end time and C3 contains the start time. You can 
use the result of this formula to calculate costs by multiplying it by 
the hourly rate.
Calculating with date serial numbers. When you calculate with 
date serial numbers, adding 1 to the date adds one day, and adding 
7 adds a week. For example, if you enter the date 10-Jul-85 in cell 
C5 and you want to produce the serial number for one week after 
that date, enter the formula = C5+7.
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Creating a 
What-If Table

Creating a 1-way 
what-if table

Jazz lets you build a what-if table that records the way in which 
changes to certain cells affect related formulas. A 1-way what-if 
table shows the effects of changes to one cell on one or more for­
mulas. A 2-way what-if table shows the effects of changes to two 
cells on a single formula.

1. Note a cell you want to be the input cell.
During the what-if operation, Jazz copies each what-if value into 
the input cell before it recalculates the formulas. Make a note of 
the input cell’s address. Be sure the cell you choose is outside the 
worksheet area where you plan to create the table.

2. Type a list of what-if values in a single column.
Type the values you want to substitute in the formulas. The entries 
can be in any order in the column. This list is the entry list.

3 Type one or more formulas that depend on the input cell in 
the row above the entry list.
Leave the cell directly above the list of what-if values empty. Enter 
the formulas to the right of that empty cell. It doesn’t matter 
whether you enter absolute or relative addresses in this formula.

4. Select the range that includes the entry list and the 
formulas.

5. Choose Set Table Ranges... from the Tools menu.
6. Click 1-Way Table.
7. Click Use Selected for Table Range.
8. Click the box next to Input Cell 1 and type the address of 

the input cell.
9- Click Compute.

One by one, Jazz copies the what-if values into the input cell, then 
recalculates the entire worksheet. It records the values of the for­
mulas in successive rows below the formulas.

W
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Before

Input cell-------------------

Enter a row of formulas 
and a column of what-if 
values.

=((50000*$E$ 1)/ 1 2)+(50000/ 1 2)
* File Edit tJLIindouj Range Tools Font Style

Jazz fills the table with 
the values of all the 
what-if formulas.

After
* File Edit Ulindow Range Tools Font Style

=((50000*$E$ 1)/12)+(50000/12)

Creating a 2-way 
what-if table

The steps for creating a 2-way what-if table are similar to those for 
a 1-way table, but you select two input cells and two what-if entry 
lists for a 2-way table, and you enter only one formula.

1. Note the cells that you want to be input cell 1 and input 
cell 2.
Make a note of the cell addresses.

2. Enter the list of what-if values for input cell 1 in a column, 
and the entry list for input cell 2 in a row.
Arrange the two lists as illustrated in the figure below. In both lists, 
you can enter the values in any order.

3- Enter a formula that depends on both input cells at the 
intersection of the two lists.
It doesn’t matter whether you enter absolute or relative cell 
addresses in this formula.

4. Select the range that includes the two entry lists and the 
formula.

5. Choose Set Table Ranges... from the Tools menu.
6. Click 2-Way Table.
7. Click Use Selected for Table Range.
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8. Click the box next to Input Cell 1 and type the address of 
the first input cell.
You can also click OK, select a cell in the worksheet, repeat steps 
5 and 6 above, and click Use Selected for Input Cell 1.

9. Click the box next to Input Cell 2 and type the address of 
the second input cell.

10. Click Compute.
Jazz copies one what-if value from each entry list into the two 
input cells, then recalculates the entire worksheet. It records the 
resulting value of the formula in the body of the table. Jazz repeats 
this for all the values in the entry lists.

Jazz uses values from 
the top of the table in 
input cell 2.-------------

Jazz uses values from 
the left side of the table 
in input cell 1.

Jazz calculates the 
what-if formula to 
calculate possible car 
payments.

Jazz fills the table with 
the values of each 
recalculation of the 
what-if formula.

B3

i =SUM((9000*A2)/B I M9000/B1)

Before
« File Edit Window Range Tools Font Style

After
< File Edit Window Range Tools Font Style_________________

1647.5 __________________________ |?3

forksheet

Keep in mind Common problems. If all the resulting values in one column of a 
1-way table are the same, the formula at the top of the column 
does not depend on the input cell you specified. Change the for­
mula so that it depends on the input cell.
In a 2-way table, identical values in a column mean that the for­
mula does not depend on Input Cell 1. Identical values in a row 
mean that the formula does not depend on Input Cell 2. In either 
case, change the formula so that it depends on the appropriate 
input cell.
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Alternate method of computing a what-if table. Follow all the 
steps above for either table, but instead of following the last step, 
click OK. Then choose Compute Table from the Tools menu. This 
allows you to change a what-if value or a formula before comput­
ing the table.
You can choose Compute Table to recompute the table each time 
you change the formula or a value in the entry lists.
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Worksheet
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Calculate icon
Corner
Navigator

End
Navigator

Cancel 
icon

Absolute 
icon

The Worksheet Reference
Menu bar displays the titles of all Worksheet menus.
Console displays information about the active cell and/or the 
selected range. The console also contains icons for performing vari­
ous activities in the worksheet.
End Navigator lets you quickly select cells in the worksheet, and 
expand or shrink the size of a selected range. Clicking an end 
arrow while in a blank cell selects the next filled cell in that direc­
tion. Clicking an end arrow while in a filled cell selects the last 
consecutive filled cell in that direction. Clicking an end arrow 
while at the end of a range selects the next filled cell in that 
column or row. If there are no more filled cells, Jazz selects the 
last cell in that column or row. To quickly expand or shrink a 
selected range, hold down the Shift key and click an end arrow.
Corner Navigator lets you quickly activate alternate corner cells 
of a selected range or the worksheet's active area. Clicking this 
icon activates, in a counterclockwise direction, the cell in each cor­
ner of the selected range. Or, hold down the Command key and 
click this icon to select, in a counterclockwise direction, the last 
filled, formatted, or protected cell in each corner of the worksheet. 
These cells delimit the worksheet’s active area.
Calculate icon calculates the value of a formula in the entry box 
and replaces the formula with its value. This icon only appears 
when a formula is in the entry box.
Absolute icon lets you change the cell reference to absolute, 
mixed, or relative when entering a formula in the entry box. This 
icon only appears when you click a cell or range in the worksheet, 
not when you type its address.
Clicking the Absolute icon cycles through the absolute, mixed, or 
relative cell reference. If the selection consists of one or more 
columns or rows, the icon alternates only between an absolute and 
a relative reference.
Cancel icon erases the contents of the entry box. This icon 
appears only when you are entering or editing information in the 
entry box.
Entry box shows the characters you are typing or editing. When 
entering a formula, you can enter cell or range addresses by typing 
them, or by clicking them in the worksheet.
Contents box shows the contents of the active cell. If the cell 
contains a formula, the formula appears instead of its value. If the 
cell contains text. Jazz inserts a double quotation mark (”) as the 
first character.
Selection box shows the address (or name) of the selected cell or 
range. If you’ve named the range, you see the range name. To 
select a cell or range, you can double-click the selection box, enter 
the cell or range address (or range name), and press Enter.
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Protect icon appears only if protection settings are being 
enforced in the worksheet. You specify protection settings and 
enforce them using the Protection... command on the Range menu.
Circular Reference icon appears if a formula results in a circular 
reference. Clicking this icon selects a cell containing a formula that 
is part of the circular reference.
Recalculate icon appears if you made a change in the worksheet 
that affects the value of any formula and recalculation mode is set 
to Manual. Clicking this icon recalculates the worksheet. This icon 
works the same as the Recalculate command on the Range menu.
Cell is the unit of the worksheet in which data appears. Each cell 
has a unique address, which identifies the cell’s location by column 
and row. For example, A2 identifies the cell in column A, row 2.
Range is any rectangular block of selected cells. Jazz identifies the 
range by an address that consists of the upper left and lower right 
cell addresses in the range, separated by one or more periods. (Jazz 
always displays two periods when identifying a range.) For exam­
ple, A4.C8 or A4..C8 both identify the range whose upper left 
corner is cell A4 and whose lower right corner is cell C8.
Active cell is highlighted by a white border to indicate that it is 
affected by your next cell entry action.
Row label refers to a row number (1-8192) in the left border of 
the worksheet.
Column label refers to a column letter (A-IV) in the top border of 
the worksheet.
Border line separates columns and allows you to expand or 
shrink columns. Dragging the border line to the right makes the 
column wider; dragging it to the left makes the column narrower.
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Selecting 
Worksheet 
Cells

If you want to: Do this:

Select a cell Click the cell. Or, double-click the 
selection box, enter the cell address 
or name, and press Enter.

Select/activate the cell 
below the active cell

Press Return.

Select/activate the cell 
above the active cell

Hold down Shift and press Return.

Select/activate the cell to 
the right of the active cell

Press Tab.

Select/activate the cell to 
the left of the active cell

Hold down Shift and press Tab.

Select a range Drag across cells to highlight the 
range, or double-click the selection 
box and enter the range address (or 
range name, if you assigned one), 
and press Enter.

Activate any cell in the 
selected range

Hold down the Command key and 
click a cell inside the range to make it 
the active cell.

Select one or more 
columns

Click a column label or drag across 
neighboring column labels.

Select one or more rows Click a row label or drag across 
neighboring row labels.

Expand a range Shift-click a cell outside the range.

Shrink a range Shift-click a cell inside the range.

W
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Entering 
Worksheet 
Data

If you enter: Rules for entering:

Numbers You can begin with one of the following 
characters:

0123456789+-.$%

You can enter fractions by using a slash (/); for 
example, 1 1/2 or 7/8.

Text You can begin with any letter or symbol except 
the equal sign ( = ).

You can begin with a number if you also include 
letters or symbols in the entry.

You can change the text alignment by typing one 
of the following as the first character:

’ (left-aligned)
\ (right-aligned)
A (centered)
\ (repeated)
” (default text format)

(If one of these characters precedes a number, 
Jazz interprets the number as text.)

Dates or Times You can assign a date or time display format to a 
cell by entering a date or time in any of the fol­
lowing formats:

You enter: Jazz formats cell as:

22-FEB-85 Date
22-FEB
FEB-85
2/22/85

9:25:10 AM Time
1 12:04 PM

14:22
23:34:15

Formulas You must begin with an equal sign ( = ).

You must use double quotes around text within a 
formula.

You can enter cell addresses in formulas by click­
ing the cells or typing their addresses (or range 
names).



Editing
Worksheet 
Data

If you want to: Do this:

Edit data in a cell Double-click the cell to put its contents 
in the entry box (or activate the cell 
and choose Open Cell from the Edit 
menu). Edit the contents, then press 
Enter.

Replace data in a cell Click the cell, enter the new data, and 
press Enter.

Remove data from a cell Click the cell, then choose Clear from
(without putting the 
data on the Clipboard)

the Edit menu.

Remove data from a cell Click the cell, then choose Cut from
(and put the data on the 
Clipboard)

the Edit menu.

Cancel last typed entry Choose Undo from the Edit menu.
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Using
Operators

Operators are the symbols that Jazz uses to indicate a relationship 
between values in a formula. You can use any of the following 
operators in formulas:

Operators Operation Example Precedence

A Exponentiation = LOG(10A5.76) 7
Negative = -C4*A3 6

+ Positive = A3+ 5.2 6
★ Multiplication = B17*56 5
/ Division = SALES/100 5
4- Addition = 012 + 45 4
- Subtraction = D20-C15 4

Equal = BALANCE = 2000/C8 3
<> Not equal = LIMIT< >TOTAL-50 3
< Less than = A4< PROFITS 3
> Greater than = C47> RESULT 3
< = Less than or 

equal
= RESULTS< =1000 3

> = Greater than or 
equal

= TOTALS > =A16 3

#NOT# Logical NOT = #NOT#(RESULTS = 250) 2
#AND# Logical AND = BAL > 100#AN D#LATE > 7 1
#0R# Logical OR = A1 =C3#OR#A1&C3 = “X” 1
& Character 

combination
=“QTY”&“ and ”&“NO” 1

The precedence number determines the order in which Jazz per­
forms operations within a formula. Jazz performs the operations 
with the largest precedence number first. If a formula contains 
operations with the same precedence number (for example, * and 
/), Jazz calculates the formula from left to right.
You can use parentheses to override order of precedence. If you 
use parentheses within parentheses, Jazz calculates the formula in 
the innermost parentheses first.

The 
Worksheet 
Menu Bar

Edit menu

Undo XZ

Cut ggH
Copy 3£C
Paste
Clear 
Select All
Paste Special...

3€R

Insert

Open Cell &0
Enter into Formula...

Parse Settings..

The Apple, File, Window, Font, and Style menus contain com­
mands that appear in all Jazz applications. For a description of 
these menus, see Chapter 1, The Standard Commands.

w File Edit Window Range Tools Font Style

Undo reverses your last action,such as entering or clearing data.

If Jazz can't undo your last action, this command appears dimmed 
as Can’t Undo. If you disabled Undo, this command is Undo 
Disabled.



Cut removes the contents of the selected cell or range from the 
worksheet and places it on the Clipboard, replacing the Clipboard’s 
contents. Jazz removes the display format and protection settings 
of cells in the selected range; those cells revert to the default for­
mat and protection settings. Cutting one or more entire rows 
removes those rows from the worksheet and moves all lower rows 
up. Cutting one or more entire columns deletes those columns and 
moves all columns over to the left.
Relative cell addresses in formulas that are cut and then pasted to 
another location in the worksheet continue to refer to the same 
cells.
If protection is being enforced in the worksheet, Jazz prevents you 
from cutting a cell or range that you have assigned the Prevent 
Entry of New Values protection setting. To cut the cell or range, 
you must first cancel this protection setting.
Copy places a copy of the current selection on the Clipboard. The 
display format and protection setting of cells in the selected range 
are also copied. This command works the same as the Cut com­
mand, except that Jazz does not remove the selected range from 
the worksheet or alter the worksheet in any way.
Relative cell addresses in formulas that are copied to another loca­
tion in the worksheet are adjusted so that they continue to refer to 
cells in the same relative position.
Paste places the contents of the Clipboard into the worksheet, 
beginning with the first cell in the selected range. If you select a 
single cell, the entire Clipboard contents are pasted once. If the 
selected range is smaller than the Clipboard contents, Jazz displays 
an alert message. If the selected range is larger than the Clipboard 
contents, Jazz pastes as many complete copies of the Clipboard 
contents as it can into the selected range.
If the Clipboard contains text from another Macintosh program or 
a Jazz word processing document, Jazz pastes data into the work­
sheet according to the options you chose with the Parse Settings... 
command on this menu.
Clear erases the contents of the selected cell or range from the 
worksheet. Jazz removes the display format and protection settings 
of cells in the selected range; those cells revert to the default for­
mat and protection settings. Jazz does not place the contents of the 
cell or range on the Clipboard.
This command differs from the Cut command, which places the 
contents of the selected range on the Clipboard.
If protection is being enforced in the worksheet, Jazz prevents you 
from clearing a cell or range that you have assigned the Prevent 
Entry of New Values protection setting. To clear the cell or range, 
you must first cancel this protection setting.
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Select All selects the active area of the worksheet. The active area 
is the smallest rectangle in the worksheet that includes cell Al and 
all cells with entries, display formats, or protection settings.
Paste Special... performs special paste operations using data on 
the Clipboard. The dialog box specifies the type of paste opera­
tion. When you click OK, the results of the paste operation appear 
in the selected range in the worksheet.
Add Values, Subtract Values, Overlay Values, Paste Values, and 
Transpose Values convert formulas to their values before adding, 
subtracting, overlaying, pasting, or transposing the contents of the 
Clipboard into the selected range.
Add Values and Subtract Values work only for cells that contain 
numbers or numeric formulas on the Clipboard. All the other paste 
options work with either numbers, text, or text formulas.
• Add Values adds the values of formulas on the Clipboard to the 

selected range, cell by cell. If the selected range contains cells 
with non-numeric values, those cells are not affected.

• Subtract Values subtracts the values of formulas on the Clipboard 
from the selected range, cell by cell. If the selected range con­
tains cells with non-numeric values, those cells are not affected.

• Overlay places the contents of the Clipboard into the selected 
range. Filled cells in the selected range are not written over by 
blank cells from the Clipboard; they remain unchanged. Empty 
cells in the selected range are replaced by whatever the Clip­
board contains for that cell. If a cell on the Clipboard contains a 
formula, Jazz copies the formula (and its current value) to the 
selected range.

• Overlay Values works the same way as Overlay, except that Jazz 
copies only the values of cells on the Clipboard — not the for­
mulas — to the selected range.

• Paste works the same way as the Paste command on the Edit 
menu, placing the contents of the Clipboard into the worksheet, 
beginning with the first cell in the selected range. Formulas are 
also pasted. This is the default.

• Paste Values works the same way as Paste, except that Jazz only 
pastes the values of cells on the Clipboard — not the formulas 
— into the selected range.

• Transpose rotates the contents of the Clipboard and pastes the 
contents into the selected range, reordering columns as rows 
and rows as columns. Relative addresses are adjusted to refer to 
the correct cells.

• Transpose Values works the same way as Transpose, except that 
Jazz only pastes the values of cells on the Clipboard — not the 
formulas — into the selected range.
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If you select a single cell and choose Paste, Jazz pastes the entire 
Clipboard contents once, beginning at that cell. If the selected 
range is smaller than the Clipboard contents, Jazz displays an alert 
message. If the selected range is larger than the Clipboard contents, 
Jazz pastes as many complete copies of the Clipboard contents as it 
can into the selected range.
If you select Transpose and the range is too small to paste at least 
one complete, transposed copy of the Clipboard contents, Jazz dis­
plays an alert message. If the range is larger than the transposed 
contents of the Clipboard, as many complete copies are pasted as 
possible.
If you transpose a range to a location whose cells already have 
entries, Jazz writes over their contents with the transposed range. 
Formulas that referred to the previous contents now refer to the 
transposed cell entries.
Insert may be Insert Rows or Insert Columns, depending on 
the current selection. If you have not selected at least one entire 
row or column, this command is dimmed.
Insert Rows moves all rows, including the selected rows, down 
and inserts a number of rows equal to the number of selected 
rows. The inserted rows become selected.
Insert Columns moves all columns, including the selected columns, 
to the right and inserts a number of columns equal to the number 
of selected columns. The inserted columns become selected.
All addresses in formulas are adjusted so that they continue to refer 
to cells in the same relative position.
Open Cell puts the contents of the active cell in the entry box for 
editing. This command works the same way as double-clicking the 
cell, except that a range selection is preserved.
Enter into Formula... shows a list of all Jazz functions, range 
names, and operators that you can use to construct (or edit) a for­
mula without having to remember them or type them from the 
keyboard.
This command is dimmed unless the entry box is empty or con­
tains a formula.
• Functions: Displays an alphabetical list of all Jazz functions.
• Range Names: Displays an alphabetical list of all the range names 

you defined for this worksheet.
• Operators: Displays the list of symbols used in formulas.
Click an item from the list and click Enter to put your selection in 
the entry box.
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Parse Settings... determines how text on the Clipboard is pasted 
into the worksheet, so that the text appears in the appropriate 
rows and columns. Jazz uses parse settings if you paste text from 
another Macintosh program or from a Jazz word processing docu­
ment into a Jazz worksheet.

Parse Settings
(•) Column Separ ators 
O Line Separators 
O Ignore Characters

□ Use Column Widths

□ Blank
□ Null
□ Carriage Return
□ Line Feed
2 Tab
□ Comma
□ Character Code:

| Cancel

Reset

□ Character Code:

The dialog box lets you choose the characters that Jazz recognizes 
as column and line separators. The separators tell Jazz when to 
stop pasting information into a column or line and move to the 
next column or line. Each time Jazz recognizes a separating charac­
ter, it stops filling the current column or line and moves to the 
next one in the range.
You can enter additional separators by clicking Character Code and 
entering a character code in the space provided. The character 
code must be a number, chosen from the table of Macintosh 
Character Codes in Appendix D.
• Column Separators: Specifies one or more characters that Jazz 

recognizes as column separators. The default column separator is 
the Tab character.

• Line Separators: Specifies one or more characters that Jazz recog­
nizes as row separators. The default line separator is the Carriage 
Return character.

• Ignore Characters: Specifies the characters that Jazz ignores when 
pasting data. When Jazz encounters one of these characters, it 
skips the character and moves to the next one.

• Use Column Widths: (Appears when the Column Separators 
option is chosen.) Specifies the width, in characters, for data 
pasted into each column. Jazz pastes text into the worksheet 
according to the column widths as they appear on the 
Clipboard.

Clicking Reset clears the contents of the dialog box and reinstates 
the defaults.
If Jazz finds a character that you’ve defined as both a column sepa­
rator and a line separator, Jazz treats it as a column separator.
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Range menu • File Edit LLIindouj Range Tools Font Style

Range
I Fill...

Format... 
Protection...

Name...
Reiiiem Names...

Set Titles 
Cancel Titles
Set Page Break

Recalc Settings...
Recalculate SR

Fill... allows you to enter a sequence of values automatically into a 
range of cells.
• Start Value: The number (positive or negative) that appears in 

the first cell.
• Step Value: The interval between each successive value. You can 

enter a negative number if you want the sequence to go down 
rather than up.

• Stop Value: The maximum or minimum value in the sequence.
• By Columns: Jazz fills the range by moving down each column 

in the range.
• By Rows: Jazz fills the range by moving across each row in the 

range.
You can enter a formula for start, step, or stop value instead of a 
number. Jazz calculates the formula and uses its value.
Filling continues until either the stop value is reached or the entire 
range is filled.
Format... changes the display format for numbers and text in the 
selected cell or cell range.
The dialog box shows the format of the active cell, and lets you 
choose a format for the selected range or choose a default format 
for numbers and text in the entire worksheet. (The Show Attrib­
utes command from the Style menu lets you see the formats for all 
cells in the worksheet.)
If you select a numeric format other than General, Jazz gives you 
the option of specifying the number of decimal places, up to 15. 
Clicking the up or down arrow in the dialog box cycles you 
through the number of decimal places. (Jazz stores numbers that 
have up to 15 decimal places.)
• Format for the Selected Range: Sets the display format for cells 

in the selected range.
• Default Numeric Format: Sets the default format for numbers in 

the worksheet.
• Default Text Format: Sets the default format for text in the 

worksheet.
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Display 
Format Description Examples

Fixed Displays numbers with a 25.00
fixed number of decimal -278.2
places. 23.0245

Scientific Uses the letter E to express 1.346E3
numbers in powers of 10. 8.09E- 12

-7.3E8

Currency Displays $ followed by a $6.98
number. Negative values ($36.00)
appear in parentheses; $0.23
commas separate thousands. $89,473

Percent Displays percentages. 24.7%
- 0.06%

Comma Displays numbers with 89,898.00
commas to separate 
thousands. Negative numbers 
appear in parentheses.

(1,000.00)

General Displays numbers as right- 10.3

Bar Graph

aligned. Very large or very 
small numbers are expressed 
in scientific format. General is 
the default for numbers.

Displays a pattern for

6.03592E8

4
positive numbers and a 
different pattern for negative 
numbers.

Date Displays dates, in one of the 
following formats:

1 DD-MMM-YY:
Day-Month-Year

23-FEB-85

2 DD-MMM:
Day-Month

23-FEB

3 MMM-YY:
Month-Year

FEB-85

4 MM/DD/YY:
Month/Day/Year

2/23/85

Continued
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Display 
Format Description Examples

Time Displays time, in AM/PM or
24 hour format:

1 HH:MM:SS AM/PM
Hour:Minute:Second

10:03:39 PM

2 HH:MM AM/PM
Hour:Minute

5:17 PM

3 HH:MM:SS, 24 Hour 
Hour:Minute:Second 
(24 hour)

23:03:45

4 HH:MM, 24 Hour
Hour:Minute (24 hour)

14:45

Text Specifies alignment for text or 
for numbers that you want 
formatted as text. By default, 
text is left-aligned and num­
bers are right-aligned.

Left: left-aligned TAX
Right: right-aligned TAX
Center: centered TAX
Repeat: repeated TAXTAXTAX

Formula Text Displays formulas 
in the worksheet instead of 
their values.

= PRIN*RATE

Default Uses the default formats 
chosen for numbers and text 
for all cells in the selected 
range.
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Protection... lets you choose protection settings for a selected 
range and enable or disable protection. The dialog box reflects the 
protection settings for the active cell. If all cells in the selected 
range do not have the same settings as the active cell, the dialog 
box displays a message notifying you of this. (The Show Attributes 
command from the Style menu lets you see the protection settings 
for all cells in the worksheet.)
• Check Entry Format: If checked, Jazz prevents you from enter­

ing data in a cell in the selected range if the data does not match 
the display format of the cell. Formats that Jazz verifies are date, 
time, numeric, and text formats. If not checked, Jazz does not 
verify the format of any data you enter in the selected range. 
This is the default.

• Hide Values: If checked, Jazz hides the contents of the selected 
cells from view. If not checked, Jazz displays the contents of the 
selected cells in the worksheet. This is the default.

• Prevent Entry of New Values: If checked, Jazz prevents you from 
changing the contents of the selected range, including cutting, 
clearing, pasting, or filling of any protected cells. If not checked, 
Jazz allows the contents of cells in the selected range to change. 
This is the default.

• Enforce Protection Settings: If checked, Jazz enforces protection 
using the protection settings you chose above for the selected 
range. Jazz also enforces protection for any ranges you previ­
ously selected for protection. The Protect icon appears in the 
console, indicating that you have turned protection on in the 
worksheet. If not checked, Jazz does not enforce protection in 
the worksheet. This is the default.

Name... assigns a name to a selected cell or cell range. The name 
is added to the list of range names displayed with the Review 
Names... command.
Once you assign a range name, Jazz uses it instead of the range 
address, wherever possible. You can assign more than one name to 
the same range, but in the worksheet, Jazz displays only the name 
that comes first alphabetically.
Review Names... lets you view, change, or discard a range name 
and its associated range. A list of range names associated with the 
worksheet appears.
Clicking a range name in the list lets you rename it or change its 
associated range. If you change the range name or its associated 
range address, Jazz adjusts all references to that range name. If you 
enter an invalid range, Jazz beeps and selects the invalid range.
Clicking OK enters your changes into the list. Clicking Undo 
reverses all changes you make to a name or its associated range 
before you click OK. Clicking Discard removes the selected name 
from the list and disassociates it from the selected range. (The con­
tents of cells in the range are not affected.)
Clicking Done enters your changes into the list and returns you to 
the worksheet.
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If you rename an existing range name, Jazz updates all formulas in 
the worksheet that referred to that range name with the new name. 
If you discard a range name from the list, Jazz replaces the range 
name with the range address in all formulas that referred to that 
range name.
Set Titles “freezes” selected rows so that they always appear at 
the top of the worksheet, or freezes selected columns so that they 
always appear on the left side of the worksheet. Frozen rows and 
columns are called titles. Titles remain visible even if you scroll to 
another part of the worksheet. Jazz displays a solid line to separate 
frozen rows or columns from the rest of the worksheet.
This command is dimmed unless one or more left columns or top 
rows are selected. It either appears as Set Left Titles or Set Top 
Titles, depending on the current selection. You can set both left 
and top titles in the worksheet.
Cancel Titles “unfreezes” rows and columns that you previously 
set as titles using Set Titles.
Set Page Break inserts a dashed line above a selected row or to 
the left of a selected column, to tell Jazz where to start printing a 
new page. This command is dimmed unless you selected a column 
or row. You can set both row and column page breaks.
To erase a page break, select the row below the page break, or the 
column to the right of the page break. When you select a row or 
column that contains a page break, this command becomes Clear 
Page Break, which removes the page break from the worksheet.
Recalc Settings... controls the way Jazz recalculates formulas or 
functions in the worksheet. Jazz saves these settings when you save 
the worksheet.

Recalculation Settings c °k a
Recalculation Mode: ® Automatic 

O Manual
[ Cancel ]

Recalculation Order: <•> Natural Order 
O By Columns 
O By Rows

Iteration Count: ■
• Automatic: Jazz recalculates the worksheet whenever a change is 

made that may affect the value of any formulas on the work­
sheet. This is the default.

• Manual: Jazz displays the Recalculate icon in the console if you 
make a change that affects the value of any formula. Jazz recalcu­
lates the worksheet only when you choose the Recalculate com­
mand or click the Recalculate icon.

• Natural Order: Before recalculating a particular formula, Jazz first 
recalculates all formulas or functions on which it depends. This 
is the default.
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Tools menu

Set Sort Ranges 
Sort

Set Table Ranges...
Compute Table

Set Distribution Ranges...
Compute Distribution

• By Columns: Jazz starts recalculating with column A. It then 
recalculates columns B, C, and so on, always working top to 
bottom.

• By Rows: Jazz starts recalculating with row 1. It then recalculates 
rows 2,3, and so on, always working left to right.

• Iteration Count: The number of times that Jazz recalculates the 
worksheet’s formulas during a recalculation pass. Enter a number 
between 1 and 255. The default is 1. Jazz ignores this option 
unless the Circular Reference icon appears in the console or the 
recalculation order is By Columns or By Rows.

Recalculate calculates formulas in the entire worksheet. Jazz recal­
culates formulas according to the choices you made with Recalc 
Settings... from this menu. This command produces the same 
results as clicking the Recalculate icon when it appears in the 
console.

File Edit Window Range Tools Font Style

Set Sort Ranges... specifies how Jazz sorts the contents of a 
selected range (the data range) in the worksheet. Jazz sorts accord­
ing to the sort ranges you specify in the dialog box. Each sort 
range must consist of one column within the data range.

Sort Ranges

Data Range: ! Use Selected

( OK J

1 Reset J

(Cancel)

First Sort Range: ' Use Selected (•) Ascending [ Sort ]

0 Descending

(•> Ascending

0 Descending

(•) Ascending

O Descending

Second Sort Range: ; Use Selected

r
Third Sort Range: [ Use Selected

You can use as few as one or as many as three sort ranges. For 
each range, choose Ascending (A, B, C...Z; 1, 2, 3,...) or Descend­
ing (...3, 2, 1; Z, Y, X...A) order. This is the order that the values 
of the cells in the range will have after sorting.
You can keep adding ranges to the dialog box by selecting a range, 
choosing this command, and then clicking Use Selected to enter 
the selection in the dialog box. You can also type the range 
addresses in the dialog box. Clicking Reset clears the contents of 
the dialog box.
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• Data Range: The range address or name of the range to sort.
• First Sort Range: The address of the entire column or any single 

cell in the column to be used as the primary range.
• Second Sort Range: The first tie-breaker column (optional). This 

is the address of the entire column or any single cell in the sec­
ond sort range. If two or more cells in the column specified by 
the first sort range have the same value, the values in the second 
sort range determine their order.

• Third Sort Range: The second tie-breaker column (optional). This 
is the address of the entire column or any single cell in the third 
sort range. After sorting with the first and second sort ranges, if 
two or more cells still have the same value, the values in the 
third sort range determine their order.

Clicking Sort returns you to the worksheet and sorts the range. 
Clicking this button is the same as clicking OK and then choosing 
the Sort command from this menu.

W
orksheet

First sort range

Third sort range
Data range (after sorting)
Second sort range

Sort sorts the data range you specified with the Set Sort Ranges... 
command. Jazz sorts using the standard Macintosh sorting 
sequence.
Set Table Ranges... creates a what-if table that records the 
changes to one or more formulas when you place different values 
in one or two input cells. It is called a what-if table because it 
shows all the results of certain formulas when particular cells 
change in value.
Before using this command, you must prepare a table range that 
includes one or more formulas that are sensitive to changes in a 
particular cell or pair of cells (the input cells). When Jazz performs 
the what-if calculations, it enters the results into the table range.
You can keep adding ranges to the dialog box by selecting a range, 
choosing this command, and then clicking Use Selected to enter 
the selection in the dialog box. You can also type the range 
addresses in the dialog box.
• 1-Way Table: Shows the effects of the changes to one cell on 

one or more formulas.
• 2-Way Table: Shows the effects of the changes to two cells on 

one formula.
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• Table Range: Specifies, in a 1-way table, the range that contains 
the column of what-if entries as its first column and the set of 
formulas as its first row. In a 2-way table, this is the range that 
contains both the column and row of what-if entries you 
created.

• Input Cell 1: The cell Jazz fills with values from the column of 
what-if entries you prepared in the table range.

• Input Cell 2: (For 2-way tables only.) The cell Jazz fills with 
values from the row of what-if entries you prepared in the table 
range.

Clicking Compute returns you to the worksheet and computes the 
what-if table. Clicking this button is the same as clicking OK and 
then choosing the Compute Table command from this menu.
Compute Table calculates a 1-way or 2-way table, based on what 
you specified with the Set Table Ranges... command. The results 
appear in the selected table range in the worksheet. You can then 
summarize the results in another part of the worksheet and graph 
them to see how your data responds to the what-if analysis.
Set Distribution Ranges... specifies ranges that Jazz uses to calcu­
late a frequency distribution. A frequency distribution shows how 
many values in a specified range fall in specified numeric intervals.

OKDistribution Ranges

( Cancel

[compute]

You can keep adding ranges to the dialog box by selecting a range, 
choosing this command, and then clicking Use Selected to enter 
the selection in the dialog box. You can also type the range 
addresses in the dialog box.
• Bin Range: Specifies a range, consisting of a column of increas­

ing numbers, or formulas of increasing value, which Jazz uses to 
compute the frequency distribution.

• Value Range: Specifies the range of values Jazz uses to compute 
the frequency distribution.

You must leave an empty column to the right of the bin range that 
is one cell longer than the bin range. This is the range where Jazz 
lists the results.
Clicking Compute returns you to the worksheet and performs the 
frequency distribution. Clicking this button is the same as clicking 
OK and then choosing the Compute Distribution command from 
this menu.
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Bin range----------------------

Value range-------------------

Jazz calculates frequency 
distribution here.

Style menu

style
✓Plain Tent

Bold
Italic

I Underline
I HQQtiDntD®

gaadjauo

Hide Grid
Hide Borders
Column Widths...

✓Shorn Llalues
| Shorn Attributes

Compute Distribution performs a frequency distribution and lists 
the results in the results column to the right of the bin range.
The first cell in the results column contains the number of values 
in the value range that are less than or equal to the first value in 
the bin range.
Each successive cell in the results column contains the count of 
values greater than the previous bin value, up to and including the 
bin value to the left.
In the extra cell of the results column, Jazz places the number of 
values (if any) that exceed the last bin range value.
Empty cells and cells containing text in the value range have the 
value zero.

« File Edit Window Range Tools Font Style

You can choose any available style for the entire worksheet. The 
style you choose is checked in the menu. The default style is Plain 
Text, which cannot be mixed with other styles. You can combine 
the other styles, however, for a variety of effects.
Hide Grid removes the column and row grid lines from the work­
sheet. When the grid is hidden, this command becomes Show 
Grid, which redisplays the worksheet grid.
Hide Borders removes the column and row labels from the work­
sheet. When the labels are hidden, this command becomes Show 
Borders, which redisplays the worksheet labels.
Column Widths... specifies the default column width, in charac­
ters, for all columns in the worksheet. The dialog box displays the 
last number you entered for the width. Jazz bases the number you 
enter on the maximum number of lowercase “m” characters, in 
the current font and style, that can fit in the cell. The initial default 
is 7.
• Restore Default Width to Selected Columns: If checked, Jazz 

restores the default column width specified in this dialog box to 
the selected columns. This option is dimmed unless one or more 
columns are selected in the worksheet.

Show Values displays the contents of all cells in the worksheet.
Show Attributes displays the format and protection settings of all 
cells in the worksheet. You can continue to perform all worksheet 
operations while this command is checked.
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The top half of each cell displays the formula or unformatted con­
tents of that cell (if any). In the bottom half of the cell, Jazz uses a 
format abbreviation to show the display format and protection set­
tings for the cell (if any).

Format Abbreviation Display Format

fix Fixed
sci Scientific
cur Currency
per Percent
com Comma
gen General
bar Bar Graph
dat Date
tim Time
txt le Text, left-aligned
txt ri Text, right-aligned
txt ce Text, centered
txt re Text, repeated
for Formula Text

For numeric formats, the number of decimal places (0-15) is dis­
played. For Time and Date formats, this number corresponds 
instead to one of the four subformats:

Number Time Subformat Date Subformat

1 HH:MM:SS AM/PM DD-MMM-YY
2 HH:MM AM/PM DD-MMM
3 HH:MM:SS, 24 hour MMM-YY
4 HH:MM, 24 hour MM/DD/YY

To the right of the format, Jazz displays any combination of up to 
three protection settings that you chose using the Protection... 
command on the Range menu. The first letter of the protection set­
ting appears only if that setting was checked in the Protection... 
dialog box.

Letter Protection Setting

c 
h
P

Check Entry Format
Hide Values
Prevent Entry of New Values
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Chapter 3
Graphics

Graphs you create with Jazz represent worksheet or 
database data visually. Illustrating a report or memo 
with a graph can increase the impact of what 
you’re saying, or clarify the meaning of the data. 
Jazz can even combine different graph types to 
emphasize particular data or present different data 
in the same graph.



Jazz can create many types of graphs, including pie charts and line, 
bar, area, stock market, percent, and scatter graphs. You can also 
enhance a graph in many ways — for example, by adding labels, 
titles, or explanatory text. Once you create a graph, you can edit 
it, save it, change its size, or print it.
To create a graph, you select the data you want to graph in a 
worksheet or database, open a graphics document, and choose the 
type of graph you want to create. You then build your graph by 
selecting additional ranges from the worksheet or database and 
adding them to the graph.

Once you use data from a worksheet or database in a graph, Jazz 
always associates the graph with that worksheet or database. This 
means that Jazz automatically changes the graph to reflect changes 
in the data. Because a graph is linked to the worksheet or database, 
you should store the graph and the associated document on the 
same disk.
You can also incorporate graphs in a word processing document. 
Jazz changes the graph and the word processing document when 
you change the data the graph is based on in the worksheet or 
database.

Using Graphics requires a thorough knowledge of the Worksheet 
or Database application. You may want to become familiar with 
these applications before you begin working on Graphics.
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How to Draw a Graph
Before you create a graph, you need to decide what kind of graph 
will represent your data most effectively. Pie charts, for example, 
are best for showing the relationship among parts of a whole, 
whereas line graphs usually show changes over time. Choosing the 
right kind of graph for the data is important.
When you draw a graph, the procedure is the same no matter what 
kind of graph you decide to use. First, you select the data you 
want to graph in the worksheet or database, and then you choose 
the graph type. If you are using worksheet entries in a graph, you 
can select any range. If you are using database values, however, all 
the values must be in the same field. Because Jazz can draw, or 
plot, some types of graphs in different ways, you must also specify 
the way you want Jazz to plot the graph. For example, a bar graph 
can be a simple bar graph, an overlapped bar graph, or a stacked 
bar graph.

Jazz draws each range you select as a plot on the graph. A plot is 
the visual representation of the data. For example, a plot can be a 
line on a line graph, a set of bars on a bar graph, or an entire pie 
chart. On most types of graphs, you can plot any number of 
ranges.
Plots consist of data points. Data points mark the places (or points) 
on a plot that represent the values you are graphing. On a line 
graph, for example, Jazz uses symbols to represent the data points 
and connects the symbols with a line. On a bar graph, the lines 
across the tops of bars mark the data points. On a pie chart, each 
wedge of the pie is a data point.

Graphics

Plot

Data Point

The data you select is usually numeric. When the range you select 
includes a cell that is empty or contains text, Jazz draws the graph 
with a space for that value. For example, if you draw a bar graph 
using data in a worksheet range that contains a blank cell or a text 
entry, Jazz leaves a space instead of plotting a bar for that value.
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When you draw a graph, you may have to switch between work­
sheets or databases and the graph. For example, when a graph is 
active, you may need to select a new range to plot. To move 
between a graph and another type of document, click the docu­
ment you want to switch to. You can also choose the name of a 
document from the Window menu to make it the active document.
This section teaches you the basic procedure for creating graphs by 
showing you how to create the most commonly used graphs. It 
describes how to plot ranges. The following section describes how 
to enhance a graph with information such as titles, labels, and 
legends.

Drawing a Pie
Chart

Pie charts compare parts to the whole. In a pie chart, each value in 
a range is a wedge of the pie. The size of each wedge corresponds 
to the percentage of the total each value represents. For example, 
if a value in the range is 25% of the sum of the range values, Jazz 
draws it as a pie wedge that is one quarter of the entire pie.

Ssfea

1 Open the worksheet or database that contains the data you 
want to graph.
Open an existing document by choosing Open... from the File 
menu. To create a new worksheet or database, choose New... from 
the File menu. If the worksheet or database is already open, click it 
to make it active.

2. Select the range that contains the data.
You can use any worksheet range. In a database range, however, 
all the values must be in the same field.

3 Open a graph.
If the graph is already open, click it to make it active. To create a 
graph, choose New... from the File menu.

4. Choose Pie from the Type menu.
Jazz draws a pie without wedges.

5. Choose Pie from the Plot menu.
Jazz draws the wedges in the pie. Each wedge represents one value 
in the selected range. All the wedges together comprise the pie 
plot.
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Keep in mind

"I

Drawing more than one range. A pie chart can represent only 
one range. If you select more than one range, Jazz draws each 
range as a separate pie and adjusts the sizes of the pies so they all 
fit in the Graphics window. You can draw as many pies as you 
like.
Exploding pie wedges. You can emphasize the values particular 
wedges represent by exploding one or more wedges from the pie. 
An exploded wedge is a wedge that Jazz pulls out from the rest of 
the pie. See Selecting a Plot in this chapter before you try to 
explode a wedge.
To specify which wedges to explode, you must create a new 
range, called an explosion range, in the worksheet or database. 
You can put the explosion range anywhere on the worksheet or 
database. The explosion range can be part of a row or column in a 
worksheet or part of a field in a database. It does not have to be 
near the range you are graphing.
Beginning at the top of the pie (the twelve o’clock position) and 
moving clockwise, Jazz associates each value in the explosion range 
with a wedge of the pie. The first value in the explosion range is 
associated with the first wedge of the pie, the second value with 
the second wedge, and so on. When the value in the explosion 
range is any number except zero, Jazz explodes the wedge. When 
it is zero, the wedge remains in the pie.

Graphics

1

Drawing a 
Line or Area 
Graph

To draw an exploded pie chart, create the explosion range in the 
worksheet or database, select the range, click the graph, and use 
the Plot Selector to select a pie chart. Choose Set Pie Wedges from 
the Plot menu. When you select a pie that already has one or more 
wedges exploded, this menu choice becomes Clear Pie Wedges. 
Choose Clear Pie Wedges to return all exploded wedges to the pie.

A line graph usually shows change over a period of time. For 
example, you can use a line graph to show sales over a 10-year 
period.
A line graph represents numeric data as a set of data points that are 
evenly spaced along one axis. When you draw a line graph, Jazz 
marks each data point on the graph with a symbol and connects 
the symbols with a line. Jazz uses a different symbol for each range 
of data points to distinguish one range from another in a multiple 
line graph.
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An area graph is similar to a line graph, except Jazz fills the area 
below the line with a pattern. When you draw more than one 
range in an area graph, Jazz stacks one area on top of another.
An area graph with more than one range emphasizes the combined 
total of all values. For example, the area graph that follows shows 
yearly sales totals. Where the line graph emphasizes the changes in 
sales from year to year, the area graph emphasizes the total sales 
for each year.
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Ticket Sales

An area graph 
emphasizes total sales.
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Graphics

1. Open the worksheet or database that contains the data you 
want to graph.
Open an existing document by choosing Open... from the File 
menu. To create a new worksheet or database, choose New... from 
the File menu. If the worksheet or database is already open, click it 
to make it active.

2. Select the range that contains the data.
You can use any worksheet range. In a database range, however, 
all the values must be in the same field.

3 Open a graph.
If the graph is already open, click it to make it active. To create a 
graph, choose New... from the File menu.

4. Choose Line, Bar, & Area from the Type menu.
If you have already chosen the type, you do not have to perform 
this step.

5. Choose Line or Area from the Plot menu.
Choosing Line, Bar, & Area from the Type menu lets you create 
many different kinds of graphs. You must also choose Line or Area 
from the Plot menu to specify whether you want to plot the 
selected range as a line or as an area.

6. Repeat steps 1 through 5 for each additional range you 
want to plot.
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Drawing a 
Bar Graph

A bar graph uses bars of varying lengths to compare different 
values in a range. Bar graphs place special emphasis on individual 
values rather than on overall trends. For example, you can use a 
bar graph to compare costs or employee salaries.
A bar graph shows numeric data as a set of side-by-side bars. Each 
bar represents a value in the range you select from the worksheet 
or database. When you select one range, Jazz draws a bar for each 
value in the range.
When you plot more than one range, Jazz draws a set of bars for 
each range. Each set of bars in a multiple bar graph has a different 
pattern to distinguish one range from another. For example, you 
can draw a graph using one range that shows the total salaries of 
one department, or a graph using many ranges that shows the 
salaries of a number of departments.

1. Open the worksheet or database that contains the data you 
want to graph.
Open an existing document by choosing Open... from the File 
menu. To create a new worksheet or database, choose New... from 
the File menu. If the worksheet or database is already open, click it 
to make it active.

2. Select the range that contains the data.
You can use any worksheet range. In a database range, however, 
all the values must be in the same field.

3. Open a graph.
If the graph is already open, click it to make it active. To create a 
graph, choose New... from the File menu.

4. Choose Line, Bar, & Area from the Type menu.
If you have already chosen the type, you do not have to perform 
this step.

108 The Handbook



■ Keep in mind

5 Choose Bar from the Plot menu.
Choosing Line, Bar, & Area from the Type menu lets you create 
many different kinds of graphs, so you must also choose a plotting 
method from the Plot menu.

6 Repeat steps 1 through 5 for each additional range you 
want to graph.

Drawing a stacked bar graph. A stacked bar graph compares 
totals in addition to individual values. A stacked bar is composed 
of smaller bars stacked one on top of the other. Jazz makes the 
values in the first range you select the bottom section of each 
stacked bar. Jazz then stacks the values in the second range on top 
of the first section, the values in the third range on top of the sec­
ond section, and so on.
For example, you can use a stacked bar graph to show the total 
amount you pay in salaries to each department and the portion 
allocated to each group within the department. The bottom section 
of each stacked bar shows the first group’s total salaries. The sec­
tion stacked on top of the bottom section shows the next group’s 
salaries, and so on.

Graphics

To draw a stacked bar graph, follow the steps in this section, but 
choose Stacked Bar from the Plot menu instead of Bar for each 
range you select.
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Drawing an overlapped bar graph. An overlapped bar graph is 
similar to a multiple bar graph, but the bars overlap each other 
slightly instead of standing side by side. Overlapped bars are partic­
ularly effective when you want to contrast two ranges. For 
example, an overlapped bar graph can emphasize the savings in 
overtime pay between two months.

To draw an overlapped bar graph, follow the steps in this section, 
but choose Overlapped Bar instead of Bar from the Plot menu.
Changing plot type. To change one kind of bar graph to 
another, select one of the plots in the bar graph and choose the 
new plotting method from the Plot menu. For example, to change 
a bar graph to an overlapped bar graph, click the Plot Selector and 
choose Overlapped Bar from the Plot menu. Jazz changes the 
entire bar graph to an overlapped bar graph. This affects only the 
bars. If the graph has other types of plots, such as a line or area, 
they do not change.
If you select a bar plot and change it to a plot other than another 
type of bar plot, Jazz changes only the plot you select. For exam­
ple, if you select a plot in a bar graph and then choose Line from 
the Plot menu, Jazz changes only the selected plot to a line graph.

Selecting a
Plot

When you work with a graph, you may need to work with a par­
ticular plot. For example, you may want to change the way Jazz 
draws the line on a line graph or the bar pattern on a bar graph. 
To do this, you need to select the plot you want to change.

1. Click the Plot Selector in the Graphics console.
Each time you click the Plot Selector, Jazz selects a different plot 
on the graph, starting with the first range you plotted. Jazz marks 
each value in the plot with a plot marker. It also displays the 
worksheet or database name and the range the plot illustrates in 
the reference box next to the Plot Selector. If the graph is a pie 
chart, Jazz places one plot marker in the middle of the pie.
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Plot Selector

The reference box---------
displays the worksheet or 
database range the plot 
represents.

Plot marker

Clearing a 
Plot

Combining 
Graph Types

2. Change the plot as necessary.
For example, you can change the plot type by choosing a different 
one from the Plot menu, or you can change the symbols, lines, or 
patterns Jazz uses in the plot. See Choosing Symbols, Lines, and 
Patterns later in this chapter.

3. Click anywhere on the graph to cancel the plot selection.

After you select a plot, you can remove it from the graph. For 
example, you may decide that you plotted too many ranges, or 
that your graph contains a plot you no longer want to use.

1. Select the plot you want to clear.
Use the Plot Selector to select the plot.

2 Choose Clear from the Edit menu.
Jazz redraws the graph without the plot you selected.

A combination of graph types can show relationships among differ­
ent data. For example, you can use a line to show the change in 
employee attrition over a number of years, and use a bar in the 
same graph to show the number of employees who left for a par­
ticular reason.

Graphics
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Attrition

Number dissatisfied 

with the company

s Number who left

Keep in mind

1. Open the worksheet or database that contains the data you 
want to graph.
Open an existing document by choosing Open... from the File 
menu. To create a new worksheet or database, choose New... from 
the File menu. If the worksheet or database is already open, click it 
to make it active.

2. Select the range that contains the data.
You can use any worksheet range. In a database range, however, 
all the values must be in the same field.

3. Open an existing graph or create a new one.
If the graph is already open, click it to make it active. To create a 
graph, choose New... from the File menu.

4. Choose the graph type from the Type menu.
5. Choose the plot type from the Plot menu.
6. Repeat steps 1 through 5 for each additional range you 

want to graph.
Each time you perform the steps, you can select a different plot 
type. For example, you can use bars in the first plot and a line in 
the second.

Restrictions on mixing graph types. Jazz only lets you mix 
graph types that are compatible. For example, a pie chart shows 
values as wedges in a circle, while all other graphs plot them on 
axes. Thus, you cannot combine a pie with any other type of plot.
Changing a graph to another type. To change an entire graph 
from one type to another, choose the new type from the Type 
menu. Jazz redraws the graph with the characteristics of the new 
graph type. For example, to convert a bar graph with a single 
range to a pie chart, select Pie from the Type menu. Jazz redraws 
the graph as a pie. If the bar graph has many ranges, Jazz changes 
each range to a separate pie.
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Changing individual plots on existing graphs. You can change 
particular plots on an existing graph rather than creating a new 
graph. For example, you may want to change one of the plots on a 
bar graph to a line. Use the Plot Selector to select the plot you 
want to change, and choose a plotting method from the Plot 
menu. Jazz changes only the plot you select. Repeat this procedure 
for each plot you want to change.
You cannot combine bar, stacked bar, and overlapped bar plots. If 
you select one bar in a multiple bar graph and choose another type 
of bar from the Plot menu, Jazz redraws all the bars using the new 
plotting method.

Graphics

113 Graphics



How to Enhance a Graph
After you draw a graph, you may need to emphasize and clarify 
parts of it. Jazz lets you enhance a graph in many ways. Some tech­
niques, such as adding labels and titles to an axis, make your data 
easier to understand. Other techniques, such as changing the kind 
of plot lines in a line graph or patterns in a bar graph, help make 
your graph more attractive. For example, you can emphasize a line 
in a line graph by making it bolder or emphasize a set of bars in a 
bar graph by using a darker bar pattern.

Adding Text 
and Tick 
Marks to an 
Axis

Axes are lines on a graph against which you plot data. After you 
draw a graph, you can add information to the axes, such as axis 
titles and labels that identify the data. When you graph sales, for 
example, axis labels can show the months when the sales took 
place. Axis titles show the category of information you are graph­
ing. If, for example, the months you are graphing show sales for 
the first quarter, use First Quarter as the axis title. An axis to which 
you add this type of information is a text axis.
The axis that displays the numeric scale Jazz uses to plot your data 
is a numeric axis. When you plot a range, Jazz automatically sets 
the minimum and maximum value of the numeric axis. Unless the 
graph is a line graph, Jazz makes the minimum axis value zero and 
the maximum axis value the largest value in the range. If the graph 
is a line graph, Jazz makes the maximum value on the axis slightly 
higher than the largest value in the ranges you plot and makes the 
minimum value slightly lower than the smallest.
The short lines on the numeric axis, called tick marks, mark the 
scale. Jazz puts tick marks at regular intervals between the maxi­
mum and minimum values. For example, if the minimum value in 
the range is zero and the maximum value is 100, Jazz places major 
tick marks at intervals of 10, 20, 30, and so on up to 100. Jazz also 
marks intervals between major tick marks; for example, it puts a 
tick mark at 15, between 10 and 20.
You can alter a numeric axis by changing the minimum and maxi­
mum values on it. You can also change the intervals at which Jazz 
places major and minor tick marks. For example, instead of placing 
minor tick marks at intervals of 5, you can place them at intervals 
of 1. In addition, you can make the tick marks appear on the 
inside, outside, or across either the text or numeric axis, or choose 
not to display tick marks at all.
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Livestock — Number on Farms

El Hogs and Pigs

El Sheep and Lamb3

All Cattle

Adding labels to a
text axis

1 Open an existing worksheet or database or create a new 
one.

2. Select the range that contains the entries you want to use as 
labels.

3 Open the graph.
If the graph is already open, click it to make it active.

4. Choose Set Labels from the Axis menu.
Jazz places the labels at each tick mark along the text axis.
After you choose Set Labels, the command changes to Clear 
Labels. To replace existing axis labels, you must first choose 
Clear Labels to delete the old labels. To add new ones, repeat 
steps 2 through 4.

Adding tick marks 
and axis titles

Graphics

Dialog box for a numeric 
axis

Dialog box for a text axis

Bottom finis Settings
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Settings for Manual Scaling
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Major Internal:

Minor Internal: 1

1. Choose Left..., Bottom..., Right..., or Top Axis... from the 
Axis menu.
If the axis is a numeric axis, Jazz displays boxes in which you can 
specify the minimum and maximum axis values and the intervals 
for tick marks. In most graphs, the left axis is the numeric axis.
When you first open a document, the left axis is a numeric axis 
and the bottom axis is a text axis.
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2. Click the box next to Display Axis to check it.
If the box is checked, you do not have to perform this step. When 
the box is checked, the axis and labels appear with the graph. If 
the box is empty, the axis and labels do not appear.

3. Click a Tick Mark option.
• None erases all tick marks from the axis.
• Inside places tick marks inside the axis.
• Outside places tick marks outside the axis.
• Cross places tick marks across the axis.

4 Type a title for the axis.
To change a title that already exists, click the location in the title 
box where you want to add or delete text. Type new text or 
Backspace to delete existing characters.

5. Click OK.

Modifying a 
numeric axis

In addition to adding titles and tick marks to a numeric axis, you 
can change the minimum and maximum values on the axis and the 
intervals between major and minor tick marks.

Set a minimum axis value that is no higher than the minimum 
value in the range you are graphing and a maximum value that is 
no lower than the maximum value in the range. Jazz plots up to 
the maximum value on the numeric axis and cuts off any value in 
the plot that rises above that point. For example, if you set the 
maximum value at 10 and the largest value in the range you are 
plotting is 100, Jazz tries to plot 100. If you are drawing a bar 
graph, Jazz tries to draw the bar to a point that is beyond the 
borders of the graph. Since the bar cannot go beyond the maxi­
mum value of 10, it appears that the value you are plotting is 10, 
instead of 100.

1. Choose Left..., Right..., Top..., or Bottom Axis... from the 
Axis menu.
Be sure that the axis you choose is a numeric axis. If the axis is a 
numeric axis, Jazz displays boxes in which you can specify the 
minimum and maximum axis values and the intervals for tick 
marks. In most graphs, the left axis is the numeric axis.
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2. Click Minimum and type the lowest value for the numeric 
axis.

3- Click Maximum and type the highest value for the numeric 
axis.

4. Click Major Interval and type the major interval value.
If you type 10, Jazz puts major tick marks at every multiple of 10, 
beginning at the minimum value you set and ending at the maxi­
mum value you set.

5. Click Minor Interval and type the minor interval value.
For example, when the major interval is 10 and the minor interval 
is 5, Jazz places one tick mark midway between the major tick 
marks.

6. Click OK.

Keep in mind Selecting numbers as labels. When you select numbers as 
labels, Jazz treats them as text rather than numbers. For example, 
you can make the title Quarterly Earnings and select a range that 
contains numbers that represent each quarter (1, 2, 3, and 4) as 
labels. Jazz treats the numbers as text.
Making long labels fit on a text axis. When an axis is too small 
for a label to fit, Jazz cuts off the text that does not fit. To make 
the complete label appear, shorten the label or choose a smaller 
font size.

Adding Labels 
to Data Points

Graphics

Each value you represent in a plot is a data point. In a line graph, 
a symbol represents each data point; in a bar graph, the top of 
each bar represents a data point. You can use labels to identify the 
value each data point illustrates. In a bar graph, Jazz places the 
labels along the tops of the bars. In a line graph, Jazz places the 
labels above the data points. In a pie chart, Jazz places the labels 
outside each pie wedge.

Cost of Animal Feed

Data point label

Data point
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Keep in mind

Adding Text 
to a Graph

Notation (a graph title)

1 Open an existing worksheet or database or create a new 
one.

2 Select the range in the worksheet or database that contains 
the entries you want to use as labels.
You can use any worksheet range to store the labels. In a database 
range, however, all the labels must be in the same field.

3 Open the graph.
If the graph is already open, click it to make it active.

4. Click the Plot Selector to select a plot.
5. Choose Set Point Labels from the Plot menu.

Set Point Labels places data from the range you select at the cor­
responding data point on the graph.
After you choose Set Point Labels, the menu choice becomes Clear 
Point Labels. Choose Clear Point Labels after you select the plot to 
delete the labels from the graph.

Matching range size with the number of data points. If you 
select a range that has more entries than the graph has data points, 
Jazz uses as many labels as there are data points. For example, if 
you select a range with 10 entries as labels for a graph with 5 data 
points, Jazz places only the first 5 labels on the graph. If you select 
a range with 3 entries, Jazz places data point labels only on the 
first 3 data points.

Text on a graph can help to explain the whole graph or certain 
parts of it. For example, you might want to use text to add a title 
to a graph or to describe an unusual rise or drop in sales.

Notation (emphasizes a 
particular bar)

Rolling Park Zoo — Concession Sales

June July August Septembe

1. Click the notation well in the Graphics console.
2. Click anywhere on the graph and drag.

As you drag the pointer, Jazz draws a notation box. Make the nota­
tion box larger than you need to hold your text. You can make 
the box smaller after you enter the text.
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Keep in mind

To change the size of the notation box, drag the size box in the 
same way you drag the size box of a Jazz window. The text 
changes to match the new size of the notation box. For example, 
when you make a long box shorter, one line of text may be split 
into two. If you make a box too small, Jazz will cut off some of 
the letters.

3. Type the text inside the box.
When the text reaches the end of the box and there is room for 
another line, Jazz automatically puts the last word you typed on 
the next line. If there is no more room in the box, Jazz does not 
allow you to type any more characters. To type more characters, 
drag the size box and expand the size of the notation box so that 
it is big enough to hold your text.

4. Click anywhere in the graph.
Jazz clears the notation box but leaves the text.

Deleting text. Click the text you want to delete. Jazz draws a 
notation box around it. Choose Clear from the Edit menu. Jazz 
deletes the text and the notation box.
Editing text. You can edit text within notation boxes. Click the 
text; Jazz draws a notation box around it. To add or delete text, 
click the location where you want to insert or delete. Type the 
text you want to add, or press Backspace to delete text.
You can also use commands on the Edit menu to work with text 
in notation boxes. Click the text. When the notation box appears, 
select the text you want to edit by dragging across it and choose 
the command you need. Cut deletes text from the graph and 
places it on the Clipboard. Copy leaves text in the graph and 
places a copy on the Clipboard. Paste replaces the selected text in 
the notation box with what is on the Clipboard or adds the text 
on the Clipboard at the insertion point if no text is selected. Dupli­
cate Notation creates an identical notation box that you can drag to 
another part of the window. Undo undoes the last command you 
performed.

Graphics
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To paste text to a new graph, select the text, choose Cut or Copy 
from the Edit menu, click the graph you want to paste the text in 
(or open it if it is not already open), draw a notation box, and 
choose Paste from the Edit menu.
To cancel the selection of the notation box, click anywhere on the 
graph.
Moving the notation box. To move a notation box, position the 
pointer on the border of the box and drag it to the new position.
Keeping a notation box from covering parts of the graph.
When you place a notation box over part of the graph, such as a 
bar in a bar plot, the notation box hides the part that it covers 
even after you cancel the notation box selection. To keep this 
from happening, move the box or change its size.
Changing the font, size, and style. Click the text you want to 
change. Jazz draws a notation box around it. Choose the font or 
point size from the Font menu or the style from the Style menu. 
You can use only one font, size, and style in a notation box, but 
you can use different fonts, sizes, and styles in different notation 
boxes. Each time you change the font, size, or style of a notation, 
Jazz uses the new font, size or style for text in subsequent notation 
boxes until you change it again.

Drawing 
Arrows and 
Lines

You can combine arrows and lines with text to annotate parts of a 
graph.

Ticket. Sales — Summer

Bl 1. Click the arrow or line well in the Graphics console.
2. Click anywhere on the graph and drag.

When you release the mouse, stretch boxes appear at the ends of 
the arrow or line. Dragging a stretch box extends, shortens, or 
moves the arrow or line in the direction in which you drag it.
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3 Drag either of the stretch boxes to position the arrow or 
line and to change its length.

Keep in mind

Choosing 
Symbols, 
Lines, and 
Patterns
Symbol---------------

4 Repeat steps 1 to 3 for each additional arrow or line you 
want to draw.
To draw a figure that contains more than one line, you must draw 
each line separately. For example, to draw a box, you must draw 
four separate lines.

5. Click anywhere on the graph to make the stretch boxes 
disappear.
To use the stretch boxes again, click the arrow or line. The stretch 
boxes reappear.

Deleting an arrow or line. To delete an arrow or line, click the 
arrow or line well. Jazz places stretch boxes on the arrow or line. 
Choose Clear from the Edit menu. Jazz deletes the arrow or line.
Moving an arrow or line. To move an arrow or line, drag it to 
the new location.

When you draw a graph, Jazz automatically chooses data point 
symbols, plot lines, or bar and area patterns. You can, however, 
choose your own symbols, lines, and patterns.

Graphics

Line

Area outline

Area pattern
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1 Click the Plot Selector in the Graphics console.
Click until the plot you want is selected,

2 Choose Symbols..., Lines..., or Patterns... from the Style 
menu.
Your choice must fit the type of graph you are drawing. For exam­
ple, patterns are not appropriate for line graphs, just as symbols are 
not appropriate for area or bar graphs. Menu choices that are not 
compatible with the selected plot are dimmed on the menu.
The type of dialog box that appears depends on the command you 
selected.

Symbol Settings | qk |

NONE + □ o o A
A V

X * H ♦ • ▲ ▼



Adding a
Legend

3- Click the symbol, line, or pattern you want to use.
Although lines are most often used in line graphs, you can also use 
them to change the outline of the bars in a bar graph or the 
outline of an area graph. This is useful when you want to make a 
particular plot stand out.

4. Click OK.
Jazz draws the plot with the symbol, line, or pattern you chose.

5. Repeat steps 1 through 4 for each additional symbol, line, 
or pattern you want to change.
Click anywhere on the graph to cancel the plot selection.

A legend provides a description of the ranges that the patterns or 
symbols in a graph represent. Each legend is composed of legend 
entries. Each legend entry consists of a symbol or pattern that 
represents one of the ranges, and text that you type to describe 
what the symbol or pattern represents.

jRoiilng^ark Zoo --Food Expenses!

Graphics

Legend entry

Legend

■

1

X

1. Choose Set Legend from the Style menu.
Jazz creates legend entries for each symbol or pattern in the graph 
on the right hand side of the graph and draws a box next to each 
symbol or pattern where you enter text. Jazz places an insertion 
point in the bottom box.

2. Type a description at the insertion point.
3- Click one of the remaining boxes.
4 Repeat steps 2 and 3 for each remaining box.
5. Click anywhere on the graph to clear the boxes.

This clears the box around the text, not the text within it.
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Keep in mind Moving a legend entry. Click the text of a legend entry to select 
it. Jazz draws a box around the text. Drag the border of the box to 
the desired position.
Changing the way Jazz displays text. You may want to make a 
long text entry appear on a single line or divide one line into a 
number of smaller lines. Click the text to select it. Jazz draws a 
box around the text. You can drag the size box the way you drag 
the size box of a Jazz window. The text changes to match the new 
size of the box. For example, when you make a long box shorter, 
one line of text may become two. If you make a box too small, 
Jazz cuts off the characters that do not fit and will not let you type 
more characters until you expand the size of the box.
Changing the font, size, and style. You can change the font, 
size, and style of the text in the legend entries. Click the text in 
the legend entry. Jazz draws a box around it. Choose the font or 
point size from the Font menu or the style from the Style menu. 
Jazz rewrites the text in the font, size, or style you chose. Each 
time you change the font, size, or style of the text portion of a 
legend entry, Jazz uses the new font, size, or style until you change 
it again.
Editing legend entries. Click the legend entry you want to edit. 
Jazz draws a box around the text. To add or delete text, click the 
location where you want to insert or delete. Type the text you 
want to add, or press Backspace to delete text.

Drawing a 
Grid

A grid is a set of horizontal and vertical lines through a graph that 
makes it easier to see the exact point at which data falls between 
two axes. You can create a grid with any type of graph except a 
pie chart.

1. Choose Grid Lines... from the Style menu.
2. Click a grid option.

• Click None to clear the grid lines.
• Click Horizontal to draw a line from each major tick mark on 

the vertical axis across the entire graph.
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Adjusting the 
Size of a 
Graph for 
Printing

Keep in mind

"I

• Click Vertical to draw a line from each major tick mark on the 
horizontal axis across the entire graph.

• Click Both to draw horizontal and vertical grid lines.
3. Click OK.

Before you print a graph, you may want to adjust its size. For 
example, you may want to make a graph small enough to fit in a 
report, or large enough for a presentation. You specify the graph 
size before you actually begin printing the graph.

1. Choose Size... from the Style menu.
2. Click the Width box.
3. Type the width you want (in inches).

For parts of inches, use decimal equivalents instead of fractions.
4. Click the Height box.
5. Type the height you want (in inches).
6. Click Fit to Window or Show Actual Size.

Fit to Window makes the graph fit the size of the window. When 
you print the graph, however, Jazz uses the sizes you specified in 
the Width and Height boxes.
Show Actual Size makes the graph the size you specified in the 
Width and Height boxes. If the actual size is larger than the win­
dow, use the scroll bars to move from one part of the graph to 
another.
Make sure that you set a graph size that is smaller than the size of 
the page you are printing on. If the graph is larger than the page, 
Jazz prints only the portion of the graph that fits on the page.

7. Click OK.

Printing a graph. To print a graph, use the same procedure you 
use to print any Jazz document. When you set up the page for 
printing, use Tall Adjusted as the Orientation option in the Page 
Setup... dialog box. See How to Print a Document, Chapter 1.

Graphics
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The Graphics Reference
Menu bar displays the titles of all Graphics menus.
Console displays information about the active graph and displays 
the cursor well, the line well, the arrow well, and the notation 
well for adding details to the graph.
Reference box displays the name of the source document for a 
selected plot.
Plot Selector selects a single plot on the graph. Clicking the Plot 
Selector cycles you through the plots one at a time. The selected 
plot appears with plot markers on it. To cancel a selection, you 
click anywhere else on the graph.
Cursor well lets you select any part of the graph so that you can 
make a portion of the graph active or edit a notation. Jazz automat­
ically returns to the cursor well after you have created a line, 
arrow, or notation box.
Line well lets you create a line to connect a data point with its 
notation. You click the line well, place the pointer on the graph, 
and drag the pointer to where you want to place the line.
Arrow well lets you create an arrow to connect a data point with 
its notation. You click the arrow well, place the pointer on the 
graph, and drag the pointer to where you want to place the arrow.
Notation well lets you place a notation box anywhere on a graph. 
You click the notation well, place the pointer on the graph, and 
drag the pointer to where you want to place the box. You can 
then enter text in the box. You can vary the size of the box and 
change the style and font of text within it. All the text in a nota­
tion box appears in the same font.
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The Graphics 
Menu Bar

The Apple, File, Window, Font, and Style menus contain com­
mands that appear in all Jazz applications. For a description of 
these menus, see Chapter 1, The Standard Commands.

« File Edit 111 i rid olli Type Plot Rhis Font Style

Edit

Edit menu

Undo 3CZ

Cut
Copy sec
Paste * LI
Clear
Select fill Sfi

Duplicate

Undo reverses your last action, such as cutting, copying, pasting, 
or clearing.
If Jazz can’t undo your last action, this command appears dimmed 
as Can’t Undo. If you disabled Undo, this command is Undo 
Disabled.
Cut removes selected text from a notation box or a legend entry 
and places it on the Clipboard.
Copy places a copy of selected text from a notation box or a 
legend entry, or places a copy of an entire graph (chosen with the 
Select All command) on the Clipboard. This command works the 
same as the Cut command, except that Jazz does not remove the 
copied graph or box from the document.
Paste places the contents of the Clipboard in a selected notation 
box or legend entry. Pasted text is left-aligned in the current font 
and style. If a line becomes full, Jazz wraps text to a new line. If 
the box becomes full, Jazz will not place the text in the notation 
box. If this happens, expand the notation box by dragging the size 
box.
Clear erases selected plots, notation boxes, arrows, or lines from a 
graph or erases an entire graph (chosen with the Select All com­
mand). Jazz does not place the deleted items or graph on the 
Clipboard.
Select All selects the entire graph.
Duplicate alternates between Duplicate Notation, Duplicate 
Arrow, and Duplicate Line, depending on whether you select a 
notation box, arrow, or line. This command is dimmed until you 
make a selection.
Duplicate Notation copies the currently selected notation box. You 
can drag the copy to the desired location on the graph.
Duplicate Arrow copies the currently selected arrow. You can drag 
the copy to the desired location on the graph.
Duplicate Line copies the currently selected line. You can drag the 
copy to the desired location on the graph.
If duplication would lead to an invalidly placed notation, arrow, or 
line, Jazz beeps to indicate the error.

Type menu

Type
✓Line, Bar, 8 Brea 

Pie
Scatter
Percent

Liieiu Horizontal

< File Edit Windom Type Plot finis Font Style

The Type menu contains the major graph types. The major type 
determines which minor types you can choose from the Plot 
menu. When you choose a new major type, Jazz changes the entire 
active graph to that type. This menu also lets you change the verti­
cal or horizontal orientation of the graph.

128 The Handbook



Line, Bar, & Area sets the major graph type to line, bar, and 
area. This results in Plot choices of Line, Bar, Overlapped Bar, 
Stacked Bar, Area, and Stock Market.
Pie sets the major graph type to a pie chart. The active choices on 
the Plot menu are Pie and Pie Wedges (which become active only 
when you select a pie chart). Jazz plots each of the selected data 
ranges as a separate pie. The currently selected pie chart appears 
with a plot marker in the center.
Scatter sets the major graph type to a scatter chart. The active 
choices on the Plot menu are X Data and Y Data.
Percent sets the major graph type to percent. The active choices 
on the Plot menu are Stacked Bar and Area.
View Horizontal alternates with View Vertical. View Horizontal 
flips the graph 90 degrees so that the horizontal axis becomes the 
vertical axis. View Vertical makes the vertical axis become the 
horizontal axis. You can use this command with bar graphs or with 
any graph types that have axes.

File Edit Window Type Plot flais Font Style

The Plot menu contains the minor graph types. The active choices 
are determined by the major graph type you choose from the Type 
menu. You use this menu to plot a new range on an existing 
graph, or to change an existing plot. You can combine any of the 
active plot choices in one graph except for bar, stacked bar, and 
overlapped bar. You can also have as many plots as you want in a 
graph.
Line represents each number in a worksheet or database range as a 
single point on a line. This command is active when the major 
graph type is Line, Bar, and Area.

129 Graphics

Graphics



Bar represents each number in a worksheet or database range as a 
bar. You can use this command, for example, when you are com­
paring a small number of items to one another. This command is 
active when the major graph type is Line, Bar, and Area.

Overlapped Bar shows different data ranges by drawing bars that 
overlap one another slightly, rather than ones that stand side by 
side. This command is active when the major graph type is Line, 
Bar, and Area.
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Stacked Bar displays shorter bars stacked one on top of the 
other, comparing individual as well as total values. You can use 
this command, for example, when you are combining several 
ranges in a single bar graph. This command is active when the 
major graph type is Line, Bar, and Area, or Percent.
When the major graph type is Line, Bar, and Area, the stacked bar 
graph represents actual values.

Graphics

When the major graph type is Percent, the stacked bar graph



Area draws a line connecting data points and fills the area below 
the line with a pattern. If you graph two or more ranges, Jazz will 
draw them one on top of the other. You can use this command, 
for example, when you are emphasizing total amounts. This com­
mand is active when the major graph type is Line, Bar, and Area, 
or Percent.
When the major graph type is Line, Bar, and Area, the area graph 
represents actual values.

When the major graph type is Percent, the area graph represents 
relative values. The total of the plotted areas is 100%.
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Stock Market... graphs stock price trends, and is active when the 
active graph type is Line, Bar, and Area. This command plots four 
data ranges: the high, low, open, and close values of a Stock 
Market graph. A plot may have one of each of the high, low, open, 
and close portions but you don’t have to provide all four values. 
You can plot the ranges on the graph in any order. You can also 
specify a new data range to replace an existing portion of a Stock 
Market graph.

Close
Open

Low -

Graphics

16 J-
T

High: Plots the selected data range as the high values of the 
stocks.
Low: Plots the selected data range as the low values of the 
stocks.
Open: Plots the selected data range with a tick mark on the left 
side of the vertical line that connects the high and low points.
These data points represent the opening values of the stocks.
Close: Plots the selected data range with a tick mark on the right 
side of the vertical line that connects the high and low points.
These data points represent the closing values of the stocks.
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X Data plots one set of data points (X range) along the bottom 
axis. This command is active when the major graph type is Scatter. 
You can have only one X range per scatter chart. Choosing a new 
X range replaces the previous X range on the graph.
Y Data plots one or more sets of data points (Y ranges) against a 
different set of data points (X range). You can use this command, 
for example, when you are showing the relationship between two 
sets of values. This command is active when the major graph type 
is Scatter. You can have as many Y ranges per scatter chart as you 
want.

20.0-j
18.0-
16.0-
14.0-
12.0-
1 0.0-

Pie compares single values to the whole by drawing the values as 
wedges in a pie. The size of each wedge corresponds to the per­
centage of the total that the value represents. This command is 
active when the major graph type is Pie. Each plotted data range 
appears as a whole pie.
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Pie Wedges emphasizes selected values in a data range by explod­
ing the corresponding wedges from the pie chart. This command is 
active when the major graph type is Pie and you have selected a 
pie chart. The command becomes Set Pie Wedges when the 
selected pie chart has no exploded wedges, and it changes to 
Clear Pie Wedges when the selected pie chart has exploded 
wedges.
To use this command, you must first create and select an explosion 
range in the worksheet or database. If the range is in a database, all 
the values must be within one field. Moving clockwise from the 
top of the pie, Jazz associates each value in the explosion range 
with a pie wedge. Any value in the explosion range that is not zero 
causes Jazz to explode the corresponding wedge. You can explode 
as many wedges of a pie chart as you want.

Exploded wedge

Graphics

Point Labels specifies entries you selected in a worksheet or data­
base range that you want to associate with data points in a plot. 
When no labels are present in a selected plot, Set Point Labels 
displays selected database or worksheet entries as point labels. 
When labels are present in the selected plot, the command 
becomes Clear Point Labels, removing all data labels.
Associate specifies the numeric axis to which you want to associ­
ate a plot. You can use this command when you have more than 
one plot on the graph and the data range for each plot varies 
greatly. For example, if one plot has values ranging from 1 to 10 
and a second plot has values ranging from 3,000 to 6,000, you 
could associate the first plot with the left axis and the second plot 
with the right axis. Each axis can have a different minimum and 
maximum value.
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The command is active only when you select a plot. If the 
selected plot is associated with the left axis, the command becomes 
Associate to Right Axis. If the selected plot is already associated 
with the right axis, the command becomes Associate to Left 
Axis. When you associate one plot in a stacked bar or a stacked 
area graph with the right axis, Jazz associates all the plots in the 
stacked bar or the stacked area graph with the right axis.

Associated with right 
axis

Associated with left axis

Axis menu « File Edit LLlindou.) Type Plot flHis Font Style

Hhis

Left... 
Bottom... 
Right...
Top...

Set Labels
Format...

The Axis menu contains commands that change the left, bottom, 
right, and top axes on your graph. The changes you can make 
depend on whether the axis is numeric or text. A numeric axis has 
values along it, and a text axis has labels.
Left... brings up a dialog box to define the settings for the left 
axis. The dialog box depends on whether the currently selected 
axis is numeric or text.
The first line in the dialog box shows which axis you are defining. 
The following settings appear in both the text and numeric axis 
dialog boxes. Jazz determines the type of axis according to the 
type of plot you have selected.
• Display Axis: Specifies whether the axis appears on the graph.
• Tick Marks: Specifies whether tick marks appear inside, outside, 

or across major and minor points on the axis. You can also 
choose to have no tick marks. The options can be different for 
the major and minor points.

• Title: Specifies a title for the axis.
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The following settings appear only for numeric axes. You can enter 
fractions as decimals. Jazz automatically calculates values for any 
settings you leave blank, so you don’t have to provide values for 
all four settings.
• Minimum: Specifies a minimum value at which the axis begins. 

You can type any positive or negative number. The minimum 
value must be less than the maximum value.

• Maximum: Specifies a maximum value at which the axis ends. 
You can type any positive or negative number. The maximum 
value must be greater than the minimum value.

• Major Interval: Specifies the increments on the axis at which 
major tick marks are placed. The major interval must be less 
than the difference between the maximum and minimum value 
and greater than the minor interval.

• Minor Interval: Specifies the increments on the axis at which 
minor tick marks are placed. The minor interval must be less 
than the difference between the maximum and minimum value 
and less than the major interval.

Jazz displays the following information only for text axes.
• Label Range: Displays the range in the worksheet or database 

that contains the axis labels.
Bottom... specifies the settings for the bottom axis. This command 
brings up the same dialog box as for Left.... The dialog box 
depends on whether the selected axis is numeric or text.
Right... specifies the settings for the right axis. This command 
brings up the same dialog box as for Left.... The dialog box 
depends on whether the selected axis is numeric or text.
Top... specifies the settings for the top axis. This command brings 
up the same dialog box as for Left.... The dialog box depends on 
whether the selected axis is numeric or text.
Set Labels specifies entries you selected in a worksheet or data­
base range to appear as labels on a text axis. The labels are placed 
along the axis, and a major tick mark appears at each label. When 
the axis already has labels, the command becomes Clear Labels.
Format... changes the display format for numbers along the 
numeric axis.
The dialog box shows the format of the numbers along the 
numeric axis, and lets you choose a different format for the num­
bers. If you have more than one numeric axis, you can change the 
format of the numbers along each axis.
If you select a numeric format other than General, Jazz gives you 
the option of specifying the number of decimal places, up to 15. 
Clicking the up or down arrow in the dialog box cycles you 
through the number of decimal places. (.Jazz stores numbers that 
have up to 15 decimal places.)

Graphics
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Format is an alternative for labeling a numeric axis. For example, 
instead of including the words “In Dollars” in an axis title, you 
can format the axis so that the numbers appear in Currency format.

Style menu * File Edit Window Type Plot Huis Font Style

Style
./Plain Tent MP 

Bold MB
Italic Ml
Underline MU
EmQllBtri© mo
gaaaauu ms

Lines...
Patterns...
Symbols...

Grid Lines...
Size...

I Legend________

You can choose any available style for text in notation boxes, axis 
labels, and titles. The chosen style also affects text you are about 
to type. The style you choose is checked in the menu. The default 
style is Plain Text, which cannot be mixed with other styles. You 
can combine the other styles, however, for a variety of effects.
Lines... specifies the type of line for line graphs, for scatter graphs 
whose data points are connected by lines, and for the outline 
around bars in bar graphs. The command is active whenever you 
select anything containing lines. A dialog box displaying different 
line types appears.
Patterns... specifies the pattern for bar or area graphs, and is 
active whenever you select any bar or area plot. A dialog box 
displaying different patterns appears.
Symbols... specifies the symbols used to mark data points in scat­
ter and line graphs. This command is active whenever you select a 
plot containing symbols. A dialog box displaying different symbols 
appears.
Grid Lines... specifies whether the graph has horizontal and/or 
vertical grid lines on it.
Size... scales the graph to a specified size. You generally use this 
command to set the size of the graph for printing.
• Fit to Window: Causes the entire graph to appear within its 

window. If you print the graph, it will print in the size you 
specified at the width and height settings.

• Show Actual Size: Causes the graph to appear in the size you 
specified at the width and height settings. If necessary, you can 
use the scroll bars to view different portions of the graph.

• Width: Specifies the width of the graph in inches. You can enter 
any positive number, using decimals for fractions. If you print 
the graph, the width should not exceed the width of the paper.

• Height: Specifies the height of the graph in inches. You can 
enter any positive number, using decimals for fractions. If you 
print the graph, the height should not exceed the height of the 
paper.

Legend specifies a legend to be associated with each data range in 
the graph. The command becomes Set Legend when you plot a 
data range. For each data range, this command creates a legend 
entry containing the pattern or symbol that represents the data 
range on the graph. You can enter explanatory text in a box to the 
right of the corresponding pattern or symbol. You can move and 
size these boxes.
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Chapter 4
Word Processing

Jazz Word Processing is an easy way to create 
letters, memos, reports, or any typed document. 
When you use Jazz Word Processing, you type just 
as you would on a standard typewriter. With Jazz 
Word Processing, however, you can edit the docu­
ment, rearrange it, or change its format quickly and 
easily. Jazz Word Processing can even replace a 
word or phrase automatically every time it occurs 
in the document. Jazz lets you enter text quickly, 
without worrying about format or accuracy, and 
arrange it or correct it later.



You control the format of text with rulers, which resemble the 
margin scale on a typewriter. Rulers control margin, tab, and para­
graph indentation settings. To change the format of text in the docu­
ment, you only need to change the ruler, not the text itself.

The ruler controls ----
paragraph indentation, 
margins, and tab 
settings.

The margin scale controls 
the format of text on a 
typewriter.

Jazz Word Processing also lets you change text alignment, such as 
from left-aligned to fully justified, and line spacing. You can also use 
different fonts, styles, and point sizes to vary parts of the text.
After you create a document and format it, you will probably want 
to print it. Printing a word processing document is similar to printing 
any other Jazz document. With word processing, however, you can 
include certain information in the document automatically, such as 
page numbers, headers and footers and the date and time.
One of the unique features of Jazz Word Processing is that you can 
include information from a Jazz worksheet or database, or an entire 
graph, using a HotView. HotViews let you create custom documents 
such as form letters, or documents that contain graphs or information 
from a worksheet or database. For example, to send a letter about 
your company’s sales to all employees, you can include the part of 
the worksheet that shows sales totals in the letter. You can then use 
Jazz to create a copy of the letter for each employee using names 
and addresses from an employee database. Jazz can also create mail­
ing labels using names and addresses from a database.
A HotView is dynamic: Jazz changes the word processing document 
automatically whenever you change any of the data in the database, 
worksheet, or graph you’ve included. If you don’t want the word 
processing document to change, you can freeze the HotView. A 
frozen view does not change even if its original source changes.



How to Enter and Change Text
Entering text with Jazz Word Processing is as easy as typing. When 
you type a character, Jazz inserts it in the document. You don’t 
even have to press Return at the end of a line: when you type 
beyond the right margin, Jazz automatically moves the current 
word to the next line.
Once you enter text, you can change it. Generally, you select the 
text and then perform a command on it. For example, you can 
move two lines of text to another area of the document, or copy 
several paragraphs to another word processing document. You can 
also emphasize text by choosing a different font, style, and 
character size for it.

Entering and 
Inserting Text

Entering text in a 
new document

To enter text in a new document, you type it at the insertion 
point, which appears as a blinking vertical bar on the first line.
You can also insert new text in existing text by positioning the 
insertion point and typing the new text. Jazz automatically read­
justs the text within the margins each time you add a character to 
an existing paragraph.

1. Create a new word processing document.
To create a new document, choose New... from the File menu and 
click the Word Processing icon. Then click New.

2 Type text without pressing Return.
When you type a character, it appears in the document at the 
insertion point, and Jazz moves the insertion point to the right of 
the new character.
When you type a word that extends beyond the right margin, Jazz 
moves the word and the insertion point to the beginning of the 
next line.

Processing

When you type a-----
character at the right 
margin. . .

Before
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3 Press Return at the end of the paragraph.
The insertion point moves to the beginning of the next line.
Always press Return to end a paragraph. This tells Jazz where one 
paragraph ends and the next one begins.

. . .Jazz moves the 
insertion point and 
current word to the 
next line.-------------

After
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Inserting text 1. Move the pointer to where you want to insert text.
The pointer appears as an I-beam in a word processing document.
If the text you want to change isn’t visible in the window, you can 
move around in the document using standard Macintosh features 
such as scroll arrows or scroll boxes. In addition, you can click a 
page box to move through the document one window at a time.

2. Click the location.
The insertion point moves to the new location.

3 Type new text.
Jazz readjusts the spacing in the paragraph.

Move the pointer to 
where you want to 
insert text.------------

Before
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As I promised in my last memo, I m passing along the 

figures from the "Five Decades of Jazz" sale we've been running 
all this quarter I think you'll agree that the figures look good, 

thosejartists
/

After

As I promised in my last memo, I'm passing along the 
figures from the "Five Decades of Jazz" sale we've been running 
all this quarter. I think you'll agree that the figures look good, 
--------------- ----  those three| artists
Spot during the sale.
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Click an insertion point 
and type the new text.

Keep in mind Keys with special functions. In Jazz Word Processing, the Tab 
and Shift keys function as they do on a typewriter. Press 
Backspace to delete a character to the left. Press Caps Lock once to 
make letters appear uppercase when you type them. Press Caps 
Lock again to make letters appear lowercase.

Selecting Text You must select text before you can perform a command on it, 
such as copying or moving. Selected text can be a single character, 
several sentences or paragraphs, or the entire document. When you 
select text, Jazz highlights it.

1. Drag the pointer from the beginning of the text you want to 
select to the end.
You can drag the pointer up, down, to the left, or to the right. 
Jazz highlights the entire block of text from its beginning to the 
current pointer position.
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To extend the selection to include text that is outside the window, 
drag the pointer across the scroll bar onto the desktop. Jazz auto­
matically scrolls the document and the highlight in the direction of 
the pointer. Move the pointer back into the document to stop the 
scrolling.

2. Release the mouse button.
Jazz highlights the selected text. You can now perform a command 
on it.

To select text, you can 
drag horizontally...

Before

or vertically.

After

Processing

Keep in mind Expanding and shrinking the selection. To expand a text
selection, hold down the Shift key and click a location outside the 
selection. To shrink a selection, hold down the Shift key and click 
a location inside the selection.
Selecting a word. Double-click anywhere in a word to select it.
Selecting the entire document. To select the entire document, 
choose Select All from the Edit menu.

Deleting Text

Deleting one 
character at a time

You can delete one character or an entire block of text from a 
word processing document. When you delete text, Jazz automati­
cally readjusts the spacing of the surrounding text.

1. Click the location to the right of the character you want to 
delete.
The insertion point, a blinking vertical bar, disappears at its previ­
ous location and appears at the location you clicked.
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2 Press Backspace.
The character to the left of the insertion point disappears.
Continue to press Backspace to delete more characters. You can 
also insert characters or move the insertion point to a new 
location.

Before

Click to the right of the 
character you want to 
delete.

After

Press Backspace.

1. Select the text you want to delete.Deleting a block 
of text 2. Choose Clear from the Edit menu.

Jazz removes the selected text and readjusts the spacing in the 
document. Jazz does not place the deleted text on the Clipboard.

Before

Select the text you 
want to delete.

As I promised in my last memo. I'm passing along the 
figures from the "Five Decadesoflazz^sale we've been running 

particularly for those thr^e artists who appeared at the Jazz 
Spot during the sale.
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Choose Clear from the 
Edit menu.

After



Keep in mind

-« Moving and
Copying Text

Other methods of deleting text. Select the text you want to 
delete and press Backspace. The selected text disappears. This is 
like choosing Clear from the Edit menu.
You can also select the text you want to delete and type any 
character. The selected text disappears and the character you type 
appears at the insertion point.
Cutting and pasting. To remove text in order to paste it in 
another location, select the text and choose Cut from the Edit 
menu instead of Clear. This places the text on the Clipboard. You 
can then paste the text in a new location.

You move text by cutting it and then pasting it in a new location. 
This lets you reorganize your document. When you move text, it 
disappears from the original location and appears in a new one.
Copying text lets you use the same text in different places without 
retyping it. When you copy text, it remains in the original location 
and appears in the new one.
You can move or copy text within the same document or to any 
other Jazz document.

1. Select the text you want to move or copy.
2. Choose Cut or Copy from the Edit menu.

Choose Cut to remove the text you selected from the document 
and place it on the Clipboard. Choose Copy to copy the text onto 
the Clipboard.

3. Click the location where you want the text to appear.
To move or copy text to another document, open the other docu­
ment and then click the location where you want to paste the text.
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4. Choose Paste from the Edit menu.
Jazz moves or copies the text from the Clipboard to the new loca­
tion and readjusts the spacing in both locations.
You can repeat steps 3 and 4 to paste this text in other locations 
until you place new text on the Clipboard.

Select the text you want 
to move or copy.

When you cut and paste, 
Jazz moves the text to 
the new location.

When you copy and-----
paste, Jazz copies the 
text to the new location.

Keep in mind

Before

After

After

Including a picture from the Clipboard. You can paste 
pictures from the Clipboard or Macintosh Scrapbook into a word 
processing document. Place the pictures on the Clipboard or 
Scrapbook using the Cut or Copy command in other Macintosh 
programs (such as MacPaint) before you open Jazz. Then paste the 
picture in the word processing document. You can adjust, cut, 
copy, clear, or paste the picture after you paste it in the word 
processing document.
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Finding Text You can locate a word or phrase you entered in a document easily 
with Jazz. This lets you find the place in a document that contains 
a particular phrase, for example, or find all the occurrences of a 
word.
When Jazz searches for a word or phrase, it ignores capitalization, 
accents, fonts, point sizes, and styles.

1. Click the location in the document where you want to begin 
searching.

2. Choose Find... from the Search menu.
The Find window appears. You can move and close this window 
or make it active, just like any other window.

3. Reposition the windows, if necessary.
Move the document and Find windows and adjust the document 
window size so that you can see the contents of both windows. 
This lets you see the document automatically when Jazz finds a 
word or phrase. If you do not do this, you may have to click the 
document window to see the word or phrase that Jazz finds.

4. Type the characters you want to find in the space provided.
You can type any word or phrase, including spaces, up to the 
length of the space provided.

5. Click Forward or Backward.
Click Forward to search forward from the insertion point. Click 
Backward to search backward from the insertion point.

6. Click Partial Word or Whole Word.
Click Partial Word to find the characters either as complete words 
or as parts of words. For example, if you type the and click Partial 
Word, Jazz finds the words the, there, other, and so on.
Click Whole Word to find the characters only as a complete word 
or words. For example, if you type the and click Whole Word, 
Jazz finds only the word the.

7. Click a Find option.
If you are searching forward, click Find Next to find and select the 
next occurrence of the word or phrase after the insertion point. 
Click Find First to find and select the first occurrence of the word 
or phrase in the document.
If you are searching backward, click Find Prev to find and select 
the occurrence of the phrase before the insertion point. Click Find 
Last to find and select the last occurrence of the phrase in the 
document.
Jazz displays an alert message if it cannot find the word or phrase. 
Click OK to return to the Find window.
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Currently selected text

Find Newt^
J [Find First ] ® Partial lilord O LUhole Ilford

as 1 promised in my last memo. I'm passing along the 
figures from the Five Became,-. . 11HB' sale we've been r 
all this quarter I think you'll agree that the figures look 

ppeared at th [jazz] 
during the sale

When you click----------
Find Next, Jazz selects 
the next occurrence of 
the text.

Keep in mind

8. Click Find Next or Find Prev to find other occurrences of 
the text, if necessary.

9- Close the Find window.
You can now choose Find Next from the Search menu to find and 
select the next occurrence of the text.
You can also keep the Find window open on the desktop. This lets 
you switch between entering text in the document window and 
finding text using the Find window. To return to the word 
processing document, click it to make it active.

Finding another word or phrase. The text you enter in the 
Find window remains there until you leave the current Jazz session 
or change the text. Changing the text in the Find box of the 
Replace window also changes the text in the Find box in the Find 
window. To search for a different word or phrase, select the text 
and type a new word or phrase. You can also edit the text by 
clicking the location you want to change and inserting or deleting 
characters.

Replacing
Text

Jazz lets you replace a word or phrase in a document with another 
word or phrase. You can replace all the occurrences of the word 
automatically, or only some. For example, you may want to 
replace a word that you misspelled or used incorrectly. You may 
also want to replace words or phrases to adapt a document for a 
new purpose.
When Jazz searches for a word or phrase, it ignores capitalization, 
accents, fonts, point sizes, and styles.
Both the word or phrase that you want to replace and the new 
word or phrase can be as long as the space provided. When you 
replace a word or phrase, Jazz automatically adjusts the spacing in 
the document.
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1. Click the location in the document where you want the 
search to begin.

2 Choose Replace... from the Search menu.
Jazz opens the Replace window. You can move and close this win­
dow just like any other window. If the Replace window is open 
when you’re working in another window, click the Replace 
window to make it active.

3 Reposition the windows, if necessary.
Move the document and Replace windows and adjust the size of 
the document window so that you can see the contents of both 
windows. This lets you see the document when Jazz finds a word 
or phrase. If you do not do this, you may have to click the docu­
ment window to see the word or phrase that Jazz finds.

4. Type the characters you want to replace in the Find box.
5 Type the new characters in the Change to box.
6 Click Forward or Backward.

Click Forward to search forward from the insertion point. Click 
Backward to search backward from the insertion point.

7. Click Partial Word or Whole Word.
Click Partial Word to replace the characters either as complete 
words or as parts of words. For example, if you type the and click 
Partial Word, Jazz finds and replaces the characters in the words 
the, there, other, and so on.
Click Whole Word to replace the characters only as a complete 
word or words. For example, if you type the and click Whole 
Word, Jazz finds and replaces only the word the.

8. Click a Find option.
If you are searching forward, click Find Next to find and select the 
next occurrence of the word or phrase after the insertion point. 
Click Find First to find and select the first occurrence of the word 
or phrase in the document.
If you are searching backward, click Find Prev to find and select 
the occurrence of the word or phrase before the insertion point. 
Click Find Last to find and select the last occurrence of the word 
or phrase in the document.
Jazz displays an alert message if it cannot find the characters. Click 
OK to return to the Replace window.

9- Click a Change option.
• Click Change, then Find to replace the current phrase with the 

new phrase. Jazz finds and selects the next occurrence of the 
phrase.

• Click Change to replace the current phrase with the new phrase. 
Jazz selects the new phrase.

• Click Change All to replace all occurrences of the phrase in the 
document. An alert message warns that you cannot undo this 
command. Click OK to replace all occurrences of the phrase 
with the new phrase.
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Before

Sales Memo

When you click
Change . . .

As I promised in my last memo, I'm passing along the 
figures from the "Five Decades of Jazz" sale we've been running 
all this quarter. I think you'll agree that the figures look, good, 
particularly for those artists who appeared at thelHS Spot 
during the sale.

irii Replace

Find: Jazz

EntertainmentChange to:

[ Find —[ Change, then fintb]—[ Change j [~cl

[Find First ] ® Forward O Backward

© Partial Word O Whole Word

After

I Sales Memo

. . , Jazz replaces the 
selected text with the 
new text.

As I promised in my last memo, I m passing along the |HM|
figures from the "Five Decades of Jazz" sale we've been running HH|
all this quarter. I think you'll agree that the figures look good, 
pa^^larlyfor those artists who appeared at the

Find: | Jazz
.... .... -.... ' =

Change to: [Entertainment

[Find Next] [ Change, then Find ] [ Change^ [Change fill] , 

[Find First ] ©Forward O Backward

© Partial Word O Whole Word

Keep in mind

10. Continue to find and replace characters using the above 
steps, if necessary.

11. Close the Replace window.
You can continue to find and select the text in the Find box by 
choosing Find Next from the Search menu.
You can also keep the Replace window open on the desktop. This 
lets you switch between entering text in the document window 
and replacing text using the Replace window. To return to the 
word processing document, click it to make it active.

Deleting a word or phrase. To delete every occurrence of a 
word or phrase from the document, enter the word or phrase 
in the Find box. Leave the Change to box blank, and click 
Change All.
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Changing the text. The text you enter in the Replace window 
remains there until you leave the current Jazz session or change the 
text. Changing the text in the Find box of the Find window also 
changes the text in the Find box in the Replace window. To use a 
different word or phrase in the Find or the Change to box, select 
the text in the box and type a new word or phrase. You can also 
edit the text by clicking the location you want to change and 
inserting or deleting characters.
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How to Format a Document
Jazz Word Processing lets you control a document’s format by set­
ting margins, tabs, line spacing, and text justification. You can also 
indent the first line of paragraphs, start a new page, create headers 
and footers, and set page numbers. To format a document, you use 
the rulers in the document and the icons in the console.

Tab icons-----------
Alignment icons
Line Space icons -

Console ——------

Ruler

Margin marker
Indentation marker

Inserting a 
Ruler

Keep in mind

At the top of each new word processing document is a ruler that 
contains default format settings. The console for the document also 
contains default format settings. You can set a different format by 
changing the settings on the ruler and in the console. You can also 
insert other rulers to create different formats in different parts of a 
document.
You can insert a ruler at any point in a document. A ruler affects 
all the text that follows it, up to the next ruler. If the document 
doesn’t have any more rulers, the ruler affects the remainder of the 
document.
Rulers never appear when you print a document.

1 Click the location where you want to insert the ruler.
2. Choose Insert Ruler from the Format menu.

Jazz moves the insertion point and anything that follows it below 
the ruler. The inserted ruler is a copy of the preceding ruler.

Hiding rulers. Hiding all rulers in a document lets you see more 
of the document at one time. To hide the rulers, choose Hide 
Rulers from the Format menu. After you hide rulers, the command 
changes to Show Rulers. Rulers control the format of the 
document even if they do not appear on the screen.
Deleting rulers. To delete a ruler from a document, click the top 
half of the ruler and choose Cut or Clear from the Edit menu.
Copying rulers. To insert a new ruler with the same settings as 
those on an existing ruler, copy the existing ruler and paste it 
where you want to insert the new ruler. Click the top half of the 
ruler you want to copy, choose Copy from the Edit menu, click 
the location where you want to place the new ruler, and choose 
Paste from the Edit menu.
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Setting
Margins, Tabs, 
and Paragraph 
Indentation

n

1

1

1

Setting margins

Setting tabs

Tabs--------
Decimal tab

A ruler lets you set the margins and tabs for text and the indenta­
tion for the first line of paragraphs. Margin settings control the 
width of your text. Tabs are useful in aligning tables. With the 
paragraph indentation marker, you control where the first line of 
each paragraph begins: at the margin, to the left of the margin, or 
to the right of the margin.

The margins you set on a ruler determine how close to the left and 
right edges of the paper Jazz prints the text. Jazz sets the margin 
markers at 1 inch and 7 1/2 inches on the default ruler, leaving 
1-inch left and right margins on letter-size (8X 11 inch) paper. 
Depending on the size of the window, however, the full margins 
may not appear on your screen.

1. Click the text you want to set margins for.
Click anywhere under the ruler that controls the text.

2. Drag the left and right margin markers on the ruler to 
where you want to set the margins.
You can’t place a margin marker on a tab marker, but you can 
place it on the indentation marker.

You set tabs by placing tab markers on the ruler. You can also 
drag the tab markers that are already on the ruler to change the 
position of existing tabs. Once you set tabs, Jazz moves the 
insertion point to the next tab marker every time you press the 
Tab key.
Tabs are especially useful for creating tables. Adding or deleting 
text at one tab doesn’t disturb text at the next tab, as long as the 
changes you make don’t extend into the next column.
You can right-align text or align numbers at the decimal point by 
placing a decimal tab marker on the ruler. Decimal tabs are useful 
in tables that contain columns of numbers with decimals.

1. Click the Tab or Decimal Tab icon in the console.
2. Click the location on the ruler where you want to place a 

tab stop or decimal tab.

0, 1 , I , 1 . 11. 1 . 1 . , . 12. , . | , . 13. i . 1 . . . 14. . . 1 . , . 15, , , 1 , . 16, , ,

___________
A

Artist Title /Price

Corea and Guida The Meeting (Philips) 7,99
Monk., Thelonius Underground (Columbia) 6.99
Ellington, Duke Ellington Indigoes (Columbia) 6.99
Goodman, Benny Together Again (RCA) 6.99
Gillespie, Dizzy At Salle Pleyel '46 (Prestige) 7,99
Jarrett, Keith Sun Bear Concerts (ECM-10 recs.) 69.99

To delete a tab, click the Tab or Decimal Tab icon and then click 
the tab marker on the ruler.
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Setting paragraph 
indentation

1

The indentation marker sets the position of the first character in a 
paragraph. When you press the Return key to signal the beginning 
of a new paragraph, Jazz indents the next character you type to the 
position of the indentation marker.

1 Click under the ruler that contains the indentation marker 
you want to set.

2 Drag the indentation marker to where you want to indent a 
paragraph.
You can place the indentation marker on the margin marker or to 
the right or left of the left margin marker. For example, place it to 
the left of the left margin marker to number a series of paragraphs 
that are left-aligned.

i .......... . - .... ........-

■ 0. 1 , 1 . , , 11, 1 , I , , . 12, , , | , |3, , , | , |4, , , 1 . , , |5, , . | , 16, , . 1 . 0
i X A A fl

1

•T-.

1. Coordinating our weekly specials with the performers at
The Jazz Spot was a stroke of genius After each
performance, we sold out of many sale items.

2. Advertising in the Weekly Calendar section of the 
newspaper paid off, too. By placing our ads near the Jazz

Keep in mind

Justifying 
Text

Indenting a block of text. To indent a block of text, insert a 
new ruler and move the margin and indentation markers to set the 
indented margin. To return to the format you used before the 
indented block of text, insert a copy of the ruler that has the 
format settings you want to use.

Justification is the position of text in relation to the margins. You 
can justify, or align, text with the left or right margins, or with 
both margins. You can also center text between the left and right 
margins. In a new document, the default is left justification. You 
align text with an Alignment icon in the console. The Alignment 
icon you choose affects only the text between the active ruler and 
the following ruler.

1. Click the text you want to justify.
Click anywhere below the ruler that controls the text.

2. Click an Alignment icon in the console.
• Click the Right icon to align text with the right margin.
• Click the Full Justification icon to align text evenly with both 

margins. Jazz justifies all lines in a paragraph except the last one. 
Full justification does not change the last line in a paragraph or 
text you positioned with a tab.

• Click the Center icon to center text between margins.
• Click the Left icon to align text with the left margin.
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Keep in mind

Setting Line 
Spacing

E
H

Keep in mind

Inserting Page 
Breaks

Keep in mind

Using more than one justification setting. To use different 
justification settings in the same document, insert a ruler where 
you want to change the justification. The new ruler is a copy of 
the preceding ruler. Click an Alignment icon. The new justification 
setting affects all text you enter below the ruler until you insert 
another ruler and change the setting.

Line spacing is the amount of space between lines of text in a 
document. You can choose single, 1.5, or double spacing. In a 
new document, the default is single spacing. The line spacing you 
choose affects only the text between the active ruler and the 
following ruler.

1 Click the text where you want to change the line spacing. 
Click anywhere below the ruler that controls the text you want to 
change.

2. Click a Line Space icon in the console.
• Click the Single Space icon to put no blank lines between each 

line of text.
• Click the 1.5 Space icon to put half a blank line between each 

line of text.
• Click the Double Space icon to put one blank line between each 

line of text.

Varying the line spacing. To use different line spacings in vari­
ous parts of a document, insert a new ruler. The new ruler is a 
copy of the preceding ruler. Click a Line Space icon. The new line 
spacing affects all text between this ruler and the next ruler.

A page break tells Jazz to start a new page when it is printing a 
document. Jazz automatically inserts page breaks when you fill a 
page. These page breaks appear as a dotted line across the docu­
ment. You can also insert a page break as you are typing a docu­
ment or in text you typed previously. You do so if you want Jazz 
to start a new page when it is printing the document, even if the 
previous page is not full. A page break you insert appears as a solid 
line across the document.
Page break lines are always visible in the window, but Jazz does 
not print them when you print the document.

1. Click the location where you want to begin a new page.
2. Choose Insert Page Break from the Format menu.

Removing page breaks. To remove a page break, move the 
insertion point to the beginning of the line following the page 
break and press Backspace once.
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Creating 
Headers and
Footers

A header is text that appears at the top of every page of a docu­
ment but the first page. A footer is text that appears at the bottom 
of each page of a document. Headers and footers can include such 
things as chapter titles, pictures, page numbers, and the date and 
time. A header or footer can be as long as 1/4 of a page.
You create a header or footer in a Header and Footer window. Jazz 
displays a header or footer in the active document and prints it 
when you print the document.

The text you type in the 
Header window . . .

...appears at the top of 
each document page 
except the first.

1. Choose Header... or Footer... from the Format menu.
If you are creating a new header or footer, a blank Header or 
Footer window appears. If you have already created a header or 
footer for this document, the window contains the existing header 
or footer.

2. Move the insertion point to the location where you want to 
enter information.
Use the pointer, the Return and Tab keys, and the space bar to 
position the insertion point.

3 Type new text, or paste text or a picture from the Clipboard 
into the Header or Footer window.
Use the ruler and the icons in the console as you would in the 
document itself to set margins, tabs, indentation, text alignment, and 
line spacing. You can use more than one font, style, and point size 
for text you type in a header or footer.
To insert the date, time, or page number, choose Date, Time, or 
Page from the HotView menu. Jazz continuously updates the date, 
time, and page number unless you freeze them. See Freezing a 
HotView later in this chapter for information on freezing the date, 
time, and page number.

4. Click the close box in the Header or Footer window to close 
the window and display the header or footer in the 
document.
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Keep in mind

Setting the
First Page 
Number

Clearing a header or footer. If you create a header or footer and 
then decide you don’t want to use it, you can clear the Header or 
Footer window. Click the Header or Footer window to make it 
active, choose Select All from the Edit menu, and then choose Clear 
from the Edit menu.

Setting the first page number lets you change the page number Jazz 
assigns to the first page of a document. If you don't change the first 
page number, Jazz starts numbering at 1.

1 Choose Set First Page # from the Format menu.
2. Type a number for the first page of the document in the 

dialog box.
3. Click OK.

Jazz numbers the first page of the document with the number you 
typed and numbers all following pages sequentially.
To see page numbers on the screen and to include them when you 
print the document, you need to place the page number in the 
document by choosing Page from the HotView menu.

Processing
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How to Include Other
Jazz Documents in 
a Word Processing Document
Jazz Word Processing lets you incorporate dynamic pictures of 
graphs or of parts of databases and worksheets in a word processing 
document. These pictures are called HotViews. When you include a 
HotView, the word processing document automatically reflects any 
changes you make in the original document. For example, if you 
include sales figures from a worksheet in a word processing docu­
ment, Jazz reflects any change you make to the worksheet figures in 
the word processing document as well.
In addition to HotViews of worksheets, graphs, and databases, Jazz 
can also include HotViews of the current date, time, or page 
number. Whenever the date, time, or page number changes, the 
HotView changes too.
You can break the link between the HotView and the original docu­
ment by freezing the HotView. After you freeze a HotView, it no 
longer reflects any changes you make in the original document.
Jazz also lets you create word processing documents, such as form 
letters or customized reports, that contain information that varies 
from one copy of the document to the next. For example, you can 
customize the same letter for several people. Jazz can automatically 
insert a different name, address, and salutation in each letter and 
print each one as if you had typed it individually. Using the same 
technique, you can also print mailing labels.
Incorporating information from other documents requires familiar­
ity with the Worksheet, Database, and Graphics applications. Read 
about these applications before you begin this section.
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Including
HotViews of
Other 
Documents

HotViews of other Jazz documents can appear anywhere in a word 
processing document. HotViews can be entire graphs, ranges from 
worksheets, or areas from databases. Unless you freeze a HotView, it 
is linked to the original document. When you change the original 
document, Jazz changes the HotView, too.

- ------------- • - — Sales Rivards ■ - --------
To: Dean LaVoie Date: January 3, 1965 ■vr
From: Randy Black th
Subject: Sales Award

The commission repi'rts are in u can see, .Adam,
Sarah, and Ben are again over >en percent.

Last Name First Name Sales($) Percentage

Moser Adam $4,355 10%
Gottleib Sarah $3 467 12%
Maher Benjamin $5 470 10%

Since this is the thirc consecut.: ve month they have done
this; I suggest we gi\ award Doug

1. Open the document that contains the data you want to 
include in the HotView.
To open a document, choose Open... from the File menu. If the 
document is already open, click it to make it active.

2. Select the data you want to include.
To include a graph, click anywhere on the graph. Jazz includes the 
entire graph, including graph enhancements such as titles, labels, 
notations, legends, and grids. To include data from a worksheet or 
database, select the range or area you want to include.

3. Open an existing word processing document or create a 
new one.
If the word processing document is already open, click it to make 
it active.

4. Click the location where you want to insert the HotView.
5. Choose Include from the HotView menu.

Jazz inserts the HotView after the insertion point.
If the HotView is from a worksheet or database, Jazz displays the 
grid lines as long as they appear in the worksheet or database 
window. If you do not want the grid lines to appear, hide them in 
the worksheet or database. You can hide the grid lines before or 
after you include the HotView.
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Keep in mind Adjusting a HotView. To move the HotView from side to side, 
click it. Jazz draws a box around it. Position the pointer on the 
border of the box and drag it to the right or left.
You cannot edit text in a HotView from a worksheet or database 
unless you freeze it. You cannot edit text in a graph.
To change the size of a HotView, drag the size box in the lower 
right corner of the box just as you drag the size box of a Jazz 
window.
To cancel the selection of a HotView, click above or below 
the HotView.
Cutting, copying, and clearing a HotView. To cut, copy, or 
clear a HotView, double-click the HotView and choose Cut, Copy, 
or Clear from the Edit menu.
If you cut or copied the HotView, you can paste it in another part 
of the word processing document. Click the location where you 
want to place the HotView and choose Paste from the Edit menu. 
Jazz places a copy of the HotView at the insertion point. The 
HotView still reflects any changes you make in the document to 
which it is linked.

Freezing a
HotView

Freezing a HotView breaks the link between the HotView and the 
original document. After you freeze a HotView, it no longer 
reflects changes you make in the original document, and you can 
edit it in the word processing document.

1. Click the HotView you want to freeze.
Jazz draws a box around it.
If you want to freeze all the HotViews in the document, skip 
this step.

2. Choose Freeze or Freeze All from the HotView menu.
Freeze freezes only the active HotView. Freeze All freezes all the 
HotViews in the document. The HotView is no longer linked to 
the original document.
If the HotView is from a worksheet or database, Jazz makes the 
data conform to the tab settings in the ruler directly above it. The 
grid no longer appears with the worksheet or database data.

Keep in mind Editing a frozen HotView. Once you freeze a HotView, you can 
work with it just as you work with any text you type in the word 
processing document. That is, you can edit it or change its font 
and style, unless it is a graph. You cannot edit a frozen HotView of 
a graph, but you can cut, copy, clear, and paste it.



Inserting the
Date, Time, 
and Page 
Number

Keep in mind

Jazz can insert a HotView of the current date or time anywhere in a 
document. As the actual date and time change, Jazz changes the date 
and time in the word processing document. For example, you can 
use a HotView of the date and time in a form letter that you send at 
different times of the year.
Jazz can also insert a HotView of the current page number any­
where in a document, including a header or footer. You can use a 
HotView of the current page number in a header or footer to print 
the correct page number automatically on each page of a document.

1. Click the location where you want to insert the date, time, 
or page number.
To place a page number in a header or footer, first choose 
Header... or Footer... from the Format menu. Use the pointer, the 
Return and Tab keys, and the space bar to position the insertion 
point where you want the date, time, or page number to appear.

2. Choose Date, Time, or Page number from the HotView 
menu.
Jazz inserts the date, time, or page at the insertion point.

Setting the time and date. You set the date or time in your 
Macintosh’s memory with the Alarm clock on the Macintosh 
Control Panel desk accessory. For information, see Macintosh, the 
owner’s guide.

Creating and 
Printing Form 
Letters

Jazz lets you create documents in which most of the text remains 
the same from copy to copy, while some of the information 
changes. In a form letter, for example, the text of the letter is the 
same but the name, address, and salutation change from letter to 
letter. The items that change are merged fields.
You can include field values from a database, such as names and 
addresses, or cell entries from a worksheet, such as monthly sales or 
commissions, as merged fields. You can also combine merged fields 
from several databases and worksheets in the same document.

Jazz lets you use 
information from a 
worksheet or 
database. . .-------

■I Adami Moser
12 1 First St
Framingham, MA 02 167

.. .as merge fields in a 
word processing 
document.

mple Form Letter
................. ........ ................ 1 ' 1 ‘

January 3, 19S5

-Pearl Adarn,|

The monthly sales figures are final. Based on your 
commission rot"- "/our le | Keep up the
good work I
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To create a document such as a form letter, you specify the work­
sheet cells or database fields that contain the merged field values 
and the location in the document where the merged fields should 
go. If you are using values from a database, you must select the 
records you want to use in the merged fields before you print the 
document.
Each time Jazz prints a copy of the document, it replaces the 
merged field with the contents of the next selected cell in the data­
base or worksheet range. Jazz prints a copy of the document for 
each record or cell in the selection.

Using a worksheet 
range

1. Open the worksheet that contains the entries you want to 
use in the merged fields.
Open an existing document by choosing Open... from the File 
menu. To create a new worksheet, choose New... from the File 
menu. If the worksheet is already open, click it to make it active.

2. Select the range that contains the entries you want to use.
3. Open an existing word processing document or create a 

new one.
If the word processing document is already open, click it to make it 
active.

4. Click the location where you want the worksheet entries to 
appear.

5. Choose Merge Field from the HotView menu.
Jazz inserts the contents of the first selected cell at the insertion 
point in the document and adjusts the spacing in the document 
according to the size of the entry.

6. Continue to type text until you come to the next point 
where you want to include a merged field.

7. Repeat steps 1 through 5 for each merged field you want to 
insert.

8. Choose Print Merge... from the File menu.
Jazz displays the same dialog box that appears if you choose Print 
Document.... Specify the settings as you would for any Jazz docu­
ment. Jazz prints copies of the document until it uses all the entries 
in the worksheet range.

Using database 
values

1. Open the database that contains the values you want to use 
in the merged fields.
To open an existing document, choose Open... from the File 
menu. To create a new document, choose New... from the File 
menu. If the document is already open, click it to make it active.

2. Select the field that contains the values you want to use.
To select an entire field, click the field name.

3. Open an existing word processing document or create a 
new one.
If the word processing document is already open, click it to make 
it active.
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Keep in mind

4. Click the location where you want the values from the 
database to appear.

5. Choose Merge Field from the HotView menu.
Jazz inserts the first field value from the selected field and adjusts the 
spacing to fit the merged field.

6. Continue to type text until you come to the next point where 
you want to use a merged field, and repeat steps 1 through 5 
for each merged field.

7. Click the database and select the records that contain the 
values you want to use.
You can select records by clicking, dragging, clicking while holding 
the Option key, or using a query. To select all the records, choose 
Select All from the Edit menu. Jazz uses only the values from the 
records you select in the merged fields.

8. Click the word processing document.
9. Choose Print Merge... from the File menu.

Jazz displays the same dialog box that appears if you choose Print 
Document.... Specify the settings as you would for any Jazz docu­
ment. Jazz prints copies of the document until it uses all the field 
values in the selected records.

Using unequal selections. You can include merged fields from 
fields or ranges from different documents. If one of the selections is 
larger than the other, Jazz repeatedly uses the last value in the smaller 
selection until it uses all the values in the larger selection. If the 
smaller selection consists of only one cell, Jazz uses the value in the 
cell in every copy of the document. For example, you can include 
address fields from a database and commissions from a worksheet. If 
you select more addresses than commissions, Jazz repeatedly prints 
the contents of the last cell in the range of commissions until it uses 
all the values in the group of addresses.
Adding spaces and punctuation. You must add punctuation and 
spaces between merged fields and other text within the document by 
typing the punctuation or space before or after the merged field. For 
example, if you want a comma between city and state, type it after 
you place a merged field for the city.
Editing a merged field. You cannot edit a merged field in a word 
processing document unless you freeze it. See Freezing a HotView 
earlier in this chapter. You can edit the value in the original work­
sheet or database. You can cut, copy, clear, or paste a merged field 
just as you would any other text in the word processing document.
Viewing field names. To see the names of the database fields in a 
word processing document instead of the merged fields, choose 
Show Definitions from the HotView menu. Choose Show Values to 
see the merged fields again.
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Printing
Mailing Labels

Setting up mailing 
labels

To create mailing labels, you use data from a database in a word 
processing document. Mailing labels are like other documents, such 
as form letters, that contain merged fields, or information that 
changes from one copy of the document to the next.
Jazz can print labels in three sizes: 3 1/2 by 15/16 inch. 3 by 5 
inch, and on a 9 1/2 by 4 1/8 inch envelope (#10). Before you 
begin, be sure you have mailing labels of the correct size in the 
printer. Jazz prints mailing labels in single columns only.

1 Open the database that contains the values you want to use 
to print mailing labels.
To open an existing database, choose Open... from the File menu. 
To create a new database, choose New from the File menu. If the 
database is already open, click it to make it active.

2. Select the field you want to use in the mailing label.
Click the field name to select the entire field. When you create mail­
ing labels, the first field is typically one that contains first names, or 
titles such as Ms. or Dr. Subsequent fields may include last name, 
address, city, state, zip or postal code, and country (if necessary).

3 Open an existing word processing document or create a 
new one.

4. Click the location where you want to include the selected 
field value from the database.
If you are printing business envelopes or large labels, adjust the left 
margin.

5 Choose Merge Field from the HotView menu.
Jazz inserts the first field value at the insertion point.

Jazz inserts the first field 
value in the selected field 
in the word processing 
document.

Address
13 St. Botol.
69 Harvar 
g Trowbri"

i 5
3i 2 Gotti eib

—

Database

6. Type a space, a punctuation mark, or press Return if 
necessary.
Jazz does not include spaces between merged fields automatically. 
You must add spaces, commas, and other punctuation. You must 
also press Return to begin a new line.

7 Repeat steps 1 through 6 until you have created a complete 
mailing label.
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"I Printing mailing 
labels

1 Open the database that contains the information you want to 
use in the mailing labels.

2 Select the records you want to use when you print labels.
You can select records by clicking or dragging, or by using a 
query.

3 Open the word processing document that contains the labels.
4. Choose Page Setup... from the File menu.
5 Click the label option you want.

• Click Small Label to print 3 1/2 by 15/16 inch mailing labels.
• Click Corporate Label to print 3 by 5 inch mailing labels.
• Click Business Envelope to print 9 1/2 by 4 1/8 inch mailing 

labels.
6 Click No breaks between pages.
7 Click OK.

A dotted line appears in the word processing document to mark 
the bottom of the label size you selected.

8. Choose Print Merge... from the File menu.
Jazz displays the same dialog box that appears if you choose Print 
Document. . . Specify the settings as you would for any Jazz docu­
ment. If you are printing business envelopes or separate labels, 
click Cut Sheet on the dialog box.

9 Click OK.
Jazz prints a mailing label for each selected record in the database. 
Click Pause to stop the printing operation temporarily, then click 
Continue to resume printing. Click Cancel to cancel the printing 
operation before it is completed.

W
ord

Processing

When you print the 
mailing labels, Jazz 
substitutes new field 
values in each label.

Keep in mind

• Jordan Nollman
— 899 Cherry
« Natick, MA 021 87

• Heather MacAdam 
53 St. Botolph

• Boston, MA 022 15

• Adam Moser 
'"122 1 First St.
• Framingham, MA 02167

Checking label alignment. Before you print all the mailing labels, 
choose Print Document... from the File menu. Jazz prints the first 
mailing label. Adjust the alignment of the labels, if necessary, and 
print the first label again until it is properly aligned.
Viewing field names. To see the names of the database fields in 
the word processing document instead of the merged fields, 
choose Show Definitions from the HotView menu. Choose Show 
Values to see the merged fields again.
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The Word 
Processing 
Screen

L

Line Space icons

Full Justification icon

Tab iconRight icon

Double Space icon

Menu bar

Console

Alignment icons

Tab marker

Center 
icon

Indentation 
marker

Left margin 
marker

Decimal tab 
marker

Single Space icon
1.5 Space icon

Left icon

Decimal Tab icon

Alx Employees

E: December 20
JECT: End of Year Bonuses

t file Edi at Search HotUieui
Annual Sales:A3..D 1 0

Memo

As the following sales figures illustrate, this has been anotB 

year for the company. I want to congratulate each of you for contribu 
the outstanding success we have enjoyed this past year. In recogijj| 
individual efforts, the stockholders voted last week to allocate a perc



Reference box

Ruler

^Style

Right 
margin 
marker

The Word Processing Reference
Menu bar displays the titles of all Word Processing menus.
Console includes document formatting controls and the reference 
box.
Reference box displays the name of the source document for a 
selected HotView.
Ruler sets the margins, indentation, and the tabs that affect all 
text that follows the ruler, up to the next ruler. Clicking the top 
half of the ruler selects the ruler so you can clear, cut, or copy it. 
When rulers appear in a document, you can hide them using the 
Hide Rulers command from the Format menu.
Decimal Tab icon lets you add and erase decimal tabs. Clicking 
the Decimal Tab icon selects and deselects it. When the Decimal 
Tab icon is selected, clicking the ruler sets a decimal tab. Clicking 
an existing decimal tab deletes it from the ruler.
Tab icon lets you add and erase regular tabs. Clicking the Tab 
icon selects and deselects it. When the Tab icon is selected, click­
ing the ruler sets a tab. Clicking an existing tab deletes it from the 
ruler. When the Tab icon is not selected, you can drag tabs along 
the ruler.
Alignment icons control the alignment of text in your document 
and indicate which type of alignment affects text at the insertion 
point. Clicking one of these icons affects text between two con­
secutive rulers in your document. As you click in different parts of 
your document, the Alignment icon affecting text at that location is 
highlighted. There are Alignment icons for left, right, center, and 
full alignment.
Full Justification icon aligns text evenly between both margins. 
Click a location in your document and then click this icon to fully 
align the text under the ruler.
Center icon centers text between the margins. Click a location in 
your document and then click this icon to center the text under 
the ruler.
Right icon aligns text at the right margin. Click a location in your 
document and then click this icon to right-align the text under the 
ruler.
Left icon aligns text at the left margin. Click a location in your 
document and then click this icon to left-align the text under the 
ruler.
Line Space icons control the line spacing of text in your docu­
ment and indicate which type of line spacing affects text at the 
insertion point. Clicking one of these icons affects text between 
two consecutive rulers in your document. As you click in different 
parts of your document, the Line Space icon affecting text at that 
location is highlighted. There are Line Space icons for single­
spacing, 1.5, and double-spacing.

W
ord

Processing
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Double Space icon selects double-spacing for text. Click a loca­
tion in your document and then click this icon to double-space the 
text under the ruler.
1.5 Space icon selects one-and-a-half spacing for text. Click a 
location in your document and then click this icon for 1.5 line 
spacing under the ruler.
Single Space icon selects single-spacing for text. Click a location 
in your document and then click this icon to single-space the text 
under the ruler.
Left margin marker sets the left margin. Drag the marker along 
the ruler to set the left margin.
Indentation marker sets the position of the first line in a para­
graph, or each line in a list. Drag the marker along the ruler to set 
the indentation.
Decimal tab marker aligns numbers at the decimal point when 
you press the Tab key. Drag the marker along the ruler to set a 
decimal tab.
Tab marker left-aligns text at the tab marker when you press the 
Tab key. Drag the marker along the ruler to set a tab.
Right margin marker sets the right margin. Drag the marker 
along the ruler to set the right margin.

Selecting Text 
or Pictures If you want to: Do this:

Select a word Double-click the word or drag across it.

Select text Drag across the selection.

Select a picture Double-click the picture, or drag 
across it. You can then cut, copy, 
clear, or freeze it.

Select text and pictures Drag across the selection.

Expand or shrink the 
selection

Shift-click at the new location.

Move a picture horizontally Click the picture to display a black 
border. Drag any part of the border 
left or right to move the picture.

Resize a picture Click the picture to display a black 
border. Drag the size box in the 
border to resize the picture.

Select the entire document Choose Select All from the Edit menu.
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The Word 
Processing 
Menu Bar

The Apple, File, Window, Font, and Style menus contain com­
mands that appear in all Jazz applications. For a description of 
these menus, see Chapter 1, The Standard Commands.

« File Edit lUindoLL* Format Search HotUiew Font Style

Edit

Edit menu

Undo

Cut
Copy sec
Paste
Clear
Select All ^A

Undo reverses your last action, such as typing or editing text. This 
command alternates with Redo, which undoes the effects of the 
Undo command and restores your last action.
If Jazz can’t undo your last action, this command appears dimmed 
as Can’t Undo. If you disabled Undo, this command is Undo 
Disabled
Cut removes selected text, rulers, or pictures (or any combination 
of these) from the document and places the selection on the 
Clipboard.
Copy places a copy of selected text, rulers, or pictures (or any 
combination of these) on the Clipboard. The contents of the docu­
ment are not affected. This command works the same as the Cut 
command, except that Jazz does not remove the selection from the 
document or alter the document in any way.
Paste places the contents of the Clipboard into the document, 
replacing the current selection or beginning at the insertion point.
When pasting text from another document, the pasted text assumes 
the font and style of surrounding text. When pasting text within a 
document, the pasted text retains its font and style.
Clear removes the current selection from the document but does 
not put it on the Clipboard. This command differs from the Cut 
command, which places the selection on the Clipboard.
Select All selects the entire document. This command performs 
the same action as dragging across the entire document to select it.

Format menu w File Edit Window Format Search HotUiew Font Style

Format
Insert Ruler 
Hide Rulers

Insert Page Break 
Set First Page #

Header...
Footer...

Insert Ruler places a ruler below the insertion point in the 
document. Any text after or below the insertion point moves 
down to make room for the ruler. The inserted ruler is a copy of 
the preceding ruler.
Hide Rulers hides the rulers from view, but maintains their for­
matting effects. When rulers are hidden, this command becomes 
Show Rulers. Show Rulers displays all inserted rulers in the word 
processing document.
Insert Page Break inserts a page break at the insertion point. A 
page break ends the current page, making the text after it appear at 
the top of the next page when you print the document. Inserted 
page breaks appear as a nonprinting solid line across your docu­
ment. You insert page breaks to control page length when your 
document is printed.
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Jazz automatically inserts a page break when you fill a page, 
according to the page size you specified with the Page Setup... 
command on the File menu. The page breaks Jazz inserts appear as 
a nonprinting dotted line across your document. You can insert a 
page break if you want Jazz to start printing a new page even if the 
previous page is not full.
Set First Page # sets the page number of the first page in the 
document. All subsequent pages are numbered sequentially from 
the page number you enter. Jazz displays the correct page number 
wherever you inserted the page number using the Page command 
from the HotView menu.
Header... opens the Header window so that you can enter or edit 
the header text for the word processing document. Click the 
window’s close box to close it, or choose Close from the File 
menu. Jazz displays the header in the document and prints it when 
you print the document.
A header is text that appears at the top of each page of your docu­
ment, beginning with the second page. It can contain one or more 
lines of text, pictures, the page number, time, and date. Each docu­
ment can include one header. The header can have a maximum 
height of approximately one quarter of a page. If you exceed the 
allowable height, Jazz prints as much of the header as it can.
Footer... opens the Footer window so that you can enter or edit 
the footer text for the word processing document. Click the win­
dow’s close box to close it, or choose Close from the File menu.
Jazz displays the footer in the document and prints it when you 
print the document.
A footer is text that appears at the bottom of every page of your 
document. It can contain one or more lines of text, pictures, the 
page number, time, and date. Each document can include one 
footer. The footer can have a maximum height of approximately 
one quarter of a page. If you exceed the allowable height, Jazz 
prints as much of the footer as it can.

Search menu

Search
Find...
Find Next 38F

Replace...

B File Edit Window Format Search Hotthew Font Style

Find... locates and selects specified text, such as a word, phrase, 
or number. This command opens the Find window, which you can 
move, activate, and close just like any other window.
• Find: Enter the text you want to find.
• Find Next or Find Prev: If you chose the Forward option, this 

button is Find Next, which finds and selects the next occurrence 
of the specified text. If you chose the Backward option, this 
button is instead Find Prev, which finds and selects the previous 
occurrence of the specified text. The document scrolls automati­
cally so that the selected text is visible. Jazz searches the docu­
ment, beginning at the insertion point or current selection.
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• Find First or Find Last: If you chose the Forward option, this 
button is Find First, which finds and selects the first occurrence 
of the specified text in the document. If you chose the Back­
ward option, this button is instead Find Last, which finds and 
selects the last occurrence of the specified text in the document.

• Forward: Jazz searches from the insertion point or current selec­
tion forward to the end of the document.

• Backward: Jazz searches from the insertion point or current 
selection back to the beginning of the document.

• Partial Word: Jazz finds occurrences of the specified text when it 
appears either as a whole word or as part of another word.

• Whole Word: Jazz finds occurrences of the specified text when 
it appears as a whole word.

If Jazz can’t find the text you’re searching for, or if you click Find 
Next or Find Prev after Jazz selects the last occurrence of the speci­
fied text, a message informs you of this.
Find Next finds and selects the next occurrence of the specified 
text you entered in either the Find or Replace window. The docu­
ment scrolls automatically to the next occurrence of the text. Jazz 
searches the entire document, beginning at the insertion point or 
current selection, and ending where it began. This command is the 
same as clicking Find Next in the Find or Replace window.

If Jazz can’t find the text you’re searching for, a message informs 
you of this.
Replace... finds and replaces specified text, such as a word, 
phrase, or number. This command opens the Replace window, 
which you can move, activate, and close just like any other 
window.
• Find: Enter the text you want Jazz to find.
• Change to: Enter the replacement text. If you don’t enter any­

thing, Jazz replaces the text with nothing (and adjusts the word 
spacing accordingly). You can use this to eliminate unwanted 
text.

• Find Next or Find Prev: If you chose the Forward option, this 
button is Find Next, which finds and selects the next occurrence 
of the specified text. If you chose the Backward option, this 
button is instead Find Prev, which finds and selects the previous 
occurrence of the specified text. The document scrolls automati­
cally so that the selected text is visible. Jazz searches the docu­
ment, beginning at the insertion point or current selection.

• Find First or Find Last: If you chose the Forward option, this 
button is Find First, which finds and selects the first occurrence 
of the specified text in the document. If you chose the Back­
ward option, this button is instead Find Last, which finds and 
selects the last occurrence of the specified text in the document.

Processing
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• Change, then Find: Replaces the current selection of the speci­
fied text with the replacement text, and then finds the next or 
previous occurrence in the document.

• Change: Replaces the current selection of the specified text with 
the replacement text, leaving the replaced text selected.

• Change All: Finds and replaces all occurrences of the specified 
text with the replacement text. This operation, once done, can­
not be undone.

• Forward: Jazz searches from the insertion point or current selec­
tion forward to the end of the document.

• Backward: Jazz searches from the insertion point or current 
selection back to the beginning of the document.

• Partial Word: Jazz finds occurrences of the specified text when it 
appears either as a whole word or as part of another word.

• Whole Word: Jazz finds occurrences of the specified text when 
it appears as a whole word.

If Jazz can’t find the text you’re searching for, or if you click Find 
Next or Find Prev after Jazz selects the last occurrence of the speci­
fied text, a message informs you of this.

« File Edit Jindow Format Search HotLIiein Font StyleHotView menu

Include places a HotView of a graph, worksheet range, or data­
base selection into the word processing document at the insertion 
point. The source graph, worksheet, or database document is not 
affected in any way.
The graph, worksheet, or database document must have been the 
last active document when you choose this command.
A HotView is linked to its source document, so that any changes in 
the source document will also be reflected in the HotView. This 
command differs from the Paste command, which places only 
static (unchanging) views of selected data or graphs into the word 
processing document.
Clicking a HotView displays a black border that includes a size 
box, so you can horizontally move or change the size of the 
HotView. HotViews of graphs are proportionally re-sized when you 
make them larger or smaller.
Dragging across a HotView, or double-clicking it, selects all of it. 
You can clear, cut, copy, and paste HotViews, but you cannot edit 
the data they contain. Any changes to a HotView must be made 
through its source document.
If you cut or copy a HotView to a document, other than a Jazz 
word processing document, it becomes a frozen view.
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Merge Field inserts the value of the first cell in a selected data­
base field or worksheet range into the word processing document 
at the insertion point. You use this command with the Print 
Merge... command from the File menu to print a word processing 
document that includes merged fields and/or ranges. When you 
print using the Print Merge... command, Jazz prints one copy of 
the document for each value in the selection. Form letters, mailing 
labels, and customized reports are examples of documents that 
include merged fields or ranges.
The Merge Field command inserts a HotView of the value, so that 
any changes made to it in the worksheet or database document are 
also reflected in the word processing document. You can clear, 
cut, copy, and paste the merged value, but you cannot edit it.
You can merge fields or ranges from more than one database or 
worksheet into the same word processing document.
You should generally use worksheet or database selections that are 
the same size (contain the same number of values), but your selec­
tions do not always have to be the same size. For example, you 
could merge the value in one selected worksheet cell with the 
values from 10 selected records in a database to have Jazz print the 
same worksheet value for each of the 10 database records.
Date inserts a HotView of the current date at the insertion point 
in a document, header, or footer. Jazz automatically updates the 
date unless you freeze it.
Time inserts a HotView of the current time at the insertion point 
in a document, header, or footer. Jazz automatically updates the 
time unless you freeze it.
Page inserts a HotView of the current page number at the inser­
tion point in a document, header, or footer. Jazz automatically 
updates the page number unless you freeze it.
Show Definitions displays the definitions of all HotViews in your 
document. For merged fields, Jazz displays the name of the source 
document for each value you inserted using the Merge Field 
command on this menu. If the source document is a database, Jazz 
also displays the field name. If the source document is a work­
sheet, Jazz displays the address (or name) of the merged range. If 
you inserted a HotView of the date, time, or page, Jazz substitutes 
Date, Time, or Page for the actual information.
When Jazz displays definitions, this command becomes Show 
Values, which displays the value of the first cell in each merged 
database field or worksheet range.
Freeze converts the selected HotView into a frozen view. A 
frozen view no longer reflects any changes made in its source 
document. If you freeze database or worksheet data, Jazz reformats 
the data to conform to the tab settings in the ruler that is affecting 
text at that location. If you freeze dates, times, or page numbers, 
Jazz freezes the current value in the word processing document. If 
you freeze a graph, Jazz freezes the appearance of the graph so that 
it no longer reflects changes made in its source document.



You freeze a HotView if you don't want changes in the source 
document to be reflected in the word processing document, or if 
you want to either edit or reformat the HotView. Freezing a 
HotView also means Jazz uses less memory and works faster.
You can select, edit, reformat, clear, cut, copy, and paste frozen 
views. You can also change the font or style of the text in the 
frozen view. Frozen graphs can only be sized (but they will not be 
proportionally sized).
Freeze All converts all HotViews into frozen views. Frozen views 
are no longer linked to their source documents, and can be edited 
or reformatted (except frozen graphs).

File Edit Window Format Search HotUiew Font Style
Style menu

style
s/Plain Tent 38 P

Bold 38B
fta/ic 381
Underline 38U
EujQDDnia 380
QUjenlKduij 38S

You can choose any available style for the current selection or for 
text you are about to type. The style you choose is checked in the 
menu. The default style is Plain Text, which cannot be mixed with 
other styles. You can combine the other styles, however, for a 
variety of effects.
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Chapter 5 
Database

The Jazz Database is a sophisticated system for 
storing and organizing information. You can enter 
any kind of information in a Jazz Database, from an 
address file to sales records. Jazz makes it easy to 
work with information once you enter it: you can 
change the order of the database, or sort it, and 
you can search for information in the database 
records automatically. You can also have Jazz 
produce a report based on selected information 
in the database.



A database is a collection of related information. One kind of data­
base you’re probably familiar with is your company’s employee 
records. Each file folder, or record, contains information about one 
employee. Each record is broken into categories that contain the 
same type of information, called fields. In an employee database, 
for example, a record contains all the information about one 
employee, broken into fields such as last name, job title, address, 
and so on. All the records contain the same fields.
Jazz stores records and fields in rows and columns. Each row con­
tains all the information for one record, and each column contains 
all the information for one field. Within each record, Jazz stores 
each piece of data you enter in a cell. Each piece of data is called a 
field value.
In the database below, record 3 contains all of the information 
about one employee, Benjamin Maher. The column farthest to the 
left is the Last Name field; it contains all the last names in the data­
base. The first cell in record 3 contains the field value for the Last 
Name field: Maher.

Each row is 
one record

Each column is 
one field

Each folder contains 
one employee record

A traditional 
database

k File Edit Window Query Sort Report Font Style
Last Name i"Maher ♦

J s

A Jazz database

Last Name first Name | Street City State | Zip Code |JC

1 Engstrom iBritt 144 Griswold Cambridge IMASS 02138 lAdm

____ 2 imans iHeathe 1 Boston IMASS Vete

4
5
6
7

Yashima 
Noli man 

Signoret

iJane 
i Jo tin 

iJordan 
iJusti ne

11 24 Main St. 
1255 Creighi" 
[899’Cherr7 

132 Hudson St

Cambridge 
Newton 
Natick 
Beverly

‘Imass 
"]mass 

IMASS

T 02'178
1“01'701
7 02658

Sur' 

Gra 
>lai 

ISecr

8 Washi ngton iCharles \ 1 66 Pleasant Cambridge MASS 02139 Ann

9 Ortiz iManuel 137 Bay St. East Boston iMASS 01994 Gari
/

A Jazz database is very flexible: it can hold several thousand 
records, and each record can have up to 100 fields. The exact 
number of records and fields you can have in one database is 
determined by the amount of available memory in your computer. 
You can add, delete, or edit records and fields without redesigning 
the whole database.
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Once you set up the database, you can manipulate the information 
it contains in several ways. You can enter records in the database 
in any order and then reorganize it as often as you like. For exam­
ple, you would probably enter employee records as people are 
hired. When you use the information, you need to organize the 
records in some more logical order, such as alphabetically or by 
department. You may also need to find a particular record or set of 
records, such as employees who live in one city or who have been 
with the company for more than five years. Jazz lets you organize 
the database and find information in it quickly and easily.
If you have a lot of information to add to the database at one time, 
you may want to create and use a database form. A form is simply 
a different way of adding or editing records in the database. 
Instead of working with many database records, you work with 
them one at a time. Once you create a database and a form, you 
can add information to the database from the form without 
opening the database again.
You can also use database information in other Jazz applications. 
For example, you can create a graph using figures from your data­
base. If you change the contents of the database, Jazz changes the 
graph, too. You can also use database information in a word 
processing document.

D
atabase

1 Database



How to Create and Use a Database
Before you create a new database, you must decide how many 
fields you need and what kind of information each field will hold. 
The next step in creating a database is defining characteristics, or 
field attributes, for each field. For example, you can specify the 
name of the field, its display width, or its initial value. Once you 
define attributes for all the fields you need, Jazz automatically sets 
up the database according to the attributes you defined.

Creating 
Fields

When you create fields, Jazz automatically names them Field 1, 
Field 2, and so on. You can rename a field if you want the field 
name to indicate what kind of information the field contains.
You can also change a field’s display width, or specify an initial 
value for it. An initial value is useful if many of the field values in 
one field will contain the same information. For example, if most 
of the employees in an employee database live in the same city, 
use the name of the city as the initial value for the City field. Jazz 
automatically enters the name of the city as the initial value in that 
field in each record.

1. Create a new database.
To create a new database, choose New... from the File menu, click 
the Database icon, and click New. Jazz displays a dialog box where 
you define field attributes such as field name, display width, and 
initial value.

Field Attributes
Field name Field 1

<•> Do Not Check Entry Format 
O Check Entry Format
O Use Formula

(Add Hnother Field J

[ Done ]

(Cancel [

□ Locked

Initial Ualue:

Display Width: (To | Characters

You can also check the field’s format, use a formula to determine 
the field value, or protect the information the field contains by 
locking it. These advanced attributes are described in How to Use 
Advanced Field Attributes later in this chapter.

2. Type a new field name.
Jazz automatically gives each new field a default name. You don't 
have to erase the default field name before you type a new one 
unless you clicked the default name first. If you clicked the default 
name before you started typing, press Backspace to erase the old
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name completely. Use only letters, numbers, or spaces, and make 
the first character of the field name a letter. A field name can be 
up to 15 characters long.

3. Click Initial Value if you want to enter an initial value.
An initial value is a field value that appears frequently in the same 
field in the database. If you type the repeated information in the 
box next to Initial Value, Jazz enters it in every record.

4. Type the initial value.
When you edit the database, you can replace the initial value with 
a different field value in individual records. You can also change 
the initial value later.

5. Click Display Width if you want to change the width of the 
field.
The display width indicates how wide the field display is.

6 Press Backspace to erase the default display width, and 
type a number from 3 to 2 54.
Make sure the field is wide enough to display both the field name 
and the data you plan to enter in the field. A field that holds years, 
for example, needs only 4 characters, but a field that holds last 
names may need 15 or more characters.
Each Jazz field holds up to 254 characters no matter how wide the 
field display is. If a particular field value contains more characters 
than the field’s width allows it to display, Jazz displays part of the 
field value, followed by ellipses (...) to indicate that not all the 
information appears.

7. Click Add Another Field, Done, or Cancel.
• Click Add Another Field to enter the current field in the data­

base and define the next field. A Field Attributes... dialog box 
appears for the next field.

• Click Done to enter the current field in the database and finish 
defining database fields. Jazz automatically creates and displays 
the new database. Click Done only when you are finished defin­
ing attributes for all the fields you want, not after each field.

• Click Cancel to discard the field you’re currently defining. Jazz 
automatically creates and displays the database with all the fields 
you defined previously.

If this is the first database you created in this Jazz session, Jazz 
names it Database 1. If you create other databases, Jazz names 
them Database 2, Database 3, and so on. You can rename a data­
base when you save it.
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Creating 
Blank Records

Keep in mind
38

Entering and 
Changing 
Field Values
Entering a field 
value

Before you can enter information in a database, you must add 
space to hold it. The space that Jazz adds to hold your information 
is called a blank record. When you first create the database, Jazz 
automatically adds one blank record. When you add more blank 
records, Jazz places them at the end of the database and numbers 
them sequentially.
Jazz lets you add blank records one at a time, or several at once. If 
you add more blank records than you have information to enter, 
you can delete them later.

1. Choose Add Record from the Edit menu.
2 Repeat step 1 for each blank record you want to add.

Adding many records quickly. To add several blank records 
quickly, hold down the Command key and type N repeatedly. 
Each time you type N, Jazz adds another blank record.
Inserting records. You can also insert a blank record between 
existing records. See Inserting New Records and Fields later in this 
chapter.

You can add field values directly to database records. You can also 
delete, replace, or edit field values in a record. To add a lot of 
information at once, you may want to use a Jazz form.

1. Click the cell where you want to enter a field value.
The cell you click becomes the active cell. The number of the 
record that contains the cell appears in the active record box.

2. Type the field value.
The field value appears in the entry box.

Cancel icon

Active field
Active record box-------
The field value you are 
typing appears in the 
entry box.

Field values can be numbers or text. Numbers can contain the 
following characters: 0, 1,2, 3, 4, 5, 6, 7, 8, 9, S, %, I, and 
space. In addition, a number can begin with a plus sign (+) or 
minus sign (-); if you type these characters anywhere but at the 
beginning of a number, however, Jazz treats the value as text. Text 
can contain any character. You can begin a number or a formula 
with an equal sign (=); Jazz calculates the value and stores the 
result. You cannot begin a text entry with an equal sign ( = ).
The field value appears in the entry box as you type it. To erase 
the value in the entry box, click the Cancel icon and start again. 
To erase a single character after you type it, press Backspace. You 
can also use any of the standard Macintosh editing techniques.
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Replacing a field 
value

If you type a text field value, Jazz places a double quotation mark 
(”) before it to indicate that the field value is text, not a number. If 
you are typing numbers that you want Jazz to treat as text, such as 
zip codes, type a double quotation mark or one of the text 
formatting characters as the first character of the field value. See 
Changing the Format of a Field later in this chapter.

3 Press Tab or Return, or click another cell.
If you press Tab, Jazz enters the field value, and the next cell in 
the same record becomes the active cell. If you were entering the 
last field value in a record, the first cell in the next record 
becomes the active cell. If you press Return, Jazz enters the field 
value, and the cell below becomes the active cell. If you click 
another cell, Jazz enters the field value, and the cell you clicked 
becomes the active cell.
If the field’s display width is too narrow to show the entire field 
value, Jazz shows as many characters as can fit in the cell, followed 
by ellipses (. . .). To see the entire field value, make the field 
wider. See Changing Field Attributes later in this chapter.

1. Click the cell that contains the field value you want to 
replace.

The old field value 
appears in the contents 
box.----- - --------- ----------
New field value

i File Edit Window Query Sort Report Font Style

2 Type the new field value.

3 Press Tab or Return, or click another cell to continue 
entering field values.
The new field value appears in the cell and the original entry 
disappears.

Changing a field 
value

1 Double-click the cell that contains the field value.
The field value appears in the entry box in the console and the 
entry box is highlighted. You don't have to double-click the cell to 
edit a field value you are currently typing.

2. Click a location between characters in the entry box.
The pointer becomes an I-beam when you move it into the entry 
box. To add a character, click where you want to insert it. To 
delete a character, click to the right of the character you want to 
delete. After you click a location, the entry box is no longer high­
lighted. A vertical bar indicates the insertion point, the location 
where you add or delete information.



Insertion point
6 File Edit Window Query Sort Report Font Style

Stroot— .... _______
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Zip CodeCity
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State
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The pointer appears as 
an I-beam.

7 Miller
Yas hi ma

3. Add or delete one or more characters.
To add a character, type it. To delete the character to the left of 
the insertion point, press Backspace. You can continue to edit the 
field value by clicking another location and inserting or deleting 
characters.

< File Edit Window Query Sort Report Font Style
Street

Active record box ■8

Street

"59 Sourjth Union

6 Maher iBenjamin 
jJane

;67 Menoto... iArlington 
ii 24 Main St. Cambridge
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Yashima iJohn l llllili—I] Newton Hass

4. Press Tab or Return, or click another cell.

City
Employee Oatabase

State

Keep in mind

Selecting
Database 
Areas

Selecting parts of 
records and fields

Deleting several characters. After you click an insertion point, 
drag the pointer across two or more characters to highlight them. 
Press Backspace once to delete the highlighted characters.

Before you can work with a cell, record, field, or other area of a 
database, you must select it. For example, after you select a field, 
you can insert another field next to it, delete it, add field values to 
it, or lock it.
To select a cell, click the cell. The cell becomes the active cell; 
you can enter text in it or change text it contains. You can also 
perform commands on the active cell, just as you can on any 
selection.
To select an entire record or field, click its record number or field 
name. You can also select parts of records and fields; groups of 
records or fields; and cells, fields, and records that aren’t next to 
one another.
Selected areas are highlighted until you select another area. Within 
a selected area, the active cell is outlined.

1. Drag the pointer from one corner of the area you want to 
select to the diagonally opposite corner.
To extend the area to include a cell that is outside the window, 
drag the pointer across the scroll bar onto the desktop. Jazz auto­
matically scrolls in the direction of the pointer. Move the pointer 
back into the database to stop the scrolling.
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2, Release the mouse button.
The area is highlighted and the active cell is outlined.

The selected cells and 
the record numbers and 
field names are 
highlighted.

Selecting a record 
with the active 
record box

1. Click the active record box.
The active record box is in the lower left corner of the console.

2 Press Backspace to erase the active record number.
The active record is the record that contains the active cell.

3. Type the record number you want to select and press 
Return.
Jazz scrolls the database to make the record visible, and makes it 
the active record. The previous selection is cancelled. If you type a 
number that is larger than the last record in the database, Jazz 
scrolls to the last record in the database and selects it.

This becomes the active 
record when you press 
Return.

Window Query
Seamans

The number of the record 
you want to select. Employ 

Streeast Name

After

"Ortiz

i File Edit Window Query

D
atabase

Selecting records 
or fields

1. Drag across the record numbers or field names you want to 
select.

2 Release the mouse button.

Before After

The records you want to 
select

ast Name|ii*i«|rjJin3^ iLast Nametirst Name
Employ

Stree

r • iBritt 44Griswo

Heather
| 5|Scarpi

___ 4| Ma her
1 Kluwer

;Lucia
i Benjamin 
iJane

12 Elliott
67 Me note

i 124 Main
* iJohn

| vlNoiiman Jordan 899 Cher
1 8 [Signoret jJusti ne

Selecting 
separated cells

1. Click the first cell you want to select.
2. Position the pointer on the record number or field name 

that contains the next cell you want to select.
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3 Hold down the Option key and click.
You can hold down the Option key and click either a record num­
ber or a field name, but not a single cell. Jazz selects the cells that 
intersect both the old selection and the record number or field 
name you click.

4 Repeat steps 2 and 3 to select additional cells.

Selecting 
separated records 
or fields

1 Click the first record number or field name you want to 
select.

3 Hold down the Option key and click.

2 Position the pointer on the next record number or field 
name you want to select.

Using the Record 
Navigator —

4 Repeat steps 2 and 3 to select additional records or fields.

1 Click one of the Record Navigator arrows.
• Click the black up arrow to move the active cell to the first 

selected record.
• Click the black down arrow to move the active cell to the last 

selected record.
• Click the white up arrow to move the active cell to the previous 

selected record.
• Click the white down arrow to move the active cell to the next 

selected record.
If only one cell in the database is selected, clicking the black 
arrows moves the active cell to the first or last record in the data­
base, and clicking the white arrows moves the active cell to the 
next or previous record in the database.

2 Click a different arrow to move to another record.
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Keep in mind Selecting the entire database. You can select the entire data­
base by choosing Select All Records from the Edit menu.
Canceling part of a selection. To remove a record, or field 
from the selection, position the pointer on the record number or 
field name, hold down the Option key, and click.
Selecting for graphs. To create a graph that is based on informa­
tion in a database, you must select a range of field values. The 
range can include any number of values in the same field. To 
create the graph, the values in the range must be numbers. You 
can also use a range of text values as labels after you create the 
graph. You select a range for a graph just as you select any field or 
part of a field. See Chapter 3 for more information on creating 
graphs.
Editing a field value without changing the current selection. 
If you have several cells, records, or fields selected, you can edit 
the field value in the active cell without changing the rest of the 
selection. Use Tab or Return to make the cell you want to edit the 
active cell, and choose Open Cell from the Edit menu. The field 
value in the cell appears highlighted in the console. You can then 
edit the field value using any of the methods described earlier in 
this chapter. Jazz changes the field value without changing the rest 
of the selection.

D
atabase

89 Database



How to Change a Database
Once you begin to use your database, you may need to change 
some of its elements. Jazz lets you change field attributes, such as 
field names, display widths, and initial values. To change the way 
Jazz displays text or numbers in a field, you change the field 
format.
If you need to add new information, or different kinds of informa­
tion, to the database, Jazz lets you insert new records and fields 
between existing records or fields, or add new records and fields 
at the end of the database. You can also delete entire records and 
fields from the database or delete some of the information that 
particular records or fields contain.

Changing 
Field 
Attributes

Keep in mind

L
■
L

You can change any of the field attributes you defined when you 
created a field. If you change the field width, Jazz displays the 
entire field in the new width. Changing the initial value, however, 
only affects records you add after you enter the new initial value.

1. Click the field name of the field you want to change.
2. Choose Field Attributes... from the Edit menu.
3. Click Field Name, Display Width, or Initial Value.

If you change the field’s initial value, Jazz uses the new value only 
in records you add from now on.
For information on the advanced field attributes, see How to Use 
Advanced Field Attributes later in this chapter.

4. Edit the current attribute or type a new one.
To edit a field attribute, follow the procedure you used to create 
the original field attributes.

5. Click OK.

Changing field attributes for several fields. To change attrib­
utes for several fields, select the fields and choose Field 
Attributes... from the Edit menu. Jazz lets you edit field attributes 
for each selected field. When you finish editing the first selected 
field and click OK, the Field Attributes... dialog box for the next 
selected field appears. When you finish editing the last selected 
field and click OK, the database reappears.
Changing field widths. You can also change the display width 
of a field by dragging the column border. Position the pointer on 
the right border line of the field you want to change. The pointer 
becomes a double arrow. Drag the border to the right to widen 
the field and to the left to make it narrower.



Changing the
Format of a
Field

Information can appear in the Jazz database in different formats. 
Text can be left-aligned, right-aligned, or centered in a cell, and 
numbers can appear in many formats. For example, the number 44 
can appear as $44.00 (Currency with two decimal places), 4400% 
(Percent), or 44.00 (Fixed format with two decimal places). A 
field’s format only affects how Jazz displays the number or text, 
not its value. Changing a field’s format affects existing field values 
as well as field values you enter after you choose the new format.
See The Database Reference for a complete description of the field 
formats you can use.

1. Select the field you want to format.
2. Choose Field Format... from the Edit menu.
3. Click the format you want.

Numeric formats

-Q Fixed
-O Scientific 
-O Currency 
~O Percent 
-O Comma 
-Q General

If you choose Fixed, Scientific, Currency, Percent, or Comma, the 
number of decimal places appears at the bottom of the dialog box. 
To change the default number of decimal places, click an arrow to 
make the number larger or smaller.
If you choose Text, Date, or Time, additional choices appear at the 
bottom of the dialog box. Click the option you want.

Text formats

4. Click OK.

D
atabase

Keep in mind Text formatting characters. You can also use text formatting 
characters to control alignment of text in a cell. If you have 
formatted the field with the text alignment you want, you don’t 
have to use a text formatting character.
You type a text formatting character as the first character in a field 
value. There are three text formatting characters you can use in a 
database. An apostrophe (’) aligns text at the left of the cell. To 
align the field value at the right, type an accent mark (') in front of 
the field value. To center it, type a caret (A). No matter what text 
formatting character you type, Jazz always displays a double 
quotation mark (”) in the contents box to indicate that an entry is 
text. The quotation mark does not appear in the cell.
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To enter a number that you want Jazz to treat as text, type a 
double quotation mark or a text formatting character first.
Changing the format of several fields. To format several fields 
at the same time, select the fields you want to format, choose Field 
Format... from the Edit menu, and choose a new format. Jazz 
formats every selected field.

Inserting New
Records and 
Fields

If you have already entered information in your database and 
decide you need a new field, you don’t have to create a new data­
base and enter the information again. You can insert a new field 
between existing fields in a database. If you have a record to add, 
you can insert it between existing records.

1. Select a record or field.
2. Choose Insert Record or Insert Field from the Edit menu.

If you insert a new field, the Field Attributes... dialog box appears. 
Once you define field attributes, Jazz inserts the new field to the 
left of the selected field. All the fields to the right move over.

Last Name I First Name
Employee Database

New field

Seamans
Engstrom
Maher
Miller....
Yashi ma

Null man

Heather

67 Menotoi

53 St. Botolph iBoston
14 Griswold iCa mb ridge

iAri'inn+n 
..T.'.'.'ri.'T

124 Main St. jMalden
255 Creighton iAriington

Street

89? Cherry \ Newton

D

1
2
3
A

6

If you insert a new record, Jazz inserts a new record above the 
selected record and renumbers all the records below it. If you 
select more than one record, Jazz inserts the new record above the 
active record, and the first cell in the new record becomes the 
active cell. All the records below the new record move down.

New record--------

This was record 6

Employee Database
Last Name |First Name Street City State

C
_T'
Q

. 
i\j

1 Seamans ;Heather i53 St. Botolph = Bosto n iMASS 021 A2 Engstrom iBritt ; 1 4 Griswold iCa mb ridge Hass 021

3 Maher i Ben jamin :67 Menotomu ■Arli nnton iMASS 025

4 Miller iJane i 1 24 Main St. i Mai den iMASS 012
\ 5 Yashima iJohn =255 Creighton ^Arlington iMASS D3E



1 Adding New 
Fields

1
Keep in mind

You can add new fields to the right of existing fields. This allows 
you to adapt an existing database to hold new information. You 
must add field values to the new fields in existing records unless 
you define an initial value.

1. Choose Add Field... from the Edit menu.
The Field Attributes... dialog box appears. Once you define field 
attributes, Jazz adds the new field to the database. Jazz automati­
cally scrolls the database so you can see the new field.

2. Repeat step 1 to add additional fields.

Adding new records. You can add another record whenever 
you need to by choosing Add Record from the Edit menu. To 
add several records, hold down the Command key and press N 
repeatedly. Each time you press N, Jazz adds another record.

Deleting
Database 
Areas

Deleting a record or field, or a group of records or fields, removes 
it from the database. The other records or fields move up or to the 
left to fill up the space. Deleting a field value from a cell removes 
the field value, but doesn’t remove the cell itself.

1. Select the area you want to delete.
2. Choose Clear from the Edit menu.

Jazz deletes the selected area and does not place the deleted entries 
on the Clipboard.

The records you want to 
delete

Before

m
in □ ■

Last Namelirst Name
Employee Database 

Street | City State | Zip Code 1dt
Seamans 53 St. Botol... iBoston MASS 021 10 iAdrr fl

Yas hi ma i John

6 Noll man Jordan 899 Cherry ^Newton iMASS 01701 Jar
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This was record 5

If you clear a single cell, or parts of records or fields, Jazz deletes 
the field values in the selected area and leaves the cells blank. You 
can enter new field values in them.
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Before

The area you want to 
clear

Last Name

Miller
Yas hi ma
Noli man

Seamans
Engstrom
Ma ha r------

Employee Database

•Heather

Arlington255 Creigh
899 Cherry :Newton

J
'mass
MASS

02208
02178

Zip Code

The cleared area--------
remains selected.
You can enter new field 
values in the cell.

Moving and 
Copying 
Database
Areas

After

Last
Employe* Database

State | Zip Code | Jco
i Seamans Boston MASS 02110 Adrr

Mahar------------- | 02156 Bea
Miller h 02208 Sec

5 Yashi ma John 255 Creigh Arlington MASS 02178 Pla

6 Noll man Jordan 899 Cherry Newton MASS 01701 €ar

You move fields, records, or field values by cutting them and then 
pasting them in a new location. This lets you reorganize the infor­
mation in your database. When you move a record, field, or field 
value, it disappears from the original location and appears in a new 
one.
Copying fields, records, or field values lets you use the same infor­
mation in different parts of the database without entering it again. 
When you copy a field, record or field value, it remains in the 
original location and appears in the new one.

1. Select the area you want to move or copy.
2. Choose Cut or Copy from the Edit menu.

Depending on the area you selected, the menu choices are Cut (or 
Copy) Field, Cut (or Copy) Record, and Cut (or Copy) Value. If 
you choose Cut, Jazz removes the selected record, field, or field 
value and places it on the Clipboard. If you cut an entire record or 
field, or a group of records or fields, Jazz removes it from the data­
base and the other records or fields move up or to the left to fill 
up the space. If you cut a single cell, or parts of records or fields, 
Jazz deletes the field values in the selected area and leaves the cells 
blank. You can enter new field values in them.
If you choose Copy, Jazz leaves the record, field, or field values in 
their original location and places a copy on the Clipboard. If you 
copy a field, you must change the name of the original field before 
you can paste the copy into the same database.
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3. Select the area where you want to paste the record, field, 
or field values.
Jazz pastes a field to the left of the field you select. It pastes a 
record above the record you select. The other fields or records 
move to the right or down to make room for the pasted field or 
record. If you are moving or copying field values, they replace 
existing values in the selected cells. If you select more cells than 
the number of values on the Clipboard, Jazz repeats the field 
values until it fills the area.

4. Choose Paste from the Edit menu.
Depending on the area you cut or copied, the menu choice is 
Paste Field, Paste Record, or Paste Value. Jazz moves the record, 
field, or field values from the Clipboard into the selected area. 
After you paste, Jazz selects the record, field, or field value you 
pasted.

The field you want 
to move

Employee Database

THW------
Britt....

Heat, he r 
L uci a

Last Name^irst Name
rtrftrn— 
Engstrom 
Seamans
Scar pi

Street City
jMAS!
"mas: 
Tmas: 
JmAS!

State

Jazz pastes the field in 
the new location.

AfterAfter

Effects on calculated fields. When you cut or clear a field on 
which a calculated field depends, all field values in the calculated 
field become invalid. If you paste the cut field back into the data­
base, the invalid field values become valid again. For more infor­
mation on calculated fields, see Calculating Field Values Using 
Formulas later in this chapter.

D
atabase

195 Database



How to Use Advanced Field
Attributes
Jazz’s advanced field attributes let you protect data, check field 
values, or calculate values for a field.
You can lock fields to prevent changes to the information in them, 
and unlock them when you want to add or change information in 
those fields. You can also have Jazz check the values you enter in a 
field to be sure they are the right kind of value.
To calculate field values, you enter a formula in the Field 
Attributes... dialog box. The formula calculates each field value 
using other field values in the same record or using values you 
provide.

Locking and
Unlocking
Fields

Locking a field ensures that someone looking at the database can’t 
change the information in it without first unlocking the field. You 
can still add new records to the database, but Jazz won’t let you 
enter or change a field value in the locked field. To add or change 
values in a locked field, you must unlock it first.

1. Select the field you want to lock.
2. Choose Field Attributes... from the Edit menu.
3- Click Locked.

If the field is already locked, the box is checked. Click the box 
again to unlock the field.

tt

4. Click OK.
Keep in mind Clearing an entry from a locked field. If you lock a field, then 

try to enter a field value in any cell in the locked field, Jazz 
displays an alert message. To delete the entry, click OK to clear the 
alert message, then click the Cancel icon.



Checking 
Field Values

"1

Keep in mind

Jazz lets you check each field value to ensure it is the kind of entry 
you want in the field — text, a number, a date, or a time. For 
example, to allow only numeric entries in a field that contains 
salaries, set the field’s format to Currency and click Check Entry 
Format. Jazz checks each field value you enter.

1. Select the field you want to check.
2. Choose Field Attributes... from the Edit menu.
3. Click Check Entry Format.

If you chose Check Entry Format previously, clicking Do Not 
Check Entry Format cancels checking.

4. Click OK.
Jazz checks new field values to see that they conform to the field’s 
format. It does not check existing field values.

Correcting an invalid entry. If you try to enter text in a field 
formatted for numbers or a number in a field formatted for text, 
Jazz displays an alert message. To delete the invalid field value, 
click OK to clear the alert message and click the Cancel icon. Enter 
a value in the correct format.

Calculating
Field Values
Using
Formulas

Jazz can calculate and enter field values automatically using a 
formula you enter in the Field Attributes... dialog box. A formula 
can use functions, numbers, and values in other fields. For exam­
ple, if your employee database contains fields such as Birthdate and 
Age, Jazz can calculate values in the Age field for you. You enter 
the formula = (NOW - Birthdate)/365.25 in the space provided for 
formulas. Jazz uses the current date supplied by the NOW function, 
the field values in the Birthdate field, and the number of days in a 
year (365.25) to calculate field values for the Age field. See Chapter 
7 for more information on the Jazz functions you can use in a 
database.

1. Choose Field Attributes... from the Edit menu.
2. Click Use Formula.

4 Type the formula.

D
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3. Click the space provided below Formula.
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Formulas must begin with an equal sign ( =), and must contain 
functions or numbers, or refer to other fields. They also contain 
operators, such as the addition (+) or division (/) operators, that 
tell Jazz what kind of operation to perform. For example, entering 
= (Salary/52)/40 calculates values for the Hourly Wage field. This 
formula uses values you enter in the Salary field, the number of 
weeks in a year, and the number of hours in a work week.
The field you refer to must already exist. If you enter a formula for 
the first field when you create the database, you can’t refer to 
other fields because you haven’t defined them yet.

If you enter a formula for a field that already contains field values, 
Jazz automatically deletes the uncalculated field values and replaces 
them with new values it calculates using the formula.
For complete rules on how to use formulas, see Entering Formulas 
in Chapter 2. For a list of operators, see The Worksheet Reference 
in Chapter 2.

5. Click Done or Add Another Field.
Jazz uses the formula to calculate values for the field.
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How to Sort a Database
Sorting a database lets you reorganize the information it contains. 
When you enter records, you don’t need to worry about the 
order, because you can change the order of the records in the 
database as often as you need to. For example, you may need to 
use the same database in different ways. In an employee database, 
sorting by last name gives you an alphabetical list of all employees. 
Sorting by department number groups employees according to the 
department they work in. After you sort a database, Jazz renumbers 
the records in numeric order.

Sorting a 
Database

Sorting a database reorders the information it contains, either 
alphabetically or numerically. The database field you use for sort­
ing is the sort field. For example, if you sort a database alphabeti­
cally by last name, the database field that contains last names is the 
sort field.
You can choose more than one sort field. For example, if the data­
base includes several employees with the same last name, you can 
specify a second sort field, such as first names. Jazz uses the sec­
ond sort field to sort only those records that have the same value 
in the first sort field. You can specify up to three sort fields.

"i

1. Choose Set Fields... from the Sort menu.

—

Sort Fields

First Sort Field: Use Selected

nn

<•: Rscendinq l Reset ]

1’1_ O Descendinq ( Cancel ]

Second Sort Field: Use Selected (•> Ascending | Sort |
| O Descending

<•) Ascending

O Descending

Third Sort Field: Use Selected
1
1
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2. Type the name of the first sort field in the space provided. 
Use one of the database field names as the name of the sort field. 
You must type the field name exactly as it appears in the database.

3. Click Ascending or Descending.
Click Ascending to order entries from A to Z or from the lowest 
number to the highest. Click Descending to order entries from Z to 
A, or from the highest number to the lowest. If you sort a field 
that contains both text and numbers, text values appear before 
numbers if you click Ascending, and after them if you click 
Descending.

4. Click the space provided for the second sort field if you 
want to set up a second sort field.

5. Repeat steps 2 and 3 to set up second and third sort fields.
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The records are not in ■ 
alphabetical order.

The records are sorted 
alphabetically by 
last name.

Keep in mind

6. Click Sort or OK.
Click Sort to sort the database immediately.
Click OK to return to the database without sorting it. Once you set 
up the sort fields, you can sort whenever you need to by choosing 
Sort from the Sort menu.

Before

Last Name First Name Stree
Seamans Heather St Bnti

j 2 Engstrom Britt 1 4 Griswo

I 3 Maher Benjamin 67 Menoto
Mills r

j 5 Yas hi ma John 255 Creig

| 6 Noll man Jordan 899 Cherr
! 7 Moser 32 Hudson

|____8_ Scar pi 1 66 Pleas

After

Employ
Last Name First Name Stree

i Engstrom iBritt 53 St. Boti

2 Gottlieb iSarah 943 Walk.

3 Maher Benjamin 67 Menoto

9- 4 Miller Jane 1 24 Main

l 5 Moser Adam 32 Hudson

! 6 Noll man Jordan 899 Chert

! 7 Ortiz Miguel 34 Elkwoo
1 8 Pryor Molly 253 Grant

Changing sort fields. To sort the database in a new order, 
choose Set Fields... from the Sort menu, click Reset to clear the 
existing sort fields, and enter new ones. You can also edit any sort 
field name the same way you edit a field value.
Preselecting sort fields. If you don't want to type the sort field 
name or if you can’t remember which field you want to use as a 
sort field, you can return to the database and select it. Click OK to 
leave the Set Fields... dialog box and select the database field you 
want to use as a sort field. Choose Set Fields... from the Sort menu 
and click Use Selected. Jazz displays the name of the field you 
selected as the sort field. You can repeat this procedure to select 
other sort fields.
Sorting blank records. If you have blank records in the data­
base, sorting in ascending order moves them to the beginning of 
the database. To delete them, select them and choose Clear from 
the Edit menu.
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Defining a 
Query

Naming a query

Active query

How to Find Information in a
Database
Jazz can automatically select records that match criteria that you set 
up. The set of criteria you use to select records in this way is 
called a query. For example, you can use a query to select all data­
base records of employees with the same last name, or to search 
for records that are over or under a value you set, such as the 
records of all employees over 65.

You can create and name several queries, but only one can be 
active at a time. To define criteria, you use a Query window, 
which contains the same fields as the database. You can enter 
criteria in as many fields as you need. If you enter several criteria 
in fields in the same row in the Query window, Jazz searches for 
records that match all the criteria. If you enter criteria in different 
rows in the Query window, Jazz searches for records that match all 
the criteria in any one of the rows.
When you open a database, Jazz sets up a Query window and 
makes it the active query. To define criteria in this Query window, 
start at Creating a query, below.

1. Choose Names... from the Query menu.

Query Names

Name:

2. Press Backspace to erase the default query name.
Jazz automatically gives each query a default name, such as 
Query 1.

3. Type a new name.
The rules for query names are the same as those for field names.

4. Click OK or Done.
If you click OK, Jazz renames the active query and does not close 
the Names... dialog box. If you click Done, Jazz renames the active 
query and returns to the database.
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Creating a query 1. Choose Show Definition from the Query menu.
The active Query window appears. The title bar shows the query 
name and the name of the database the query is associated with.

database.
When you use the query, Jazz will select all the records with 
values in this field that match the criterion. You can type the 
criterion in uppercase or lowercase letters. Jazz ignores case when 
it searches for records that match a criterion.

Jazz will select all — 
records with Smith in 
the last name field.

w File Edit Window Query Sort Report Font Style
i” Smith

II I

4. Press Return, Tab, or click another cell.
5. Repeat steps 3 and 4 to enter additional criteria, if 

necessary.
You can specify as many criteria as you want in the same query.
Enter a criterion in a cell in the same field, but in a different row, 
if you want Jazz to match any criterion in that field.



Jazz will select all------
records of employees 
named Smith or Jones.

Jazz will select records 
of male employees 
named Smith.

Keep in mind

1

Enter a criterion in a cell in another field in the same row if you 
want Jazz to match all of the criteria in that row. For example, Jazz 
can search for records of all male employees named Smith.

||Last Namefirst NamejDate Hired Birthdate |

—Smith

6. Click the close box in the title bar to close the query 
window.

Using operators and wildcards. Criteria can be exact text or 
numeric matches, or they can use logical operators, such as greater 
than (>) and less than (<). Criteria can also be formulas. Formulas 
must start with an equal sign ( =).
If you have a simple criterion, such as an exact text match, or a 
single condition, you can enter exactly what you want Jazz to 
search for. For example, entering <35 in the Age field finds all 
records in which the field value is less than 35.
You can also use wildcard characters in a criterion. A question 
mark (?) matches any single text character in a criterion. You can 
use ? anywhere in a criterion. For example, Ada?s matches field 
values such as Adams, Adans, and Adads.
An asterisk (*) matches any number of text characters in a 
criterion. For example, Ada* matches any entry that begins with 
Ada, such as Adams, Adamsky, Ada, etc. The asterisk must be the 
final character in the criterion. If you type *dams, Jazz ignores any 
characters after the asterisk. Because the asterisk is a wildcard, Jazz 
matches everything in the database.
For a complete set of rules on setting up criteria with formulas and 
wildcard characters, see Using Queries in The Database Reference.
Setting up another query. To create another query, choose 
Names... from the Query menu, press Backspace to erase the name 
of the active query, and click New. Jazz creates a new active query 
and gives it a default name. To rename it, type a new name and 
click OK. You can then enter criteria for the new query.
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Selecting 
Records with 
a Query

Once you define a query, you can use it to select matching records 
in the database. To use a query, you must first make it active.

1. Choose Names... from the Query menu.
2. Click the name of the query you want to use.
3. Click OK or Done.

Click OK to confirm your choice and remain in the dialog box.
Click Done to confirm your choice and return to the database. The 
query you click becomes the active query.

4. Choose Select with Criteria from the Query menu.
Jazz selects all records that match the criteria in the active query.

Changing a 
Query

You can delete all of the criteria in a query and set up new criteria, 
or you can delete the entire query. You can also edit criteria in a 
query.

Clearing or 
deleting a query

1. Choose Names... from the Query menu.
2. Click the name of the query you want to change.

If the query you want to change is already active, you don’t have 
to click its name.

3. Click Clear or Discard.
Clear erases the criteria in the active query but leaves the Query 
window so you can enter a different set of criteria. Discard erases 
both the active query and the Query window. The query at the 
top of the list of named queries becomes the new active query.

4. Click OK or Done.
Click OK to confirm your choice and remain in the dialog box. 
Click Done to confirm your choice and return to the database.

Editing a query 1. Choose Names... from the Query menu.
2. Click the name of the query you want to edit.

If the query you want to change is already active, you don’t have 
to click its name.

3. Click OK.
4. Click Done to leave the dialog box.
5. Choose Show Definition from the Query menu.
6. Click the criterion you want to edit, and make any changes 

you want.
Edit a criterion the same way you edit field values in the database.

7. Click the Database window.
You can now use the query you edited or continue with another 
task.
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Keep in mind Discarding the last query. If you have only one query, you can­
not discard it. You can, however, edit any or all of the criteria in 
the last query.
Changing the name of a query. To change the name of a 
query, choose Names... from the Query menu, and click the name 
of the query you want to rename. Press Backspace and type the 
new name.
Dropping duplicates from a query selection. If you have 
duplicate records in a selection, you can drop duplicates from the 
selection without affecting the other selected records. Choose Drop 
Duplicates from the Query menu. Choosing Drop Duplicates 
doesn’t remove the duplicate records from the database; it just 
removes them from the selection.
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Page
Header

Section
Header

Record —
Detail
Line

Section — 
Summary

Report —
Summary

Page Footer

How to Create a Database Report
A Jazz database report lets you see all or part of a database in 
printed form. You can make a report simple or complex. For 
example, you can create a simple report that lists every record in 
the database, or you can break a report into sections, give each 
section a title, calculate section and report totals, and include notes 
at the bottom of each page.

EMPLOYEE SALES COMMISSION REPORT

Employee s Employee's Current Sales Change from
Last Name First Name Sales Amount Commission Last Month's

Store Numbei 1
Pryor $3,841 $384 $400

J

$3,351 $400

Scarpi Lucia $4,985 $474 ($265)

Total Sales for Store Number 27 $16,927

Total Commissions $1,621

Store Number 35

Ortez Miguel $5,100 $510 $104

Gottleib Sarah $3,180 $382 $641

Noilman Jordan $3,468 $260 $ 1.352
Moser Adam $3,470 $347 ($645)

Store Number 56

Signoret Justin $3,527 $352 ($124)

Hood Helene $4,286 $386 $146

Chen Lee $4,064 $366 $108

Total Sales for Store Number 56 $ 11.876

Total Commissions $1,104

Total Sales $118.763

Total Commissio $6,158

Figures for the month of November, 1985
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The database

!□ Employee Sales
Last name First name Store | Sales Rmt 1 Comm Preu Sales

1 Pryor i Molly $3,840.55 $384 $3,440.85

2 Yas hi ma John 27 $4,750.35 $428 $4,665 95

3 Engstrom i Britt $3,350.88 $335 $2,950 64

4 Scar pi i Lucia $4,985.25 $474 $5,250 1 0

5 Ortez i Miguel 35. $5 100 00 : $510 $4 995 R3

fl

Employee Sales: Report 1

zzzzzn
Page Header fl

SALES COMMISSION REPORT

The printed 
report Section Header

Store Number i=Store

Record Detail Line
=Last name i=First name

Section Summary

9;

EMPLOYEE SALES COMMISSION REPORT

Employee's Employee’s Current Sales Change from
Last Name First Name Sales Amount Commission Last Month's Sales

Store Number 27

Pryor Molly $3,841 $384 $400
Yashima John $4,750 $428 $84
Engstrom Britt $3,351 $335 $400
Scarpi Lucia $4,985 $474 ($265)

Total Sales for Store Number 27 $16,927
$1,621

Store Number 35

2

The completed report 
definition

Creating a report takes several steps. First, you open the database 
and sort the records the way you want them to appear in the 
report. Next, you set up a report definition. In it, you specify the 
information you want to include in the report, and how you want 
the report to look. After you complete the report definition, you 
name it and use it to produce the report. Before you produce the 
report, you can preview it on the screen, and modify the defini­
tion if you need to. When the report looks the way you want it to, 
you can print it or save it in a document.
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Sorting 
the Database

Before you create a report, decide how you want to organize the 
records in the database. To break a report into sections, you must 
sort the records so that they are in the same order as the sections 
you want in the report. For example, if you want a report that lists 
employees’ sales commissions by store, sort the records in the 
database using the Store field. You will also use the Store field to 
divide the report into sections.
The Store field is the sort field in the database and the break field 
in the report definition. It is called the break field because it is the 
field Jazz uses to break the report into sections.

1 Open the database you want to use.
To open the database, choose Open... from the File menu. If the 
database is already open, click it to make it active.

2. Sort the records in the database by the field you plan to use 
as the break field.
If you don’t know how to sort, see How to Sort a Database earlier 
in this chapter.

EMPLOYEE SALES COMMISSION REPORT

Employee Sail 
Last name [ Fir st name | Store | Sales

1 Pryor j Molly $ 5,8

2 Yas hi ma iJohn 271 $4,7

3 Engstrom iBritt 2?i

4 Scar pi i Lucia $ 4,9

5 Ortez Migue’ $ 5,1

6 Gottleib Sarah 35i Lp,1

7 Noll man Jordan 35i $ 5,4

R Moser A darn 35; $ f.,4

9 Mac Adam Heather 48; $ 4 3

10 Miller Jane 48; $ 1,2

1 1 Lloyd Arwen 48; $ :>,2

12 Washington Charles 48 i $ 5,9

13 Maher Benjamin 48; $

14 Signoret Justin 56i $

15 Hood Helene 56 $4 2

Lfi Chen Lee 56 $4 r

Each value in the break

Employee's 
Last Name

Current
Sales Amount

Sales Change from
Commission Last Month's Sales

Employee's 
First Name

Store Number 27

Pryor Molly $3,641 $384 $400
Yashima John $4,750 $428 $84
Engstrom Britt $3,351 $335 $400
Scarpi Lucia $4,985 $474 ($265)

Total Sales for Store Number 27 $16,927
Total Commissions $1,621

field creates a section.

Store Number 35

Ortez Miguel $5,100 $510 $104
Gottleib Sarah $3,180 $382 $641
Noilman Jordan $3,468 $260 $ 1.352
Moser Adam $3,470 $347 ($645)

Total Sales for Store Number 35 $15,218
Total Commissions $ 1.499

Store Number 48

MacAdam Heather $4,356 $414 $155
Miller Jane $4,214 $379 $987
Lloyd Arwen $5,218 $391 $534
Washington Charles $3,925 $430 $363
Maher Benjamin $3,201 $320 $85
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Setting Up a
Report 
Definition

Beginning the 
definition

A database report consists of several categories. The page header 
can include the report title and column headings. The section 
header acts as a title for each section of a report. The record detail 
line contains the field values for each record. The section summary 
calculates statistics for a section of the report. The page footer con­
tains notes you want to add to the bottom of a report page. The 
report summary calculates statistics for the entire report.
To specify what you want in your report and how you want it to 
look, you set up, or define, a report definition.

To define a report, you open a blank Report Definition window 
and then enter or specify the information you want to include in 
the report.

• Choose Show Definition from the Report menu.
A blank report definition appears on the screen.

You can enter three types of data in a report definition: text, field 
names, and formulas. You can also format each cell individually. 
General rules for entering and formatting data in a report definition 
include:
• Text appears in a report exactly as you type it in the report defi­

nition. For example, if you want a column heading in the report 
to say Sales Amount, type Sales Amount in the report definition.

• A field name preceded by an equal sign (=) in the report defini­
tion produces field values in the report. For example, to include 
the sales commission for each employee in the report (from the 
field named Comm), type = Comm under Record Detail Line in 
the report definition.

• Formulas perform calculations for a field. Begin all formulas with 
an equal sign (=). For example, to show the total sales commis­
sion for all employees in the report, type =FSUM(Comm) under 
Report Summary in the report definition.
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Defining the page 
header

• A cell’s format affects how values appear in the report. It does 
not affect how the data appears in the report definition. For 
example, if you enter Commission in the report definition cell 
that you formatted for right-aligned text, it appears left-aligned in 
the report definition, but right-aligned in the final report. 
Choose Field Format... from the Edit menu to format each cell 
in the report definition.

The page header appears at the top of every page of the report. It 
can include the report title and column headings.

1 Insert the rows you need for the page header.
To insert a row, select a cell and choose Insert Report Line from 
the Edit menu. Jazz inserts a new row above the row that contains 
the cell you selected. You can insert a new row whenever you 
need one. Insert as many rows as you will need to enter the page 
header.

2. Select a cell in the row in which you want to type the 
report title.

3- Type the report title and press Enter.
4, Select a cell in the row in which you want to type column 

headings.
5 Type the first column heading and press Tab.

Pressing Tab enters the text and selects the next cell in the same row.
6 Repeat steps 4 and 5 to enter the rest of the column 

headings in the same row.
Type one column heading per cell. If you need more than one row 
for column headings, you can insert one and then repeat steps 4 
and 5. To skip a line between the report title and the column 
headings, leave the row above the column headings blank.
You can delete a line by selecting a cell in a row and choosing 
Delete Report Line from the Edit menu. Jazz deletes the row that 
contains the cell you selected.
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Defining the 
section header

The section header appears above each section of the report. 
Because a section is created according to the break field, you 
probably want to use the values in the break field as part or all of 
the section header. For example, if you want to break the sales 
commission report into sections by store number, type Store 
Number in one cell and = Store in the next cell in the same row.
Jazz uses the text, Store Number, and the individual store numbers 
from the Store field as the section header each time it begins a 
new section; for example, Store Number 1, Store Number 2, and 
so on.

[Section Header

1. Insert the rows you need for the section header.
To skip a line after each section header, leave a blank row below 
the section header text.

2. Select a cell in the row in which you want to type the 
section header.

3. Type the text part of the section header and press Tab.
4. Type the break field name, preceded by an equal sign (=), 

and press Enter.
Each time Jazz begins a new section, it uses the new break field 
value in the section header.

Defining the 
record detail line

The record detail line specifies the fields whose values you want to 
include in the report. When you produce the report, Jazz includes 
the values in the fields you specify here. To define the record 
detail line, type either a field name preceded by an equal sign (=), 
or a formula that uses a field name. Type each field name or 
formula in the cell under the corresponding column heading in the 
page header.
Jazz evaluates a formula as it does in a worksheet. For example, to 
keep a running total of sales commissions, type the formula 
= FPREV+Comm, which adds the formula’s previous value to the 
value in the Comm field.
You can use any of the worksheet functions that require a single 
value as an argument by using the field name as the argument. For 
example, to round the values of each sales amount to an integer, 
type =ROUND(Sales Amt, 0).
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You can also create a formula by using operators and field names. 
For example, to show the difference between the present sales 
amount and the previous sales amount, type = Sales Amt-Prev 
Sales. You can also combine functions and operators in a 
formula. For example, to round the difference between the 
present sales amount and the previous sales amount, type 
= ROUND(Sales Amt-Prev Sales, 0).

E
l Record Detail Line
| = Last name • = Fi rst

Defining the 
section summary

1. Select a cell in the row under Record Detail Line.
2. Type the field name, preceded by an equal sign, that 

corresponds to the column heading above it, and press 
Enter.
Type the field name exactly as it appears in the database. Jazz does 
not accept an incorrect field name.
To enter a formula that uses field names, enter the formula instead 
of the field name alone.

3. Repeat steps 1 and 2 for each field whose values you 
include in the record detail line.

The section summary appears at the end of each section of the 
report. You can enter text, field names, and formulas in the same 
line in a section summary, each in a separate cell.

Section Summary

Total Sales for i Store
Total Commissions

Nt

Jazz summarizes each section by performing the calculations you 
specify. You can use one of the following Jazz database report 
functions to make your summary calculations:

212 The Handbook



Defining the page 
footer

• FXNGfield) averages the values in field.
• F COUNT field) counts the number of values found in field.
• FMAX(/ze/(/) finds the maximum value in field.
• FMINfield) finds the minimum value in field.
• FPAGE inserts the current page number.
• FPREV is the value of the report cell when it was last evaluated.
• FSTD(/ze/<V) finds the standard deviation of the values in field.
• FSUMfield) adds the values in field.
• FN NFfield) finds the variance of the values in field.
For example, when you type the summary line Total Sales for 
Store Number = Store =FSUM(Sales Amt), Jazz uses the FSUM 
function to find the total sales for each store, and reports it at the 
end of each section. See Chapter 7 for a complete description of 
the database report functions.

1. Insert the rows you need for the section summary.
You can have more than one summary line in a section summary.

2. Select a cell in the row in which you want to type the 
section summary.

3. Type the beginning text of the summary and press Tab.
4. Type the name of the break field, preceded by an equal 

sign, and press Tab.
Use the break field because you are summarizing a section Jazz 
created according to the break field value.

5. Type the formula part of the summary and press Enter.

A page footer usually contains the page number and any notes you 
want to include at the bottom of each page of the report.

D
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1. Insert the rows you need for the page footer.

| Page Footer
F Figures for the month of November, 1 985,

ZZZtjfll

2. Select a cell in the row in which you want to type the page 
footer.

3. Type the footer text and press Enter.
A page footer can be more than one line.
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Defining the 
report summary

4. Select a cell in the row under the page footer text.
Leave a blank row if you want to skip a line.

5. Type =FPAGE and press Enter.
The FPAGE database report function inserts the current page 
number in each page footer.

The report summary appears once, at the end of the report, and 
performs calculations for the entire report. You define a report 
summary the way you define a section summary, except that you 
don't include a field name because you want Jazz to make a calcu­
lation for every record in the report. You use the database report 
functions to make calculations for the entire report the way you 
use them in the section summary.

Report Summary

Total Sales i
Total Commission

; = FSUMtSalef Amt 1

Defining the 
break field

1. Insert the rows you need for the report summary.
You can have more than one summary line in a report summary.

2. Select a cell in the row in which you want to type the 
report summary.

3. Type the text part of the report summary and press Tab.
4. Type the formula part of the report summary and press 

Enter.

The break field is the field you used to sort the database. Jazz 
scans a database, record by record, to create a report, using the 
values in the field you specify after Break Field to group the 
records in sections. When Jazz gets to a record with a break field 
value that is different from the break field value in the previous 
record, it makes the calculations you specify in the section sum­
mary for all the records in that section. Jazz then begins a new 
section, which includes the next group of records with the same 
break field value. If you don’t specify a break field, Jazz does not 
break the report into sections.

Break Field =Store

1. Select the first cell after Break Field.
2. Type the field name, preceded by an equal sign ( =), that 

you used to sort the database.
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Defining the page 
size

The page size is the number of lines per page of your printed 
report. The default page size depends on both the font you use to 
print the report and the length of your paper.

1. Select the first cell after Page Size.
2 Type the number of lines you want for each printed page 

and press Enter.
You can enter any number that is less than the default.

Closing the report 
definition

Once you complete the report definition, you can close the Report 
Definition window.

Keep in mind

1
= Employee Sales: Report 1 ......s
------ 1---------- ---------------1 o

Page Header SJ
- :EP PLOY EE SALES COMMISSION ....REPORT [

Employee's iEmploi ee's -Current hales ichangefr

— Last Name[First f a me [Sales; Amount ^Commission i Last Mont h's Sales _

— Section Header
Store Number i=Sto re

- Record Detail Line
=Last name 1=First name i=Sales Amt l=Comm :=R0UND( Sales Amt

Section Summary

Total Sales fori Store •lumber =Store ' ' = FSUM(S ales Amt;'

Total Commissions = F3UM(C omm)

Page Footer
Figures for the month of Noyember, .1985.......................i.........................................i'.......................

Report Summary
.................. [=FPAGE....................... i.................................. :...................

... Total Sales........ i...... ■ = F3U Mi Sales; AmtY

Total Commissions = FSUM(Comm; d
Break Field =Store Page Size: 50
lai.....

01 a
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• Click the close box to close the Report Definition window.
The report definition disappears from the screen. Jazz automatically 
saves it under the default report definition name.

Possible problems. If Jazz won’t accept an entry in the report 
definition, or if the report contains incorrect information when 
you preview it later on, you may have:
• Sorted the database incorrectly. Jazz scans the database only 

once when it creates a report. It ends a section each time it 
finds a value in the break field that is different from the previous 
value. If your break field is not the same as your sort field, the 
report will probably contain more than one section for the same 
break field value.

• Entered a field name incorrectly. If you don’t type a field name 
exactly the way you did in the database, Jazz does not accept it.

• Forgotten to type an equal sign (=) before a field name. If you 
don’t begin a field name with an equal sign, Jazz uses the field 
name, not the field's values, in the report.
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Naming a
Report 
Definition

Naming the first 
report definition

Jazz automatically saves the report definition when you save the 
database. You can use it again to create another report with the 
same database, even if the database changes. You will probably 
want to choose a name for each report definition to help you 
remember what type of report the definition produces.

The first time you create a report definition, Jazz names it for you. 
When you choose Names... to name it, the default name appears in 
the report definitions list and as the active definition. You can use 
the default name or change it. You can name the first report defini­
tion either before or after you set it up.

1. Choose Names... from the Report menu.
The Names... dialog box appears with the default report definition 
name.

Reuiem Names Done

Name:

Naming other 
report definitions

2. Type the new name in the box.
3. Click OK or Done.

Click OK to confirm your choice and remain in the dialog box. 
Click Done to confirm your choice and close the dialog box.

After you create the first report definition, you will want to name a 
new report definition before you set it up, so it becomes the active 
report definition. Otherwise, when you choose Show Definition, 
you will see the last report definition you used.

1. Choose Names... from the Report menu.
2. Type the name you want to give the report definition in the 

space provided.
3- Click New.
4. Click OK or Done.

Producing a 
Report

Producing a report includes previewing a report on the screen and 
then printing a copy or saving the report on a disk. To produce a 
report, you must open a database and select the report definition 
you want to use with it. Jazz reads the records you select from the 
database and produces the report using the specifications in the 
active report definition.
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Selecting records

Making the report 
definition active

Previewing a 
report

Printing a report

Before you produce a report, you must select the database records 
you want to include in the report. To produce a report that con­
tains information on certain records only, you must select those 
records. For example, in the sales commission report, you may 
only want to include records with sales over $1000.

1. Open the database you want to use.
To open the database, choose Open... from the File menu. If the 
database is already open, click it to make it active.

2. Select the database records you want to use in your report.
You can set up a query to select the records that match criteria 
you set. If you don’t know how to select records with a query, see 
How to Find Information in a Database earlier in this chapter. To 
include all records, choose Select All Records from the Edit menu. 
To select a group of records that are next to each other, drag 
across the record numbers.

Before you can use a report definition to produce a report, you 
must make it active.

1. Choose Names... from the Report menu.
2. Click the name of the report definition you want to use.

The report definition name becomes the active one.
3. Click OK or Done.

Click OK to confirm your choice and remain in the dialog box. 
Click Done to confirm your choice and close the dialog box.

Previewing a report lets you see the report on the screen, page by 
page, just as Jazz will print it. You can see if you need to change 
anything in the report definition before you print the report or 
save it in a document. If you haven’t already done so, you must 
open the database, select the records you want to use, and make 
the report definition active.

1. Choose Preview... from the Report menu.
2. Click the down scroll arrow to move down on the same 

page.
You can scroll back up the same page with the up scroll arrow.

3. Click Next Page at the bottom of the window to move for­
ward one page at a time.
You cannot go back to the previous page.

4. Click Done when you finish previewing the report.
You can click Done at any point.

When the report looks correct on the screen, you are ready to 
print a copy of it. If you haven’t already done so, you must open 
the database, make the report definition active, and select the 
records you want to use.
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Saving a report in 
a document

Changing a
Report 
Definition
Changing parts of 
a report definition

1. Choose Page Setup... from the File menu.
2. Enter the number you want for the left margin and 

click OK.
3. Choose Print... from the Report menu.

Jazz displays the same dialog box that appears if you choose Print 
Document.... Specify the settings as you would for any Jazz 
document.
The printed copy of a report is identical to the one you preview 
on the screen.
You can save a report in a document on a disk. A saved report 
consists of the text in the report, but not the report definition. 
You can transport and use this document in Jazz Word Processing 
(as a Text Only document) or with any Macintosh application that 
can use text documents. If you haven’t already done so, you must 
open the database, make the report definition active, and select the 
records you want to use.

1. Choose Generate Document... from the Report menu.
2. Type the name you want to give the document in the space 

provided.
This name does not have to be the same as that of the report 
definition.

3- Click Drive if you need to change the current disk drive.
4. Click Save to store the document on a disk.

You can change parts of a report definition, or clear its contents 
completely. If you no longer need a report definition, you can 
delete it.

You will probably create several report definitions for the same 
database. As you change the database, you may need to make 
minor changes to a report definition before you can use it to 
produce a report. For example, you may sort the database using a 
different field, and need to change the break field, section header, 
and section summary.

1. Choose Names... from the Report menu.
2. Click the name of the report definition you want to change. 

The report definition becomes the active definition.
3. Click OK or Done.

Click OK to confirm your choice and remain in the dialog box. 
Click Done to confirm your choice and close the dialog box.
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Clearing a report 
definition

n Deleting a report 
definition

4. Choose Show Definition from the Report menu.
The report definition appears as you last used it.

5. Change the report definition as necessary.
You edit values in the report definition just as you edit field values 
in the database.

6. Close the Report Definition window.

Clearing a report definition removes the information you entered 
under each category, but does not delete the report definition 
itself. You can use it when you need to enter new information for 
every category.

1. Choose Names... from the Report menu.
2. Click the name of the report definition you want to clear.

The report definition becomes the active definition.
3. Click Clear.
4. Click OK or Done.
5. Choose Show Definition from the Report menu.

The report definition appears with every category blank.
6. Enter new information in the report definition.
7. Close the Report Definition window.

You may decide that you no longer need a particular report defini­
tion. In that case, you can delete it.

1. Choose Names... from the Report menu.
2. Click the name of the report definition you want to delete.

The report definition becomes the active definition.
3. Click Discard.

The report definition name disappears from the active definition 
box and from the report definition list.

4. Click OK or Done.
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How to Create and Use a Database 
Form
To create a form, you must first create the database you want to 
associate with the form.
When you create a form, Jazz automatically links it to the active 
database and places a copy of each database field on the form. You 
can use the form to add information to database records, or to edit 
records that already hold information. Jazz automatically enters 
each field value you type in a field on the form in the associated 
field in a database record. The number of the database record you 
are working with appears in the active record box in the form 
console.
When you use a Jazz form, you work with two different menu bars 
and screens: Use Form and Modify Form. To enter or edit field 
values in a database, use the Use Form menu bar. When you are 
using the Use Form menu bar and screen, Jazz moves everything 
you type in the form to the database.

Use Form menu bar ------

The database this form is 
linked to

Fields--------------------------

To change the way the form looks — to add to it, delete from it, 
or rearrange it — you use the Modify Form menu bar. When you 
work with Modify Form, the changes you make to the form do not 
affect the database. For example, if you delete a field from the 
form, the field remains in the database.
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Modify Form menu bar

fl

— « File Edit Window Field Font Style

Eli 1 Employee Database

.. . Form 1 .......

Fields1

Notations boxes show — 
you can change the text 
and placement of the 
fields.

1

2Q
0

To move from the Use Form menu bar to the Modify Form menu 
bar, choose Modify Form from the Edit menu. Choose Use Form 
to move from the Modify Form menu bar to the Use Form menu 
bar.
Because a form is linked to the database you use it with, you 
should save the form and the database on the same disk. Once you 
create the form, however, you don’t need to open the database to 
use the form.

Creating a
Form

When you create a new form, Jazz automatically includes all the 
fields from the active database in the new form. If you have 
several databases open at the same time, the active database is the 
last database you clicked. Once Jazz creates a form, you use it to 
add completed records to the database. If you don’t have a data­
base open, Jazz creates a blank form.

1. Create a database or open an existing one.
If you don’t know how to create a database, see How to Create 
and Use a Database earlier in this chapter. If the database you want 
to use to create the form is already open, click it to make it active.

2. Create a new form.
To create a new form, choose New... from the File menu, click the 
Form icon, and click New. Jazz automatically moves each field 
from the active database to the form. The text to the left of the 
field name indicates the kind of information you should enter in 
the field.

D
atabase

221 Database



Keep in mind

Active record number

Jazz displays each field 
value from the active 
record in the form.

Illindom Query

Creating a tailored form. You can change a form to adapt it to 
your own needs. For example, you can delete fields if you have 
database fields that you don’t want all users to see. See How to 
Change a Database Form later in this chapter.
Changing the text next to the field. You can change the text 
that accompanies each field. See Adding and Deleting Text later in 
this chapter.

Entering Field
Values with a 
Form

To enter field values in the database, you must first add blank 
records to hold the new information. You can then fill in field 
values.

1. Choose Use Form from the Edit menu.
Once you create a form, you must choose Use Form to enter infor­
mation in the database. If you are already using the Use Form 
menu bar, Use Form does not appear as a choice in the Edit menu.

2. Choose Add Record from the Edit menu.
This adds a blank record to the end of the database. Jazz scrolls to 
make the new record visible.

3. Click the field on the form you want to enter information 
in.

4. Type the field value.
5. Press Tab to move to the next field.

Pressing Tab enters the field value into the database and makes the 
next field active.

6. Repeat steps 4 and 5 to type the rest of the field values.
7. Press Return or choose Add Record from the Edit menu.

If you press Return after typing a field value for the last database 
field, Jazz moves to the first field in the next record. If you were 
adding field values to the last record in the database, Jazz beeps to 
let you know that you have to add another record before you can 
continue entering information.
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8 Repeat steps 3 through 7 to enter field values in additional 
records.

Active record number

Field values

Keep in mind

Viewing
Records with 
a Form

♦± o

Editing Field
Values in a
Form

4- o± o
• File Edit Window Query

|T)E1[3] iDatabase I

Employee Database
Last Namefirst Name| Street | City | State | Zip Code | J(

H- Engstrom iBritt ;44 Griswold ;Cambridge jMASS 102138|Ac rr

1

=ii - ■ ■ ■■■...... = rurm i ■■■—

---------------------------------------- 1E ngst ro m
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Inserting a new record. You can insert a blank record before 
the current record by choosing Insert Record from the Edit menu.

As you enter field values in a form, you move from field to field 
by pressing Tab or by clicking the field you want to move to. You 
can use the Record Navigator to move from record to record or 
from the first to the last record in the database. The number of the 
record you are viewing appears in the active record box in the 
lower right corner of the console.

1. Click the black up arrow to view the first database record.
2. Click the black down arrow to view the last database record.
3. Click the white up arrow to view the previous record.
4. Click the white down arrow to view the next record.

D
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You can edit existing field values using a form. When you edit 
field values in a form, the values in the database change as well.

1. Choose Use Form from the Edit menu.
If you are already using the Use Form menu bar, Use Form does 
not appear as a choice. Continue to the next step.

2. Use the Record Navigator to locate the record you want to 
edit.

3. Click the field you want to edit.
4. Select the area you want to edit.

Drag to select a single letter, double-click to select a word, or drag 
from one end of the box to the other to select the entire field 
value.

Database



5 Press Backspace, or choose Cut or Clear from the Edit 
menu.
Backspace deletes the selected area. Cut deletes the selected area 
and places a copy of the deleted text on the Clipboard. Clear 
deletes the selected area and doesn’t place a copy on the Clipboard.

Keep in mind

6. Edit the existing value or type a new field value.

Inserting or deleting a character in a field value. To insert 
or delete one or two characters, click the location in the field 
value where you want to insert or delete. The insertion point (a 
blinking vertical bar) appears where you clicked. Type the charac­
ters you want to insert, or press Backspace to delete characters to 
the left of the insertion point.
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How to Change a Database Form
Changing a form lets you adapt it to your own needs. You can add 
titles, instructions, or explanatory text anywhere on the form, or 
delete text the form contains. You can also add new fields to the 
form, duplicate existing fields, and delete fields. Changing the 
appearance of the form by adding, deleting, or rearranging fields 
and notation boxes does not affect the database. You use the 
Modify Form menu bar to change the appearance of the form.

Adding and
Deleting Text

You can change any of the text that Jazz placed on the form when 
you created it, or add new notation boxes with additional text. For 
example, you can add instructions for entering information in a 
particular field, or you can add a title or general instructions on 
how to use the form.
You can also delete a notation box or the text inside it. If you 
delete a notation box, you can’t add text to it again. If you delete 
text in a notation box, you can enter new text in the box.

Changing text in 
notation boxes

1. Choose Modify Form from the Edit menu.
If you are already using the Modify Form menu bar, Modify Form 
does not appear as a choice. Continue to the next step.

2. Click the notation box you want to change.
3- Edit the existing text or type new text.

To edit text, click to the right of the first character you want to 
delete, press Backspace to delete old text, and type the new text. 
To insert a character or a word in existing text, click the location 
where you want to insert the new text, and then type the text. 
You can also drag over part or all of the text and cut it.
To change the size of the notation box, drag the size box.

Before After

Enter Zip Code:

Notation boxes

Size box

Enter Job Title:

|Enter Soc.Sec/^

Enter Zip Code y. Zip Code

i Enter Job Title: h Job Title

Enter your social 
security * in the 
format 
xxx-xx-xxxx|

■

When you finish editing the notation box, choose Use Form from 
the Edit menu and continue to another task.

Adding new 
notation boxes

1. Choose Modify Form from the Edit menu.
2. Click the notation well.



Deleting text or 
notation boxes

Keep in mind

3. Drag the pointer diagonally across an open area on the 
form.
You can’t drag over any part of an existing field or notation box.

4. Type the information you want in the notation box.
5. Repeat steps 3 and 4 to add additional notation boxes to 

the form.

1. Choose Modify Form from the Edit menu.
2. Click the box or drag over the text you want to delete.
3. Choose Cut or Clear from the Edit menu.

Cut deletes the selected text inside a notation box and places a 
copy of it on the Clipboard. Clear deletes both the notation box 
and the text and does not place a copy on the Clipboard.

Changing the size of fields and notation boxes. Jazz fields and 
notation boxes can hold up to 254 characters, depending on how 
big the box is. If the field or notation box can't display all the text 
you enter, or if it is too big, you can change its size. Click the field 
or notation box you want to change and drag the size box to make 
it larger or smaller.

Before
__

R
; Enter Last Name:; Last Name

iEnter Fi rst Name: First Name

:Enter Street: Street

After

Rearranging
Form

a The fields on your form don’t have to be in the same order as the 
corresponding fields in the database. You can move fields and 
notation boxes to arrange the form as you wish. Jazz won’t move a 
field or notation box if you try to move it to a space that is too 
small for it.

1. Choose Modify Form from the Edit menu.
2. Click the notation box or field you want to move.
3. Position the pointer on any part of the border of the box.

Don’t position the pointer completely inside a notation box or 
field.
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4 Drag the box to a new place on the form.
You can drag notation boxes and fields over existing boxes to a 
clear place on the form.

Before

Then the text moves.

After

database
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Adding and
Deleting
Fields

Adding a field to a 
form

If you add a new field to the database, you can also add it to the 
form. You can also repeat fields if your form is too large for Jazz 
to display all at once. For example, if you have more than eight 
fields in an employee database, you may want to repeat the Last 
Name field so you or another user can always see whose record 
you are working with.
You can also delete fields from a form. Deleting fields is not the 
same as deleting field values. If you delete a field from a form, you 
can’t add field values to that field in the database while using the 
form. If you delete a field value, you can enter a new field value in 
the field. In either case, the field still exists in the database.

1. Choose Modify Form from the Edit menu.
2. Open the database.

If the database is already open, click it to make it active.
3. Select the field you want to place on the form.

Select a field by clicking the field name in the database.
4. Click the form.
5. Click the anchor well.
6. Click the location where you want to place the field.

Jazz places the anchor at the location you clicked.
7. Choose Place from the Field menu.

Jazz places a notation box and the field below the anchor.

Jazz places a copy of the 
field on the form.

« File Edit Window Field Font Style

EL 08 Employee Database

Deleting a field 
from a form

1. Choose Modify Form from the Edit menu.
2. Click the field you want to delete.
3- Choose Clear from the Edit menu.

Clear deletes the field and does not place a copy of the cleared 
information on the Clipboard. Clearing a field from a form does 
not delete the field in the database.
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How to Protect Information in a
Form
Locking a field in a form is similar to locking a field in a database. 
If you lock a field in a form, you (or another user) can look at, but 
not change, information in that field. Locking a field in the form 
does not lock the field in the database. You can still add field 
values to the field in the database, but you can’t add field values to 
the database from the form until you unlock the field. If you lock 
the field in the database, however, it is also locked in the form.

Locking a 
Field

1. Choose Modify Form from the Edit menu.
If you are already using the Modify Form menu bar, Modify Form 
does not appear as a choice. Continue to the next step.

2. Click the field you want to lock.
3. Choose Lock from the Field menu.

If the field is already locked, Lock is checked. When you lock a 
field, the box around it disappears when you use the form.

The fields in boxes are 
not locked.

This field is locked. — Entor Strwd

Keep in mind

943 Commonwealth Avenue

Unlocking a field. When a field you click is locked, Lock is 
checked on the Field menu. Choose Unlock to unlock the field.
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How to Select Database Records 
Using Form Query
A form query is similar to a database query: it selects records in 
the database according to criteria you enter in a query window. 
Before you try to set up a form query, read How to Find Informa­
tion in a Database earlier in this chapter.

Using Query 
in a Form

L
L
L

Using a form query is similar to using a database query. You define 
criteria in a query, and use the query to search for matching 
records in the database. A form query differs from a database 
query in several ways, however:
• You can set up and use only one form query. To use a different 

query, you must clear the original criteria and enter new ones.
• You can use only one criterion per field.
• You can’t save sets of criteria in a form query.
• When you use the query, you see the matching records one at a 

time.
These differences make a form query less powerful than a database 
query, but easier to use.

Defining and 
using criteria

1. Choose Use Form from the Edit menu.
If you are already using the Use Form menu bar, Use Form does 
not appear as a choice.

2. Choose Define Criteria from the Query menu or click the 
Query icon.

3. Type the criteria you want to match in the fields.
For example, if you want to find all the records with the field 
value Yashima in the Last Name field, type Yashima in the query 
Last Name field. If you enter criteria in more than one field, Jazz 
finds records that match all the criteria — for example, the records 
of all employees named Yashima who live in Boston.

■
L
L

Criteria can also include logical operators. For example, entering 
the criterion >65 in the Age field finds all the records that contain 
field values greater than 65. For a complete set of rules on setting 
up criteria, see Using Queries in the Database Reference.
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EJ
Changing criteria 
in a query

Keep in mind

4 Choose View Matching Records from the Query menu or 
click the View Matching icon.
Jazz automatically selects records that match the criteria and lets 
you look at only those records, one at a time. Click the black 
arrows in the Record Navigator to view the first or last selected 
record; click the white arrows to view the next or previous 
selected record.

5 Choose View All Records from the Query menu or click the 
View All icon to cancel the query selection.

1 Choose Use Form from the Edit menu.
2 Choose Define Criteria from the Query menu.
3 Double-click the criterion you want to change.
4. Type a new criterion or leave it blank.
5 Repeat steps 3 and 4 to change other criteria.

Adding a new criterion. To add a criterion in a field that was 
previously empty, click the field and type the new criterion.
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The Database Reference
Menu bar displays the titles of all Database menus.
Console displays information about the database selection. The 
console also lets you quickly locate records, using the Record 
Navigator or the active record box.
Record Navigator lets you quickly locate and activate records. 
Clicking the black up arrow activates the first record in the selec­
tion; clicking the black down arrow activates the last record in the 
selection. If only one cell is selected, the black arrows locate and 
select the first or last record in the database. Clicking the white up 
or down arrow activates the previous or next record in the current 
selection. If only one cell or record is selected, the white arrows 
select the previous or next cell or record.
Cancel icon erases the contents of the entry box. This icon 
appears only when you are entering or editing information in the 
entry box.
Border line separates fields and allows you to expand or shrink 
them. Dragging the border line to the right makes the field wider; 
dragging it to the left makes the field narrower.
Entry box shows the characters you are typing or editing.
Contents box displays the unformatted contents of the active cell. 
If the cell contains text, Jazz inserts a double quotation mark (”) as 
the first character.
Active record box displays the number of the record that con­
tains the active cell. This box lets you quickly select a specific 
record by clicking the box, entering the record number, and press­
ing Enter. Entering a number greater than the number of records in 
the database selects the last record in the database.
Active field box displays the name of the field that contains the 
active cell.
Field is one column in the database and is identified by a field 
name. Each field contains one item of information within a record. 
For example, in an employee database, the first name of an 
employee is one field.
Active field is the field that contains the active cell. Jazz displays 
the name of the active field in the active field box.
Active cell is highlighted by a white border to indicate that it is 
affected by your next action.
Active record is the record that contains the active cell. Jazz dis­
plays the number of the active record in the active record box.
Record is one row in the database and is identified by a record 
number. Each record consists of a collection of information on one 
subject in the database. For example, in an employee database, all 
the information on Jordan Noilman comprises one record.
Field value is the contents of one cell in the database.
Cell is the intersection of a field and a record and contains a field 
value.
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Selecting
Database Data

If you want to: Do this:

Select a record Click the record number, or use the 
Record Navigator or active record box.

Select neighboring 
records

Drag over neighboring record 
numbers.

Select all records Choose Select All Records from the 
Edit menu.

Select an entire field Click the field name.

Select neighboring fields Drag over the neighboring field 
names.

Select a cell Click the cell.

Select neighboring cells Drag over neighboring cells.

Select the cell below the 
active cell

Press Return.

Select the cell above the 
active cell

Hold down Shift and press Return.

Select the cell to the right 
of the active cell

Press Tab.

Select the cell to the left 
of the active cell

Hold down Shift and press Tab.

Select separated records 
or fields

Click the first record number, or field 
name. Option-click each separated 
record number or field name, or 
Option-click and drag to select more 
than one.

Cancel a selected record, 
field or cell

Option-click the selected record 
number or field name.



“1
Entering
Database Data

The rules for entering database data are the same as for entering 
worksheet data, with the exception of formulas. See Chapter 2, 
Entering Worksheet Data, for a summary of the rules for entering 
numbers, text, dates, and times in a database.

If you enter: Rules for entering: Examples:

Formulas for You enter a formula = Sale-Cost
calculated that calculates the = Profit *.95
fields value of a field in the 

Field Attributes... dia­
log box. Jazz uses 
the formula to calcu­
late the value of the 
field for each record.

The formula can con­
sist of field names, 
text, numbers, and 
operators. Text must 
be enclosed in double 
quotation marks.

You must begin with 
an equal sign ( = ).

= (Salary/52)/40

Formulas in You enter a formula in =FCOUNT(LastName)
a Report a record detail line, = FSUM(No. Sold)
window section summary, 

page footer, or report 
summary.

You can use formulas 
and functions, such as 
the Database Report 
Functions described in 
Chapter 7.

You must begin with 
an equal sign ( = ).

= INT(Sales Amt)

Continued

235 Database
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If you enter: Rules for entering: Examples:

Queries in You enter a query in <45
a Query a cell below the field > “Foster"
window that you want Jazz Smith

to search. Ada*

A query can consist 
of field names, text, 
numbers, operators, 
and wildcard charac­
ters (? and *).

Text other than field 
names must be 
enclosed in double 
quotation marks, 
except when entered 
as an exact match.

You must begin with 
an equal sign ( = ) if 
the query begins with 
a field name. (You 
begin a query with a 
field name only when 
using logical opera­
tors such as #AND# 
or #OR#.)

Editing
Database Data

Using
Operators

The procedures for editing database data are the same as for edit­
ing worksheet data. See Editing Worksheet Data in Chapter 2 for a 
summary of editing procedures.

The rules for using operators in database formulas are the same as 
for using operators in worksheet formulas. See Using Operators in 
Chapter 2 for the list of operators you can use in formulas.
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Using Queries This table summarizes the types of queries you can enter in a 
Query window to find matching records. Enter the query in the 
field you want Jazz to search.

To find all 
records that are:

Use this 
operator: Example:

What Jazz 
finds:

Less than 
or equal to

< = < =50 All employees who 
are age 50 or under.

< = ‘‘Jones’’ All employees 
whose last names 
alphabetically pre­
cede and include 
Jones.

Less than < <25 All employees 
younger than 25.

< ‘‘Baker” All employees 
whose last names 
alphabetically pre­
cede Baker.

Identical to Jones All employees 
named Jones.

MAR-85 All employees hired 
on this date.

35 All employees who 
are age 35.

Different from < > < >45 All employees who 
are not age 45.

< > “Foster” All employees who 
are not named 
Foster.

Greater than > >25 All employees older 
than 25.

> “Davis” All employees 
whose last names 
alphabetically follow 
Davis.

Greater than 
or equal to

> = > =“Hudson” All employees 
whose last names 
include and alpha­
betically follow 
Hudson.

> =19 All employees who 
are age 19 or older.

Meeting more than 
one criterion

#AND# = AGE = 25#AND#SEX = “M” All employees who 
are age 25 and male.
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To find 
all records 
that are:

Use this 
operator: Example:

What Jazz 
finds:

Meeting any one 
of several 
criteria

#OR# = AGE = 25#OR#AGE = 26 All employees 
who are age 25 
or 26.

= NAME = “Smith”#OR#NAME = “Jones” All employees 
named Smith or 
Jones.

Matching any 
single text 
character (also 
for numbers 
formatted as text)

? Ada?s All employees 
whose last names 
are, for example, 
Adams, Adans, 
Adads, and so forth.

0213? All 5-digit zip codes 
that begin with 0213 
and end with any 
other number (for 
example, 02134, 
02138, 02139).

Matching any 
number of text 
characters at the 
end of an entry 
(also for numbers 
formatted as text)

* Ada* All names that 
begin with Ada and 
end with any 
number of other 
letters (for example, 
Adams, Adamsky, 
Adamson).

576-* All telephone num­
bers that begin with 
576- and end with 
any other characters 
(for example, 
576-1212, 
576-2091).

Comparing one 
field with 
another field

(Use any 
operator)

= VAC TAKEN = VAC EARNED Employees who 
have taken exactly 
as much vacation as 
they have earned.

= VAC TAKEN < VAC EARNED Employees who 
have taken less 
vacation than they 
have earned.



The Database 
Menu Bar

The Apple, File, Window, Font, and Style menus contain com­
mands that appear in all Jazz applications. For a description of 
these menus, see Chapter 1, The Standard Commands.

Edit menu

Undo

Cut 38 H
Copy 38 C
Paste 38 U
Clear
Select fill Records .38 R

Insert '38:1
Add Record 38 N
Add Field...

Open Cell 380
Field Attributes...
Field Format...

Parse Settings...

« File Edit Window Query Sort Report Font Style

Undo reverses your last action, such as entering or cutting data.
If Jazz can’t undo your last action, this command appears dimmed 
as Can’t Undo. If you disabled Undo, this command is Undo 
Disabled
Cut removes the selection from the database and places it on the 
Clipboard.
This command may be Cut Record, Cut Field, or Cut Value, 
depending on the current selection. Cutting one or more records 
removes the selected records from the database and moves all 
records up. Cutting one or more fields moves all fields over to the 
left. Jazz removes the display format of the selected field(s); they 
revert to General format.
Copy places a copy of the current selection on the Clipboard.
This command may be Copy Record, Copy Field, or Copy 
Value, depending on the current selection. For the Copy Field 
command, Jazz also copies the display format of the selected fields. 
This command is similar to the Cut command, except that Jazz 
does not remove the selection from the database or alter the data­
base in any way.
Paste places the contents of the Clipboard into the selected loca­
tion in the database. This command may be Paste Record, Paste 
Field, or Paste Value, depending on the current selection and the 
contents of the Clipboard.
Paste Record places the contents of the Clipboard above the 
selected record and moves all records down. No data is written 
over.
Paste Field places the contents of the Clipboard to the left of the 
selected field and moves all fields over. No data is written over.
Only fields on the Clipboard that are not in the database are 
pasted. Jazz does not allow duplicate field names in a database.
Paste Value places the contents of the Clipboard into the selected 
location in the database. Jazz writes over the previous contents of 
the selected location. The cells on the Clipboard replace the 
selected cells in the database. If there are fewer cells on the Clip­
board than in the selected area of the database, then Jazz pastes as 
many complete copies of the contents of the Clipboard as it can.
If the Clipboard contains text from another Macintosh program, or 
from a Jazz word processing document, Jazz pastes data into the 
database according to the options you chose with the Parse Set­
tings... command on this menu.
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Clear erases the contents of selected records or fields but does not 
change the format or names of selected fields. Jazz does not place 
the contents of the selection on the Clipboard. This command may 
be Clear Record, Clear Field, or Clear Value. This command 
differs from the Cut command, which removes selected records or 
fields from the database and places the selection on the Clipboard.
Select All Records selects every record in the database.
Insert may be Insert Record or Insert Field, depending on the 
current selection. If a report definition is the active window, this 
command is instead Insert Report Line.
Insert Record inserts a new, blank record immediately above the 
selected record and moves all records down.
Insert Field inserts a new, blank field to the left of the selected 
field and moves all fields over. When you choose this command, 
Jazz displays a dialog box for specifying the attributes for the new 
field. This is the same dialog box Jazz displays for the Field 
Attributes... command, also on this menu.
Insert Report Line inserts a new, blank line above the selected cell 
in a report definition.
Add Record adds a new, blank record after the last record in the 
database. The added record becomes selected. You can have up to 
several thousand records in a database, depending on available 
memory.
If a report definition is the active window, this command is instead 
Delete Report Line. Delete Report Line erases the line that con­
tains the selected cell from a report definition.
Add Field... adds a new, blank field after the last field in the data­
base. Jazz displays a dialog box for specifying the attributes for the 
new field. This is the same dialog box Jazz displays for the Field 
Attributes... command, also on this menu. You can have up to 100 
fields in a database, depending on available memory.
Open Cell puts the contents of the active cell in the entry box 
for editing. This command produces the same results as double­
clicking the cell, except that a selection is preserved.
Field Attributes... changes the characteristics of the selected 
fields or defines the characteristics of a new field. The dialog box 
that appears is the same one you see when you create a new 
database or choose the Add Field... or Insert Field command from 
this menu.



You can enter a new name (up to 15 characters) or edit the exist­
ing name of this field. The name must begin with a letter and can 
be more than one word. If you do not name a field, Jazz assigns a 
default name of Field 1, Field 2, Field 3, and so forth.
• Do Not Check Entry Format: Jazz does not check the format of 

any data entered in this field.
• Check Entry Format: Jazz prevents you from entering data in this 

field if the data does not match the display format of the field. 
Formats that Jazz checks are date, time, numeric, and text.

• Use Formula: Jazz uses the formula you enter in the Formula 
space to compute the value of this field for each record.

• Locked: If checked, Jazz does not allow changes to the contents 
of this field. This option does not appear if you chose Use For­
mula, above, since Jazz must be able to change the contents of 
the field in order to enter the computed value of this field.

• Initial Value: Jazz automatically fills records with whatever you 
enter as the initial value for this field. Enter a field value that 
you want Jazz to repeat for each record in the database.

• Formula: (Appears instead of Initial Value when you choose Use 
Formula.) Enter the formula Jazz uses to compute the value of 
this field. The formula must begin with an equal sign ( = ) and 
can only consist of field names, text and numbers, and 
operators.

• Display Width: Specifies the field’s width. To change it, enter a 
new width. Jazz remembers up to 254 characters in a field, even 
if you cannot see all of them in the field. The default field width 
is 10 characters.

If you are creating a new database, the Add Another Field button 
appears. Clicking this button adds the current field to the database 
and lets you define the next field.
If this field was also selected as a sort field (using Set Fields... on 
the Sort menu), the dialog box informs you of this.
If you choose Use Formula, enter a formula that Jazz uses to calcu­
late the value of this field for each record. The formula can be 
used to establish a relationship between the calculated field and 
other fields in the database, or can be used to compute a numeric 
value for the calculated field. The formula must begin with an 
equal sign.
For example, if you are defining the field attributes for the Feb 
Totals field in the Regional Sales Offices database, you can 
construct a formula that computes monthly totals for each region, 
using other fields in the database. The formula =4*Weekly Totals, 
entered in the Field Attributes... dialog box for the Feb Totals field, 
computes the February totals for each sales region using values in 
the Weekly Totals field. Jazz enters the results in the database in 
the Feb Totals field.



Field Format... changes the display format for numbers and text 
in the selected fields.
The dialog box shows the format of the selected field.
If you select a numeric format other than General, Jazz gives you 
the option of specifying the number of decimal places, up to 15. 
Clicking the up or down arrow in the dialog box cycles you 
through the number of decimal places. (Jazz stores numbers that 
have up to 15 decimal places.)

Month/Day/Year

Display
Format Description Examples

Fixed Displays numbers with a 
fixed number of decimal 
places.

25.00
-278.2
23.0245

Scientific Uses the letter E to 
express numbers in 
powers of 10.

1.346E3
8.09E-12

-7.3E8

Currency Displays $ followed by 
a number. Negative 
values appear in 
parentheses; commas 
separate thousands.

$6.98
($36.00)

$0.23
$89,473

Percent Displays percentages. 24.7%
- 0.06%

Comma Displays numbers with 
commas to separate 
thousands. Negative numbers 
appear in parentheses.

89,898.00
(1,000.00)

General Displays numbers as 
right-aligned. Very large 
or very small numbers are 
expressed in scientific format. 
General is the default for 
numbers.

10.3
6.03592E8

Date Displays dates, in one of the 
following formats:

DD-MMM-YY:
Day-Month-Year

DD-MMM:
Day-Month

MMM-YY:
Month-Year

MM/DD/YY:

23-FEB-85

23-FEB

FEB-85

2/23/85

Continued



Display
Format Description Examples

Time Displays time, in AM/PM or
24 hour format:

HH:MM:SS AM/PM
Hour:Minute:Second

10:03:39 PM

HH:MM AM/PM
Hour:Minute

5:17 PM

HH:MM:SS, 24 Hour 
Hour:Minute:Second 
(24 hour)

23:03:45

HH:MM, 24 Hour
Hour:Minute (24 hour)

14:45

Text Specifies alignment for text or 
for numbers that you want 
formatted as text. By default, 
text is left-aligned and num­
bers are right-aligned.

Left: left-aligned TAX
Right: right-aligned TAX
Center: centered TAX

Parse Settings... determines how text on the Clipboard is pasted 
into the database, so that the text appears in an appropriate form. 
Jazz uses parse settings if you paste text from another Macintosh 
program, or from a Jazz word processing document, into a Jazz 
database.

D
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The dialog box lets you choose the characters that Jazz recognizes 
as column (field) or line (record) separators. The separators tell Jazz 
when to stop pasting text into a field or record and move to the 
next field or record. Each time Jazz recognizes a separator, it stops 
filling the current field or record and moves to the next one.



You can enter additional separators by clicking Character Code and 
entering a character code in the space provided. The character 
code must be a number chosen from the table of Macintosh 
Character Codes in Appendix D.
• Column Separators: Specifies one or more characters that Jazz 

recognizes as column (field) separators. The default column sepa­
rator is the Tab character.

• Line Separators: Specifies one or more characters that Jazz recog­
nizes as line (record) separators. The default line separator is the 
Carriage Return character.

• Ignore Characters: Specifies the characters that Jazz ignores when 
pasting data. When Jazz encounters one of these characters, it 
skips the character and moves to the next one.

• Use Column Widths: (Appears when the Column Separators 
option is chosen.) Specifies the width, in characters, of data 
pasted into each field. Jazz pastes text into the database accord­
ing to the column widths as they appear on the Clipboard.

Clicking Reset clears the contents of the dialog box and reinstates 
the defaults.
If Jazz finds a character that you’ve defined as both a column sepa­
rator and a line separator, Jazz treats it as a column separator.

Query menu

Shorn Definition 

Select with Criteria
Drop Duplicates

Names...

« File Edit LLiindom Query Sort Report Font Style

Show Definition displays the active query in a window. If the 
Query window is already open, this command makes the Query 
window active. You use the active query to select matching 
records in the database. To close the Query window, click the 
window’s close box.
The query remains active whether the Query window is open or 
closed. To make a query the active query, choose Names... from 
this menu.
Select with Criteria makes the Database window active (if it 
wasn’t already active) and selects all the records in the database 
that match the active query. A query consists of criteria that Jazz 
uses to select all records from the database with matching fields. A 
check next to this command indicates that the current selection 
consists of all records that match the active query.
Drop Duplicates drops duplicate records from the selected 
records. Jazz deselects all duplicate records in the selection. The 
duplicate records are not deleted from the database.
Names... chooses or changes the active query and its associated 
definition.
Clicking New adds a new query name to the list.
Clicking Clear erases the criteria for the selected query, but saves 
the name of the query.
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Clicking Discard removes the selected query from the list and 
removes its Query window.
Clicking OK enters your changes into the list. Clicking OK also 
makes the selected query the active query, so you can use it to 
select matching records in the database.
Clicking Undo undoes your last action, unless you already clicked 
OK.
Clicking Done enters your changes into the list and returns you to 
the database.
Jazz saves query definitions when you save the database.

Sort menu K File Edit Window Query Sort Report Font Style

sort
Set Fields...
Sort

Set Fields... specifies how Jazz sorts all the records in the data­
base. Jazz sorts according to the sort fields you specify in the dia­
log box.
You can use up to three sort fields. For each sort field, you choose 
Ascending (A, B, C...Z; 1, 2, 3,...) or Descending (...3, 2, 1; Z, Y, 
X...A) order.
You can keep adding entries to the dialog box by selecting a field, 
choosing this command, and then clicking Use Selected to enter 
the active selection in the dialog box. Clicking Reset clears the 
contents of the dialog box.
• First Sort Field: The name of the primary field to be used for 

sorting the records.
• Second Sort Field: The first tie-breaker field (optional). If two or 

more records have the same value in the first sort field, the 
values in the second sort field determine the order of the 
records.

• Third Sort Field: The second tie-breaker field (optional). If two 
or more records have the same value in the first and second sort 
fields, the values in the third sort field determine the order of 
the records.

Clicking Sort sorts all the records in the database. Clicking this 
button is the same as clicking OK and then choosing the Sort 
command from this menu.
Sort sorts all records in the database, using the sort fields specified 
with the Set Fields... command.

Report menu « File Edit Window Query Sort Report Font Style

Report
Shorn Definition

Preuieuu...
Generate Documen
Print...

Names...

The Report menu creates a report from the selected records in a 
database. A report displays the information from those records in a 
tabular format. You first open a database, and then set up a report 
definition to specify the information you want included in the 
report and the way you want the report to look. You can then 
either print a copy of the report or save it in a document.
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Show Definition opens a report definition, which displays all of 
the parts, or categories, you can have in a report. If the report 
definition is already open, this command makes the report defini­
tion the active window. To close the report definition, click the 
window’s close box.
Space is left under each category, so that you can enter the infor­
mation to define your report. The report definition contains the 
following categories: Page Header, Section Header, Record Detail 
Line, Section Summary, Page Footer, Report Summary, Break Field, 
and Page Size.
You can use the database report functions as well as any of the 
worksheet functions that use single values as arguments in the 
report definition. See Chapter 7 for a description of the Jazz 
functions.
• Page Header: The heading at the top of every page of the 

printed report. This heading can include the report title, the 
column headings, and the page number. A page header can be 
more than one line.

• Section Header: The heading at the top of each section, which is 
determined by the break field you specify in the definition.

• Record Detail Line: The field values you are including from an 
individual record. Each detail line reports information for one 
record from the database. Jazz includes the field value for each 
selected database record when you enter a field name preceded 
by an equal sign ( = ) in the record detail line. Jazz includes the 
formula value when you enter a formula using a field name in 
the record detail line. For example, the formula = FPREV + Sales 
Amt produces a running total of sales amounts. You type the 
field name or formula in the same column as its corresponding 
column heading.

• Section Summary: The statistical calculations for each report sec­
tion. Sections are defined by the break field. You can use the 
Jazz database report functions to make calculations for the fields 
you want summarized. The database report functions can find 
averages, sums, maximum and mimimum values, standard devia­
tion, variance, count field entries, and keep a running total of 
summary calculations.

• Page Footer: The notes at the bottom of each page. You can 
type text as a single entry or in separate cells. You can also use 
the FPAGE function in a separate cell to insert the current page 
number. A page footer can be more than one line.

• Report Summary: The statistical calculations for the entire report. 
You can use the database report functions to calculate the report 
summaries in the same way you use them for section summaries.



• Break Field: The field that you use to sort the database. Jazz 
scans a database, record by record, to create a report, using the 
field you specify as the break field to group the records in sec­
tions in the report. When Jazz gets to a record with a break field 
value that is different from the break field value in the previous 
record, it makes the calculations you specify in the section sum­
mary for all the records in that section. Jazz then begins a new 
section for the next group of records with the same break field 
value.

• Page Size: The number of printed lines per page. The default 
size changes depending on the font and paper size.
You tell Jazz what to include in a report and how to format it 
through the report definition. First you type the information in 
the cells below the report categories. Then you use the Field 
Format... command on the Edit menu to format each cell 
individually. When Jazz finds a category in the report definition, 
it places the text, formula values, or field values you entered for 
that category in the report, in the format you gave it. When you 
format a report cell, the report definition does not reflect the 
format change. Jazz puts the changes in the actual report. If you 
do not want to use a category in a report, leave it blank.
You must precede a field name with an equal sign if you want 
to show the field values for that field in the report. For example, 
if you type the field name Sales Amt, you see Sales Amt in the 
report. If you type = Sales Amt, you see that field’s value for 
each record.

Preview... displays a copy of the report defined by the active 
report definition, just as it will look when you print it. You see 
one page at a time, and can page forward by clicking Next Page at 
the bottom of the dialog box. You can scroll up and down each 
page by using the scroll bar to the right of the window. You can 
return to your database by clicking Done.
Generate Document... names and saves a Macintosh text 
representation of the report in a document. You can later open it 
as a word processing document or read it into any application that 
uses the standard Macintosh text format.
Print... prints a copy of the report. The copy looks the same as 
the one you preview on the screen. You can use the Page Setup... 
command on the File menu to set the left page margin before you 
print.
Names... lets you perform operations on one or more report defi­
nitions. You can use, modify, or delete an existing definition, or 
open and name a new one.



All named report definitions appear in the Review Names defini­
tions list. If you have not yet named a report definition, a default 
name appears in the list. This is the default name of the first report 
definition you create with Show Definition.
To create and name a new report definition, type the name you 
want to give the report definition in the space provided, and click 
New.
To make a named report definition active, click its name on the 
report definitions list.
To rename an active report definition, type the new name in the 
space provided.
To erase the contents of an active report definition, but save the 
definition under the same name, click Clear.
To delete an active report definition, click Discard.
To undo your last action, click Undo. For example, you select a 
named definition and delete it. If you click Undo, Jazz restores the 
definition.
To confirm your last action and remain in the dialog box, click OK.
To confirm your last action and close the dialog box, click Done.

Style menu w File Edit Window Query Sort Report Font Style

Style
✓Plain Tent

Bold
/ ta/ic
Underline
amQOtaB
0SJQS1BEB

Hide Grid
I Hide Record Numbers

You can choose any available style for the entire database. The 
style you choose is checked in the menu. The default style is Plain 
Text, which cannot be mixed with other styles. You can combine 
the other styles, however, for a variety of effects.
Hide Grid removes the column and row lines from the database. 
When the grid is hidden, this command becomes Show Grid, 
which redisplays the column and row lines.
Hide Record Numbers removes the left border of record num­
bers from the database. When the record numbers are hidden, this 
command becomes Show Record Numbers, which redisplays the 
record numbers.
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The Modify
Form Screen

Size box



■ The Form Reference
Jazz Form has two different menu bars: Use Form and Modify 
Form. You see the Use Form menu and screen when you add 
information to a database. You see the Modify Form menu and 
screen when you edit a form. The following section describes the 
Modify Form screen.
Menu bar displays the titles of the Modify Form menus.
Console contains the reference box, anchor well, and notation 
well.
Reference box shows the name of the database that the form is 
attached to.
Anchor well, when highlighted, indicates that you can place the 
anchor anywhere on the form.
Anchor indicates where Jazz places fields and accompanying nota­
tion boxes that are copied from the database onto the form.
Notation well, when highlighted, indicates that you can add nota­
tion boxes to the form.
Notation boxes contain information about the form fields. The 
information in a notation box does not affect the database. The 
active notation box contains a size box that you can use to resize 
the notation box. You can also drag the notation box anywhere on 
the form.
Size box lets you change the size of the active notation box or 
active field.
Fields contain database field names, which you cannot edit. You 
can drag the active field to any clear area on the form.

Fields

D
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The Modify 
Form Menu 
Bar
Edit Menu

The Apple, File, Window, Font, and Style menus contain com­
mands that appear in all Jazz applications. For a description of 
these menus, see Chapter 1, The Standard Commands.

k File Edit Windom Field Font Style

Edit
I Undo 382

Cut 38 H
Copy 38C
Paste 38U

I Clear
Select fill 38fl

Use Form

Undo reverses your last action, such as clearing or cutting.
If Jazz can’t undo your last action, this command appears dimmed 
as Can’t Undo. If you disabled Undo, this command is Undo 
Disabled
Cut removes selected text from the form and places it on the 
Clipboard.
Copy places a copy of selected text on the Clipboard. This com­
mand works the same as the Cut command, except that Jazz does 
not remove the selection from the form or alter the form in any 
way.
Paste places the contents of the Clipboard into the active notation 
box on the form.
Clear erases the selected notation box or field and its contents 
from the form. Jazz does not place the information on the 
Clipboard.
Select All selects every notation box and field on the form.
Use Form displays the Use Form menu bar, so you can add infor­
mation to the database rather than edit the form.

Field Menu 6 File Edit Windom Field Font Style

Field
Place

Lock
Unlock

Place, after you click the anchor on the form, copies the selected 
database field onto the form, placing it beneath the anchor.
Lock locks the selected field so you can view but not change the 
information it contains when you use the form. When you lock a 
field, the box that surrounds it in Use Form disappears. This com­
mand is dimmed if you don’t have a field selected.
Unlock unlocks the selected field if it was locked, so you can add 
more information to it when you use the form. This command is 
dimmed if you don’t have a field selected.
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Style Menu

Style

it File Edit IDindom Field Font Style

1

✓Plain Text *P 
Bold '*B
Italic SI
Underline SU 
IBiiiQDDEa so 
gojaaano ss

Align Fields

You can choose any available style for the entire form, or choose 
different styles for each notation box or field. The style you 
choose is checked in the menu. The default style is Plain Text, 
which cannot be mixed with other styles. You can combine the 
other styles, however, for a variety of effects. The style you 
choose for a form does not affect the database.
Align Fields arranges notation boxes and fields in columns, after 
you have lined them up approximately.
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The Use Form
Query icon

View All icon Active record box
Reference box

Menu bar lindoiB/ Query

Console

View Matching

SeamansEnter employee'3 last name:

Enter employee's fi rst name: Heather

Boston)Enter city:

Enter state:

Enter employee'3 street address, including 
apartment number if necessary:

7 EII3! / i Employee Database ■1

T
Employee Database ■

This form is used by Personnel to record i nformation about e 
Rolling Hills Park, Inc. ■ j



Menu bar displays the titles of the Use Form menus.
Console displays information about the record you are working 
with. The console contains the Record Navigator, reference box, 
View Matching icon, View All icon, Query icon, and active record 
box.
Record Navigator lets you quickly locate and activate records. 
Clicking the black up arrow activates the first record in the selec­
tion; clicking the black down arrow activates the last record in the 
selection. Clicking the white up or down arrow activates the next 
or previous record in the selection.
Reference box shows the name of the database that is attached to 
the form.
Active record box displays the record number of the database 
record you are looking at in the form.
View Matching icon, when selected, indicates that you can only 
see records that match criteria you defined. Clicking this icon is 
the same as choosing View Matching Records from the Query 
menu.
View All icon, when selected, indicates that you can see all 
records one at a time. Clicking this icon is the same as choosing 
View All Records from the Query menu.
Query icon, when selected, shows the Form query. Clicking this 
icon is the same as choosing Define Criteria from the Query menu.
Fields contain the database field values. The active field is the 
field where you are currently entering or editing a field value. It 
contains the insertion point. D

atabase

255 Database



The Use Form
Menu Bar

The Apple, File, and Window menus contain commands that 
appear in all Jazz applications. For a description of these menus, 
see Chapter 1, The Standard Commands.

<c File Edit Windom Query

Edit

Edit Menu

Undo 9€Z

Cut « H
Copy :*C
Paste
Clear

Modify Form

Cut Record
Insert Record 9SI
Rdd Record !SN

Undo reverses your last action, such as clearing or cutting.
If Jazz can't undo your last action, this command appears dimmed 
as Can’t Undo. If you disabled Undo, this command is Undo 
Disabled.
Cut removes selected text in a field and places it on the Clipboard.
Copy places a copy of the selected text on the Clipboard. This 
command works the same as the Cut command, except that Jazz 
does not remove the selection from the form or alter the form in 
any way.
Paste places the contents of the Clipboard into the selected field 
on the form. If you have cut one or more records from the data­
base, the command appears as Paste Record. Paste Record places 
the contents of the Clipboard into the database, starting with the 
active record.
Clear erases the field value in the selected field. Information that 
you clear is not put on the Clipboard.
Modify Form displays the Modify Form menu bar, so you can 
edit the form rather than add information to the database.
Cut Record removes the active record from the form and the 
database and places it on the Clipboard.
Insert Record inserts a new, blank record to the database above 
the active record and makes it the active record. All the old 
records move down one row to make space for the new record, 
and all records are renumbered.
Add Record adds a new, blank record after the last record in the 
database and makes it the active record.

Query Menu «■ File Edit Windom Query

Uietu Matt hing Records &Q
I'/Uiew fill Records

No Duplicates

View Matching Records shows only those records that match the 
criteria you defined using the Define Criteria command. You view 
the records one at a time.
View All Records shows all records in the database, one at a 
time.
No Duplicates removes duplicate records from the selection. The 
duplicate records are not deleted from the database. This command 
works only with selections made using the Define Criteria com­
mand on this menu.
Define Criteria lets you enter criteria that you can use to select 
records that match the criteria.
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Chapter 6
Communications

Jazz Communications lets a Macintosh communicate 
with another computer, either directly or through 
telephone lines. By connecting your Macintosh to 
another computer, you can send and receive entire 
documents or portions of documents. For example, 
you can send a sales report you produced with Jazz 
Word Processing or receive documents from other 
computers. You can connect to time-sharing ser­
vices, networks, and electronic bulletin boards to 
receive information such as stock prices. You can 
also use Jazz Communications to make your Mac­
intosh emulate, or function as, a Digital Equipment 
Corporation (DEC) VT™ 100 or VT™ 52 terminal 
and connect to larger computer systems. This 
allows you to use many programs that run on the 
larger system and to send electronic mail.



To communicate with another computer or time-sharing service, 
you need to have:
• A modem. The modem, short for moduiator/demodulator, con­

verts your computer’s normal electrical signals into signals that 
can travel over telephone lines.

• A cable. The cable connects the Macintosh to the modem. If you 
are connecting two computers directly, rather than through a 
modem, you must use a different cable.

To use Jazz Communications, you must:
• Connect the modem to your Macintosh and to the telephone.
• Choose your communications settings.
• Establish a connection with the other computer.
• Send or receive the information.

260 The Handbook



How to Prepare Jazz for 
Communications
To communicate with another computer, you must first connect 
the modem to the Macintosh, preferably to the socket in the back 
labeled with a telephone icon. Refer to your modem owner’s guide 
for details.
You must then choose your communications settings. These 
include such things as the speed at which you send data (baud 
rate) and the way in which the computer checks data for errors 
(parity). This section explains how to choose the settings so you 
can begin communicating with another computer.
There are three types of communications settings: terminal, con­
nection, and modem. If you are communicating with time-sharing 
services, networks, or other large computer systems, you must 
match most of the other computer’s settings. If you are com­
municating with a personal computer, such as a Macintosh, you 
can choose the settings yourself, as long as both computers use the 
same settings.

Choosing
Terminal 
Settings

Jazz lets your Macintosh emulate different terminals when you 
communicate with other computer systems. A terminal usually con­
sists of a monitor and a keyboard, and has limited processing abili­
ties; information processing takes place in the other computer. 
Terminals handle and display information in different ways, and 
remote computers expect them to behave in a particular way.
You must prepare for communication by choosing the terminal 
settings you need to communicate with the other computer. After 
you choose all of the settings, you confirm your choices by click­
ing OK in the Terminal Settings dialog box. To use the default ter­
minal settings, click OK without changing any of the settings.

1. Create a communications document.
To create the document, choose New... from the File menu, click 
the Communications icon, and click New. Com

m2. Choose Terminal... from the Settings menu.

Terminal Settings L 0K.J
Terminal Mode: @ LIT 1 00

6 UT 52 | Cancel I

End of Line: O CR/LF
• CR

Columns per Line: (•; 80
O 132

Font Size: (•) 9 Point 
O 12 Point

Ruto Wrap □

Local Echo □

Show Keypad □
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3. Click the Terminal Mode you want.
VT 100 is usually a safe choice if you’re unsure of the terminal 
type you want to emulate.
If you are communicating with another personal computer, you 
can choose either setting as long as it matches the other com­
puter’s setting.

4. Click the End of Line setting you need.
If, during a communications session, the cursor doesn’t move to 
the beginning of the next line when you press Return, change the 
setting to the other option. CR/LF means carriage return and line 
feed. CR means carriage return alone.

5. Click the number of Columns per Line you want to use.
The Macintosh displays either 80 or 132 characters per line when 
emulating a terminal. The most commonly used setting is 80 
characters per line. You must scroll to see all of the text if you use 
132 characters per line.

6. Click a Font Size.
Characters are smaller in the 9-point font size than in the 12-point 
font size.

7. Click Auto Wrap to turn it on.
When you are sending or receiving data, this tells the Macintosh to 
move any text that extends beyond the right margin to the next 
line. Otherwise, the text does not appear on the screen. (The num­
ber of characters per line, 80 or 132, defines the right margin.)
If you want text you receive to wrap when it reaches the right 
margin, click the box to turn auto wrap on. Clicking the box when 
it is checked turns auto wrap off.

8. Click Local Echo to turn it on.
If, during a communications session, the characters you type don’t 
appear on your screen, turn local echo on. If the characters appear 
twice, turn it off. A check mark appears in the box when local 
echo is on. You can turn it off by clicking the box.

9. Click Show Keypad to display the terminal keys in the 
console.
The terminal keys work like the VT 100 arrow keys and keypad.

10. Click OK to accept the terminal settings.

Choosing 
Connection 
Settings

To communicate with another computer, you must choose connec­
tion settings. Connection settings specify the port, baud rate, data 
bits, stop bits, parity, and flow control options. Except for the port 
connection, all the settings described in this section must match 
those of the computer with which you are communicating. If you 
do not know what settings the other computer uses, call the other 
computer system's operator or consult the system’s manual for 
information.
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1. Choose Connection... from the Settings menu.

connection settings L OK ]

Connection to: (<i) Telephone Port 
) Printer Port 1 Cancel

Port Settings: ( ) Baud Rate 
j Data Bits 
J Stop Bits 
3 Parity

Flom Control

2. Click Telephone Port or Printer Port.
Choose the port to which you have connected your communica­
tions cable on the back of your Macintosh. Generally, you connect 
the cable to the telephone port. Use the printer port only if you 
have already connected something else, such as a hard disk, to the 
telephone port.
If a Communications document that uses Telephone Port is open, 
you must close it or change the setting to Printer Port before you 
can use Telephone Port in another Communications document.

3. Click Baud Rate, and then click the rate you need.
Baud rate is the speed at which you send and receive data. The 
available baud rates appear in the bottom of the Connection 
Settings dialog box after you click Baud Rate. Common rates are 
300 and 1200, but you must use a baud rate that matches what the 
other computer is using. Modems have limitations on the baud 
rates they can support. Refer to your modem owner’s guide to find 
out what baud rates you can use.

4. Click Data Bits, and then click 7 or 8 bits.
A bit is the smallest unit in which computers store and receive 
information. The number of data bits is the number of bits used 
for each character you are sending.

5. Click Stop Bits, and then click 1 or 2.
The number of stop bits is the number of bits that follows each 
character to signal its end.

6. Click Parity, and then choose None, Odd, or Even.
Parity determines what type of error checking, if any, Jazz uses to 
verify that each character you send matches what the other com­
puter receives, or that each character you receive matches what the 
other computer sends.

7. Click Flow Control.
Flow control regulates the flow of information between your 
Macintosh and the other computer. If too much information is 
coming in at one time, flow control sends a stop message to the 
other computer. When the Macintosh is ready to receive more 
information, it sends a start message to tell the other computer to 
resume sending.
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• Keep Output XON/XOFF checked to control the flow of data 
you send to another computer.

• Keep Input XON/XOFF checked to control the flow of data you 
receive from another computer.

To turn either of the flow control options off, click the box. The 
check mark disappears.
The numbers that appear are only in effect if flow control is on. 
They represent characters that tell the other computer to stop or 
resume sending data. If you are using flow control, keep the exist­
ing settings of 17 (stop) and 19 (resume) unless you know that the 
other computer requires different settings.
To change the settings, click the box and use the Backspace key to 
delete the numbers you want to change. Then type the new 
numbers.

8. Click OK to accept the connection settings.

Choosing
Modem
Settings

Modem settings specify the type of phone service you have and 
the type of modem you are using. You must also specify the 
phone number you want to call.

1. Choose Modem... from the Settings menu.

Modem Settings
It ox J.

Phone Type: (i)Tone 
O Pulse ( Cancel |

Modem Type: ® Hayes’"
O Apple™ 
O Other

Phone Number :

2. Click Tone or Pulse, depending on the type of phone serv­
ice you have.
Choose Pulse for rotary dialing phones and for pushbutton phones 
that use pulse dialing. For most pushbutton phones, choose Tone.

3- Click the type of modem you have.
4. Type the phone number you want to call.

Remember to type 9 if your business phone requires it, and add a 
comma after the 9 to tell Jazz to pause for a moment to wait for an 
outside line. Jazz doesn’t actually dial the number until you choose 
Dial from the Commands menu.
If you chose Other for the modem type, you must include the dial­
ing command for the type of modems you are using. Refer to your 
modem’s owner’s guide for information on the dialing command 
you need to use.

5. Click OK to accept the modem settings.
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Saving Com­
munications 
Settings

Using a new 
document name

Using the current 
document name

If you call a particular computer often, you should save your com­
munications settings. For example, if you call a time-sharing service 
frequently, you can save the settings for that service. When you’re 
ready to call the service again, open the document that contains 
the settings you saved previously and proceed from there.
You can save communications settings in a document that you 
name, using Save or Save As... from the File menu. You save only 
the settings in this way, not the information that appears in the 
Communications window.

After you choose the terminal, connection, and modem settings, 
you can save the settings under a new document name.

1. Choose Save As... from the File menu.
2. Type a new document name or edit the current name.
3. Click Save.

After you choose the terminal, connection, and modem settings, 
you can save them under the current document name.

• Choose Save from the File menu.
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How to Communicate with Another 
Computer
Jazz Communications lets you make calls to, and receive calls from, 
another computer. This establishes a connection between the two 
computers. Once you make a connection, you can actually begin 
to send and receive data.
Jazz lets you send any Macintosh document you’ve saved on a 
disk, or part of a document that is currently active. Similarly, you 
can receive entire documents on a disk or receive information into 
an open document.

Using Saved 
Communica­
tions Settings

If you have previously saved communications settings in a docu­
ment, you can use them by opening the document that contains 
the settings.

1. Choose Open... from the File menu.
2. Click the Communications icon.
3. Click the name of the document that contains the communi­

cations settings you want to use.
4. Click Open.

Making and
Answering a
Call

Making and answering calls establishes a connection with another 
computer so that you can send and receive information.

Making a call After you choose your communications settings, you must call the 
other computer to begin communicating with it. If your computer 
is directly connected to the other computer with a cable, you 
don’t need to call it.

1. Open a communications document or create a new one.
If you are using saved settings, open the document that contains 
those settings.

2. Choose Dial from the Commands menu.
This tells the modem to dial the phone number you set. The 
modem at the other computer emits a high-pitched tone when the 
connection is established. You may then need to follow a log-on 
procedure for the computer you called. The other computer may 
send a message to indicate that the connection exists and to 
prompt you to log on. Once you complete any required log-on 
procedure, you can send and receive information.

Answering a call When another computer calls your computer, a ring message 
appears on the screen if a communications document is active and 
you are using a Hayes, Apple, or other type of intelligent modem.

• Choose Answer from the Commands menu.
You are now connected to the other computer and can send and 
receive information.
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Keep in mind Automatic answering. If your modem has an AA (Auto-Answer) 
setting, you don’t have to choose Answer from the Commands 
menu. The modem answers the call automatically.
Problems establishing a connection. If you have problems 
communicating with another computer, be sure that your settings 
match those of the other computer. You should also check that 
your cables are correctly connected.

Sending a 
Document

Jazz lets you send entire Macintosh documents you saved on a disk 
to another computer.

1. Check that the other computer is ready to receive the 
document.
You may receive a message from the other computer saying that it 
is ready. If you don’t, you can telephone the person you are com­
municating with to check that the other computer is ready to 
receive the document.

2. Choose Set File... from the Send menu.

Send a Document

| OK ] Data Disk...

I [ Fie(t )
[ Cancel | | Driue

(•) To Jazz,M
O Lilith HModem Protocol 
O Without Protocol

3. Click To Jazz, With XModem Protocol, or Without Protocol. 
The protocol you choose must match the protocol of the other 
computer.
• To Jazz sends your document with a protocol that ensures relia­

ble transmission. Jazz sends the entire document, including infor­
mation such as the format, headers and footers, and fonts. Jazz 
also sends the document type, size, and name when you choose 
To Jazz. You must use this option whenever you are com­
municating with another Macintosh computer that is using Jazz. 
Other programs may not recognize this protocol.

• With XModem Protocol also sends your document with a pro­
tocol that ensures reliable transmission, but it does not send the 
document type, size, or name. In addition, it may not send cer­
tain formatting information. Use this option with any other com­
puter that uses XModem protocol.

• Without Protocol sends only the text of your document, without 
information such as the format and fonts. When you choose this 
option, Jazz lists documents that contain only text.
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Keep in mind

Sending 
Part of a 
Document

Receiving 
Data in a 
Document on 
a Disk

4. Scroll through the list of documents and click one.
5. Click OK.
6. Choose Start from the Send menu.

The Sending dialog box appears while Jazz sends the document. 
When Jazz has sent the entire document, the dialog box disappears.

Stopping the sending process. To stop sending data, or if Jazz is 
having a problem sending the data, click Cancel in the Sending 
dialog box. If Jazz cannot send the data, an alert message appears.

To send part of an open worksheet, database, or word processing 
document, you must first select the information you want to send.
Before you begin sending, check that your communications 
settings match those of the other computer and that the other 
computer is ready to receive the data.

1. Open the document that contains the information you want 
to send.
Choose Open... from the File menu to open the document.

2. Select a part of the document.
3. Click the Communications window.
4. Choose Set Selection from the Send menu.

To see the name of the selected document and the selected area in 
the Reference Board, choose Reference Board from the Window 
menu.

5. Choose Start from the Send menu.

When you receive data from another computer, you can save the 
data in a document on a disk.

1. Check that the other computer is ready to send the data.
You can telephone the person you are communicating with to 
check that the other computer is ready to send the document.

2. Choose Set File... from the Receive menu.
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Keep in mind

Receiving 
Data in an
Open 
Document

3 Type a name for the document you will receive.
If you type a document name that already exists, Jazz asks if you 
want to replace the contents of the existing document. Click Yes 
to replace the contents of the existing document. If you click No, 
you must enter a different document name.

Receiue a Document

Stocks

Data Disk...

| OK j [ Cancel |

® From Jazz™
O Lilith HModem Protocol
O Ulithout Protocol

L Eject )

Dr i ue

4. Click From Jazz, With XModem Protocol, or Without 
Protocol.
The protocol you choose must match the protocol of the other 
computer.

5. Click OK.
6. Choose Start from the Receive menu.

If you choose From Jazz or With XModem Protocol, the Receiving 
dialog box appears on your screen while you are receiving the 
document. When you have received the entire document, the 
dialog box disappears.
If you choose Without Protocol, the RCV indicator in the console 
is on while you receive the document.

Stopping the receiving process. If you choose From Jazz or
With XModem Protocol, the receiving process ends automatically 
when you have received the entire document. To stop the receiv­
ing process before you have received the entire document, click 
Cancel in the Receiving dialog box. If you choose Without Pro­
tocol, you must choose Stop from the Receive menu to stop 
receiving data in the document.

Jazz lets you receive data from another computer into an open 
worksheet, database, or word processing document. You must 
indicate the place in the document where you want the data to 
appear.

1 Open the document in which you want to receive the data.
2. Select the location where you want the data to appear.

If you are receiving data in a word processing document, click a 
location where you want the data to be inserted. If you select an 
area in a word processing document, the data you receive replaces 
the selection.
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If you select a range in a worksheet that cannot accommodate all 
the data you are receiving, Jazz fills the range with as much data as 
fits. If you select a single cell in a worksheet, Jazz begins receiving 
in that cell and uses as much of the worksheet as is necessary to 
receive the incoming data. The new data replaces any existing data 
that was in the range into which you received information.
If you select cells or fields in a database, the incoming data 
replaces any existing data in the selected area. If the selected area 
cannot accommodate all the data, Jazz fills the area with as much 
data as can fit. If you select records in a database, Jazz inserts new 
records after the last selected record and pastes the incoming data 
in the inserted records.

3. Click the Communications window.
Choose Reference Board from the Window menu to see the Refer­
ence Board, which shows the document name and the area you 
selected.

4. Choose Set Selection from the Receive menu.
5. Check that the other computer is ready to send the data.
6. Choose Start from the Receive menu.
7. Choose Stop from the Receive menu when you finish 

receiving the data.

Keep in mind Graphing data from a communications session. To graph data 
you receive in a communications session, receive the data into a 
worksheet or database. Then graph the data just as you would 
graph any worksheet or database data. For instance, if you use the 
Communications application to call Dow Jones News/Retrieval® 
Service, you can receive stock quotations in a worksheet and graph 
the trends the data indicates.
Using parse settings. When you receive data into a worksheet or 
database, you may want to use Parse Settings... to ensure that 
incoming data appears in a meaningful form in the document. See 
The Communications Reference for information on using parse 
settings.

Hanging Up To end a communications session, you may first have to log off 
from the computer you called, using the log-off procedures for that 
computer. You must then hang up to disconnect the Macintosh 
from the other computer.

• Choose Hang Up from the Commands menu.
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The Com­
munications 
Screen

Menu bar

Console-

Terminal keys

Stock Report

15 MOST RCTIUE NYSE

STOCKS SALES CLOSE NET CHANGE
Steel Corp 1,737,700 35 3/8 + 1/8
RingCo 1,693,300 18 1/4 - 3/8
Natl Pub 1,438,500 47 3/4 - 1/2
DePacif 1,235,400 23 3/4 - 1/2
CommNth 1,226,400 32 1/2 + 1/4
RMF Inc 1, 194,900 52 + 1 5/8
Star Oil 1,033,200 43 7/8 - 1/4
XYZ Corp 903,800 29 7/8 - 1/4
ZapCo 807,200 27 3/4
CPU Co 792,900 34 1/2 + 7/8
Vidget Corp 748,000 38 5/8 -1 1/8
HAL Co 687,200 1 18 3/4 - 3/8
Lmn Auto 669,800 29 5/8 + 3/8

Communications 
window
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The Communications Reference
Menu bar displays the titles of all Communications menus.
Console displays indicators that provide status information when 
the Macintosh operates like a VT 100 terminal.
CD indicator indicates that your Macintosh has established com­
munication with a remote computer. You must first make sure that 
the CD (Carrier Detect) switch on your modem is off. (For a Hayes 
or Apple modem, set this switch up.)
RCV indicator indicates that your Macintosh is currently receiving 
data in a document or a selection (after you choose the Start com­
mand on the Receive menu). The RCV indicator appears only if 
you are receiving data without using a protocol.
Terminal keys operate just like the VT 100 arrow keys and key­
pad. You click a key (or press the mouse button to repeat it). Alter­
natively, you can use the Macintosh numeric keypad to generate 
the equivalent VT 100 key. The terminal keys appear in the con­
sole when you choose the Terminal... command on the Settings 
menu and click the Show Keypad check box.
Communications window displays up to 24 lines and 80 
columns (characters). You can enter or receive information up to 
132 columns wide, but you can only see 80 columns at a time. 
You can scroll horizontally to see characters not currently visible 
on the screen. The Communications window also includes tab 
stops set at 8-character intervals.
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VT 100
Keyboard 
Equivalents

Blue = Equivalent ASCII control character produced by holding down 
Command () and Shift keys while you type this key

Numeric
Keypad
Equivalents

The optional Macintosh Numeric Keypad provides your Macintosh 
with all VT 100 arrow keys and keypad equivalents.

Blue = Equivalent VT 100 key produced by holding down the Shift key while you 
type this key

Black = Equivalent VT 100 key produced by typing this key

The Com­
munications 
Menu Bar

The Apple, File, and Window menus contain commands that 
appear in all Jazz applications. For a description of these menus, 
see Chapter 1, The Standard Commands.

6 File Edit UlindOLLi Commands Settings Send Receiue

Edit

Edit menu

Undo

Cut
Copy * C
Paste
Clear
Select All

Undo is not used in this application and is always dimmed.
Cut is not used in this application and is always dimmed.
Copy places a copy of up to one full screen (24 lines), which you 
select in the Communications window, on the Clipboard. You can 
Shift-click to shrink (or expand) the selection before copying it. 
The contents of the Communications window are not affected 
when you use this command.
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Commands menu

Commands
Dial 
Answer 
Hang Up

SD

H

Send

Settings menu

Send
Send

BreakShort 
Long Break

Answerback

Settings
Terminal...
Connection...
Modem...
Set Answerback...

Paste transmits to the other computer whatever text is on the 
Clipboard, beginning at the cursor location (assuming you have 
established communication and can send data).
Clear is not used in this application, and is always dimmed.
Select All selects the entire screen.

• File Edit UJindoiu Commands Settings Send Receiue

Dial calls the phone number you specified using the Modem... 
command on the Settings menu. You use this command if you 
have a modem that can perform auto-dialing of your telephone.
Answer tells Jazz to answer an incoming call. You use this com­
mand if you have a modem that can answer calls on the telephone. 
If your modem is set to answer calls automatically, you don’t have 
to use this command.
Hang Up ends the call and hangs up the phone.
Send Short Break transmits a short break signal to the remote 
computer. You should find out from the other computer if you 
need to send a short break signal.
Send Long Break transmits a long break signal to the remote 
computer. You should find out from the other computer if you 
need to send a long break signal.
This command is the same as Send Short Break, except that the 
duration of the break signal is longer.
Send Answerback transmits the message that you specified using 
the Set Answerback... command on the Settings menu, in response 
to a request from the other computer. If the other computer sends 
an automatic enquiry (ENQ) character (used as a request for a 
response), Jazz sends the answerback message automatically, and 
you do not have to choose this command.

-

w File Edit lllindoLU Commands Settings Send Receiue

Terminal... defines terminal settings for the Macintosh.
• Terminal Mode: The VT 100 option causes the Macintosh to 

operate like a Digital Equipment Corporation VT 100 terminal. 
The VT 52 option causes the Macintosh to operate like a Digital 
Equipment Corporation VT 52 terminal.

• End of Line: Controls how Jazz interprets the Return key. CR 
(Carriage Return) is the standard setting for a VT 100. If, when 
you press Return, the cursor moves to the beginning of the cur­
rent line instead of moving to the beginning of the next line, 
you should switch the setting to CR/LF (Carriage Return/ 
Linefeed).
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• Columns per Line: Controls how many columns (characters) are 
received across the Communications window. An 80-column 
width provides the standard 24-line by 80-column display. A 
132-column width provides a 24-line by 132-column display, but 
you must scroll the window to see all 132 columns.

• Font Size: Specifies the point size of characters in the 
Communications window.

• Auto Wrap: Tells the Macintosh to wrap to the next line any text 
that extends beyond the right margin. Otherwise, text that 
extends beyond the right margin won’t be visible. Choose this 
option if you want text to be automatically wrapped.

• Local Echo: If checked, the Communications window echoes 
characters you type. You should set Local Echo to off if every 
character you type appears twice, and to on if you can’t see 
what you type. If you see three characters for every character 
you type, your modem is probably also set to echo characters; 
so you should change the modem’s switch setting.

• Show Keypad: If checked, the terminal keys are displayed in the 
console. The terminal keys operate just like the VT 100 arrow 
keys and keypad. If not checked, the terminal keys are hidden 
in the console.

Connection... defines the connection between the Macintosh and 
the other computer.
• Telephone Port: Specifies that your communications cable is 

plugged into the telephone port.
• Printer Port: Specifies that your communications cable is plugged 

into the printer port. You can use the printer port for communi­
cations if you have a hard disk that is connected to the tele­
phone port. Using the printer port is not recommended for data 
transmission rates above 300 baud.

• Baud Rate: Specifies the speed at which data is exchanged 
between the Macintosh and the other computer.

• Data Bits: Specifies the length (in bits) of a character being trans­
mitted. If you are planning to use the XModem or Jazz protocol 
to send or receive files, this option must be 8.

• Stop Bits: Specifies the number of additional bits that must fol­
low each character to signal its end.

• Parity: Determines the type of error checking, if any, Jazz uses 
when it sends data. If you are planning to use the XModem or 
Jazz protocol to send or receive files, this option must be None.

• Flow Control: Synchronizes data transmission between the 
Macintosh and the other computer. Flow control can be on or 
off for outgoing data (output), incoming data (input), or both. 
Default character codes are set for XON (17) and XOFF (19).
If you want to use different character codes, you can enter 
them in the spaces provided. Each code must be entered as a 
number, chosen from the list of Macintosh Character Codes in 
Appendix D. The character codes you enter must match those of 
the other computer.
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■

Send menu

Send
Set File...
Set Selection
Start

You can use up to two Communications windows at the same time — 
one using the telephone port setting and the other using the printer 
port setting.
Modem... defines modem settings, such as your phone type and 
modem type.
• Phone Type: Specifies the type of telephone service you are 

using. Tone is for most push-button phones. Pulse is for a 
rotary-dial phone or for a push-button phone that uses pulse 
dialing.

• Modem Type: Specifies the type of modem you are using 
(Hayes, Apple, or Other).

• Phone Number: Specifies the telephone number that Jazz dials 
when you choose Dial from the Commands menu.

Some business phone services may require a pause to be inserted 
between certain digits to give the phone time to respond to the 
digits being dialed. Insert a comma (,) in the phone number to get 
a pause. For example, the phone number 9,3567293 gives a single 
pause for an outside line.
If you add a telephone credit card number to the number you are 
entering, you should type a number of pauses between the tele­
phone access service number and the credit card number. You 
may have to experiment with the number of pause characters 
(commas) that you use. Try using five commas.
If you choose Other and are using a modem that is not capable of 
auto-dialing, you can include a dialing command for the modem 
when you enter the phone number.
Set Answerback... defines a brief message (up to 20 characters) 
that Jazz sends to the other computer when you choose Send 
Answerback from the Commands menu. (Jazz sends the answer­
back message automatically if it receives an ENQ request from the 
remote computer.) The answerback message can be any message, 
such as an identification or status message, that you send fre­
quently in response to a request from the other computer.

K File Edit Window Commands Settings Receiue

Set File... specifies the document to send to another computer.
You send the document by choosing the Start command from this 
menu.
The communications protocol you choose must match the pro­
tocol being used by the other computer.

■
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• To Jazz: Jazz sends the entire file, including the text, format, 
fonts, sizes, styles, pictures, page breaks, headers, and footers. 
The document type, size, and name are also sent. You must use 
this protocol to send Jazz files to another Macintosh that is using 
Jazz to receive files. This is the only protocol you can use to 
send form, communications, and graphics documents.

• With XModem Protocol: With this protocol, Jazz does not send 
the document type; Jazz sends the document in an uninterpreted 
binary form. With word processing documents, Jazz only sends 
the text; it does not include format, fonts, sizes, styles, page 
breaks, headers, and footers. You can use this protocol to send 
entire files to computers that can accept files using the XModem 
protocol.

• Without Protocol: Jazz sends a text-only document. Use this pro­
tocol to send entire documents to computers that accept text- 
only documents. Clicking this option displays only text files in 
the dialog box.

An example of a text-only file is a word processing document that 
you saved by clicking Text Only in the Save As... dialog box. If 
you use the XModem protocol to send a Jazz word processing 
document, Jazz sends it as a text-only file.
Set Selection specifies a selection from the worksheet, database, 
or word processing document that you want to send. You send 
the data by choosing the Start command from this menu. Jazz 
sends only the text of the selection.
Start sends the entire document or selection. Jazz displays a dialog 
box with a message that it is sending the document or selection. 
You can click Cancel to stop sending in progress. When all the 
data has been sent, the dialog box disappears.

Receive menu

Receive • File Edit Window Commands Settings Send Receive
I Set File?.

Set Selection
Parse Settings...
Start

Set File... specifies the name of the document that will receive the 
data. You receive the data by choosing the Start command from 
this menu.
The communications protocol you choose must match the pro­
tocol being used by the other computer.
• From Jazz: Jazz receives the entire file, including the text, for­

mat, fonts, sizes, styles, pictures, page breaks, headers, and 
footers. You must use this protocol to receive Jazz files from 
another Macintosh that is using Jazz to send files. Jazz preserves 
the name and type of the document as it was sent.

• With XModem Protocol: With this protocol, Jazz does not 
receive the document type; it receives the document in an 
uninterpreted binary form. With a word processing document, 
Jazz receives the file as a text-only document, without the for­
mat, fonts, sizes, styles, page breaks, headers, and footers. You 
can use this to receive entire files from computers that can send 
files using the XModem protocol. Use this protocol to receive a 
Symphony, 1-2-3, or SYLK document that you want to convert 
into a Jazz worksheet.
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• Without Protocol: Jazz receives the file as text only. Choose 
this option to receive files from other computers that can send 
text-only files.

After receiving a Symphony, 1-2-3, or SYLK document, convert it 
into a Jazz worksheet using the Convert... command on the Apple 
menu.
If you use the From Jazz protocol and there is not enough space 
on the disk to receive the document, Jazz displays an alert message 
notifying you that the document cannot be received.
Set Selection tells Jazz to receive data in a selection in a work­
sheet, database, or word processing document. You receive the 
data in the selection by choosing the Start command from this 
menu.
Parse Settings... defines how data appears when Jazz receives it 
in a worksheet or database. You can choose or change these set­
tings before you receive the data. Jazz saves these settings when 
you save your communications settings.
You use the Parse Settings... command to ensure that data appears 
in an appropriate form when you receive it in a Jazz document. 
The dialog box lets you choose the characters that Jazz recognizes 
as column and line separators. The separators tell Jazz w’hen one 
group of characters (such as a word or number) ends and the next 
group of characters begins. Each time Jazz recognizes a separating 
character, it moves to the next group of characters being received.
You can enter additional separators by clicking Character Code and 
entering a character code in the space provided. The character 
code must be a number chosen from the table of Macintosh 
Character Codes in Appendix D.

Parse Settings

(•) Column Separators □ Blank
I nK J

O Line Separators □ Null | Cancel
O Ignore Characters □ Carriage Return j Reset

□ Line Feed
□ Use Column Widths 0 Tab

□ Comma
□ Character Code: ■
□ Character Code: o

om
m

• Column Separators: Specifies one or more characters that Jazz 
recognizes as column (or word) separators. The default column 
separator is the Tab character.

• Line Separators: Specifies one or more characters that Jazz recog­
nizes as line (or row) separators. The default line separator is the 
Carriage Return character.
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• Ignore Characters: Specifies the characters that Jazz ignores when 
receiving data. When Jazz encounters one of these characters, it 
skips the character and moves to the next one.

• Use Column Widths: (Appears when the Column Separators 
option is chosen.) Specifies the width, in characters, of data 
received in each column of a worksheet, or in each field in a 
database. Jazz receives information in the document according to 
the width you specify for each column (up to eight columns).

Clicking Reset clears the contents of the dialog box and reinstates 
the defaults.
If Jazz finds a character that you’ve defined as both a column sepa­
rator and a line separator, Jazz treats it as a column separator.
Start tells Jazz to begin receiving data. If you chose Without Pro­
tocol using the Set File. . . command on this menu, the RCV indi­
cator appears in the console while Jazz is receiving data. Jazz 
displays the received data in the Communications window and also 
stores it in the selection or document you specified. To stop 
receiving data, choose Stop from the Receive menu. Jazz continues 
to display any incoming data in the Communications window, but 
no longer stores the data.
If you are using the From Jazz or XModem protocol, Jazz instead 
displays a dialog box with a message that it is receiving data. You 
can click Cancel to stop receiving data. After all the data has been 
received, the dialog box disappears.
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Chapter 7 
Functions

Jazz has 100 functions that, when used in formulas, 
perform specialized calculations. Some functions 
calculate numeric values, and other functions 
manipulate text. For example, you can use the SUM 
function to add a series of numbers. The formula 
= SUM(D2..D8) performs the same calculation as 
the formula = D2 + D3 + D4 + D5 + D6 + D7 + D8. 
You can use the LENGTH function to count the 
number of characters in a piece of text. The 
formula = LENGTH(A7) performs the same task 
as if you select cell A7 and count the number of 
characters it contains.
Whenever you write complex or repetitive 
formulas, check this chapter to see if Jazz has a 
function that can do the work for you.



Function 
Format

The general format of a function is:
function name(argument1 ,argument2,...)

In SUM(D2..D8), the function name is SUM and the argument is the 
range D2..D8. The function name tells Jazz which specialized calcu­
lation to perform. The function’s argument provides the values that 
the function uses in its calculation. A function produces, or 
returns, a single value, dependent upon the arguments you give it 
to evaluate.

Arguments

Rules for
Using 
Functions 
in Formulas

Arguments are numeric or text values, expressions, cell or range 
references, or even other functions, that the function uses to 
return its value. The following table lists the types of arguments 
you can use and examples of ways to use them in functions.

Types of
Arguments

Examples

Single 
numeric 
value

by number 
by address 
by cell name 
by expression 
by function
by combination

INT(375.68)
INT(D6)
INT(total)
INT(25.8 +47.5/35.5)
INT(SUM(D2..D8))
INT(MAX(D2..D8),total,35.2,G5)

Multiple 
numeric 
values

by numbers 
by addresses 
by range address 
by range name 
by combination

AVG(25,33,67,84)
AVG(B6,G5,H8,J9)
SUM(D2..D8)
SUM(range2)
SUM(range3,D2..D8,35.2,G5)

Single text 
value

by text entry 
by address

LENGTH(“Penny Lane”)
LENGTH(A7)

• A function can only be used as part of a formula. For example, 
the SUM function can be used in the formula = SUM(D2..D8).

• When a function requires two or more arguments, separate them 
with commas; for example, AVG(25,33,67,84).

• When the argument type is text, use double quotes around 
actual text entries, but not around cell names or addresses. For 
example, if the text Penny Lane is in cell A7, you can write 
LENGTH(“Penny Lane”) or LENGTH(A7).
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• The arguments that each function requires must be enclosed in a 
pair of parentheses. If you use a function as an argument, 
enclose its arguments in one pair of parentheses, and enclose the 
function and its arguments in another pair of parentheses. For 
example, the formula = INT(SUM(D2..D8) is not correct. The 
correct formula is = INT(SUM(D2..D8)). D2..D8 is the argument 
for the SUM function, and SUM(D2..D8) is the argument for the 
INT function.

• A few functions do not require arguments. Write them in for­
mulas without any parentheses. For example, the RAND function 
returns a random number in the formula =RAND.

"I Types of 
Functions

Jazz provides the following types of functions:
Mathematical Functions include the general math functions ABS, 
CPYSGN, INT, MOD, RAND, ROUND, SQRT, and the engineering 
functions EXP, EXP1, EXP2, LN, LN1, LOG, PI, and SCALE.
Trigonometric Functions include the trigonometric functions 
SIN, COS, and TAN, and the arc functions ASIN, ACOS, ATAN, and 
ATAN2.
Logical Functions include TRUE, FALSE, IF, ISBLANK, ISERR, 
ISNA, ISNUMBER, ISREF, and ISSTRING.
Financial Functions calculate the FV (future value), PV (present 
value), NPV (net present value), PMT (payment), and IRR (internal 
rate of return).
Calendar Functions include the date functions DATE, 
DATEVALUE, DAY, MONTH, and YEAR, and the time functions 
TIME, TIMEVALUE, HOUR, MINUTE, and SECOND. The NOW 
function returns the present date and time.
Statistical Functions calculate the SUM (sum), AVG (average), 
STD (standard deviation), and VAR (variance) of a group of numeric 
values. MAX and MIN find the maximum or minimum numeric 
value. COUNT returns the number of non-blank cells found in a 
group.
Data Range Functions perform the same calculations as the 
statistical functions do, but on a specified column within a data 
range. They include the DSUM, DAVG, DSTD, DVAR, DMAX, 
DMIN, and DCOUNT functions.
Special Functions are a group of advanced tools that perform a 
variety of complex tasks. CHOOSE, HLOOKUP, VLOOKUP, 
INDEX, N, and S find and return a value in a list or range. COLS 
and ROWS count the number of columns and rows within a range. 
CELL and CELLPOINTER return information about the value in a 
specific cell. ERR and NA are used to specify cells whose values are 
dependent on other cells that contain the values ERR or NA.
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Mathematical 
Functions

Text Functions perform calculations with and manipulate text. 
CHAR, CLEAN, and CODE work with the Macintosh character 
codes. PROPER, UPPER, and LOWER change case. EXACT, FIND, 
LEFT, LENGTH, REPEAT, REPLACE, RIGHT, SUBSTR, and TRIM 
locate and move text and parts of text. FIXED converts a number 
to text and VALUE converts text to a number.
Database Report Functions are used in database report defini­
tions. They perform calculations for a section of a report, a page of 
a report, or for an entire report. They include FAVG, FSUM, FSTD, 
FVAR, FMAX, FMIN, FPREV, FCOUNT, and FPAGE.
In this chapter, functions and their descriptions are listed in groups 
by type. Within each group, they appear alphabetically.

Jazz mathematical functions perform a variety of operations on 
single numeric values. You can enter single numeric values as 
numbers, cell addresses, or arithmetic expressions. The math func­
tions always return single values.

ABS(x) returns the absolute value, or positive form, of x.
Argument: x can be any numeric value.
Examples: = ABS( - 678) returns 678.

= ABS(678) returns 678.

CPYSGN(ro_x,/rom_y) returns the value of with the sign
of from_ y.
Arguments: to_jc and from_y can be any numeric value.
Examples: = CPYSGN(86, - 74) returns - 86.

= CPYSGN(- 86,74) returns 86.

EXP(v) calculates e^x. The number e is 2.7182818.
Argument: x can be any numeric value.
Examples: =EXP(1) returns 2.7182818.

= EXP(2) returns 7.3890561.

EXPl(x) calculates (eAx)- 1.
Argument: x can be any numeric value.
Examples: = EXP 1(2) returns 6.3890561.

= EXPl(18/9) returns 6.3890561.

EXP2(x) calculates 2Ax.
Argument: x can be any numeric value.
Examples: = EXP2( - 2) returns 0.25.

= EXP2(2) returns 4.
= EXP2(2*2) returns 16.
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INT(x) returns the integer part of x. INT truncates the fractional 
part of x. In effect, INT rounds down for positive numbers and 
rounds up for negative numbers.
Argument: x can be any numeric value.
Examples: = INT(35.75) returns 35.

= INT(-35.75) returns -35.
= INT(FV(200,0.075/12,12*3)) returns 8046, rounded 

down from 8046.2763.

LN(x) returns the natural logarithm, or log base e, of x.
Argument: x can be any numeric value greater than 0.
Examples: = LN(2) returns 0.6931471.

= LN(4) returns 1.3862943.

LNl(x) returns the natural logarithm, or log base e, of (1 + x).
Argument: x can be any numeric value greater than - 1.
Examples: = LN1(2) returns 1.0986122.

= LN1(4) returns 1.6094379.

LOG(x) returns the common logarithm, or log base 10, of x.
Argument:
Examples:

x can be any numeric value greater than 0.
= LOG(2) returns 0.3010299.
= LOG(4) returns 0.6020599.

MOD(x, base) returns the remainder (modulo) of (x/base). The 
result has the same sign as x.
Arguments: x can be any integer.

base can be any integer except 0.
Examples: = MOD(15,6) returns 3, the remainder of 15/6. 

= MOD(- 15,6) returns -3.
= MOD(3*5,6) returns 3-
= MOD(5,15) returns 5.
= MOD(15,5) returns 0.

PI returns the value 7T (3-1415927), which is the ratio of a circum­
ference of a circle to its diameter. You can use PI to convert 
degrees into radians for the trigonometric functions. Angle in 
radians = Angle in degrees * (PI/180).
Arguments:
Examples:

None.
= PI returns 3.1415927.
= SIN(30*PI/180) returns 0.5, the sine of 30 degrees.
= PI*4A2 returns 50.265482, or the area of a circle 

whose radius is 4.

Functions
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RAND generates random numbers between 0.0 and 1.0. Each time 
Jazz recalculates the worksheet, RAND generates a new random 
number.
Arguments: None.
Examples: =RAND could return .87320723.

= RAND* 10 returns a number between 0.0 and 10.
= INT(RAND* 10) returns integers between 0 and 10.

ROUNDix noplaces) returns the value of x rounded to n__places.
If n_places is positive, then x is rounded n_places to the right of 
the decimal point.
If ri—places is zero, then x is rounded to an integer.
If ii—places is negative, then x is rounded to the nearest multiple 
of 10 specified by n_places. For example, if n_places is -2, then 
x is rounded to the hundreds place. If noplaces is - 1, then x is 
rounded to the tens place.

Arguments: x can be any numeric value.
n_ places can be any numeric value from - 15 to

+ 15, inclusive.
Examples: = ROUND(145.258,3) returns 145.258.

= ROUND(145.258,2) returns 145.26.
= ROUND(145.258,1) returns 145.3.
= ROUND(145.258,0) returns 145.
= ROUND(145.258, - 1) returns 150.
= ROUND(145.258, - 2) returns 100.

SCALE(x,power) calculates x*2A(INT(power)). The SCALE function 
converts power to an integer value before calculating 2'''power.
Arguments: x can be any numeric value.

power can be any numeric value.
Examples: = SCALE(4,3) returns 32, or 4*(2A3).

= SCALE(-4,3) returns -32, or -4*(2A3).

SQRT(x) returns the positive square root of x.
Argument: x can be any positive numeric value.
Examples: = SQRT(25) returns 5.

= SQRT(20 + 5) returns 5.

T rigonometric 
Functions

The Jazz trigonometric functions can be divided into two groups. 
The first group computes the basic trigonometric functions: the 
sine, cosine, and tangent. The second group computes the arc 
functions: the arcsine, arccosine, 2-quadrant arctangent, and 
4-quadrant arctangent.
All angles that you enter for the trigonometric functions must be in 
radians. To convert from degrees to radians, multiply the number 
of degrees by (PI/180).
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The arc functions return all angles in radians. To convert from 
radians to degrees, multiply the number of radians by (180/PI).

ACOS(x) returns the angle whose cosine is x. The result is always 
between 0 and 7T (Quadrant I or II).
Argument: x must be a value between - 1 and + 1, inclusive.
Examples: = ACOS(.5) returns 1.05 radians.

= ACOS(.5)* 180/PI returns 60 degrees.

ASIN(x) returns the angle whose sine is x. The result is always 
between - 7T/2 and 7F/2 (Quadrant IV or I).
Argument: x must be a value between - 1 and + 1, inclusive.
Examples: = ASIN(.5) returns 0.52 radians.

= ASIN(.5)* 180/PI returns 30 degrees.

ATAN(x) returns the angle whose tangent is x. The result is always 
between - 7T/2 and 7T/2 (Quadrant IV or I).
Argument:
Examples:

x can be any numeric value.
= ATAN(.5) returns 0.46 radians.
= ATAN(.5)* 180/PI returns 26.56 degrees.
= ATAN(1) returns 0.79 radians.

ATAN2(xy) returns the angle whose tangent is y/x. The result is 
returned for any quadrant, and ranges in value from - ir to 7F, 
whereas ATAN(x) only returns values from - 7T/2 to tt/2.
Arguments: x and y can be any numeric values. If x is positive,

Examples:

both arctangent functions return the same value, x 
and y cannot both equal 0.

= ATAN2(-3,3) returns 2.36 radians (Quadrant II). 
= ATAN2(3,-3) returns -0.785 radians (Quadrant IV).

The following table lists the range of values of = ATAN2(x,y):

If x is: and y is: = ATAN2(x,y) is:

positive 
negative 
negative 
positive

positive 
positive 
negative 
negative

between 0 and 7T/2 
between 7F/2 and ir 
between - 7T and - 7T/2 
between - tt/2 and 0

Functions

COS(x) returns the cosine of angle x. The result is always between 
- 1 and 1, inclusive.
Argument: x can be any numeric value, and is the size of the 

angle (in radians).
Examples: = COS(PI) returns - 1.

= COS(60*PI/180) returns 0.5.
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SIN(x) returns the sine of angle x. The result is always between - 1 
and 1, inclusive.

Logical 
Functions

Argument: x can be any numeric value, and is the size of the 
angle (in radians).

Examples: = SIN(PI/2) returns 1.
= SIN(30*PI/180) returns 0.5.

TAN(x) returns the tangent of angle x.
Argument: x can be any numeric value, and is the size of the 

angle (in radians).
Examples: = TAN(PI/4) returns 1.

= TAN(30*PI/180) returns 0.58.

The Jazz logical functions return values based upon the result of a 
conditional statement. A conditional statement evaluates a given 
condition, which is usually an equation comparing two numbers, 
functions, formulas, or text values. The result of the evaluation is 
either TRUE (1) or FALSE (0).
Generally, when a condition is found to be TRUE, Jazz takes 
one action. When a condition is found to be FALSE, Jazz 
takes a different action. For example, if Balance is a cell 
containing a numeric value, then the conditional statement 
IF(Balance> = 0,Balance,“Overdrawn”) evaluates the equation 
Balance> =0. It returns the numeric value in Balance when the 
balance is positive, and returns Overdrawn when the balance is 
negative.

FALSE is the value 0. FALSE, or 0, is returned when a condition is 
not true.
Arguments: None.
Examples: = FALSE = TRUE returns 0.

= “I Love Lucy” = “I Love New York” returns 0.
= A7>A8 returns 0 if the value in A7 is not greater 

than the value in A8.

lT(cond, t,f) returns t when condition cond is TRUE. IF returns f 
when cond is FALSE.
Arguments: cond can be any expression or logical condition that 

evaluates to TRUE or FALSE.
t can be text or numeric.
f can be text or numeric.

Examples: = IF(9>8,C3,D3) returns the value in C3, because the
condition 9>8 is TRUE.

= IF(Close>35,“Sell”,Close) returns Sell when the 
value in Close is greater than 35, and the value 
Close when it is less than or equal to 35.
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ISBLANK(ceZZ) returns 1 (TRUE) when cell is empty; otherwise, it 
returns 0 (FALSE).
Argument: cell is a cell name or address.
Examples: = ISBLANK(A5) returns 0 when cell A5 contains any 

text or numeric value.
= IF(ISBLANK(A5),“Skip”,Total+ A5) returns Skip 

when cell A5 is blank; otherwise, it adds the value 
in A5 to the value in Total.

ISERR(ceZZ) returns 1 (TRUE) when cell contains the value ERR; 
otherwise, it returns 0 (FALSE).
Argument: cell is a cell name or address.
Examples: = ISERR(H3) returns 0 when the value in H3 is text, 

numeric, NA, REF, or blank.
= IF(ISERR(H3),“Error”,“OK”) returns Error when cell 

H3 contains ERR; otherwise, it returns OK.

ISNA(ceZZ) returns 1 (TRUE) when cell has the value NA; otherwise 
it returns 0 (FALSE).
Argument: cell is a cell name or address.
Examples: = ISNA(G9) returns 0 when the value in G9 is text, 

numeric, ERR, REF, or blank.
= IF(ISNA(G9),“No number”,G9+ 10) returns No 

number when G9 contains the value NA; other­
wise, it returns the result of G9 + 10.

ISNUMBER(ceZZ) returns 1 (TRUE) when cell has a numeric value; 
otherwise, it returns 0 (FALSE). Numeric values also include dates, 
times, currency, and percentage values.
Argument: cell is a cell name or address.
Examples: = ISNUMBER(J5) returns 0 when the value in J5 is text, 

ERR, NA, REF, or blank.
= IF(ISNUMBER(J5),J5 +J6,“Can’t add”) returns the 

result of J5+J6 if J5 contains a numeric value; 
otherwise, it returns Can't add.

ISREF(ceZZ) returns 1 (TRUE) when cell has the value REF; other­
wise, it returns 0 (FALSE).
Argument:
Example:

cell is a cell name or address.
= ISREF(M9) returns 0 when the value in M9 is 

numeric, text, ERR, NA, or blank.
= IF(ISREF(M9),"Recalc”,“OK”) returns Recalc when 

cell M9 contains REF; otherwise, it returns OK.

Functions
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Financial 
Functions

ISSTRING(ceZZ) returns 1 (TRUE) when cell contains text; other­
wise, it returns 0 (FALSE).
Argument: cell is a cell name or address.
Examples: = ISSTRING(B9) returns 0 when the value in B9 is

numeric, ERR, NA, REF, or blank.
= IF(ISSTRING(B9),B9,“No”) returns the text in B9 

when B9 contains text; otherwise, it returns No.

TRUE is the value 1. TRUE, or 1, is returned when a condition is 
true.
Arguments: None.
Examples: = TRUE = TRUE returns 1.

= FALSE = FALSE returns 1 because 0 equals 0.
= 25 = 5*5 = 20+ 5 returns 1 because 25 equals (5*5) 

equals (20 + 5).

The Jazz financial functions make calculations concerning loans, 
annuities, and cash flows that occur over a term, or period of time.
You can enter interest rates as either percents or decimal fractions. 
For example, you can type 15.5% either as 15.5% or as .155. Jazz 
automatically converts all percentages to decimal values for you.
Remember that the term and the interest rate must be expressed in 
the same time periods. For example, if you want to calculate a 
monthly payment, and the interest and term are given in years, 
then divide the yearly interest rate by 12 to find the monthly 
interest, and multiply the term by 12 to get the number of 
payment periods.
In the following examples, all monetary function results are 
returned in cells formatted as Currency, 2, and all percentage 
results are returned in cells formatted as Percent, 2.

FVJpmZ, int, term) calculates the future value of a series of pay­
ments, each of amount pmt, earning periodic interest rate int, over 
the number of payment periods specified in term. Jazz assumes that 
the first payment takes place at the end of the first payment 
period. Jazz also assumes that the last payment is made at the end 
of the last period, and earns no interest.
Arguments: pmt is the amount of each payment. 

int is the periodic interest rate. 
term is the number of payment periods.

Example: = FV(200,7.5%/12,12 *3) returns $8,046.28, or the
future value of a series of $200 monthly payments, 
earning 7.5% interest annually, made over a three 
year period. The actual amount of money you 
invest is $7,200.
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IRR(guess.range) calculates the internal rate of return for the range 
containing the cash flow values. Jazz bases the calculation on a 
series of approximations for the internal rate of return. Because 
this function could have more than one possible solution, you 
must enter a guess as the first argument to ensure that the function 
finds the correct solution. Make a reasonable estimate of the inter­
nal rate of return. If the resulting value doesn’t seem reasonable, 
try another guess.
Arguments: guess is the percentage representing your guess of the 

internal rate of return.
range is the cell range containing the cash flow 

amounts. Jazz considers negative numbers as cash 
outflows, and positive numbers as cash inflows.

Examples: = IRR(5%,B1 ..B13) returns 6.11% over a one-year
term, if the initial payment is $1000 and the 12 
periodic receipts are each $120. In range B1..B13, 
Bl contains the value - 1000, and B2..B13 each 
contain the value 120.

= IRR(5%,C1..C13) returns 7.09% over a one-year 
term, if the initial payment is $1000 and the 12 
periodic receipts are: $120, $124, $128, $132, 
$136, $130, $120, $124, $128, $132, $120, 
and $124.

tiPN(int, range) calculates the present value of range, which con­
tains a series of future cash flows, at periodic interest rate int. Jazz 
assumes that the cash flows occur at equal time intervals, and the 
first cash flow occurs at the end of the first payment period.
Arguments: mt is the periodic interest rate.

range is the range containing the cash flows.
Example: = NPV(10%,Dl..D12) returns $340.69, if the assumed

interest rate is 10% and D1..D12 contains 12 
future cash flows, each of which is $50.

PMT(pr/n, zwt, term) calculates the amount needed per payment to 
pay off a loan of amount prin, at periodic interest rate int, over 
the number of payment periods specified in term.
Arguments: prin is the principal, or amount of the loan.

int is the periodic interest rate of the loan. 
term is the number of payment periods.

Example: = PMT(1OOO,1O%/12,12) returns $87.92 as the monthly
payment needed to pay off a 12-month loan of 
$1000 at 10% interest.
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PN (pmt, int, term) calculates the present value of a series of pay­
ments, each of amount pmt, collecting periodic interest rate z'nf, to 
be made over the number of payment periods specified in term. 
Jazz assumes that the first payment takes place at the end of the 
first payment period. Jazz assumes that the last payment is made at 
the end of the last period, and earns no interest.
Arguments: pmt is the amount of each payment.

int is the periodic interest rate.
term is the number of payment periods.

Example: = PV(50,15 %/l 2,12) returns $553-97, which is equiva­
lent to putting $50 each month for a year into a 
bank account earning 15% annually.

Calendar 
Functions

The Jazz calendar functions use serial numbers to represent dates 
and times. Serial numbers can be integers (31340), fractions 
(.3545717), or mixed numbers (31340.3545717).
Each date between midnight December 31, 1903 and midnight 
February 6, 2040 corresponds to the integer part of a serial num­
ber, called the date number. Date numbers are the number of days 
since December 31, 1899- They range from 1460, for January 1, 
1904 to 51170, for February 6, 2040. You can use date numbers in 
functions to get information about the year, month, and day of the 
month.
The fractional part of a serial number corresponds to a time of the 
day. This is called the time number. Time numbers range from 
0.000, for midnight of the previous day, to 0.999, for just before 
midnight of the current day. You can use time numbers in 
functions to get information about the hour, minute, and second 
of a day.
Jazz can display date and time numbers in various date and time 
formats, but stores them internally as numbers. Because they are 
stored as numbers, you can use them in formulas. For example, the 
date 22-Oct-85 and the time 8:30:35 AM are stored as the serial 
numbers 31340 and .3545717. Jazz uses the integer part of a num­
ber for calculating dates and the fractional part for calculating 
times.

DATE(jr, mon, day) returns the date number for yr, mon, day.
Arguments: yr is an integer between 4 (1904) and 140 (2040), 

representing the year.
mon is an integer between 1 and 12, representing the 

month.
day is an integer between 1 and 31, representing the 

day of the month. The number must be appropri­
ate to the given month. (It is not valid to use 30 
for February.)
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Examples: = DATE(85,10,22) returns 31340.
= DATE(85,10,22) returns 22-Oct-85 in a cell formatted 

as dd-mmm-yy.
= DATE(85,10,22) returns 10/22/85 in a cell formatted 

as mm/dd/yy.

DATEVALUE(rf_fxf) returns the date number for the text date 
d—txt. This function performs the same calculation as the DATE 
function, except it uses text instead of number values as its
argument.
Argument: d—txt must be a date, written as text, in one of the 

Jazz date formats.
Examples: = DATEVALUE(“22-Oct-85”) returns 31340.

= DATEVALUE(“10/22/85”) returns 31340.
= DATEVALUE(“Oct-85”) returns 31319, for Oct 1, 

1985.
= DATEVALUE(“22-Oct”) returns the date number for 

Oct 22 of the present year.

DAYuLwm) returns the day value (1 to 31) of date number 
d_num.
Argument: d_num is an integer, or the integer part of a fixed 

number, representing a date number.
Examples: Because = DATE(85,10,22) returns 31340, then

= DAY(31340) returns 22, for the 22nd of the month.
If date number 31340 is in a cell named datenum, then 
= DAY(datenum) also returns 22.

HOUR(Lnwm) returns the hour value (0 to 23) of time number 
t_num
Argument: t_num is a fraction, or fractional part of a number, 

representing a time number.
Examples: Because = TIME(8,30,35) returns 0.3545717, 

then = HOUR(0.3545717) returns 8, for 8 AM.
If time number 0.3545717 is in a cell named timenum, 
then = HOUR(timenum) also returns 8.
= HOUR(l/4) returns 6, for 6 AM.
= HOUR(3/4) returns 18, for 6 PM.
= HOUR(l/7) returns 3, for 3 AM.
= HOUR(31340.623287) returns 14, for 2 PM. Functions
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MINUTE(r_w«m) returns the minute value (0 to 59) of time 
number t_num.
Argument: t_num is a fraction, or fractional part of a number, 

representing a time number.
Examples: Because = TIME(8,30,35) returns 0.3545717, then

= MINUTE(0.3545717) returns 30, for 30 minutes after 
the hour.
If time number 0.3545717 is in a cell named timenum, 
then = MINUTE(timenum) also returns 30.
= MINUTE) 1/7) returns 25.

MONTH(rf_nwzn) returns the month value (1 to 12) of date 
number d_num.
Argument: d_num is an integer, or integer part of a number, 

representing a date number.
Examples: Because = DATE(85,10,22) returns 31340, then

= MONTH(31340) returns 10, for October.
If date number 31340 is in a cell named datenum, then 
= MONTH(datenum) also returns 10.
= MONTH(31340.623287) returns 10, for October.

NOW returns the serial number for the present date and time. The 
integer part of the serial number is the date number, and the frac­
tional part of the serial number is the time number. You can use it 
in calculations and with the DAY, MONTH, YEAR, HOUR, 
MINUTE, and SECOND functions. Jazz updates the serial number 
whenever you recalculate the worksheet.
Arguments: None.
Examples: If the present date is October 22, 1985, and the 

present time is 2:57:32 PM, then
= NOW returns 31340.623287,
= MONTH(NOW) returns 10, for October, and
= HOUR(NOW) returns 14, for 2 PM.

SECOND(f_wwm) returns the second value (0 to 59) of time 
number t__num.
Argument: t_num is a fraction, or fractional part of a number, 

representing a time number.
Examples: Because = TIME(8,30,35) returns 0.3545717, then

= SECOND(0.3545717) returns 35, for 35 seconds.
If time number 0.3545717 is in a cell named timenum, 
then = SECOND(timenum) also returns 35.
= SECOND(l/7) returns 42.
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Statistical 
Functions

Tlt&E(br,min,sec) returns the time number for br,min,sec.
Arguments: hr is an integer from 0 to 23 representing the hours, 

mm is an integer from 0 to 59 representing the 
minutes.

sec is an integer from 0 to 59 representing the 
seconds.

Examples: = TIME(8,30,35) returns 0.3545717.
= TIME(8,3O,35) returns 8:30:35 AM to a cell formatted 

as HH:MM:SS AM/PM.
= TIME(2O,3O,35) returns 0.845717.
= TIME(20,30,35) returns 8:30:35 PM to a cell 

formatted as HH:MM:SS AM/PM.

TIMEVALUE(r_rxt) returns the time number of the text time t_Jxt. 
It performs the same calculation as the TIME function, except it 
uses text instead of numeric values as its argument.
Argument: t_txt is a time of the day, written as text, in one of 

the Jazz time formats.
Examples: = TIMEVALUE(“8:30:35 AM”) returns 0.3545717.

= TIMEVALUE(“8:30 PM”) returns 0.8541666. 
= TIMEVALUE(“2O:3O:35”) returns 0.8545717.
= TIMEVALUE(“2O:3O”) returns 0.8541666.

YEAR(rf_«Mm) returns the year value (4 to 140) of date number 
d_num. Year value 4 is the year 1904, and 140 is the year 2040.
Argument: d_num is an integer, or integer part of a number, 

representing a date number.
Examples: Because = DATE(85,10,22) returns 31340, then

= YEAR(31340) returns 85, for the year 1985.
If 31340 is in a cell named datenum, then
= YEAR(datenum) also returns 85.
= YEAR(51170) returns 140, for the year 2040.

The Jazz statistical functions perform calculations on lists of values. 
A list contains one or more arguments. Each argument in the list 
can be a single numeric value or a range of numeric values. 
Numeric and text values can be used with the COUNT function.
All statistical functions ignore blank cells found in a list or range. 
All statistical functions other than the COUNT function ignore cells 
containing text values. For example, if you use the AVG function 
to average the numeric values in a range that spans 8 cells, and 
there is a blank cell and a cell containing text within that range, 
Jazz divides the sum by 6 to find the correct average.

unctions

95 Functions



All examples in this section are based on the Weekly Sales work­
sheet. All monetary function results are returned in cells formatted 
as Currency, 2.

A 6 c D E
1 DAY/DATE BOOKS SOLD DAILY SALES WEEKLY TOTALS o|
2 Mondi-19) 38 $286 90 Total sales $3,462 10

3 Tue( 11-20) 53 $583 00 Avg sales amt $577 02

4 Weddl-21) 49 $428.75 Highest amt $1 .044 00

5 Thu(closed) Lowest amt $286 90 ■
6 Fri(1 1-23) 51 $507 45 Days open 6

7 Sat< 1 1-24) 87 $1 .044 00 Total books sold 346

8 Sund 1-25) 68 $612 00 Avg sold daily 58

9 Variance 249 22

10 Std Dev 15 79

1 1 H

A.VG(arg_lisf) averages the numeric values in the arg_list.
Argument: arg_list must contain numeric values.
Examples: = AVG(C1..C8) returns $577.02, the average sales 

amount.
= AVG(B1..B8) returns 58, the average number of 

books sold.

COUNT(«rg_/z'sf) counts the non-blank cells in arg_list.
Argument: arg_list can contain either numeric or text values.
Examples: = COUNT(C2..C8) returns 6, the number of days open. 

= COUNT(C5) returns 0, because it is blank.
= COUNT(B1 ,.C8) returns 14, ignoring blank cells.

MAX(flrg_
Argument:

.list) returns the maximum numeric value in arg_list. 
arg_ list must contain numeric values.

Examples: = MAX(C1..C8) returns $1044.00, the highest daily 
sales amount for the week.

= MAX(B1..B8) returns 87, the highest number of 
books sold in one day.

MIN(«rg_
Argument:

Zz'sf) returns the minimum numeric value in arg_list. 
arg_list must contain numeric values.

Examples: = MIN(C1..C8) returns $286.90, the lowest daily sales 
amount for the week.

= MIN(B1..B8) returns 38, the lowest number of books 
sold in one day.
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STD(<arg_Zz'sZ) finds the standard deviation of the numeric values in 
arg_list by taking the square root of the variance. The formula 
used is = SQRT(VAR(arg_ZzsZ)).
For many statistical calculations, you may want a sample standard 
deviation. You can compute this by using the following formula:
= SQRT(COUNT(«rg_Zzsf)/(COUNT(r?rg_ZzsZ) - 1)) * STD(<?rg_Zz st)
Argument: arg_list must contain numeric values.
Example: = STD(B1..B8) returns 15.79, the standard deviation

for books sold that week.

SUM(arg_ZzsZ) sums the numeric values in arg__list.
Argument: arg_ list must contain numeric values.
Examples: =SUM(C1..C8) returns $3462.10, the total sales

amount for the week.
= SUM(B1..B8) returns 346, the total number of books 

sold that week.
VAR(<rzrg_Zz'sZ) finds the population variance of the numeric values 
in arg_list with the following formula:

n(Sx2) - (Sx)2 n is the number of arguments in
^2 arg_list, or = COUNT(«rg_ ZzsZ).

x is one argument in arg_list.

For many statistical calculations, you may want a sample variance. 
You can compute this by using the following formula:
= (COUNT(arg_Zz'sZ)/(COUNT(rzrg_ZzsZ) - 1))* VAR(<arg_ZZsf).
Argument: arg._ list must contain numeric values.
Example: =VAR(B1..B8) returns 249.22, the variance for books

sold that week.

Data Range 
Functions

The Jazz data range functions treat one range of the worksheet as a 
database and another range as a database query. The first range is 
the data range and the second is the criterion range. You can per­
form statistical calculations on a column of cells within the data 
range in rows selected by criteria you set up in the criterion range. 
Each function scans the input data range inp and selects the rows 
within that range that match the contents of your criterion range 
crit. Each function then counts over to the column number you 
have specified col, and calculates the cells in that column that are 
selected by your criteria. Remember that the first column in the 
input range is column 0 and the first row contains the names of 
each column.
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In the Trip Expenses worksheet below, the input range is A1..E7. 
To the right of the input range are three criterion ranges, which 
can be set up anywhere on the worksheet outside of the input data 
range. A criterion range consists of one or more column titles from 
the input range and the criterion you want to meet from those 
columns. For example, the first criterion range consists of the 
column title City and the criterion Toronto. When Jazz makes cal­
culations using this criterion range, it only works on rows that 
contain information about Toronto.
All examples of the data range functions are based on the Trip 
Expenses worksheet. All monetary function results are returned in 
cells formatted as Currency, 2.

Input range

Criterion ranges

A 1 B
Trip E

C 1
»pense<

D E F G
1 Day City Gas Hotel Food City
2 Day 1 Toronto $18 25 $45 75 $28 00 Toronto
3 Day 2 Toronto $6 85 $45 75 $26 00 —4
4 Day 3 Ottawa $24 38 $38 50 $24 75 City
5 Day 4 Montreal $8 75 $45 25 $35 00 .......J Montreal
6 Day 5 Montreal $4 55 $40 25 $32 00 /
7 Day 6 Montreal $1 1.351 $45 25 $29.00 / City
8 / Toronto
9 / Ottawa

10
—H-

Montreal

DAVG(zw/>, co/, crz7) averages the numeric values in column col of 
input range inp, for the rows selected by criterion range crit.
Arguments: inp is the input range.

col is the input range column number.
crz'f is the criterion range.

Examples: = DAVG(A1 ..E7,4,G4..G5) returns $32.00, the average 
spent on food in Montreal.

= DAVG(A1 ..E7,2,G4..G5) returns $8.22, the average 
spent on gas in Montreal.

DCOUNT(m/t, col, crit) counts the non-blank cells in column col of 
input range inp, for the rows selected by criterion range crit.
Arguments: inp is the input range.

col is the input range column number.
crit is the criterion range.

Example: = DCOUNT(A1 ,.E7,O,G1 ..G2) returns 2, the number of
days spent in Toronto.

DMAX(inp,col,crit) finds the maximum numeric value in column 
col of input range inp, for the rows selected by criterion range 
crit.
Arguments: inp is the input range.

col is the input range column number. 
crit is the criterion range.

Example: = DMAX(A1 ,.E7,4,G7..G10) returns $35.00, the most
spent in all three cities on food.
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Special 
Functions

DMIN(f«p, co/, crz?) finds the minimum numeric value in column col 
of input range inp, for the rows selected by criterion range crz'h 
Arguments: inp is the input range.

col is the input range column number.
crit is the criterion range.

Example: = DMIN(A1..E7,4,G7..G1O) returns $24.75, the least
spent in all three cities on food.

DSTDp'np, col, crit) computes the standard deviation of the numeric 
values in column col of input range inp, for the rows selected by 
criterion range crit.
Arguments: inp is the input range.

col is the input range column number. 
crit is the criterion range.

Example: = DSTD(A1 ,.E7,2,G7..G10) returns $6.88, the standard
deviation of the amount spent in all three cities on 
gas.

DSUM(m/>, col, crit) sums the numeric values in column col of input 
range inp, for the rows selected by criterion range crit.
Arguments: inp is the input range.

col is the input range column number.
crit is the criterion range.

Example: = DSUM(A1 ,.E7,2,G4..G5) returns $24.65, the total
amount spent on gas in Montreal.

T)NAR(inp, col, crit) computes the variance of the numeric values in 
column col of input range for the rows selected by criterion 
range crit.
Arguments: inp is the input range.

col is the input range column number.
crit is the criterion range.

Example: = DVAR(A1..E7,2,G7..G1O) returns $47.43, the variance
of the amount spent in all three cities on gas.

The Jazz special functions perform a variety of tasks. HLOOKUP, 
VLOOKUP, and INDEX look up values in a range. N and S tell 
whether a specified cell in a table or a range contains a numeric or 
text value. ROWS and COLS count the number of rows or columns 
in a range. CHOOSE returns a value from an argument list based on 
its position in the list. CELL and CELLPOINTER give information 
about the data contained in a specified cell. ERR and NA locate and 
mark cells whose formulas are dependent upon other cells containing 
the values ERR or NA.
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In range lookups, the index row is row 0 and the index column 
is column 0. In list lookups, the first argument in the list is 
argument 0.

CELL(attrib,cell) returns the code that represents an attribute, such as 
the column-width or format, of cell.
Arguments: attrib must be one of the attributes listed in the table 

below.
cell is the cell you are testing.

The following table illustrates the cell property names and codes 
returned.

If attrib is: The result is:

“address”

“row”

“col”

“type”

“width”

“format”

an address, such as B7

a row number (between 1 and 8192)

a column number (between 1 and 256)

b, if blank
n, if a numeric value
t, if a text value

the number of m’s that fit into a cell in the current 
column width.

blank, if default format

(nn is number of decimal places) 
fix nn, if fixed numeric 
sci nn, if scientific numeric 
cur nn, if currency 
per nn, if percent
com nn, if numeric with commas

gen, if general numeric 
bar, if bar graph 
for, if formula text

tim 1, if HH:MM:SS AM/PM
tim 2, if HH:MM AM/PM
tim 3, if HH:MM:SS, 24 hr. 
tim 4, if HH:MM, 24 hr.

dat 1, if DD-MMM-YY
dat 2, if DD-MMM 
dat 3, if MMM-YY 
dat 4, if MM/DD/YY

txt le, if left-aligned text 
txt ri, if right-aligned text 
txt ce, if centered text 
txt re, if repeated text
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Examples: = CELL(“type”,D6) returns b if D6 is blank, n if it con­
tains a numeric value, or t if it contains a text value.

= CELL(“format”,D6) returns txt le if D6 is formatted as 
text, left-aligned.

= CELL(“format”,H9) returns fix 3 if H9 is formatted as 
a fixed number with 3 places to the right of the 
decimal.

CELLPOINTER(«»r/fc>) returns the code representing an attribute 
of the active cell. The attribute is updated when you recalculate.
Argument: attrib must be one of the attributes listed in the table 

for the CELL function.
Examples: = CELLPOINTER(“row”) returns 28 if the active cell is 

in row 28.
= CELLPOINTER(“format”) returns tim 1 if the active 

cell contains a time formatted as HH:MM:SS 
AM/PM.

CHOOSER, argO, argl,...) returns the rath argument in argument list 
(argO,argl,...).
Arguments: n is the number that selects the argument from the

Examples:

argument list.
arg0,argl,... can be text, numbers, formulas, or cell 

addresses.
= CHOOSE(0,' ‘John”, “Paul”, “George”, “Ringo”) 

returns John because it is argument number 0.
= CHOOSE(3,1978,1979,1980,1981,1982) returns 1981 

because it is argument number 3.

COLS(rarage) counts the number of columns in range. This func­
tion is helpful when used with named ranges.
Argument: range is the input range.

A T B !
= Test

C 1
Scores = 

t1 ! E 1 F ~G 1
1 Student Score 1 Score 2 Score 3 Score 4 Score 5 Score 6

2 Almeida ,J 88 83 5 92 5 89 87 92 1—

3 Berman,R 91 89 5 83 93 85 91 5

4 Blake,M 84 87 94 5 92:

5 Corita,M 91 93 5 86 89 88

Examples: = COLS(Almeida) returns 6 because the range named
Almeida, B2..G2, contains 6 columns.

= COLS(Blake) returns 4, because the range named 
Blake, B4..E4, contains 4 columns.

= COLS(scores) returns 6, because the range named 
scores, B2..G5, contains 6 columns.
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ERR returns the value ERR. Any formula that refers to a cell con­
taining a value of ERR returns the value ERR. Therefore, this func­
tion prevents a chain of inaccurate calculations from continuing 
throughout a worksheet.
Arguments: None.
Examples: = IF(G6 = 0,ERR,MOD(G5,G6)) returns ERR if the value

in G6 is 0; otherwise, it performs the MOD 
function.

= IF(Height< 10,ERR,Height) returns ERR if the cell 
named Height is less than 10; otherwise, it returns 
the value Height.

HLOOKUPixeZ. zbZ_ range, n_ rows') finds a value in a table by 
performing a horizontal lookup. HLOOKUP searches across the 
top, or index, row in tbl_range until it locates a value with selec­
tor sei, and stops at that cell. HLOOKUP stays in that column and 
counts n_rows below the index row and returns the value found 
in that cell. Jazz can find either a text value or a numeric value. 
The lookup process differs slightly for each data type.
Arguments: sei must be text for a text lookup (when the index 

row contains text), sei must be a numeric value 
for a numeric lookup (when the index row con­
tains numbers).

tbl_range is the range of the lookup table, including 
the index row.

n__rows can be any positive integer, and is the 
number of rows to move below the index row.

Text Lookup: Jazz searches the index row for a cell with a text 
value that matches sei exactly. This search is case sensitive. For 
example, selector “Total” finds Total, but not total. When the 
matching value is found, Jazz moves n_rows below the index row 
in the same column, and returns the value found in that cell. If 
no text value matches sei, then Jazz selects the last value.

Index row —

Table range

"-----------\
Student Readi ng Spelling Lang Arts Hath Soo Studies Average
Bankhead J 88 92.5 86 94 89.5 90.0
Burton, R 91 88.5 96 98.5 93.5 93'5

4 Christie, .J 87.5 91 84 81 85.5 85.8

Examples: = HLOOKUP(“Lang Arts”,Al ,.G4,3) returns 84.
= HLOOKUP(“Soc Studies”,Al..G4,3) returns 85.5.
= HLOOKUP(“Lang Arts”,Al,.G4,1) returns 86.
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Numeric Lookup: Jazz searches the index row in tbl_range until it 
finds a number in a cell that is larger than selector value sei. It 
then backs up one cell, so that it stops at the cell whose value is 
the highest number that is less than or equal to the value in sei.
For example, if the values in the index row are 10, 20, 30, and 40, 
and the selector value is 33, Jazz searches until it reaches 40, and 
then backs up to 30 to do its vertical movement. It now moves 
n_rows below the index row in the same column and returns the 
value found in that cell. In order for a numeric lookup to work, 
the values in the index row must be in ascending order.

Index row

Table range

jin --- - - -- School Pnniilation ■■ . - ■ --

A B 1 C o 1 E T F 1 G\
1955 1960 1965 1970 1975 1980

Kinder 83 95 81 68 54 63
First 85 106 1 10 96 92 95
Second 79 1 14 108 110 87 88

5 Thi rd 88 1 15 120 105 95 84

Numeric
Examples: = HLOOKUP(1967,Al ,.G5,2) returns 110.

= HLOOKUP(1967,A1..G5,3) returns 108. 
= HLOOKUP(1981,A1..G5,4) returns 84.

lNDEX(range,col,row') returns the value of the cell located at the 
intersection of col and row, counting from the top left corner of 
range.
Arguments: range is the input range.

col is the number of columns to count over from the 
first column (which is column 0).

row is the number of rows to count down from the 
top row (which is row 0).

| A B
stocks

c
-Monthly 

D E F G -L-

1 Stock No Month 1 Month 2 Month 3 Month 4 Month 5 Month 6 fl

2 1 66 69 25 71 70 5 72 74 -

3 2 15 75 145 14 5 13 75 14 14 25

4 3 28 5 28 33 31 75 32 5 38 5 37

5

Examples: = INDEX(A1 ..G4,5,2) returns 14, Month 5’s closing
price for stock 2.

= INDEX(A1..G4,5,3) returns 38.5, Month 5’s closing 
price for stock 3.

= INDEX(A1..G4,2,1) returns 69.25, Month 2’s closing 
price for stock 1.
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grange) returns the value in the upper left corner cell in range. If 
the upper left cell in range contains a numeric value, N returns 
that number. If it is not a number, N returns the value 0.
Argument: range is the input range.

i=n= — .....................

A 6 C 1 D T~ E F G ■i ? :
1 1979 1980 1981 1982 1983 1984 fl
2 Pent $2,820 $2,400 $2,700 $3,600 $4,200 $4.SOO

3 Gas $900 $840 $984 $1 .008 $1 .032 $1 056 LJ
4 Electric $336 $240 $276 $312. $348 $396

5

Examples: = N(B1) returns 1979.
= N(B1..G4) returns 1979.
= N(A1..G4) returns 0, because Al is blank.

NA assigns the value NA (not available) to a cell, and to any cell 
whose formula is dependent upon the cell containing NA. This 
function acts as a place holder in the worksheet when you are 
unable to enter a value needed to complete a formula by 
displaying NA in all cells that depend on that value.
Arguments: None.
Examples: = NA returns NA to A5 if it is the cell in which you 

enter the formula.
= A6 + A5 returns NA because it is dependent on A5.
= A7 + A6 returns NA if A6 is dependent upon A5.

ROWS(rawge) returns the number of rows found in range. This 
function is helpful when used with named ranges.
Argument: range is the input range.

ih
h
T 
g

A B
lest

C
Scores =
~D E F " G Of

1 Student Score 1 Score 2 Score 3 Score 4 Score 5 Score 6 fl]
2 Al meida,J 88 83 5 92 5 89 87 92

3 Berman,P 91 89 5 83 93 85 91 5 1
4 Blake.M 84 87 94 5 92

5 Corita.M 91 93 5 86 89 88

Examples: = ROWS(Score 1) returns 4, because the range named 
Score 1, B2..B5, contains 4 rows.

= ROWS(Score 2) returns 3, because the range named 
Score 2, C2..C4, contains 3 rows.

= ROWS(scores) returns 4 because the range named 
scores, B2..G5, contains 4 rows.
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Sfrange) returns the value of the upper left corner cell in range. If 
the upper left cell in range is text, S returns that piece of text. If it 
is not text, S returns a blank.
Argument: range is the input range.

1
1

-

Examples: = S(A1) returns a blank.
= S(A2..G4) returns Rent.
= S(B1..B4) returns a blank.

VLOOKUPi.wV, tbl_ range, n_ cols) finds a value in a table by per­
forming a vertical lookup, and is similar in principle to a horizontal 
lookup. VLOOKUP searches down the first, or index column in 
tbl_ range until it locates a value with selector sei, and stops at 
that cell. VLOOKUP stays in that row and counts n_cols to the 
right of the index column and returns the value found in that cell. 
Jazz can find either a text value or a numeric value. The lookup 
process differs slightly for each data type.
Arguments: sei must be text for a text lookup (when the index 

column contains text), sei must be a numeric value 
for a numeric lookup (when the index column 
contains numbers).

tbl_ range is the range of the lookup table, 
including the index column.

cols can be any positive integer, and is
the number of columns to count to the right of 
the index column.

Text Lookup: Jazz searches the index column for the text entry 
that matches sei exactly. This search is case sensitive. For example, 
selector “Total” finds Total, but not total. When the matching 
value is found, Jazz moves n_cols to the right of the index 
column in the same row, and returns the value found in that cell. 
If no text value matches sei, then Jazz selects the last value.

Index column

Table range

------ - A B 1 C 1 0 1 E F
ID CODE COMPANY NAME STOCK EXCH CLOSE PREY CLOS NET CHG flj
PPL Purple Computer Nasdaq ($) 24.625 24 0.625
BKB Black'3 Bank London (p) 527 517 10

4 CCM Colorful Camera NYSE($) 72.125. 72.875 -0.75
cr LLB Lemon Laboratories Arnex ($) 27.875 27.125 0.75
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Text
Examples: = VLOOKUP(“PPL”,A1..F5,1) returns Purple

Computer.
= VLOOKUP(“PPL”,A1..F5,2) returns Nasdaq ($). 
= VLOOKUP(“BKB”,A1 ..F5,l) returns Black’s Bank. 
= VLOOKUP(“LLB”,A1..F5,3) returns 27.875.

Numeric Lookup: Jazz searches the index column until it finds a 
number in a cell that is larger than selector value sei. It then backs 
up one cell, so that it stops at the cell whose value is the highest 
number that is less than or equal to the value in sei. For example, 
if the values in the index column are 10, 20, 30, and 40, and the 
selector value is 33, Jazz searches until it reaches 40, and then 
backs up to 30 to do its horizontal movement. It now moves 
ri—Cols to the right of the index column in the same row, and 
returns the value found in that cell. For a numeric lookup to work 
correctly, the values in the index column must be in ascending 
order. If no value in the range is larger than sei, then Jazz uses the 
last value.

Index column

Table range

-[—1-— 77
=L I----

A —c—r D I F G . o
1 Income Status 1 Status2: Stat us 3 Stat us 4 fl I

$35,000 $9,219 $7,265 $1 1,315 $8,531
$35,050 $9,241 $7,282 $ 1 1,339 $8,552

4 $35,100 $9,263 $7,298 $1 1,364 $8,572

5

Numeric
Examples: = VLOOKUP(35023,A1 ,.E4,4) returns $8,531 in a cell

formatted as Currency, 0.
= VLOOKUP(35070,A1..E4,3) returns $11,339 in a cell 

formatted as Currency, 0.
= VLOOKUP(35070,A1..E4,1) returns $9,241 in a cell 

formatted as Currency, 0.

Text 
Functions

The Jazz text functions can count the number of characters in a 
piece of text, find a string of characters within text, replace one 
text entry with another, test whether two pieces of text are exactly 
alike, and remove control characters and excess blank spaces. You 
can also find the Macintosh character code equivalent for any 
character. Text functions can be used in formulas when text values 
are permitted.
Character positions in text begin at position 0. For example, in the 
text Penny Lane, the P is at position 0m the first e is at 1, and the 
first n is at 2. The blank is at position 5, and the last e is at 9.
When specifying a position number, use positive integers. If you 
type 4.5 as a position number, Jazz interprets it as 4. If you type 
- 4 as a position number, Jazz considers it an invalid entry.
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CHAR(code_num) returns the character represented by the Macin­
tosh character code_num. The Macintosh character code set is 
listed in Appendix D.
Argument: code_num can be any integer between 0 and 255, 

inclusive, and corresponds to one of the Macin­
tosh character codes.

Examples: = CHAR(36) returns $.
= CHAR(65) returns A.

CLEAN(tarf) removes all control characters (Macintosh character 
codes between 0 and 31, inclusive) from txt.
Argument: txt is the text entry.
Example: = CLEAN(“aL Monthly Rate<CIO”) returns Monthly

Rate.

CODE(/a7) returns the Macintosh character code for the first 
character in txt.
Argument:
Examples:

txt is the text entry.
= CODE(“A”) returns 65, for uppercase A.
= CODE(‘'Again”) returns 65, for uppercase A.
= CODE(“again”) returns 97, for lowercase a.

EXACT(/xZ/, Zxf2) tests whether two pieces of text are exactly alike. 
Jazz returns 1 (TRUE) when they are the same and 0 (FALSE) when 
they are different.
Arguments: txtl is the first text entry. 

txt2 is the second text entry.
Examples: = EXACT(“text”,“test”) returns 0. 

= EXACT(“TEXT”,“text”) returns 0.
= EXACT(“text”,“text”) returns 1.

FINDto/, in_txt2,pos) returns the position at which the first 
occurrence of txtl begins within in_txt2. Jazz begins searching at 
position pos in in_ txt2. If the sequence is not found, FIND returns
- 1.
Arguments: txtl is the character sequence you want to find. 

in_txt2 is the text you are searching through. 
pos is the character position in in_txt2 at which to 

begin searching for txtl.
Examples: = FIND(“i”,“Where is it?”,0) returns 6.

= FIND(“i”,“Where is it?”,2) returns 6.
= FIND(“i”,“Where is it?”,7) returns 9.

Functions
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ElXET)(x,n_digits) converts number x to text, in fixed format with 
n_digits to the right of the decimal point.
Arguments: x is the numeric value you are converting to text. 

n_digits is the number of digits to the right of the 
decimal point.

Examples: = FIXED(1.234,2) returns 1.23 as text.
= FIXED(56.789,0) returns 57. as text.

LEFT(Ax7, n_chrs) returns the n_chrs in the left part of txt. 
Arguments: txt is the text entry.

n_chrs is the number of characters you want returned. 
Example: = LEFT(“This is text.”,4) returns This.

LENGTH(fxf) counts the number of characters, including spaces, in 
txt.
Argument: txt is the text entry.
Examples: = LENGTH(“half note”) returns 9. 

= LENGTH(“halfpenny”) returns 9.
= LENGTH(“half-mast”) returns 9.

LOWERfat) converts all letters in txt to lowercase.
Argument: txt is the text entry.
Examples: = LOWER(“perCent”) returns percent.

= LOWER(“FIXED Rate”) returns fixed rate.

PROPER(Zxf) converts the letters in txt to uppercase and lower­
case, with the initial letter of each word capitalized.
Argument: txt is the text entry.
Examples: = PROPER(“dallas”) returns Dallas.

= PROPER(“ft. worth”) returns Ft. Worth.
= PROPER(“john, paul, george, and ringo”) returns 

John, Paul, George, And Ringo.

REPEAT(fxf, n_ times) duplicates txt the number of times in 
n_ times.
Arguments: txt is the text entry.

H—times is the number of repetitions.
Examples: = REPEAT(“Hubba”,2) returns HubbaHubba.

= REPEATf‘Hello ”,3) returns Hello Hello Hello .
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9£P1.k.CE(prig_txt,pos,n_chrs,new_txt) removes n_chrs from 
orig_txt beginning at position pos, and then inserts new_txt start­
ing at the same position. REPLACE can use the FIND function to 
locate the original text.
Arguments: orig_txt is the original text entry.

Examples:

pos is the position in orig_txt at which Jazz begins 
removing characters.

n_cbrs is the number of characters you remove. 
new__txt is the replacement text.
= REPLACE(“mUsic”,0,2,“Mu”) returns Music.
= REPLACE(“I like punk rock.”,7,4,“jazz and”) returns 

I like jazz and rock.
= REPLACE(“pizazz”,FIND(“piz”,“pizazz”,0),3, “j”) 

returns jazz. FIND locates piz and returns its start 
position, 0. Then REPLACE removes the 3 charac­
ters beginning at position 0 and substitutes a j.

RIGHT(£rf, n_chrs) returns the n_cbrs in the right part of txt.
Arguments: txt is the text entry.

n_chrs is the number of characters you want returned.
Examples: = RIGHT(“This is a text entry”,3) returns try. 

= RIGHT(“This is a text entry”,5) returns entry.

SUBSTR(fxf,/>os, ri—Chrs) returns the sequence of characters in txt 
starting at position pos that is n_chrs in length.
Arguments: txt is the text entry.

Examples:

pos is the position in txt where the character sequence 
begins.

n_chrs is the number of characters you want returned.
= SUBSTR(“database”,0,4) returns data.
= SUBSTR(“database”,2,3) returns tab.
= SUBSTR(“database”,4,4) returns base.

TRIM(fxf) removes all spaces that precede the first character and 
follow the last character in text txt. TRIM also replaces any con­
secutive spaces embedded inside the text with a single space.
Argument: txt is the text entry.
Examples: =TRIM(“ St. Moritz ”) returns St. Moritz.

= TRIM(“ St. Moritz”) returns St. Moritz.

UPPER(txt') converts all letters in txt to uppercase.
Argument:
Examples:

txt is the text entry.
= UPPER(“dallas”) returns DALLAS.
= UPPER(“ft. worth”) returns FT. WORTH.
= UPPER(“John, Paul, George, and Ringo”) returns

JOHN, PAUL, GEORGE, AND RINGO.
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VALUE(tet) converts txt that looks like a number into its actual 
numeric value. VALUE also converts a number in a particular 
format into its unformatted numeric value.
Argument: txt is the text entry.
Examples: = VALUE(“123.45”) returns the number 123.45.

= VALUE(25%) returns .25.

Database
Report 
Functions

The Jazz database report functions can only be used in database 
report definitions. The FAVG, FCOUNT, FMAX, FMIN, FSTD, 
FSUM, and FVAR functions perform statistical calculations in sec­
tion and report summaries of database reports. The FPREV func­
tion keeps a running total for each record or section of a report. 
The FPAGE function inserts the current page number in a header 
or footer of a report. You specify the formulas for these functions 
in the report definition that you use to produce a report with a 
database.
Below is a sample database sorted by the grade field. The grade 
field is also the break field in your report definition. Enter calcula­
tions for each grade level under Section Summary in the report 
definition. Enter calculations concerning the entire school under 
Report Summary in the report definition. Enter calculations for one 
record under Record Detail Line in the report definition.
All examples of the database report functions are based on the 
School Averages database.

lang arts sot st
School Ruerages 

students
!□!

1 4 Palatini 21: 86 74 89 35 88 25

2 4Rosen 23: 89 23 83 76. 86 35

3 40zava 20; 84 55 89 65 92 45
82 474 4 McCarthy 22: 83 95: 89 66

83 68;5 5 Klemmer 19 85 46; 88 92;

6 SGarcia 24* 86 95 92 46 91 33

7 5 Hood 21 90 34 87 84 88 95

8 6 Anderson 24 94 35 85 48 88.75

9 6 Librandi 22 89 33 83 79; 85.95

10 6 Zera 21 86.74 93 25 90 35

1 1 7;Sanchez 23; 84 36 87 56; 88 25

12 7;Kraus$ 22; 89 23: 83 55; 89.95

13 7;Chen 24 83 27; 86 94 91.25;

14 80'Bryant 22 82 47 84 74 86 55

15 8 Ridlon 23; 83.74 86 72: 84 76
16 8 Qrandall 81.76 85.73 83 43

310 The Handbook



TWGfield) averages the numeric values in field for the selected 
records.

Argument: field is the field containing the data.
Section Summary Example: = FAVG(math) returns the average 

math score for each grade.
Report Summary Example: = FAVG(math) returns the average 

math score for the whole school.

FCOUNT(/ze/rZ) counts the nonblank entries in field for the 
selected records.
Argument: field is the field containing the data.
Section Summary Example: = FCOUNT(lang arts) returns the 

number of language arts scores 
for each grade.

Report Summary Example: = FCOUNTflang arts) returns the 
number of language arts scores 
for the school.

FMAX(/ife/d) finds the maximum numeric value in field for the 
selected records.
Argument: field is the field containing the data.
Section Summary Example: = FMAX(lang arts) returns the highest 

language arts score for each 
grade.

Report Summary Example: = FMAX(lang arts) returns the highest 
language arts score in the school.

FMIN(/ze/rf) finds the minimum numeric value in field for the 
selected records.
Argument: field is the field containing the data.
Section Summary Example: = FMIN(soc st) returns the lowest 

social studies score for each 
grade.

Report Summary Example: = FMIN(soc st) returns the lowest 
social studies score in the school.

FPAGE returns the current page number of a report. FPAGE can 
be used in a page header or footer.
Arguments: None.
Page Footer Example: = FPAGE returns 4 if it is currently 

the fourth page of a report.
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FPREV returns the previous value of a report definition cell.
Arguments: None.
Record Detail Line Example: = FPREV + students computes a 

cumulative total of the number 
of students in each successive 
class in the school.

Section Summary Example: = FPREV + FSUM(students) computes
a cumulative total of the number 
of students in each grade in the 
school.

FSTD(/ze/<Z) computes the standard deviation of the numeric values 
in field for the selected records.
Argument: field is the field containing the data.
Section Summary Example: = FSTD(math) returns the standard

deviation of the math scores for 
each grade.

Report Summary Example: = FSTD(math) returns the standard
deviation of the math scores in 
the school.

MSWLlfield) sums the numeric values infield for the selected 
records.
Argument: field is the field containing the data.
Section Summary Example: = FSUM(students) returns the total

number of students in each 
grade.

Report Summary Example: = FSUM(students) returns the total
number of students in the 
school.

FVARlfield) computes the variance of the numeric values infield 
for the selected records.
Argument: field is the field containing the data.
Section Summary Example: = FVAR(math) returns the variance of

the math scores in each grade.
Report Summary Example: = FVAR(math) returns the variance of

the math scores in the school.
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Appendix A. Exchanging Data Between 
Jazz Documents
Jazz documents can exchange either static views or HotViews of data.
A static view is not linked to its originating document. For example, 
suppose you paste a Jazz graph into a word processing document. Any 
subsequent changes to the worksheet or database on which the graph is 
based are not reflected in the copy of the graph in the word processing 
document.
A HotView, in a word processing document, is linked to its originating 
document unless you freeze it. For example, suppose you include a 
HotView of a Jazz graph in a word processing document. Any subse­
quent changes to the graph or its associated worksheet or database will 
automatically be reflected in the HotView of the graph in the word pro­
cessing document. Freezing a HotView breaks the link with the origi­
nating document. Cutting or copying a HotView to a document, other 
than a Jazz word processing document, also breaks the link with the 
originating document.

Exchanging
Static Views

* Word processing documents can also include HotViews of this data. See the following 
table.

From:
Use
Command: To:

Use
Command:

Worksheet * Cut or Copy Word Processing 
Database 
Communications 
Worksheet
Form

Paste

Graph * Copy Word Processing Paste

Word Processing Cut or Copy Word Processing 
Database 
Communications 
Form
Worksheet

Paste

Database * Cut or Copy Word Processing
Worksheet
Database
Communications

Paste

Form Cut or Copy Word Processing 
Worksheet 
Communications 
Form

Paste

Communications Copy Worksheet
Word Processing 
Database
Form
Communications

Paste
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Exchanging 
HotViews

•Applies to HotViews in word processing documents.

From: To: Use Command:

Worksheet Word Processing Include
Merge Field

Graph Word Processing Include

Database Word Processing Include 
Merge Field

Word Processing* Word Processing Cut or Copy and Paste
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Appendix B. Memory Management
Jazz takes up about 256K of Macintosh memory, allowing another 256K 
of memory for your work. You can see what proportion of the available 
memory you’re using by choosing the About Jazz... command from the 
Apple menu. The first figure tells you how many kilobytes of memory 
are available for data; the second tells you what percentage of the total 
memory you are currently using. (The second figure depends not only 
on the amount of data you’ve entered, but also on which features of the 
program you are using.) You should use this information as a guideline, 
not as an absolute indicator. You can conserve memory by following 
some of the hints below.
• Close any windows you’re not using.
• Use only one point size and style for the text. The Geneva font takes 

up the least memory.
• Use the point sizes that appear in outline on the Font menu, as they 

take up less memory than those that appear in bold.
• Choose Disable Undo from the Apple menu, which prevents you 

from undoing commands, but saves memory.
• Remove or freeze any unnecessary HotViews in your documents. 

HotViews use more memory than data that is cut or copied from one 
document and pasted in another.

• Reduce the size of the active area in a worksheet by eliminating 
blank rows or columns between blocks of data, and by resetting 
unused cells to the default format. (Formatted or protected cells 
are part of the active area, even if they don’t contain data.) Use the 
Corner Navigator to determine the active area.

• Remove empty records in a database.
• Whenever possible, use a single query definition and a single report 

definition in a database.
• If you don’t have enough memory to generate a database report, 

copy the relevant records to a new database and close the original 
database. Generate the report from the new database.
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International
Systems

US System

Appendix C. Internationalizing Jazz
To start Jazz, put the local system disk in the internal drive. Then, put 
the Jazz Program Disk in the external drive and start Jazz as usual.
Jazz displays dates, times, numbers, and currency in formats appropri­
ate to the local system disk you are using. It also uses the correct collat­
ing sequence (sorting order) for each country.
The Jazz Primer Disk comes with the US system files. Using the Finder, 
delete the US system folder from the Primer Disk, and then copy the 
system folder from the local system disk onto the Jazz Primer Disk.
(Make sure you have a backup copy of the Primer Disk before you do 
this.)
International keyboards use symbols on some keys instead of the words 
that appear on US keyboards. The Handbook and Primer refer to keys 
by their names on the US keyboard. Use the following chart to see 
which keys you should press on the keyboard you are using.

In the Jazz Books: On Your Keyboard:

Backspace

Caps Lock ■O

Enter -rsr

Return

Option -c

Shift O

Tab —1

There are two ways to produce international characters on US 
keyboards. The Key Caps command on the Apple menu lets you 
click characters that don’t appear on your keyboard. You can also 
generate international characters with the Option key and various 
key combinations. Appendix D gives the key combinations for each 
character in the Macintosh character set.
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Appendix D. Macintosh Character Codes
The first column of this table shows the Macintosh character codes 
and the third column shows the Macintosh standard character set. 
Some fonts do not display all the characters listed. If you press a 
combination of keys to produce a character that is not in the font 
you are using, Jazz displays an open square (□) in the document. 
The second column lists character codes in the Lotus International 
Character Set (LICS) that correspond to the codes (and characters) that 
Jazz uses for files converted from Symphony. In some cases, more than 
one LICS code translates to the same Macintosh code. Any LICS charac­
ter that has no equivalent in the Macintosh standard character set ap­
pears as a question mark (?) in the converted document. (A list of those 
codes appears at the end of this appendix.)
The fourth column of the table shows how to generate each character 
using the US Macintosh keyboard. (In some cases, there is more than 
one way to generate the same character.)

Macintosh 
code LICS code Character

On US 
keyboard, press

0 0 control @
1 1 control A
2 2 control B
3 3 control C
4 4 control D
5 5 control E
6 6 control F
7 7 control G
8 8 control H
9 9 control I
10 10 control J
11 11 control K
12 12 control L
13 13 control M
14 14 control N
15 15 control 0
16 16 control P
17 17 control Q
18 18 control R
19 19 control S
20 20 control T
21 21 control U
22 22 control V
23 23 control W
24 24 control X
25 25 control Y
26 26 control Z
27 27 escape
28 28 FS

Continued
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Macintosh 
code LICS code Character

On US 
keyboard, press

29 29 GS
30 30 RS
31 31 US
32 32 space space
33 33 exclamation I
34 34 double quote
35 35 pound sign #
36 36 dollar sign $
37 37 percent %
38 38 ampersand &
39 39 single quote
40 40 left parenthesis (
41 41 right parenthesis )
42 42 asterisk *
43 43 plus +
44 44 comma
45 45 hyphen -
46 46 period
47 47 slash /
48 48 zero 0
49 49 one 1
50 50 two 2
51 51 three 3
52 52 four 4
53 53 five 5
54 54 six 6
55 55 seven 7
56 56 eight 8
57 57 nine 9
58 58 colon
59 59 semicolon
60 60 less than <
61 61 equal =
62 62 greater than >
63 63 question mark ?
64 64 at sign @
65 65 A A
66 66 B B
67 67 C C
68 68 D D
69 69 E E
70 70 F F
71 71 G G
72 72 H H
73 73 I I
74 74 J J
75 75 K K
76 76 L L
77 77 M M
78 78 N N
79 79 O O

Continued
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Macintosh 
code LICS code Character

On US 
keyboard, press

80 80 P P
81 81 Q Q
82 82 R R
83 83 S S
84 84 T T
85 85 U U
86 86 V V
87 87 w w
88 88 X X
89 89 Y Y
90 90 Z Z
91 91 left bracket [
92 92 backward slash \
93 93 right bracket ]
94 94,130,146 ” (circumflex)
95 95 underscore —
96 96,128,144 ' (grave accent)
97 97 a a
98 98 b b
99 99 c c
100 100 d d
101 101 e e
102 102 f f
103 103 g g
104 104 h h
105 105 i i
106 106 j j
107 107 k k
108 108 I I
109 109 m m
110 110 n n
111 111 0 0

112 112 P P
113 113 q q
114 114 r r
115 115 s s
116 116 t t
117 117 u u
118 118 V V

119 119 w w
120 120 X X

121 121 y y
122 122 z z
123 123 left brace {
124 124 vertical bar I
125 125 right brace }
126 126,132,148 ■ (tilde)
127 127 del
128 196 A (A with umlaut) Option-u A
129 197 A (A with ring) Shift-Option-A
130 199 Q (C with cedilla) Shift-Option-C

Continued
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Macintosh 
code LICS code Character

On US 
keyboard, press

131 201 E (E with acute) Option-e E
132 209 N (N with tilde) Option-n N
133 214 O (O with umlaut) Option-u O
134 220 U (U with umlaut) Option-u U
135 225 a (a with acute) Option-e a
136 224 a (a with grave) Option-' a
137 226 a (a with circumflex) Option-i a
138 228 a (a with umlaut) Option-u a
139 227 a (a with tilde) Option-n a
140 229 a (a with ring) Option-a
141 231 q (c with cedilla) Option-c
142 233 e (e with acute) Option-e e
143 232 e (e with grave) Option-' e
144 234 e (e with circumflex) Option-i e
145 235 e (e with umlaut) Option-u e
146 237 i (i with acute) Option-e i
147 236 i (i with grave) Option-' i
148 238 1 (i with circumflex) Option-i i
149 239 T (i with umlaut) Option-u i
150 241 n (n with tilde) Option-n n
151 243 6 (o with acute) Option-e o
152 242 d (o with grave) Option-' o
153 244 6 (o with circumflex) Option-i o
154 246 o (o with umlaut) Option-u o
155 245 o (o with tilde) Option-n o
156 250 u (u with acute) Option-e u
157 249 u (u with grave) Option-' u
158 251 u (u with circumflex) Option-i u
159 252 u (u with umlaut) Option-u u
160 t (dagger) Option-t
161 176 0 (degree, ring accent) Shift-Option-8
162 162 0 (cent sign) Option-4
163 163 £ (pound sign) Option-3
164 167 § (section mark) Option-6
165 183 • (middle dot) Option-8
166 182 11 (paragraph) Option-7
167 223 B (German double s) Option-s
168 ® (registered) Option-r
169 169 © (copyright) Option-g
170 184 ™ (trademark) Option-2
171 129,145 ' (acute) Option-e Option-e
172 131,147 (umlaut) Option-u Option-u
173 ¥ (not equal) Option-=
174 198 ZE (AE diphthong) Shift-Option-’
175 216 0 (O with slash) Shift-Option-o
176 oo (infinity) Option-5
177 177 ± (plus/minus sign) Shift-Option-=
178 190 < (less than equal) Option-,
179 174 > (greater than equal) Option-.
180 165 ¥ (Yen sign) Option-y
181 181 p, (micron) Option-m

Continued
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Macintosh 
code LICS code Character

On US 
keyboard, press

182 d (partial differential) Option-d
183 S (summation) Option-w
184 II (product) Shift-Option-p
185 173 tt (pi) Option-p
186 f (integral) Option-b
187 170 a (feminine ordinal) Option-9
188 186 2 (masculine ordinal) Option-O
189 fl (capital omega) Option-z
190 230 ae (ae diphthong) Option-’
191 248 0 (o with slash) Option-o
192 191 c (inverted question) Shift-Option-/
193 161 i (inverted exclamation) Option-1
194 -i (logical not) Option-I
195 V (square root) Option-v
196 160 /(Dutch Guilder) Option-f
197 = (approximately equal) Option-x
198 172 A (delta) Option-j
199 171 « (left double angle) Option-/
200 187 » (angle quote right) Shift-Option-/
201 ... (ellipsis) Option-;
202 (non-breaking space) Option-space
203 192 A (A with grave) Option-' A
204 195 A (A with tilde) Option-n A
205 213 O (O with tilde) Option-n O
206 215 CE (OE diphthong) Shift-Option-q
207 247 ce (oe diphthong) Option-q
208 - (en dash) Option- -
209 — (em dash) Shift-Option- -
210 “ (left double quote) Option-[
211 ” (right double quote) Shift-Option-[
212 ‘ (left single quote) Option-]
213 ’ (right single quote) Shift-Option-]
214 175 -r- (divide sign) Option-/
215 O (diamond) Shift-Option-v
216 253 y (y with umlaut) Option-u y
217 221 Y (Y with umlaut) Shift-Option-'
218 /(diagonal fraction bar) Shift-Option-1
219 168 H (general currency) Shift-Option-2
220 < (left single angle quote) Shift-Option-3
221 > (right single angle quote) Shift-Option-4
222 fi (fi ligature) Shift-Option-5
223 fl (fl ligature) Shift-Option-6
224 t (double dagger) Shift-Option-7
225 • (period centered vertically) Shift-Option-9
226 , (low closing single quote) Shift-Option-O
227 180 ,, (low closing double quote) Shift-Option-w
228 %o(per thousand) Shift-Option-e
229 194 A (A with circumflex) Shift-Option-r
230 202 E (E with circumflex) Shift-Option-t
231 193 A (A with acute) Shift-Option-y
232 203 E (E with umlaut) Shift-Option-u
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Macintosh 
code LICS code Character

On US 
keyboard, press

233 200 E (E with grave) Shift-Option-i
234 205 i (I with acute) Shift-Option-s
235 206 1 (I with circumflex) Shift-Option-d
236 207 I (I with umlaut) Shift-Option-f
237 204 I (I with grave) Shift-Option-g
238 211 O (O with acute) Shift-Option-h
239 212 O (O with circumflex) Shift-Option-j
240 Apple logo Shift-Option-k
241 210 0 (0 with grave) Shift-Option-I
242 218 U (U with acute) Shift-Option-;
243 219 U (U with circumflex) Shift-Option-z
244 217 U (U with grave) Shift-Option-x
245 149 i (lowercase dotless i) Shift-Option-b
246 " (circumflex accent) Shift-Option-n
247 ' (tilde accent) Shift-Option-m
248 ’ (macron accent) Shift-Option-,
249 ’ (breve accent) Shift-Option-.
250 (dot accent [above]) Option-h
251 0 (ring accent) Option-k
252 , (cedilla accent)
253 " (double acute accent)
254 i (nasalization sign)
255 (Caron or hacek accent)
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The LICS codes listed below have no equivalent in the Macintosh stan­
dard character set. If you convert a Symphony file that contains any of 
these characters, they will appear as question marks (?) in the Macin­
tosh document.

LICS code Symphony description

133-143
150
151
152
153
154
155
156-159
164
166
178
179
185
188
189
208
222
240
254
255

(undefined) 
ordinal indicator 
begin attribute (display only) 
end attribute (display only) 
unknown character (display only) 
hard space (display only) 
merge character (display only) 
(undefined) 
low opening double quotes 
pesetas sign 
superscript 2 
superscript 3 
superscript 1 
fraction one fourth 
fraction one half 
uppercase eth (Icelandic) 
uppercase thorn (Icelandic) 
lowercase eth (Icelandic) 
lowercase thorn (Icelandic) 
(undefined)
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Glossary
absolute address
A worksheet cell address that always refers to the same cell, even if 
you copy a formula containing the address to another cell or 
range. Dollar signs precede the column letter and row number of 
an absolute cell address (for example, $A$1).
Absolute icon
The icon that appears when you click a cell to enter its address 
into a formula. Clicking this icon lets you change a cell reference 
in a formula from relative to absolute to mixed to relative.
active area
The rectangular area in a worksheet or database that extends from 
the first to the last cell you enter data in or format. The rectangle 
can be as small as one cell or as large as the entire worksheet.
active cell
The worksheet cell or database field, indicated by a highlight, that 
is affected by your next action. If you selected a worksheet or 
database range, the active cell has a white border.
active field box
The area in the Database console that displays the name of the 
field containing the active cell.
active record box
The area in the Database and Use Form consoles that displays the 
active record number.
active selection
The selected area in a document, indicated by a highlight.
Alignment icons
The icons in the Word Processing console that let you left-align, 
right-align, center, or fully justify the text in a document.
anchor well
The well in the Modify Form console that anchors the upper left 
corner of the notation box or the field in a form.
application
One of Jazz’s five subsystems for manipulating data. The five appli­
cations are Worksheet, Graphics, Word Processing, Database, and 
Communications.
argument
A value or set of values that you provide for a function.
arithmetic formula
A mathematical expression in a worksheet or database that tells 
Jazz to calculate a numeric value by using arithmetic operators 
and/or functions (for example, = A5/(12*5) )■
arrow well
A well in the Graphics console that you click to place an arrow on 
a graph. For example, you can use an arrow with text to annotate 
a graph.
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axis label
A numeric or text entry in the Graphics application that you use to 
identify the data on a text axis or the values on a numeric axis.
bar graph
A graph that shows numeric data as a set of evenly spaced bars. 
Each bar is a value in a range you select from a worksheet or 
database.
baud rate
The speed at which data is transmitted or received during a com­
munications session.
border
The area along the top and to the left of a worksheet or database 
that contains column labels and row labels, or field names and 
record numbers.
border line
The vertical line that separates columns from each other in a work­
sheet or database border. When you place the pointer on the bor­
der line, it changes to a double arrow so you can adjust the width 
of the column or field.
Calculate icon
An icon that you click to calculate a worksheet formula in the 
entry box and replace the formula with its value. This icon only 
appears when a formula is in the entry box.
Cancel icon
An icon in the Worksheet and Database consoles that appears as 
soon as you enter data in the entry box. The Cancel icon lets you 
erase the entry in the entry box.
CD indicator
The carrier detect indicator that appears in the Communications 
console when your Macintosh has established a communications 
link with another computer.
cell
The basic unit of the worksheet into which you enter data. In a 
database, the cell contains a field value.
cell address
The location of a worksheet cell, identified by a column label and 
a row number (for example, A5 or BC25).
cell entry
Data entered into a worksheet cell. A cell entry can be a number, 
text, or a formula.
Circular Reference icon
The icon that appears in the Worksheet console if a formula results 
in a circular reference. Clicking this icon selects a cell containing a 
formula that is part of the circular reference.
column
A vertical block of cells in a worksheet. A column is one cell wide 
and runs the length of a worksheet.
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column border
The area at the top of a worksheet that contains the column labels 
(for example, A, B, or CA).
column labels
The letters A through IV at the top of each worksheet column. 
Each letter or letter combination identifies one column.
Communications application
The application that allows Jazz to communicate with another com­
puter. You can send or receive messages and documents, emulate 
VT 100 or VT 52 terminals, and have access to information serv­
ices, mainframe computers, and time-sharing services.
Communications console
The area in the Communications application that contains the RCV 
indicator, the CD indicator, and the terminal keys.
console
The area in each Jazz application below the menu bar. All consoles 
contain icons, wells, boxes, or indicators, but the function of each 
console varies from application to application.
contents box
In the Worksheet console, the area that displays the value in the 
active cell or the formula that produces the value in the active cell. 
In the Database console, the area that displays the contents of the 
active cell within the selected field or record.
Corner Navigator
The icon in the Worksheet console that you click to move to each 
corner in the selected range. If you hold down the Command key 
while clicking this icon, you move to each corner of the active 
area in the worksheet.
criteria
The information you enter in a database query that defines which 
records you want to search for in the database.
cursor
In the Communications application, the location where data you 
enter is displayed on the screen.
cursor well
The well in the Graphics console that you click to edit a notation 
or to make part of the graph active.
data
Information that you enter in Jazz documents. For example, data in 
a worksheet can be numbers, text, or formulas.
database
An organized collection of data consisting of records that are made 
up of fields (for example, name, address, or phone number). The 
fields are the basic units of a database.
Database application
The application that allows you to enter and organize data in fields 
and records. You can then use this application to sort and search 
for records and generate reports.
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Database console
The area in the Database application that contains the active field 
box, the active record box, the contents box, the entry box, the 
Cancel icon, and the Record Navigator.
data bits
The units used to measure the size of a character transmitted 
during a communications session.
data points
The individual data values in a plotted range. On a line graph, data 
points are marked by symbols, and the symbols are connected by 
lines. On a bar graph, data points are marked by the lines across 
the top of a bar.
Decimal Tab icon
The icon in the Word Processing console that you click to set dec­
imal tabs on the ruler. In a word processing document, a decimal 
tab aligns numbers on the decimal point or right-aligns text.
default
An initial setting that Jazz automatically uses unless you change it.
display format
In a worksheet or database, the way a numeric or text value 
appears in a cell, a range, or a field.
double arrow
The shape the pointer assumes in a worksheet or database when 
you place the pointer on a column border line. When the pointer 
is in the shape of a double arrow, you can drag it to change the 
column or field width.
End Navigator
The icon in the Worksheet console that you click to quickly select 
cells and expand or shrink the size of a selected range.
entry box
The box in the Worksheet and Database consoles where you enter 
new data or edit previously entered data.
field
A collection of similar information in a database. All values that 
you enter in a field appear in the same database column.
field value
The contents of a cell in a database.
flow control
The communications setting that regulates the flow of information 
a computer sends or receives during a communications session so 
that nothing is lost due to differences in transmission rate.
Form
The icon that you click to work with a database through a form. A 
form lets you modify or view the information in a database one 
record at a time.
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Form consoles
In the Database application, there are two Form consoles. The 
Modify Form console contains the notation well, the anchor well, 
and the reference box. The Use Form console contains the View 
Matching icon, the View All icon, the Query icon, the active record 
box, the reference box, and the Record Navigator.
formula
A mathematical expression that defines the relationship between 
two or more cells in a worksheet or database. A Jazz formula can 
calculate numeric or text values.
frozen view
In a word processing document, data from another Jazz application 
that is no longer linked to its source. Unlike a HotView, a frozen 
view does not change if you change the source document. You 
can select, edit, cut, paste, and change the font or style of a frozen 
view. (You cannot, however, edit a frozen graph.)
function
A built-in formula, such as the SUM function, that automatically 
performs a certain calculation in a worksheet or database.
Graphics application
The application that lets you create, view, edit, save, and print 
graphs, using database or worksheet data.
Graphics console
The area in the Graphics application that contains the cursor well, 
the line well, the arrow well, the notation well, the Plot Selector, 
and the reference box.
HotView
In a word processing document, a dynamic view of data from 
another Jazz document (for example, a graph). Any changes in the 
original document are reflected in the HotView, unless you break 
the link between the source document and the HotView by freez­
ing it.
insertion point
The location (indicated by a blinking vertical bar) where you can 
enter characters in any Jazz application.
legend
The patterns or symbols and the text used to define the symbols 
or patterns in a graph.
line graph
A graph that represents numeric data as a set of evenly spaced data 
points connected by a line. A line graph shows change over a 
period of time.
Line Space icons
The icons in the Word Processing console that you click to choose 
single-spacing (1), one-and-one-half-spacing (1.5), or double-spacing 
(2) between lines of text.
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line well
The well in the Graphics console that you click to place a line on 
a graph. For example, you can use a line with text to annotate a 
graph.
logical formula
A formula that evaluates a condition by using a logical operator or 
logical function. For example, in the formula
= IF(A7>0,A7 - A8,“Overdrawn”), if the value in A7 is > 0, the 
value in A8 is subtracted from the value in A7; if the value in A7 is 
0 or less, then the word Overdrawn appears in the cell.
long text entry
A text entry that is longer than the current column width and 
either extends into the next column (if the next cell is empty), or 
is cut short and followed by an ellipsis (if the next cell is filled).
mixed address
A worksheet cell address that is part absolute and part relative. A 
dollar sign preceding either the column letter or the row number 
indicates which part is absolute. For example, if a formula in B2 
contains the address A$l, and you copy the formula to cell G8, the 
address becomes F$l.
modem
A device that enables computers to communicate with each other 
through conventional telephone lines.
notation boxes
The boxes created when you click the notation well in the 
Graphics and Modify Form consoles. You can use notation boxes 
for adding text to a graph or for writing instructions on a form.
notation well
The wells in the Graphics and Modify Form consoles that you click 
to place a notation box in a graph or on a form.
numeric axis
The reference line in a graph that you use to plot the numeric 
values for that graph.
operator
A symbol that you use in a worksheet or database formula to indi­
cate the operation to be performed (for example, + , - , *, or /).
page box
The box in the scroll bar that you either click to scroll through a 
document by windows, or press to scroll through windows 
continuously.
parity
The communications setting that determines the type of error 
checking (if any) that Jazz uses when it transmits or receives a 
character during a communications session. The parity can be set 
to odd, even, or none, and both computers must have the same 
setting.
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pie chart
A graph that compares parts to the whole. In a pie chart, each 
value in a range is a wedge of the pie. The size of each wedge cor­
responds to the percentage of the total each value represents.
plot
The part of the graph that represents a range you select from the 
worksheet or database (for example, a line on a line graph or a set 
of bars on a bar graph). Each range you select is a separate plot on 
the graph.
plot marker
The symbol that marks the plot you select in a graph with the Plot 
Selector.
Plot Selector
The icon in the Graphics console that you click to cycle through 
and select one of the plots on a graph so you can clear the plot or 
change its appearance.
Protect icon
The icon in the Worksheet console that only appears if you 
enforce the protection settings in the worksheet.
query
One or more criteria that Jazz uses when searching for records in a 
database.
Query icon
The icon in the Use Form console that you click to display a win­
dow in which you define the criteria for your query.
range
Any rectangular block of selected worksheet cells. The smallest 
range is a single cell, and the largest is the entire worksheet (for 
example, A2 or A2..B7). To create a graph, you use a range of 
worksheet entries.
range address
The location of a range in a worksheet. A range address consists of 
the address of the upper left cell and the address of the lower right 
cell separated by one or more periods (for example, A2..C4).
RCV indicator
The indicator in the Communications console that shows if you are 
currently receiving data in a document or a selection. The RCV 
indicator appears only when you are receiving data without using a 
protocol.
Recalculate icon
The icon that appears if you make a change in the worksheet that 
affects the value of any formula (and recalculation mode is set to 
Manual). Clicking this icon recalculates the worksheet.
record
A set of information in a database that contains a single value for 
each field. A record appears as a single row and each record has a 
record number that identifies it,
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Record Navigator
The icon in the Database and Use Form consoles that you click to 
move to the first or last selected record by using the black arrows. 
You click the white arrows to move to the next or previous 
selected record.
Reference Board
The window that displays the name of the last Jazz document from 
which you made a selection. The Reference Board also displays the 
range address for a worksheet selection, or the first field name for 
a database selection.
reference box
The area in the Graphics and Word Processing consoles that dis­
plays the name of the source document for a plot or a selected 
HotView. The area in the Modify Form and Use Form consoles that 
displays the database associated with the form.
relative address
A worksheet cell address in a formula that is always relative to the 
cell containing the formula. If you copy a formula with a relative 
address, the address changes to reflect its new position in relation 
to the formula. For example, if a formula in cell B2 contains the 
relative address Al and you copy the formula to cell G8, the 
address becomes F7.
row
A horizontal block of cells across a worksheet. A row is one cell 
deep and runs the width of the worksheet.
row border
The area to the left of a worksheet that contains the row labels (for 
example, 1, 2, or 57).
row labels
The numbers, ranging from 1 to 8192, that identify each worksheet 
row.
selection box
The area in the Worksheet console that displays the address or 
name of the selected cell or range. You can also type an address in 
a selection box to locate that address in the worksheet.
size box
The box in the lower right corner of the active window or 
notation box that you drag to change the size of the window or 
notation box. In a notation box, the size box appears as a small 
black square.
stacked bar graph
A graph that compares totals as well as individual values. Each part 
of each stacked bar represents a value in one of the ranges you are 
graphing.
static view
In any Jazz application, the data that you cut, copy, or paste using 
the Clipboard. Unlike a HotView, a static view is no longer linked 
to its source document and does not change when the original data 
changes.
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stop bits
Additional bits that follow each character in a communications ses­
sion to signal the character’s end.
stretch box
The box at the end of an arrow or line in a graph, which you drag 
to change the size of the arrow or line.
symbols
The characters that mark each data point on the plot of a line 
graph or scatter graph.
Tab icon
The icon in the Word Processing console that you click to set tabs 
on the ruler.
terminal keys
The keys on the Communications console that are equivalents for 
the keys on the VT 100 keypad.
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text axis
The reference line in a graph to which you add axis labels that 
identify the data you are graphing.
text display format
The way text appears in a worksheet cell or database field.
text formula
A formula that uses or refers to a text value in a worksheet or data­
base. For example, if Al contains “data” and Bl contains “base,” 
then the value of A1&B1 is database.
value
A number or the result of a formula.
View All icon
The icon in the Use Form console that you click to view all 
records in the database.
View Matching icon
The icon in the Use Form console that you click to view records 
in the database that match the criteria in your query.
what-if table
In the Worksheet application, there are two what-if tables. A 1-way 
table shows the changes to one or more formulas when you place 
different values in one cell. A 2-way table shows the changes to 
one formula when you place different values in two cells.
window
The area of the screen through which you can view a portion of a 
document.
Word Processing application
The application that allows you to create, edit, and format docu­
ments. Using a HotView, you can also include dynamic views of 
information from other documents in a word processing 
document.

333 Glossary



Word Processing console
The area in the Word Processing application that contains the Line 
Space icons, the Alignment icons, the Tab icon, the Decimal Tab 
icon, and the reference box.
worksheet
An electronic spreadsheet organized into columns and rows.
Worksheet application
The Jazz application that allows you to enter numbers and text into 
an electronic worksheet so you can perform calculations with that 
data.
Worksheet console
The area in the Worksheet application that contains the selection 
box, the contents box, the entry box, and various icons.
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Index

About Jazz... command 26
ABS function 284
Absolute address 60-61, 73, 79
Absolute icon 61, 79
ACOS function 287
Active

area 79, 86 
cell 37, 42-44, 54, 65, 79-81, 185 
database 221, 228
document 6, 8, 10, 25, 27, 161, 

174, 266
field 185, 222, 233, 251, 255 
graph 104
notation box 251 
query 201, 203-204, 244 
record 187, 233 
report definition 216-218, 247 
window 25, 31-32, 151, 202, 240

Active field box 233
Active record box 187, 220, 233, 

255
Active record number 222-223
Add Another Field button 198, 241
Add Field...command 193, 240
Adding 

characters 186 
criteria 231 
fields 193, 228, 240 
text 118-119, 225-226

Add Record command 184, 222, 
240

Address
absolute 60, 73, 79 
cell 36-37, 41-42, 54, 73-74, 

79-80
range 41, 44, 53, 69-70, 79-80,

92-93
Alert message 54, 151, 268
Align Fields command 253
Aligning 

footers 16, 29 
headers 16, 29 
labels 167 
numbers 90-91, 155-157, 242-243 
text 21, 39, 64, 82, 90-91 

155-157, 169-170, 191, 242-243
Alignment icons 156, 169
Anchor 251
Anchor well 228, 251
Answer command 266, 275
Apple menu 26-27
Applications

Communications 1, 14, 18, 22, 
26, 32, 270

closing 11

Database 1, 32, 102
Graphics 1, 32, 36, 102
icons 6-7, 27, 143, 182, 261, 266 
menus 26
opening 6
quitting 11
starting 6
Word Processing 1, 9, 16, 18, 32,

141-142
Worksheet 1, 18, 32, 102

Area command 107, 132
Area graph 105-107, 132 
Arguments, function 57, 282 
Arithmetic formulas 53
Arithmetic functions 56
Arrows 120-121
Arrow well 120, 127
ASIN function 287
Associate command 135
ATAN function 287
ATAN2 function 287
Auto-dialing 277
Automatic answer 267, 275
Auto wrap 262, 276
AVG function 53, 56-57, 296
Axis 135

graph 114-117
labels 114-117, 137-138 
numeric 114-117, 136-138 
settings 115-116, 136-137 
text 114, 115-117, 136-137 
titles 115-116, 136

Axis menu 136-137

Backspace key 38, 119, 146-147, 
201, 264 See also Cancel icon; 
Cut command

Bar command 107, 109, 130
Bar graph 103, 108-110, 113, 129
Baud rate 261, 263, 276
Blank

form 221
records 184, 200, 240
report definition 209

Blinking vertical bar 143, 145, 185, 
224

See also Insertion point
Border line 65, 80, 233
Bottom... command 115, 137
Break field 208, 211, 214, 247

Cables 263, 266-267, 276
Calculated fields 195, 235
Calculate icon 56, 79
Calculating

with dates 71-72
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field values 197-198
with formulas 53. 94, 197-198, 

235. 241
with functions 56-57, 281 
with logical formulas 59 
with numbers 37
with text formulas 58
with time 71-72

Cancel button 17, 27, 30-31, 167, 
268, 280

Cancel icon 39, 79, 184, 233 
Canceling 83 See also Erasing 

cell entry 39, 79
HotView 162 
moved range 50 
protection 67

Cancel Titles command 66, 93 
Caps Lock key 144
CD indicator 273 
Cell address 36-37, 41-42, 54, 

73-74, 79-80
in formulas 53, 58, 60, 82 

CELL function 300
CELLPOINTER function 301
Cell references 55, 61, 79 
Cells 36, 86

active 37, 42-44, 54, 65, 79-81.
185 

copying 47, 64 
copying formulas to 49, 60-62 
cutting 50, 64 
display format 63-64, 72, 83 
editing 39-41, 79, 83 
erasing 39, 46-47, 49 
formatting 38, 63-64, 72 
in frequency distribution 97 
hiding 68, 92 
moving 47-48 
protecting 67, 92, 97 
removing data 83 
replacing data 40, 83 
selecting 42-43, 79, 81, 186-187,

234 
transposing 50, 86-87 
value 53-54, 57, 65. 68-69 
in what-if table 73-76, 95 

Center icon 156, 169 
Change button 151 
Changing See also Sizing 

cells 40, 44 
cells in what-if table 73-76 
column widths 65, 80, 244, 280 
database 190-191 
disk 10 
display formats 63-64 
field attributes 190 
field values 184-185 
fonts 13-14, 32, 120, 124 
graph types 111-112 

lines 120-122 
patterns 121-122 
plots 110-111, 112 
point size 13-14, 124 
query 203-205 
query name 205 
range names 70-71 
report definition 218-219 
sort fields 200 
symbols 121-122 
window size 12

Changing appearance See also
Formatting

form 220, 225-228
numbers 38, 63-64, 90-91 
text 64 
worksheet 63-66

Character codes 88, 244, 276, 279, 
317-323

CHAR function 307
CHOOSE function 301
Circular Reference icon 55, 80 
CLEAN function 307
Clear button 204, 219, 244, 248 
Clear command

Communications 275 
Database 193, 224, 228, 240 
Form 252. 256
Graphics 128
Word Processing 146, 154, 159, 

162, 171
Worksheet 46, 83, 85 

Clearing report definitions 219 
Clear Labels command 115, 1,37 
Clear Page Break command 93 
Clear Pie Wedges command 105,

135
Clear Point Labels command 135 
Clicking 12 

cell 37, 40, 58, 83 
close box 25 
to enter 54, 58, 79. 185 
HotView 174 
icon 6, 27, 79-80, 169-170, 182, 

261
insertion point 41 
page box 25, 42, 144 
scroll arrow 12, 25, 42 
scroll bar 25 
scroll box 42 
to select 42, 45, 81, 124, 170, 

186, 228, 234
window 32

Clipboard 20, 31. 46-47, 85-86, 119, 
147

Close box 10, 25, 27, 158, 172, 203 
Close command 10, 25, 27
Closing

document 10, 27
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Query window 203 
report definition 215 
window 25, 150, 152, 

158, 172, 203, 244
CODE function 307 
COLS function 301 
Columns 36, 79, 94 

deleting 50-52 
freezing 65-66, 93 
headings 209-210 
inserting 51-52, 87 
labels 51, 80 
multiple copies 48 
pasting into 87 
selecting 45, 81 
separators 243, 244, 279 
transposing 50 
widening 65, 80, 244 
widths 244, 280

Column Widths... command 65, 97 
Combining documents

See Including HotView 
Combining graph types 111-113 
Command key 26, 81, 184, 193, 

274
Commands See also specific 

commands
dimmed 84, 87, 122, 

128, 252, 274
Commands menu 275 
Communications 261-265, 273-280 

calling another computer 266-267 
connection settings 262-264, 276 
hanging up 270 
modem settings 264, 277 
point size in 14, 262, 276 
printing 18, 30 
receiving document 268-270 
saving settings 265, 267 
sending document 267-268 
terminal settings 261-262, 275-276

Communications application 1, 14, 
18, 26, 32, 270

Communications icon 261, 266 
Communications menu bar 274 
Communications window 268, 270, 

273, 274-275, 276, 288
Compute button 96
Compute Distribution command 97 
Compute Table command 96 
Connection... command 263, 276 
Connection settings 262-264, 276 

baud rate 261, 263, 276 
data bits 263, 276 
flow control 263-264, 276 
parity 261, 263, 276 
stop bits 263, 276

Console
Communications 273

Database 233
Graphics 110, 118, 120, 122, 127 
Modify Form 251
Use Form 255
Word Processing 169
Worksheet 79, 94

Contents box 37-39, 54, 79, 185, 
233

Continue button 17, 167
Control characters 307
Convert button 22
Convert... command 22, 26 
Converting documents 21-23, 26 
Copy command 20

Communications 274
Database 194, 239
Graphics 119-120, 128
Modify Form 252
Use Form 256
Word Processing 147-148, 154, 

162, 171
Worksheet 47, 49, 61, 85

Copying
ceils 47, 64
display format 64
between documents 19-21 
existing document 9 
fields 194-195
formulas 49, 60-62, 72
HotView 162 
range names 62 
records 194-195 
rulers 154 
start-up disk 6 
text 147-148

Corner Navigator 44, 79
Correcting errors 37-38, 55, 57, 59 
COS function 287
COUNT function 296
CPYSGN Function 284
Creating

blank records 184
database 182-183 
documents 6-7, 143, 266 
fields 182-183
footers 16, 158-159, 172 
form 221-222 
form letters 163 
graph 112, 189
headers 16, 158-159, 172 
mailing labels 166 
query 202 
report 206-219 
report definition 216

Criteria 201-203, 205, 230, 244
See also Searching database 

Criterion range 297-298 
Cursor well 127
Cut command 20
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Communications 274 
Database 194, 239 
Graphics 119-120. 128 
Modify Form 252
Use Form 224, 256
Word Processing 147, 154, 162, 

171
Worksheet 46, 47, 49-50, 83, 85 

Cut Record command 256 
Cutting

cells 46-47
cells with formulas 49 
display format 64 
field values 194 
HotView 162 
records 194
text 147-148

Database 21, 23, 240
adding blank records 184 
changing 190-191 
changing fonts 13 
converting 21 
copying 194-195 
creating 182-183 
defined 180
deleting fields 193, 228
deleting records 193 
editing 184, 236
entering information 184-186, 

222, 235-236
fields 182-183, 184-186, 239-245 
formatting 191-192 
and form 220-224, 251 
in form letter 163
graphing 8. 102, 105, 135, 189 
including HotView of 161. 174 
inserting records 192, 223, 256 
and mailing labels 166 
moving 194-195
pasting into 20-21, 23, 194-195, 

243
printing 15
protecting 196
query 237-238
receiving data in 269-270 
records 165, 184-186, 230-231, 

234, 239-245
reports 206-219, 245-248 
searching 201-205
selecting areas in 186-189 
sending 278
sorting 199-200, 208, 214, 245 

Database application 1. 32, 102 
Database icon 182
Database menu bar 233, 239-248
Database window 204, 244

Data bits 263, 276
Data points 103, 105, 106, 117, 133
Data ranges 95, 130, 133, 135, 1.38. 

297
Date command 175
DATE function 292
Date

calculating with 71-72 
entering 64, 71-72, 82 
in footer 29, 158, 163 
format 64, 71, 90-91, 98, 242 
freezing 175
in header 29, 158, 163
inserting 16, 29, 158, 163
inserting HotView of 163

DATEVALUE function 293
DAVG function 298
DAY function 293
DCOUNT function 298
Decimals 37, 71, 98, 137, 191, 242
Decimal Tab icon 155, 169
Decimal tab marker 155. 170
Define Criteria command 230-231.

256
Delete Report Line command 240 
Deleting 37, 39-40

arrows in graph 121
cell 46-47
characters 145, 184, 186, 224 
columns 50-52
field values 193, 228
fields 193, 228
lines in graph 121 
notation box 225 
page break 93, 157 
a plot 111, 113 
query 204-205 
range 46-47
range names 70-71 
records 193
rows 50-52
rulers 154
text 116, 119, 145-147, 152, 

225-226
Desk Accessories 27, 163
Dial command 264, 266, 275
Dialog box 27, 92, 165, 240, 243, 

280
Dimmed command 84, 87, 122, 

128, 252, 274
Disable Undo command 27
Discard button 71, 92, 204, 219, 

245, 248
Disk

changing 10
ejecting 10. 22 
inserting 6
Jazz Program 6
Jazz Start-Up 6, 10, 13
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Macintosh 22
saving documents on 8-10, 22, 

221, 268
storage 6, 17, 36, 218 

Display format 38, 47, 49, 63-64, 
85, 89-91. 97-98, 137, 242 

DMAX function 298
DMIN function 299 
Documents

active 6, 8, 10, 25, 27, 161, 174, 
266

canceling changes in 10 
closing 10, 27 
converting 21-23, 26 
copying between 19-21 
creating 6-7, 143, 266 
formatting between 21 
including HotView of 19, 

161-162, 174, 313-314 
moving between 19-21 
naming 8-9, 269 
opening existing 7, 27, 104, 164, 

166, 266
opening new 6-7, 27, 104, 143, 

164
printing 17, 29-31, 171-172, 175 
receiving 268-270, 273, 278-280 
renaming 9
saving existing 8-9, 27, 265 
saving new 8-9, 27, 265 
selecting entire 145 
sending 267-268, 277-278 
word processing 142-167, 169-176

Dollar sign 61 See also Absolute 
address

Done button 92, 198, 201, 204, 
217-219, 245, 248

Double arrow 65, 190
Double-clicking 6-7, 27, 42, 87, 174,

185, 223
Double Space icon 157, 170 
Dragging

border line 65, 80, 190
HotView 174-175
margin marker 170 
notation box 118 
scroll box 12, 42 
to select 43, 81, 144, 170-171,

186, 224
size box 12, 119, 124, 162 
stretch box 120
title bar 25

Drive button 7, 10, 22, 218
Drop Duplicates command 205, 244 
DSTD function 299
DSUM function 299
Duplicate command 128
Duplicate Notation

command 119, 128

DVAR function 299

Editing 39, 79, 83, 240
database 184, 236
field value 184-185, 223-224 
form 251
HotView 162, 174 
merged field 165 
query 204 
range address 70 
range names 70-71 
text 119, 150, 152-153, 225, 236 
worksheet 39-41, 79, 83

Edit menu
Communications 274-275
Database 239-244
Modify Form 252
Use Form 256
Worksheet 84-88

Eject button 7, 10, 22
Ellipses 26, 38, 63, 183, 185, 259
Enable Undo command 27
Ending Jazz 11,31
End Navigator 43-44, 79
Entering

database data 184-186, 222, 
235-236

dates 64, 71-72, 82
field values 184-186, 222
formulas 53-56, 79, 82, 211-212, 

235
fractions 37, 82
logical formulas 59-60
numbers 37-38, 82 
query 237 
text 38-39, 82, 143-144 
text formulas 58 
time 64, 71-72, 82

Enter into Formula... command 56, 
70, 87

Enter key 37, 54, 70, 81
Entry box 37, 42, 54, 79, 185, 233 
Equal sign

with field name 209, 211, 215, 
246-247

with formula 38, 53, 82, 184 
Erasing See Backspace key; Cancel 

icon; Deleting; Removing 
ERR function 302
EXACT function 307
EXP function 284
EXP1 function 284
EXP2 function 284
Expanding See also Shrinking;

Sizing; Widening
columns 65, 80. 244, 280
range 44, 81
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selection 145, 170, 274
Exploding pie wedges 104-105, 129, 

135
Explosion range 105, 135

FALSE function 288
FAVG function 311
FCOUNT function 311
Field attributes 182, 190, 196-201 
Field Attributes... command 190, 

196, 240
Field Format... command 191, 210, 

241, 247
Field menu 252
Field name 187, 190, 211, 221

in database 182, 187, 190
in report 209, 211-212, 215, 246 
in word processing document 165 

Fields 180, 239-245, 251
active 185, 222, 233, 251, 255 
adding 193, 228, 240 
copying 194-195 
creating 182-183
deleting 193, 228 
erasing 208, 211-214, 247 
in form 220, 228, 256 
formatting 191-192 
locking 196, 229 
merged 30-31. 164-165. 175 
moving 194-195, 227 
pasting 20-21, 195 
selecting 164, 186-188, 234 
sort 199-200, 208, 215, 241. 245

Field values
adding 184-185 
calculating 197-198 
changing 184-185 
checking 197 
copying 194-195 
deleting 193
editing 184-185, 223-224 
entering 184-186, 222 
in form 222-224 
moving 194-195
in report 209, 211-214, 246

File menu 6, 15, 27-3 1 
Files, converting 21-23, 26
Fill... command 38, 89
Find... command 149-150
FIND function 307
Finding text See Searching 
Find Next command 173
Find window 149-150, 172-173
First sort field 199, 245
First sort range 95 
FIXED function 59, 308
Flow control 263-264, 276

FMAX function 311 
FMIN function 311 
Font menu 13, 32. 124 
Fonts 13-14, 32 

in footers 158 
in graphs 120, 128, 138 
in headers 158 
in legend 124 
size 13-14, 32, 262 
styles 14, 97, 176

Footer... command 158, 163, 172 
Footers 28-29

aligning 16, 29 
with communications 18 
creating 16, 158-159, 172 
date in 29. 158, 163 
formatting 16. 29 
page numbers in 29, 163 
in report 210, 213, 246 
time in 29, 163

Form 1 
adding fields 220, 228, 256 
changing appearance of 220, 

225-228 
changing fonts 13 
creating 221-222 
and database 220-224, 251 
deleting fields 222, 228 
field values in 222-224 
printing 30 
protecting 229, 252 
query 230-231 
rearranging 226-227 
saving with database 221 
text in 225-226 
viewing records with 223 

Format... command
Graphics 137
Worksheet 37-38, 63-64, 72, 89 

Format menu 29, 171-172 
Formats See also Display format 

date 71. 82, 90-91 
function 282 
numeric 89, 98, 137, 242, 282 
page 15-16, 28 
time 71-72, 82, 90-91 

Formatting 82 See also
Display format 

after converting files 23 
between documents 21 
cells 38, 63-64, 72 
database 191-192 
dates 242 
documents 154-159 
footers 16, 29 
graphs 137 
headers 16, 29 
numbers 38, 63-64, 90-91.

242-243
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pages 15-16, 28
and protection 67
report definition 210 
text 39, 64, 91, 154-159, 

191-192, 242-243
time 243
word processing

document 154-159, 171-172 
worksheet 38, 63-64, 72

Form icon 221
Form letters 163-165, 175
Formulas 67, 72, 85, 93, 98, 203 

with absolute address 60, 73 
arithmetic 53
calculating with 53, 94, 197-198, 

235, 241
cell address in 53, 58, 60, 82 
circular references 55, 80 
copying 49, 60-62 
cutting 46, 49
entering 53, 79, 82, 211-212, 235 
with functions 58, 282-283 
invalid 46-47, 49, 52
logical 53, 59-60 
moving 49
parenthesis in 55, 57, 84 
with range name 69-70 
recalculating 56, 73, 75, 80, 93 
with relative address 60, 73 
in reports 211-212, 246 
text 53, 58
in what-if tables 73-76, 95

FPAGE function 246, 311
FPREV function 312
Fractions 37, 82
Freeze command 175
Freezing

columns 65-66, 93
graph 175-176
HotView 162, 175-176, 313 
rows 65-66, 93 
titles 65-66, 93

Frequency distribution 96-97
FSTD function 312
FSUM function 312
Full Justification icon 156, 169
Function name 282
Functions 53, 87, 283

arguments 57, 282
arithmetic 56
calculating with 56-57, 281 
calendar 283, 292-295 
data range 283, 297-299 
defined 36, 56
financial 283, 290-292
format 282
in formulas 58, 282-283 
logical 56, 283, 288-290 
mathematical 56, 283, 284-286

range name 70
report 213, 246, 284, 310-312 
special 283, 299-306 
statistical 283, 295-297
text 56, 284, 306-310 
trigonometric 283, 286-288

FV function 290
FVAR function 312

Generate Document...
command 218, 247

Graphics application 1, 32, 36, 102
Graphics menu bar 128
Graphics window 105
Graphing

database 8, 102, 105, 135, 189 
ranges 103-110, 118, 129-135 
worksheet 8, 36, 102, 105, 135 

Graphs 102-104
adding lines and arrows 103, 

120-121
adding text 114-115, 118-120, 138 
adding tick marks 114-117, 133, 

136-137
axis 114-117
changing plot type 110, 111 
changing point size 13 
clearing plot 111
creating 112, 189 
dragging notation box 118 
frozen 175-176 
grid 124-125
including HotViews of 161
labeling 114, 115-118 
legend 123-124 
patterns 106, 121-123, 138 
plot lines 121-123 
printing 125
selecting plot 110-111
sizing 125
symbols 121-123
in word processing document 102

Graph types
area graph 105-107, 132
bar graph 103, 108-110, 113, 129 
combining 111-113
line graph 103, 105-107, 113 
overlapped bar 110, 113, 129-130 
pie chart 104-105, 129, 134 
stacked bar 109, 113, 129, 131 
stock market 129, 133

Grid lines, in HotView 161
Grid Lines... command 124-125, 138

Hang Up command 270
Header... command 158, 163, 172
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Headers 28-29
aligning 16, 29
with communications 18
creating 16, 158-159, 172
with date 29, 158, 163
formatting 16, 29
in report 210, 213, 246
with time 29, 163

Hide Borders command 97
Hide Grid command 97, 248
Hide Record Numbers command 248
Hide Rulers command 171
Hiding

cells 68, 92
range 68
rulers 154
worksheet data 68

Highlighted 7, 37, 43, 54 See also
Active; Selecting

cell 37, 80, 180
characters 40, 186
entry box 185
selection box 42
text 54, 144

HLOOKUP function 302 
HotView 19, 142, 160, 161-167, 

174-176
editing 162, 174
freezing 162
grid lines in 161
including 19, 161-162, 174 

HotView menu 174-176
HOUR function 293

I-beam 40, 144, 185
Icons

Absolute 61, 79
Alignment 156, 169
Application 6-7, 'Ll
Calculate 56, 79
Cancel 39, 79, 184-185, 233
Center 156, 169
Circular Reference 55, 80 
clicking 6, 27, 79-80, 169-170.

182, 261
Communications 261, 266
Corner Navigator 44, 79
Database 182
Decimal Tab 155, 169
Double Space 157, 170
End Navigator 43-44, 79
Form 221
Full Justification 156, 169
Jazz 6
Left 156, 169
Line Space 157, 169
1.5 space 170
Plot Selector 105, 110, 113, 118,

122, 127

Protect 67, 80, 92 
Query 230, 255 
Recalculate 56, 80, 93-94
Record Navigator 188, 223, 233, 

255
Right 156, 169
Single Space 157, 170
Tab 155, 169
View All 231. 255
View Matching 231, 255 
Word Processing 143

IF function 288
Imagewriter 15, 28 
Include command 161. 174 
Including HotView 19, 161-162, 

174, 313-314
Indentation marker 155, 156, 170 
Indenting paragraph 155-156 
INDEX function 303
Initial value 182-183, 190, 240 
Input cells 73-76, 95
Input range 298
Insert Columns command 51, 87 
Insert Field command 192
Insert Page Break command

Word Processing 18, 171 
Worksheet 18

Insert Record command
Database 192, 223
Use Form 256

Insert Report Line command 210, 
240

Insert Rows command 51, 87 
Insert Ruler command 154, 171 
Inserting See also Entering 

cell address 41 
characters in field value 186, 224 
column 51-52. 87 
date 16, 29. 158. 163 
disk 6 
fields 192 
footers 158-159, 172 
headers 158-159. 172 
page breaks 18, 171-172 
page numbers 16, 163 
range address 41 
records 184, 192, 223, 256 
row 51-52, 87, 210 
ruler 154 
text 143-145 
time 158, 163

Insertion point 40, 123. 143, 158, 
185

Integrating data 2, 19 See also 
Including HotView; Source 
document

INT function 285
Invalid formulas 46-47, 49, 52
IRR function 291
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ISBLANK function 289
ISERR function 289
ISNA function 289
ISNUMBER function 289
ISREF function 289
ISSTRING function 290

Jazz icon 6
Jazz Program Disk 6
Jazz Start-Up Disk 6, 10, 13
Justification 155-156 See also

Aligning

Locking fields 196, 229
LOG function 285
Logging off 270
Logging on 266
Logical

formula 53, 59-60
function 56, 60
operator 59, 203

Long
label 117
number 65 
text entry 39, 65, 124

Lotus International Character Code
(LICS) 317-323

Lotus 1-2-3 21-23, 26
LOWER function 308

Keys
Backspace 38, 119, 144, 146-147, 

201, 264
Caps Lock 144
Command 26, 79, 81, 184, 193
Enter 37, 54, 70, 80-81 
Key Caps 316
Option 188, 190, 234, 316
Return 37, 44, 54, 144, 156, 158, 

234, 275
Shift 44, 79, 144, 145, 234
Tab 44, 81, 144, 158, 185, 234

Labeling a graph 114-117, 137
Labels

axis 114-117, 137-138
column 51, 80
data points 117-118
long 117
row 51,80

Left... command 115, 136
LEFT function 308
Left icon 156, 169 
Legend, graph 123-124, 138
Legend command 138
LENGTH function 308
Line

graph 103, 105-107, 113 
separators 244, 279 
spacing 157, 169

Line, Bar, & Area command 107, 
129

Line command 107, 129
Lines, in graphs 120, 122, 128, 138
Lines... command 122, 138
Line Space icon 157, 169
Line well 120, 127
LN function 285
LN1 function 285
Lock command 229, 252

Macintosh Character Codes 88, 244, 
276, 279, 284, 307, 317-322

Macintosh Control Panel 163
Macintosh Font Mover utility 13
Macintosh Numeric Keypad 274
Macintosh techniques 12, 42
Mailing labels 15, 142, 166-167, 175 
Margin markers 170
Margins 15, 16, 18, 28, 29, 155, 170
Matching criteria 203, 230 See also 

Searching database
MAX function 296
Memory 26, 45, 163, 240, 315
Menu 26
Menu bar 7

Communications 274
Database 251, 255
Graphics 127
Modify Form 220-221, 229, 252
Use Form 220-221,

256
Word Processing 171
Worksheet 79

Merged fields 30-31, 163-165, 175
Merge Field... command 164-165, 

175
Microsoft file 21-22, 26
MIN function 296
MINUTE function 294
Mixed address 60, 79 See also 

Absolute address;
Relative address

Modem 264, 267, 275, 277 
defined 260

Modem... command 264, 1~n
Modem settings 

modem type 264, 277 
phone number 264, 277 
phone type 264, 277 
saving 264
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MOD function 285
Modify Form command 225-228, 

229, 256
Modify Form menu bar 220-221, 

229, 252
MONTH function 294
Mouse button 12, 43
Moving

among records 188, 223, 233, 255
around documents 26, 144
around a form 223
around a worksheet 42-43
arrows in graph 121
cells 44, 47-48
database 194-195
between documents 19-21
fields 194-195, 227
field values 194-195 
formulas 49 
legend 124, 138 
lines in graph 121 
notaton box 120, 138, 227 
ranges 47-48 
records 194-195 
text 147-148 
window 25 
worksheet 42

Multiple copies 48, 50, 62, 87

N function 304
NA function 304
Name... command, Worksheet 69,

92
Names... command, Database 201, 

203, 205, 216-219, 244, 247
Naming

database 183
a document 8-9, 269
a query 201-205
range 44, 69-70, 92 
report definition 216, 248

New button 7, 27, 143, 244, 261
New... command 6, 27

Communications 261
Database 104, 182
Graphics 104, 107-108
Word Processing 143, 164-165, 

221
Worksheet 104, 107-108

No Duplicates command 256
Notation box 32, 118, 128, 225,

251
moving 120. 138, 227

Notation well 118, 127, 251 
NOW function 294
NPV function 291

Numbering pages 16, 29, 159, 163,
213

Numbers
aligning 90-91, 156, 242-243
as arguments 282
in database formulas 241
in date 71-72
entering 37-38, 82
in field values 184 
formatting 38, 63-64, 90-91, 

242-243
in graphs 130-131, 137
as labels 117
pasting 86
in time 72

Numeric
axis 114-117, 136-138 
data in graphs 103, 106, 108 
formats 89, 98, 137, 242, 282

OK button 10, 30, 69, 125, 167, 
196, 264

1.5 Space icon 170
1-way table 73, 76, 95
Open button 7, 27, 264
Open Cell command

Database 189, 240
Worksheet 41, 83, 87

Open command 6, 161, 208
Open... command 7, 19, 22, 27

Communications 266
Graphics 104
Word Processing 164, 166

Opening
applications 6, 208
dependent document 8 
existing documents 7, 27, 104, 

164, 166, 266
graph 104
new document 6-7, 27, 104, 143, 

164
Operators

in database formulas 236
list of 84, 87
logical 59, 203
in reports 211-2 12
text 58
in worksheet formulas 53-55, 

58-59
Option key 188, 234, 316
Original document See

Source document
Outlined

active cell 186
point sizes 13

Overlapped Bar command 110, 130
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Overlapped bar graph 110, 113,
129-130

Page
box 12, 25, 42, 144 
breaks 16, 18, 28, 93, 157, 

171-172
footer 213, 246 
format 15-16, 28 
header 210, 246 
settings 15-16, 28 
size 215, 247

Page Break command 18
Page command 159, 175
Page numbers 16, 29, 159

in report 213 
inserting HotView of 163

Page Setup... command 15, 28, 30, 
218, 247

Paper size 15, 28
Parentheses

in formulas 55, 57, 84
with functions 283

Parity 261, 263, 276
Parse settings

column separators 243-244, 279 
column widths 244, 280 
ignore characters 244, 280 
line separators 244, 279

Parse Settings... command 
Communications 270, 279 
Database 243
Worksheet 88

Paste command 20, 51, 119-120, 
171

Communications 275
Database 195, 239
Graphics 119-120, 128
Modify Form 252
Use Form 256
Word Processing 147-148, 154, 

162, 171
Worksheet 47, 51, 62, 85

Paste Field command 20
Paste Record command 20
Paste Special command 50, 86
Paste Values command 20
Pasting 20-21, 23 See also Cut 

command; Copy command 
cells 47-49
cells with formulas 49, 86 
into database 20-21, 23, 243 
fields 20-21, 195 
field values 195
in a graph 119-120, 128
HotView 162
numbers 86

range 47
records 20-21. 195
text 88, 147-148, 243
into worksheet 20-21, 46-48,

85-86
Patterns, in graphs 106, 121-122, 

138
Patterns... command 122, 138 
Pause button 17, 30, 167 
Percent command 129
Phone number, for 

communications 264, 277
Pie charts 104-105, 129, 134 

exploding wedges 104-105, 129, 
135

Pie command 104, 129, 134
Pie Wedges command 135
PI function 285
Place command 228, 252
Plot lines, graph 121-123
Plot marker 110, 129
Plot menu 112, 129
Plots

changing 110, 111-112
defined 103
removing 111 
selecting 110-111

Plot Selector 105, 110, 113, 118, 
122, 127

Plot type
changing 110, 111-112

PMT function 291
Pointer

as double arrow 65, 190
as I-beam 40, 144, 185
moving 42-43, 45

Point Labels command 135
Point size 13-14, 32, 262, 276 
Precedence numbers 55, 84 
Preview... command 217, 247 
Previewing report 217, 247 
Print... command 218, 247
Print Current command 17, 30
Print Document... command 17, 30, 

165, 167
Printer port 263, 276
Printers 15, 18, 28
Printing

with communications 18, 30 
entire document 17, 29-30 
footers 29, 158 
form letters 163-164 
graph 125 
headers 29, 158
interrupting 17, 30-31, 167 
mailing labels 166-167 
page breaks 93, 157. 171 
part of document 17, 29-30 
report 218, 247
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ruler 154
text only 17, 30
word processing document 15, 30, 

175
worksheet 15

Printing options 15-18,30-31
Print Merge... command 15, 30.

164-165, 167, 175
Print Selection... command 17, 30
PROPER function 308
Protect icon 67, 80, 92
Protecting

cells 67, 92, 97
database 196
form 229, 252
range 67, 92
worksheet 47, 49, 67-68, 92, 97 

Protection... command 67-68, 80, 92 
Protection settings 67, 80, 92

canceling 67
after cutting 47, 49, 85

Protocol 267
PV function 292

Query
database 201-205, 217, 244-245 
entering 237
form 230-231
name 205

Query icon 230, 255
Query menu 244-245, 256
Query window 201, 203-204, 230, 

244-245
Quit command 11, 31
Quitting Jazz 11,31
Quotation marks, in contents 

box 38-39, 57-58, 79. 82, 192, 
283

RAND function 286
Range address 41, 44, 53, 69-70, 

79-80, 92-93
in formulas 53. 58

Range menu 89-94, 98
Range names 44, 69-70, 87, 92, 93 

changing 70-71
copying 62
deleting 71
editing 70-71

Ranges 80
copying 47-48
copying range names 62 
defined 43 
erasing 46-47 
expanding 44, 81 
explosion 105, 135

formatting 63-64
in frequency distribution 96 
graphing 103-110, 1 18, 129-132, 

135
hiding 68
input 298
multiple copies in 48
names 44, 62, 69-71, 87, 92-93 
pasting 47
plotting 103-110, 118, 129, 135 
protecting 67, 92
selecting 43-44, 81
shrinking 44, 81
transposing 86-87

RCV indicator 269, 273, 280
Recalc Settings... command 56, 93
Recalculate command 56, 80, 94
Recalculate icon 56, 80, 93, 94
Recalculating formulas 56, 73, 75, 

80, 93 "
Receive menu 278-280
Receiving a document 268-270, 273, 

278-280
Record Navigator 188, 223, 233,

255
Record number 186, 187
Records 180, 239-245

blank 184, 200, 240
copying 194-195
deleting 193
dropping duplicate 205
field values in 184-186, 194-195, 

197-198, 222
in form 256
inserting 184, 192, 223, 256 
moving among 188, 223, 233. 255 
pasting 20-21, 195 
in report 240
selecting 165, 186-188, 230-231, 

234, 240
searching for 201-203
sorting 199-200, 208, 214, 245

Redo command
Word Processing 171
Worksheet 84

Reference Board 19, 21, 268
Reference box 110, 127, 169, 251, 

255
Reformatting See Changing 

appearance; Formatting
Relative address 60, 73. 79, 85-86
Removing text 147-148 See also

Backspace key; Cancel
icon; Deleting

Renaming
a document 9
query 205

REPEAT function 308
Replace... command 151, 173
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REPLACE function 309
Replace window 150-152, 173 
Replacing text

in database 185
in word processing 

document 150-153, 173
in worksheet 40, 83

Report 206-219, 245-248 
break field 208, 211, 214, 247 
changing report

definition 218-219 
definition 209-216, 218-219, 240, 

246
formulas in 235 
naming report definition 216 
page footer 213, 246 
page header 210, 246 
page size 215, 247 
previewing 217, 247 
printing 218, 247 
producing 216-218 
record detail line 211, 246 
report summary 214, 246 
section header 211 
section summary 212, 246 
sorting database for 208, 214, 249 

Report definition 240, 246
blank 209 
changing 218-219 
clearing 219 
closing 215 
formatting 210 
naming 216, 248 
setting up 209-215

Report Definition window 209, 215
Report menu 245-248
Reset button 199, 244, 280
Return key 37, 44, 54, 143, 156, 

158, 185, 222, 234
Revert to Saved command 10, 31 
Review Names... command 70, 92 
Right... command 115, 137 
RIGHT function 309
Right icon 156, 169 
ROUND function 286
Rows 36, 79 

deleting 50-52 
freezing 65-66, 93 
inserting 51-52, 87, 210 
label 51, 80 
multiple copies 48 
pasting into 87 
selecting 45, 51. 81 
transposing 50

ROWS function 304
Ruler 154-159. 169, 171

S function 305
Save As... command 9-10, 27, 265 
Save button 9-10, 218
Save command 9, 27, 265
Saving 

communications settings 265, 279 
database with form 221 
dependent document 10 
entire document 9, 27 
existing document 8-9, 27, 265 
new document 8-9, 27, 265 
page settings 28 
print settings 30 
report 218 
report definition 216 
on a separate disk 10 
text only 9, 27

SCALE function 286 
Scatter command 129 
Scientific notation 38, 63 
Scrapbook 148
Scroll arrow 12, 25, 42, 57,

144, 217
Scroll bar 12, 22, 25, 43, 145,

247
Scroll box 12, 25, 42, 144 
Scrolling 7, 12, 22, 25, 43, 145, 

187, 247
Searching 

database 201-205 
for records 201-203 
for text 149-150, 172-173

Search menu 172-174 
SECOND function 294 
Second sort field 199, 245 
Second sort range 95 
Select All command

Communications 275 
Graphics 128 
Modify Form 252 
Word Processing 145, 159, 165, 

170-171
Worksheet 67, 86 

Select All Records 
command 189, 217, 234, 240 

Selecting 15, 19, 45
cells 42-43, 79, 81, 186-187, 234 
by clicking 42, 45, 81, 124,

170, 186, 228, 234 
column 45, 51.81 
database areas 186-189 
by double-clicking 42, 170 
by dragging 43, 170 
entire document 145 
field 164, 186-188, 234 
field value 223 
plot 110-111 
range 43-44, 81
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record 165, 186-188, 230-231, 
234, 240

row 45, 51, 81
sort field 200
text 144-145, 170 
by typing 44 
a word 145

Selection box 42, 70, 79
Select with Criteria 

command 204, 244
Send Answerback command 275
Sending documents 267-268, 

277-278
Send Long Break command 275
Send Menu 277-278
Send Short Break command 275
Set Answerback...

command 277
Set Distribution Ranges... 

command 96
Set Fields... command 199-200, 

245
Set File... command 267, 277,

278
Set First Page # command 159, 

171-172
Set Labels command 115. 137
Set Left Titles command 65, 93
Set Legend command 123, 138
Set Page Break command 93
Set Pie Wedges command 105, 

135
Set Point Labels command 135
Set Selection command 268, 

270, 278, 279
Set Sort Ranges... command 94
Set Table Ranges... 

command 95, 96
Settings 

after converting files 23, 26 
axis 115-116, 136-137 
communications 261-265, 

275-277
connection 262-264, 276 
justification 157
line 122
margin 155 
modem 264, 277 
page 15-16, 28
Parse... 243-244, 279-280 
pattern 122 
print 17, 30-31 
protection 67-68, 80, 85, 92 
recalculation 56, 93 
saving 265 
symbol 122 
tab 155
terminal 261-262, 275-276

Settings menu 275-277

Setting up
query 203
report definition 209-215

Set Titles command 93
Set Top Titles command 65, 93 
Shift-clicking 79, 81, 145, 170, 

274
Shift key 44, 79, 144. 145, 234, 

274
Show Attributes command 56, 64, 

68, 92, 97
Show Borders command 97
Show Definition command

Query menu 202, 204, 244
Report menu 209, 219, 246

Show Definitions...
command 175, 246

HotView menu 165, 167, 175
Show Grid command 97, 248
Show Record Numbers 

command 248
Show Rulers command 154, 171
Show Values command 97, 166,

167
Word Processing 166, 167
Worksheet 56, 64, 68, 97

Shrinking See also Expanding; Sizing 
columns 65 
range 44, 81
selection 145, 170, 274

SIN function 288
Single Space icon 157, 170 
Size box 12, 25, 119, 124, 162, 

226, 251
Size,., command 125, 138
Sizing

field 226, 251
graph 125
HotView 162, 174
legend box 138
notation box 118, 225-226, 251 
window 12, 25, 31

Sort button 95, 200, 245
Sort command

Database 199, 245
Worksheet 95

Sort field 199-200, 208, 215, 
241, 245

Sorting
database records 199-200, 208, 

214, 245
worksheet 94-95

Sort menu 245
Source document 19, 161. 169, 

174-176, 313 See also
HotView

SQRT function 286
Stacked Bar command 109, 131 
Stacked bar graph 109, 129, 131
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Start command 268, 270, 278,
280

Starting Jazz 6
Start-Up disk 6, 10, 13
Static views 174, 313 See also 

HotView
STD function 297
Stock market graph 129, 133 
Stock Market... command 133 
Stop bits 263, 276
Stop command 270, 280
Stretch box 120-121
Style menu 14, 32

Database 248
Graphics 124, 138
Modify Form 253
Word Processing 176
Worksheet 97

SUBSTR function 309
SUM function 57, 282, 297
SYLK format 21-23, 26
Symbols

ampersand 58-59
asterisk 203
dollar sign 61
equal sign 38, 53, 82, 184, 209, 

211, 215
in graphs 103, 121

Symbols... command 122, 138
Symphony file 21-23, 26

Tab icon 154-155, 169
Tab key 44, 81, 144, 158, 185, 234
Tab marker 155, 170
Tabs 155, 169-170 See also

Formatting
TAN function 288
Telephone port 263, 276
Terminal... command 261, 273, 

275-276
Terminal emulation 261-262
Terminal keys 262, 273, 276
Terminal settings

auto wrap 262, 276 
columns per line 262, 276 
end of line 262, 275 
font size 262, 276 
local echo 262, 276 
show key pad 262, 276 
terminal mode 262, 275

Text 138, 176
adding 118-119, 225-226 
aligning 21, 39, 64, 82, 90-91 

155-157, 169-170, 191, 242-243
as arguments 57, 282 
axis 114, 115, 117, 136, 137 
copying 147-148

cutting 147-148
deleting 116, 119, 145-147, 152, 

225-226
editing 119, 150, 152-153, 225 
entering 38-39, 82, 143-144 
in field values 184 
formatting 39, 64, 91, 154-159, 

191-192, 242-243 
formulas 53, 58 
functions 56, 59 
in graphs 114-115, 118-120, 138 
indenting 156 
in legend 123-124 
moving 147-148
with numbers 39, 82, 185, 192 
pasting 88, 147-148, 243 
removing 147-148 
replacing 150-153, 173 
in report definition 209 
searching for 149-150, 172-173 
selecting 144-145, 170 
style 14, 32

Text formatting characters 39, 82, 
185, 191

Text only 9, 17, 30, 218, 247, 
278-279

Third sort field 199, 245
Third sort range 95
Tick marks 114-117, 133, 136-137 
Time

calculating with 71-72 
entering 64, 71-72, 82 
in footer 163, 175 
formats 64, 71-72,82, 91, 243 
freezing 175 
in header 165, 175 
inserting HotView of 163

Time command 175
TIME function 295
TIMEVALUE function 295
Title

axis 115-116, 136 
bar 25, 202-203 
graph 115-116, 136 
report 209-210 
worksheet 65-66, 93 

Tools menu 94-97 
Top... command 115, 137 
Transposing entries 50, 86-87 
TRIM function 309 
TRUE function 290 
2-way table 74-75, 95-96 
Typefaces 13, 32 
Type menu 128-129 
Typing

to enter cell address 42, 58, 79 
to enter formula 54 
to enter range address 44, 58, 79 

Typing mistake See Correcting errors
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I ndo button 92
Undo command

Communications 274
Database 239, 252
Graphics 119, 128
Use Form 256
Word Processing 171 
Worksheet 83, 84

Undo Disabled command
Database 239
Graphics 128
Modify Form 252
Use Form 256
Word Processing 171 
Worksheet 84

Undo Paste command 49
Unlock command 252
UPPER function 309
Use Form command 222, 225, 

230-231, 252
Use Form menu bar 220-221, 256

Value function 310
Values

cells 53-54, 57, 65, 68, 89 
checking 68
field 184-186, 191, 193-198,
in form letters 164-165
formulas 53-55, 58-60, 73-76, 79, 

84, 93
function 57, 282
graphing 103, 105, 108-109, 110 

114, 116, 117, 131-133
pasting 86
what-if 73-76

VAR function 297
Vertical bar 16, 40, 185 See also 

Insertion Point
View All icon 231, 255
View All Records command 231, 

256
View Horizontal command 129
View Matching icon 231, 255
View Matching Records 

command 231, 256
View Vertical command 129
VLOOKUP function 305

What-if table 73-76, 95
Widening columns 65, 80, 244, 280 

See also Expanding; Shrinking
Wildcard characters 203, 236, 238
Window list 32
Window menu 8, 12, 21. 31-32, 

104, 268, 270

Windows See also Zoom Up 
command

active 25, 31-32, 151, 202, 240 
closing 25, 150. 152, 158, 172, 

203, 244
defined 12
moving 25 
sizing 12, 25, 31

Word Processing application 1, 9, 
16, 18, 32, 141-142

Word processing document 
changing fonts 13-14, 32. 120, 

124
converting 23
copying text 147-148 
deleting text 145-148.152 
entering text 143-144 
footer 158-159, 163, 172 
formatting 154-159, 171-172 
form letters 163-165 
freezing HotView 162, 313 
HotView 19, 160, 161-162, 174, 

313-314
mailing labels 142, 166-167, 175 
merged fields 163-165,

175
moving text 147-148 
printing 15, 30, 175 
receiving data 269 
replacing text 150-153, 172-173 
searching 149-150, 173 
selecting text 144-145, 170 
sending 278 
worksheet data 36, 163, 174-175 

Word processing icon 143 
Worksheet

cells 37-38, 41-48, 54, 63-64,
72, 83, 79-81, 185-187, 234 

changing appearance 63-66 
changing fonts 13-14, 32 
columns 45, 48, 50-52, 65-66, 80, 

87
converting to 21, 23, 26 
copying cells 47-48, 85 
copying formulas 60-62, 85 
cutting 46-48, 85 
defined 35-36
deleting rows or columns 50-52 
display formats 63, 89-91, 98 
editing 39-41, 79, 83 
entering date or time 71-72, 82 
entering formulas 53-56, 58-60 
entering fractions 37, 82 
entering numbers or text 37-38, 

82
erasing 46-47, 85 
font styles 14, 97 
formatting 38, 63-64, 72 
in form letters 163
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formulas 53-56, 58-60, 80, 82 
freezing rows or columns 65-66, 

93
functions 56-58
graphing 8, 36, 102. 105, 135 
including HotView of 161 
inserting rows or columns 51-52,

87
moving around in 42-43
moving data 47-48
naming a range 44, 69-70, 92 
overlaying 86
pasting 20-21, 46-48, 85, 86 
printing 15
protection 47, 49, 67-68, 92, 97 
range names 70
recalculating 56, 73, 75, 80, 93 
receiving data 268-270, 279 
rows 45, 48, 51-52, 65-66, 79-80, 

87
selecting cells 42-43, 79, 81 
selecting a range 43-44, 81 
selecting rows or columns 45 
sending 278
sorting 94-95
titles 65-66, 93
transposing 50, 86-87 
using operators 84
what-if tables 73-76, 95 
widening columns 65, 80
in word processing document 36, 

163, 174-175
Worksheet application 1, 18, 32,

102
Worksheet menu bar 84

X Data command 134
XModem protocol 22, 26, 267, 276, 

278, 280

Y Data command 134
YEAR function 295
Yes button 27

Zoom Down command 12, 31
Zoom Up command 12, 31
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Reader 
Comment 
Form

Once you are familiar with the Primer and the Handbook, please answer 
the following questions.

Which applications did you learn to use from the Primer?
□ Worksheet □ Database
□ Graphics □ Communications
□ Word Processing

Which applications did you learn to use from the Handbook?
□ Worksheet □ Database
□ Graphics □ Communications
□ Word Processing

When do you use the Primer?
□ For learning about Jazz □ As a reference □-----------------------------

When do you use the Handbook?
□ For learning about Jazz □ As a reference □-----------------------------

Do you use one book more than the other?
□ Primer more than the Handbook □ Handbook more than the Primer
□ Use them equally

Please comment on the quality and the number of illustrations and 
examples in the Primer and the Handbook.

Is there any information that you needed and were unable to find in the 
books? If yes, please describe.

What errors, if any, did you find in the books?
Book Title Page No. Error

How would you describe yourself?
□ First-time computer user
□ User of one other software package
□ User of several software packages
□ User of one other integrated software package
□ _______________________________________ —---

How often do you plan to use Jazz?
□ 1 hour a week □ I hour a day □ 2 or more hours a day
□ ________________________________________ ___

Name _ _______________________________________________ ___________

Title____________________ Company---------------------------------------- ------

Address___________________________________________________________

City__________________________ State-----------------------Zip-----------------

Telephone_____________________________ Date---------------------------------
Completed and returned forms become the property of Lotus 
Development Corporation.



Tape here

L
L

Fold here

BUSINESS REPLY MAIL
FIRST CLASS PERMIT NO. 1359 CAMBRIDGE, MA

Postage will be paid by addressee:

Lotus Development Corporation
Attn: Documentation Department
161 First Street
Cambridge, MA 02142-9990

Hi......Illllll II I I I I I II I II



L
'Li
L
■

L
■■

u
L
■
■
■



Lotus Development Corporation
1’61 First Street
Cambridge, MA 02142

Part No. 17001


	‎M:\Apps\1985\Lotus Jazz\Manual\Lotus_Jazz_Handbook_000a.tif‎
	‎M:\Apps\1985\Lotus Jazz\Manual\Lotus_Jazz_Handbook_000b.tif‎
	‎M:\Apps\1985\Lotus Jazz\Manual\Lotus_Jazz_Handbook_365.tif‎
	‎M:\Apps\1985\Lotus Jazz\Manual\Lotus_Jazz_Handbook_366.tif‎

